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Welcome to MicroEJ developer documentation. Browse the following chapters to familiarize yourself with MicroEJ
Technology and understand the principles of app and platform development with MicroEJ.

The Glossary chapter describes MicroEJ terminology.

The Overview chapter introduces MicroEJ products and technology.

The SDK User Guide chapter presents the MicroEJ Software Development Kit.
The Application Developer Guide presents how to develop a Java application.

The Platform Developer Guide teaches you how to integrate a C Board Support as well as simulation config-
urations.

The Kernel Developer Guide introduces you to advanced concepts, such as partial updates and dynamic app
life cycle workflows.

The Tutorials chapter covers a variety of topics related to developing with the MicroEJ ecosystem.
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CHAPTER

ONE

MICROEJ GLOSSARY

This glossary defines the technical terms upon which the MICROEJ VEE (Virtual Execution Environment) is built.

Add-On Library An Add-On Library is a pure managed code (Java) library. It runs over one or more Foundation
Libraries.

Abstraction Layer An Abstraction Layer is the C code that implements a Foundation Library’s low-level APIs over
a board support package (BSP) or a C library.

Application An Application is a software program that runs on a Powered by MicroEJ device.

Standalone Application A Standalone Application is an Application that is directly linked to the
C code to produce a Mono-Sandbox Firmware.

Sandboxed Application A Sandboxed Application is an Application that can run over a Multi-
Sandbox Firmware. It can be linked either statically or dynamically.

System Application A System Application (formerly called a Resident Application) is a Sand-
boxed Application that is statically linked to a Multi-Sandbox Firmware, as it is part of the
initial image and cannot be removed.

Kernel Application A Kernel Application is a Standalone Application that implements the ability
to be extended to produce a Multi-Sandbox Firmware.

Architecture An Architecture is a software package that includes the Core Engine port to a target instruction set
and a C compiler, core Foundation Libraries ([EDC], [BON], [SNI], [KF]) and the Simulator. Architectures are
distributed either as evaluation or production version.

Core Engine, also named “MEJ32” The Core Engine, also named MEJ32, is a scalable 32-bit core for resource-
constrained embedded devices. It is delivered in various flavors, mostly as a binary software package. The
Core Engine allows applications written in various languages to run in a safe container.

Firmware A Firmware is the result of the binary link of a Standalone Application with a Platform. It can be pro-
grammed into the flash memory of a device.

Mono-Sandbox Firmware A Mono-Sandbox Firmware is a Firmware thatimplements an unmod-
ifiable set of functions. (formerly called a Single-app Firmware)

Multi-Sandbox Firmware A Multi-Sandbox Firmware is a Firmware thatimplements the ability to
be extended, by exposing a set of APIs and a memory space to link Sandboxed Applications.
(formerly called a Multi-app Firmware)

Foundation Library A Foundation Library is a library that provides core or hardware-dependent functionalities.
A Foundation Library combines managed code (Java) and low-level APIs (C) implemented by one or more
Abstraction Layers through a native interface (S\/).

Mock A Mock is a mockup of a Board Support Package capability that mimics an hardware functionality for the
Simulator.
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Module Manager MicroEJ Module Manager (MMM) downloads, installs and controls the consistency of all the de-
pendencies and versions required to build and publish a MicroEJ asset. It is based on Semantic Versioning
specification.

Platform A Platform integrates a MICROEJ VEE, an Architecture, one or more Foundation Libraries with their re-
spective Abstraction Layers, and the board support package (BSP) for the target Device. It also includes as-
sociated Mocks for the Simulator.

SDK MICROEJ SDK allows Firmware developers to build a Powered by MicroEJ device, by integrating an Architec-
ture with both Java and C software on their device.

Simulator The Simulator allows running Applications on a target hardware simulator on the developer’s desktop
computer. The Simulator runs one or more Mock that mimics the hardware functionality. It enables devel-
opers to develop their Applications without the need of hardware.

Studio The Studio is the part of the SDK that can be rebranded by customers for their specific ecosystem. It allows
application developers to write a Sandboxed Application, run it on a Virtual Device, deploy it on a Powered
by MicroEJ device, and publish it to a MicroEJ Forge instance.

VEE MICROEJVEE is an applications container. VEE stands for Virtual Execution Environment, and refers to the first
implementation that embeds a virtual 32-bit processor, hence the term “Virtual”. MICROEJ VEE runs on any
OS/RTOS commonly used in embedded systems (FreeRTOS, QP/C, uc/0S, ThreadX, embOS, Mbed OS, Zephyr
0S, VxWorks, PikeOS, Integrity, Linux, QNX, ...) and can also run without RTOS (bare-metal) or proprietary
RTOS. MICROEJ VEE includes the small MEJ32, along with a wide range of libraries (Add-On Libraries and
Foundation Libraries).

Virtual Device A Virtual Device is a software package that includes the simulation part of a Firmware: runtime,
libraries and application(s). It can be run on any PC without the need of the SDK. In case of a Multi-Sandbox
Firmware, it is also used for developing a Sandboxed Application in the SDK.
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CHAPTER

TWO

OVERVIEW

The MicroEJ product line offers profitable solutions to device manufacturers, application developers and service
providers for:

« Device software development at lower cost and effort,
+ Application development and deployment for generating extra revenue streams with services and data.

MicroEJ solutions enable delivery of user experience and business models similar to mobile Internet (smartphones
and tablets) for embedded devices with strong cost constraints and strict resource limitations (processor perfor-
mance, RAM and flash memory footprint, low-power). It also combines the techniques, methods and tools that
drove the PC and mobile Internet software industry, with the complex technical foundations of embedded systems
(fragmented processor architectures and diverse hardware-dependent software).

With MicroEJ solutions, you will use proven methods that cut software development time and cost. You will create
software that delivers incredible user experience and adjusts to the needs of your business.

2.1 Getting Started

MicroEJ Getting Started is available on https://developer.microej.com/get-started/.
Starting from scratch, the steps to go through the whole process are:

« Download and install a SDK Distribution;

+ Select between one of the available boards;

« Import a demo Application;

« Download and install the corresponding Platform for the target hardware;

+ Run the Application on Simulator with a Virtual Device;

« Build the Application for the target hardware to produce a Firmware;

« Deploy the Firmware on the board.

The following figure gives an overview of the SDK workflow:
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Fig. 1: SDK Workflow Overview

2.2 MICROEJ VEE

MicroEJ VEE (Virtual Execution Environment) is an applications container for resource-constrained embedded de-
vices running on microcontrollers or microprocessors. It allows devices to run multiple and mixed managed code
(Java, JavaScript) and C software applications.

MicroEJ VEE provides a fully configurable set of services that can be expanded, including:
» asecure multi-application framework,
+ aGUI framework (includes widgets),
« anetwork connection with security (SSL/TLS, HTTPS, REST, MQTT, ...),
« astorage framework (file system)

« aJava Cryptography Architecture (JCA) implementation.

2.2. MICROEJ VEE 5
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Fig. 2: MICROEJ VEE Overview

2.3 MICROEJ SDK

MICROEJ SDK offers a comprehensive toolset to build the embedded software of a device. The SDK covers two
levels in device software development:

« Device Firmware development
+ Application development

The firmware will generally be produced by the device OEM, it includes all device drivers and a specific set of Mi-
croEJ functionalities useful for application developers targeting this device.

2.3. MICROEJ SDK 6
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Sources y Sources
MICROEJ.SDK
Firmware Development Application Development
Import Build
Virtual
Device
Build
|7
Target Local Deploy
i MICROEJ
7 rmware ” APPLICATION
Build Flash — (r) —
L7 Install Publish

MICROEJ.Forge

Fig. 3: SDK Workflow Overview

Using the SDK, a firmware developer will produce two versions of the MicroEJ binary, each one able to run appli-
cations:

« A Firmware binary to be flashed on OEM devices;
« AVirtual Device which will be used as a device simulator by application developers.
Using the SDK, an application developer will be able to:

« Import Virtual Devices matching his target hardware in order to develop and test applications on the Simu-
lator;

+ Deploy the application locally on an hardware device equipped with the Firmware;

« Package and publish the application on a MicroEJ Forge Instance, enabling remote end users to install it on
their devices. For more information about MicroEJ Forge, please consult https://www.microej.com/product/
forge.

The following diagram outlines the SDK content. Please refer to the SDK User Guide chapter for more details on the
SDK and its usage.
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Fig. 4: SDK Components Overview
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THREE

SDK USER GUIDE

MICROEJ SDK is an integrated environment to create software applications for MicroEJ-ready devices. The SDK
provides tools to write applications and run them on a virtual (simulated) or real device. The capability to execute
an application in a simulated environment allows to quickly test changes done in the application code and hence
provide a short development feedback loop.

Since the purpose of the SDK is to develop for targeted MCU/MPU computers (IoT, wearable, etc.), it is a cross-
development tool. But unlike standard low-level cross-development tools, the SDK offers unique services like
hardware simulation and local deployment to the target hardware.

MS.- Simulator
|
: Test
MlCROEJSDK MICROEJ
APPLICATION Target
@) | Publish el

MICROEJ, Forge

Fig. 1: MicroEJ Application Development Overview

The SDK is composed of the following main elements:

+ SDK Version 5.x, an Integrated Development Environment (IDE) for writing Applications and building
Firmware. It is based on Eclipse Java edition and relies on the integrated Java compiler (JDT).

Itis also packaged with Eclipse to produce a SDK Distribution.

+ MicroEJ Module Manager, the module and build manager used to compile and package any kind of MicroEJ
modules natures. It provides a Command Line Interface to build modules, especially used in a Continuous
Integration environment. See MicroEJ Module Manager section for more details.

+ Architecture, the software package that includes the MEJ32 port to a target instruction set and a C compiler,
SOAR, core libraries and Simulator. See MicroEJ Architecture section for more details.

The SDK allows to connect repositories hosting software modules in source and binary form. By default, it is con-
figured with the repositories provided MicroEJ Corp.:




MicroEJ Documentation, Revision d4ede019

+ Centraland Developer Repository, the modules repositories containing all the libraries required to develop

an Application. See Module Repositories section for more details.

« Github Repositories, source repositories with examples and demos. See GitHub Repositories section for

more details.

The SDK is licensed under the SDK End User License Agreement (EULA). The following figure shows a detailed view
of the elements.

SDK Distribution YY .MM

& MICROEJ, <DK

Eclipse Rich Client Platform (RCP)

SDK Version 5.m.p

Java Linter & Debugger

Text Editors (C/C++, Markdown, XML)
Code Quality (Sonarlint & Null Analysis)

- i
s eclipse

SDK Version5.m.p @

Workbench & Wizards
Front Panel Designer
Platform Builder
Memory Map Analyzer
Heap Analyzer

Font Designer

Module Manager Ef?

Module Dependencies Resolver
Build Tools (including Java Compiler)
Command Line Interface

Module Natures

(skeletons, build types, plugins)

Architecture

MICROEJ SDK EULA

(End User License Agreement)

©MEJ:.

Core Engine (MEJ32)

SOAR

Simulator

Front Panel

Runtime Foundation Libraries
o EDC, BON, SNI, KF

ELF tools for C Toolchain linking
Build & Link Scripts

License Check

J

3.1

Installation

Fig. 2: SDK Detailed View

@ Module Repositories

Central Repository

Various Licenses: ‘ . @
SDK EULA, Apache, Eclipse, BSD, etc.

Packs
. Foundation Libraries

Add-On Libraries
. Abstraction Layer Implementations
. Add-On Tools

Developer Repository
Packs ‘ (r)

Foundation Libraries
Add-On Libraries
. Abstraction Layer Implementations
Demo Applications Modules
Demo Platform Modules
. Demo Firmware & Virtual Devices

GitHub Repository

O

Libraries Usage Examples

Demo Applications Sources

Demo Platform Sources

Ecosystem Tools

Abstraction Layer Implementations

This chapter will guide you to install the SDK Distribution on your workstation.

If you want to evaluate MicroEJ, we recommend to refer to the Getting Started chapter which will guide you to install
a SDK Distribution compatible with the Getting Started page.

3.1. Installation
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i
MICROEJ,

SDK

-
w» eclipse
Fig. 3: SDK Splash Screen

3.1.1 Install Latest SDK Distribution

This section will guide you to install the latest SDK Distribution 22.06 using the step-by-step executable installer.

The SDK Distribution 22.06 requires a JDK 11 and thus can only work with an Architecture 7.17.0 or higher. In all
other cases, please jump to /nstall SDK Distribution 21.71 section. See also the System Requirements page for more
information on the list of supported environments.

Note: Launching the SDK Distribution installer requires administrator privileges and a JDK 11 installed by default
on your workstation. If you don’t have one of them or if you do not want to modify your default settings, please
jump to Install Portable SDK Distribution section.

Download SDK Distribution

Download the SDK Distribution 22.06 installer for your operating system:
« Windows (.exe)
o Linux (.zip)
» macOS x86_64 - Intel chip (.zip)
+ macOS aarch64 - M1 chip (.zip)

3.1. Installation 1
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Check JDK Version
The SDK Distribution 22.06 installer requires a JDK 11 installed by default on your workstation. If you don’t have
any JDK installed, see the Get JDK section.

Check the default Java version by running the following command in a new terminal:
> java -version

openjdk version "11.0.15" 2022-04-19
OpenJDK Runtime Environment Temurin-11.0.15+10 (build 11.0.15+10)
OpenJDK 64-Bit Server VM Temurin-11.0.15+10 (build 11.0.15+10, mixed mode)

Now you can proceed with the installation steps.

Install SDK Distribution

« Launch the installer executable
- OnWindows, start MicroEJ-SDK-Installer-Win64-22.06.exe.

- On Linux, unzip MicroEJ-SDK-Installer-Linux64-22.06.zip and start
MicroEJ-SDK-Installer-Linux64-1.0.0.sh.

- On macOS, unzip MicroEJ-SDK-Installer-Linux64-22.06.zip and start
MicroEJ-SDK-Installer-Mac0S-1.0.0.app.

& Installation of MicroEl® SDK Dist. 22.06 - X
Welcome ‘ D}
Step 10f8 g

T=| Welcome to the installation of MicroEJ® SDK Dist. 22.08!
Q This software is developed by:

- MicroEJ <support@microej.comz
@ The homepage is at: http://developer.microej. com

MICROEJ.

Qan

Fig. 4: Welcome to the installer

« Clickonthe Next button.

+ Select |accept the terms of this license agreement. . Then click onthe Next button.

3.1. Installation 12
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& Installation of MicroEl® SDK Dist. 22.06

Licensing Agreements
Step 4of 8

@ Please read the following license agreement carefully:

OMICRCEJ SDE EULR

PEEAMELE

THIS SCOFIWARE LICENSE AGREEMENT (THE

« AGEEEMENT =») APPLIES TC PRODUCTS LICENMSED BY
INDUSTRIAL SHART SOFIWARE TECHNOLOGY 5.4
CPERATING UNDER THE BRAND NAME MICRCEJ, 11 RUE
DU CHEMIN RCUGE, F-44373 NHANTES,

MT DO T THCTTILTIMNC 2V AR TTE CIRCINIARTES

FRANCE

(®) I accept the terms of this license agreement.

MICROEJ]

@ Previous

(_) Ido not accept the terms of this license agreement.

© quit

Fig. 5: Accept the terms of this license agreement

+ Select the installation path of your SDK. By defaultitis C:\Program Files\MicroEJ\MicroEJ-SDK-22.06
for Windows. Then click onthe Next button.

& Installation of MicroEl® SDK Dist. 22.06

Target Path
Step 5of 8

— x

[& select the installation path:
C:\Program FiIesWiUoEJWiUoEJ—SDK—ZZ.06|

MICROEJ]

-@ Previous @ Quit

E Browse...

Fig. 6: Choose the installation path

+ Clickonthe OK button to confirm the installation path.

3.1. Installation
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@ Installation of MicroEl® SDK Dist, 22.06 — *
Target Path Y
Step 5of 8 Q

Message X

& select The target directory will be created:
C:\Progra_ C:\Program Files\MicroE/\MicroEJ-SDK-22.06 ;se

Cancel

MICROEJ.

@ Previous @ Quit

Fig. 7: Confirm your installation path

« Wait until the installation is done. Then click on the Next button.

& Installation of MicroEl® SDK Dist. 22.06 —

Installation
Step 6 of 8

Pack installation progress:

[Finished]

Overall installation progress:
717

MICROEJ.

* Previous @ Quit

Fig. 8: Installation in progress

« Select options depending on your own preferences. Then click on the Next button.
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& Installation of MicroEl® SDK Dist. 22.06 — X
Setup Shortcuts ‘ D)
Step 7of 8 g

Create shorteuts in the Start-Menu
Create additional shortcuts on the desktop

Select a Program Group for the Shortcuts:

create shortout for:

() current user
(®) all users
Administrative Tools v
it
MicroE1® SDK Dist, 22.08 Default

MICROEJ]

<$I Previous @ Quit
Fig. 9: Select the options
+ Theinstallation has completed successfully. Click on the Done button.
& Installation of MicroE) @ SDK Dist. 22.06 — *
Installation Finished
Step 8 of 8 Q\

| 4

% Installation has completed successfully.

4% An uninstaller program has been created in:
C:\Program Files\MicroEJ\MicroEJ-SDK-22.06

MICROEJ]

Fig. 10: Your installation has completed successfully

The SDK Distribution is now installed on your computer. You can launch it from your application launcher or by
executing the MicroEJ executable in the installation path.

Now you can check if there is a newer SDK version available.
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3.1.2 Update SDK Version

Once you have a SDK Distribution installed, you can update the included SDK Version to a newer version. SDK
versions are uploaded to an Eclipse P2 repository located at https://repository.microej.com/p2/sdk/.

Note: If you want to know which SDK version is currently installed in your SDK Distribution, see the SDK Version
chapter.

To update your SDK Distribution to a newer SDK version, follow the next steps:

« Select Help > Checkforupdates .

File Edit Source Refactor Navigate Search Project Run Window Help

w4 YO Y QR vyEGY B I i vil v & Welcome
i Package Explorer 2 f Type Hierarchy % §°0 @ Help Contents
There are no projects in your workspace. ¥ Search
To add a project: Show Contextual Help
#¢ Create a Sandboxed Application project Show Active Keybindings... Ctrl+5Shift+L
# Create a Standalone Application project ¥ Tips and Tricks...
£ Create an Add-On Library project * Eeing SRR I IERElD £11
Cheat Sheets...
¥ Create a Module project
(=]
[ Create a Platform project Q; lChec: :I)r Ugd:tt;s
nstall New Sottware...
Create a Front Panel project
€ About MicroF)® SDK

T9 Create a project...
1 |mport projects...

Fig. 11: Check for updates

« If your SDK is up-to-date, you will see the following screen:

2% Information X

Mo updates found.

¥’ Configure available software sites to reach more content.

Fig. 12: No update available

« If an update is available, you will see the following screen:
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¥ Available Updates O

x
Available Updates w
’_ .

Check the updates that you wish to install.

Name Version Id
[ % MicroE) SDK 5.6.2 com.is2t.microej.sdk feature.feature.group
< »
Select All Deselect All
Details

Fig. 13: Update available

+ Check the version you want to install. Then click onthe Next button.

» Review and confirm the updates. Then click onthe Next button.

@‘: Available Updates

LR

Update Details

Review and confirm the updates.

Name Version Id
‘% MicroE) SDK 5.6.2 com.isZt.microej.sdkfe...

Size: 323,205 KB
Details

@ < Back Finish Cancel

Fig. 14: Review the updates

+ Select |acceptthe terms of the license agreements. . Then click on the Finish button.

3.1. Installation
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¥ Available Updates O s
Review Licenses
.

Licenses must be reviewed before the software can be installed. This includes licenses for software required to complete the install.

Licenses: License text:
> MICROEJ SDK EULA MICROE) SDK EULA ~
This Software is based on Apache EasyAnt, Apache Ivy and Apache lvyDE.
This Software is provided both as Executable Software (code compiled AND PREAMBLE
This Seftware Tool is provided to You by 152T under the terms

THIS SOFTWARE LICENSE AGREEMENT (THE

« AGREEMENT =) APPLIES TO PRODUCTS LICENSED BY
INDUSTRIAL SMART SOFTWARE TECHNOLOGY S.A
OPERATING UNDER THE BRAND NAME MICROEJ, 11 RUE

DU CHEMIN ROUGE, F-44373 NANTES, FRANCE
(«MICROE) &) INCLUDING ANY OF ITS SUBSIDIARIES

(« MICROEJ PARTNERS ») OR DISTRIBUTORS (« MICROE)
DISTRIBUTORS =) TO YOU (« THE LICENSEE »).

On purchase of any Licensed Product from MICROEJ or an
MICROE] Partner or an MICROE] Distributor. the related i

This Software Tool is provided to You by 152T under the terms
This Software Tool is provided to You by 152T under the terms

"f,' | accept the terms of the license agreements

< 3 | O 1 do not accept the terms of the license agreements

Fig. 15: Accept the terms of the license agreement

« Wait until the Software Update pop-up appears. Then click on the Restart Now button.

15} Software Updates *

e Restart MicroE) ® SDK to apply the software update?

e I

Fig. 16: Restart your SDK.

The update of your SDK is done.

3.1.3 Install Other SDK Distributions

Install Portable SDK Distribution
The portable package allows you to install the SDK Distribution when the use of the SDK Distribution installer is not
possible:
« you do not have administrator privileges on your workstation;
« you want to install SDK Distribution 22.06 but JDK11is not your default JDK version;
« you want to install SDK Distributionup to 21.11 but JDK 8 is not your default JDK version.
Perform the following steps:

« Download the Portable SDK Distribution for your operating system:

3.1. Installation 18
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SDK | JDKWindows Linux macOS x86_64 (Intel | macOS aarch64 (M1
Dis- | Ver- chip) chip)

tri- sion

bu-

tion

- . Portable (.zip) Portable (.zip) Portable (.zip) Portable (.zip)

06

) o Portable (.zip) Portable (.zip) Portable (.zip) N/A

11

« Once downloaded, extract the zip file in a local directory of your choice
« Editthe MicroEJ-SDK.ini file

« Configure the path to the JDK version indicated above by adding the option -vm at the beginning of the file.
If you don’t have any JDK installed, see the Get JDK section.

-vm

[path_to_jdk]1/bin

-startup
plugins/org.eclipse.equinox.launcher_1.6.400.v20210924-0641. jar

« Start the SDK by executing MicroEJ-SDK.exe on Windows or MicroEJ-SDK on Linux or macOS.

Now you can check if there is a newer SDK version available (see Update SDK Version section).

Install SDK Distribution 21.11

This section will guide you to install the SDK Distribution 21.11 using the step-by-step executable installer.

The SDK Distribution 21.11 requires a JDK 8 and is not available for macOS with M1 chips. See the System Require-
ments page for more information on the list of supported environments.

Note: Launching the SDK Distribution installer requires administrator privileges and a JDK 8 installed by default
on your workstation. If you don’t have one of them or if you do not want to modify your default settings, please
jump to Install Portable SDK Distribution section.

Download SDK Distribution

Download the SDK Distribution 21.11 installer for your operating system:
« Windows (.exe).
o Linux (.zip).

» macOS x86_64 - Intel chip (.zip).

3.1. Installation 19
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Check JDK Version

The SDK Distribution 21.11 installer requires a JDK 8 installed by default on your workstation. If you don’t have
any JDK installed, see the Get JDK section.

Check the default Java version by running the following command in a new terminal:

> java -version

java version "1.8.0_281"
Java(TM) SE Runtime Environment (build 1.8.0_281-b09)
Java HotSpot(TM) 64-Bit Server VM (build 25.281-b09, mixed mode)

Now you can proceed with the installation steps.

Install SDK Distribution

« Launch the installer executable
- On Windows, start MicroEJ-SDK-Installer-Win64-21.11.exe.

- On Linux, unzip MicroEJ-SDK-Installer-Linux64-21.11.zip and start
MicroEJ-SDK-Installer-Linux64-21.11.sh.

- On macOs, unzip MicroEJ-SDK-Installer-Linux64-21.11.zip and start
MicroEJ-SDK-Installer-Mac0S-21.11.app.

c Installation of MicroE) ® SDK Dist, 21.11 — x
Welcome *ui
Step 1of 8 :

7| Welcome to the installation of MicroEJ@® SOK Dist, 21,111
Q This software is developed by:

- MicroE] <support@microe].com:=
EI The homepage is at: http://developer.microej.com

MICROEJ.

€ quit

Fig. 17: Welcome to the installer

« Clickonthe Next button.

+ Select |accept the terms of this license agreement. . Then click onthe Next button.
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Q Installation of MicroE)® SDK Dist. 21.11 — *
Licensing Agreements ‘\
Step 4 of 8 g
@ Please read the following license agreement carefully:
MICROEJ SDE EULA 2
FPEEAMELE

THIS SOFTWARE LICENSE AGREEMENT (THE

« AGREEMENT =) APFLIES TO FPRCODUCTS LICENSED EY
INDUSTRIAL SMART SOFTWARE TECHMOLOGY 5.4
OFERATING UNDEER THE ERAND NAME MICROEJ, 11 RUE

NI CURMIMN DO T AA2793 WAMTES  TDAMCE

(®) I accept the terms of this license agreement.

MICROEJ]

(O Ido not accept the terms of this license agreement.

<$I Previous @ Quit

Fig. 18: Accept the terms of this license agreement

« Select the installation path of your SDK. By defaultitis C:\Program Files\MicroEJ\MicroEJ-SDK-21.11
for Windows. Then click onthe Next button.

Q Installation of MicroE)® SDK Dist. 21.11 — x
Target Path ‘ D
StepSof 8 g

[& Select the installation path:
C:\Program Files\MicroEJ\MicroEJ-SDE-21.1 1| E Browse. ..

MICROEJ]

<$I Previous @ Quit

Fig. 19: Choose the installation path

+ Clickonthe OK button to confirm the installation path.
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& Installation of MicroE)® S
Target Path
Step 5of 8

& select

C:IProglg

Message

The target directory will be created:
C:\Program Files\MicroE/\ MicroE)-SDK-21.11 bnse .

Cancel

MICROEJ.

@ Previous @ Quit

Fig. 20: Confirm your installation path

« Wait until the installation is done. Then click on the Next button.

« Select options depending on your own preferences. Then click on the Next button.

@— Installation of MicroE)® SDK Dist. 21.11 —

Installation
Step 6 of 8

MICROEJ.

Pack installation progress:

[Finished]

Overall installation progress:

* Previous @ Quit

Fig. 21: Installation in progress

3.1. Installation
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@ Installation of MicroE)® SDK Dist. 21.11

Setup Shortcuts
Step 7of 8

7-Zip

Accessibility
Accessories
Administrative Tools

ik

Create shortcuts in the Start-Manu
Create additional shortcuts on the desktop

Select a Program Group For the Shortcuts:

<

creake shorteut For:

() current user

(@) all users

MicroEJ® SDF Dist. 21.11

MICROEJ.

@ Previous

Default

© quit

Fig. 22: Select the options

+ Theinstallation has completed successfully. Click on the Done button.

@ Installation of MicroE)® SDK Dist. 21.11

Installation Finished
Step 8of 8

| 4

MICROEJ.

&% Installation has completed successfully,

&% An uninstaller program has been created in:
C:\Program Files\MicroEJ\MicroEJ-SDK-21.11

Fig. 23: Your installation has completed successfully

The SDK Distribution is now installed on your computer. You can launch it from your application launcher or by

executing the MicroEJ executable in the installation path.

Now you can check if there is a newer SDK version available (see Update SDK Version section).

The following table gathers all SDK Distributions links for SDK version 5. x .

3.1. Installation
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SDK | JDK Windows Linux macOS$S macO0S SDK Ver- | Eclipse
Dis- Ver- x86_64 (Intel | aarch64 (M1 | sion Version
tri- sion chip) chip)
bu-
tion

Installer (.exe) | Installer (.zip) | Installer (.zip) | Installer (.zip)
22. 11 5.6.0 2022-03
06

Installer (.exe) | Installer (.zip) | Installer (.zip) | N/A
21. 8 5.5.0 2020-06
11

Installer (.exe) | Installer (.zip) Installer (.zip) | N/A
21. 8 5.4.0 2020-06
03

Installer (.exe) | Installer (.zip) Installer (.zip) | N/A
20. 8 5.3.1 2020-06
12

Installer (.exe) | Installer (.zip) | Installer (.zip) | N/A
20. 8 5.3.0 2020-06
10

Installer (.exe) | N/A N/A N/A
19. 8 5.1.0 4.7.2
05

If you need an older distribution of the SDK, it is available in the SDK Downloads Page.

3.1.4 System Requirements

« Hardware:
- Intel x64 (Dual-core i5 minimum) or macOS AArch64 (M1) processor
- 4GB RAM (minimum)
- 2GB Disk (minimum)

« Operating Systems :

Windows 10, Windows 8.1 or Windows 8

Linux distributions (tested on Ubuntu 18.04,20.04 and 22.04) - As of SDK Distribution 20.10 (based
on Eclipse 2020-06), Ubuntu 16.04 is not supported.

macOS x86_64 with Intel chip (tested on version 10.13 High Sierra, 10.14 Mojave)

macOS aarch64 with M1 chip (tested on version 12.0.1 Monterey), from SDK Distribution 22.06
« Java Runtime Environment:

The compatible JRE/JDK version depends on the Distribution, the SDK and the Architecture version. This table lists
the supported combinations:

Distribution | SDK Architecture | JRE/JDK

22.06 >=5.6.0 | >=7.17.0 JDK1

<=21.1 >=5.6.0 | >=7.17.0 JREorJDK8or11
<=21.11 <56.0 |* JRE or JDK 8
<=21.1 * <7.17.0 JREorJDK8
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https://repository.microej.com/packages/SDK/20.10/MicroEJ-SDK-Installer-Linux64-20.10.zip
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The combinations not listed here are not supported. For the supported combinations, tests have been done with
both the Oracle and the Eclipse Adoptium JDK builds.

Warning: It is important to note that the SDK Distribution 22.06 requiresa JDK 11 (not a JRE) and can be
used only with an Architecture 7.17.0 or more.

Get JDK

You can download and install a JDK from https://adoptium.net/temurin/releases/.

Warning: When installing the Eclipse Temurin/AdoptOpenJDK build on Windows, the option JavaSoft
(Oracle) registry keys must be enabled:

ﬁ AdoptOpen)DK JDK with Hotspot 8u282-b08 (x64) Setup — X

Custom Setup

Select the way you want features to be installed.

Click the icons in the tree below to change the way features will be installed.

AdoptOpen]DK Development Kit with
--------- =3-| Add to PATH Hotspot

--------- gl Associate .jar

--------- X | Set JAVA HOME variable

--------- =3~ JavaSoft (Oracle) registry keys
B EI TETT e VIEr This feature requires 186MB on your
hard drive. It has 3 of 5 subfeatures
selected. The subfeatures require 4KB
on your hard drive.

Location: C:\Program Files\AdoptOpen]DK\jdk-8.0.282.8-hotspot), Browse...

Reset Disk Usage Back Mext Cancel

Without this option, the SDK installer cannot find the JDK and the message The application requires a
Java Runtime Environment 8 is displayed.
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3.1.5 Troubleshooting

Incompatible Default Java Version

When launching theinstaller, you may get the followingerror: The application you are trying to install requires a JDKI1

e The application that you are trying to install requires a JDK 11 .You are running a 1.8.0_281 version of the Java platform.Please upgrade to & newer version,

Or when launching the SDK, you may get the following error: Version: 11 or greater is required .

Incompatible JWM

Wersion 1.8.0_281 of the J¥M is not suitable for this product. Version: 11
or greater is required.

The default Java version installed on your system is not compatible. You have two options:

« eitherinstall a JDK 11 as your default JVM. If you are on Windows OS, ensure you enabled JavaSoft (Oracle)
registry keys duringthe JDK installation (see Get JDK),

« orinstall the portable SDK Distribution if you don’t want to modify your default JVM version.

This latter case is recommended if you are installing SDK Dist. 22.06 while you already have active projects based
on SDK Dist. 21.11.

3.2 Licenses

3.2.1 SDKEULA

MICROEJ SDK is licensed under the SDK End User License Agreement (EULA), which covers the following elements:
+ SDK Tools & Plugins packaged in the SDK 5.x Version,
« Architectures,

« Modules published to the Central Repository with the SDK EULA license, such as GUI or Networking Pack (see
Central Repository Licensing for more details).
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& MICROEJ 5D« @) Module Repositories
SDK Distribution YY.MM @ eclipse MICROEJ SDK EULA Central Repository o

Various Licenses including SDK EULA

(End User License Agreement)

SDK Version 5.m.p @s Developer Repository 9)
Architecture

Module Manager Ef@ ) )
o GitHub Repository

Fig. 24: SDK EULA Coverage

3.2.2 License Manager Overview

Architectures are distributed in two different versions:

« Evaluation Architectures, associated with a software license key. They can be downloaded at https://
repository.microej.com/modules/com/microej/architecture/.

» Production Architectures, associated with a hardware license key stored on a USB dongle. They can be re-
quested to our support team.

The license manager is provided with Architectures and then integrated into Platforms, consequently:

« Evaluation licenses will be shown only if at least one Evaluation Architecture or Platform built from an Eval-
uation Architecture has been imported in the SDK.

+ Production licenses will be shown only if at least one Production Architecture or Platform built from a Pro-
duction Architecture has been imported in the SDK.

Thelist ofinstalled licensesis available in the SDK preferences dialog pagein Window > Preferences > MicroEJ

& Preferences u_lw
type filter text MicroEJ f= v -
Checkstyl - |
£ .st}r £ General settings for MicroE) development:
Copyright
> Data Management == MicroEl repository
EasyantdEclipse - -
Help CAPyruntime-Mew_configurationtrepo Browse... ] [ Refresh

> IceTea

> Install/Update Licenses

m

instant Messagirig License Id Edition License Tags Expiration Date Packs Add...
& !,)(FRYS -J2MSN-Y3MAS-RBK46 | STD 152T_J8F5C « 2020-12-31 g
> Java Remove
4 Microkl
Architectures i
Naming Convention
Platforms
Platforms in workspace
Updates LB [ Restore Defaultsl [ Apply ]
@' [ OK ] [ Cancel ]

Fig. 25: License Manager View
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3.2.3 License Check

The table below summarizes where the license is checked.

Application Run on | Build on De- | Documentation Link
Simulator vice
(Virtual
Device)
Standalone Application or Kernel Application | NO YES Run on the Device
Sandboxed Application NO NO Application Linking

3.2.4 Evaluation Licenses

This section should be considered when using Evaluation Architectures, which use software license keys. Amachine
UID needs to be provided to activate an Evaluation license on the MicroEJ Licenses Server. The machine UID isa 16
hexadecimal digits number.

Get your Machine UID

Retrieving the machine UID depends on the kind of MicroEJ Platform being evaluated.

If your MicroEJ Platform is already imported in Package Explorer and built with MicroEJ Module Manager, the Archi-
tecture has been automatically imported. The machine UID will be displayed when building a MicroEJ Standalone
Application on device.

[INFO ] Launching in Evaluation mode. Your UID is XXXXXXXXXXXXXXXX.
[ERROR] Invalid license check (No license found).

Otherwise, an Architecture or Platform should have been manually imported from the SDK preferences page. The
machine UID can be retrieved as follows:

« Goto Window > Preferences > MicroEJ ,

« Select either Architectures or Platforms ,
« Click on one of the available Architectures or Platforms,

+ Pressthe GetUID button to getthe machine UID.

Note: To accessthis GetUID option, at least one Evaluation Architecture or Platform must have been imported
before (see License Manager Overview).

Copy the UID. It will be needed when requesting a license.
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& UID successfully generated @

Your UID was successfully generated.

Your UID is:  |A856470297673E28

Fig. 26: Machine UID for Evaluation License

Request your Activation Key

« Go to MicroEJ Licenses Server https://license.microej.com.
+ Clickon Create anew account link.

« Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and log in with your new account.

+ Click on Activate a License .
« Set Product P/N: to 9PEVNLDBU6IJ.
« Set UID: to the machine UID you copied before.

« Clickon Activate .

« The license is being activated. You should receive your activation by email in less than 5 minutes. If not,
please contact our support team.

« Once received by email, save the attached zip file that contains your activation key.
Install the License Key

If your MicroEJ Platform is already imported in Package Explorer and built with MicroEJ Module Manager, the license
key zip file must be simply dropped to the ~/.microej/licenses/ directory (create it if it doesn’t exist).

» ThisPC » Local Disk (C:) » Users » user » .microgj » licenses
MName Date modified Type Size
REW2Z-XSTRL-5ZYUE-K33DCzip 30/09/2020 12:27 Compressed (zipp... TKB

Fig. 27: MicroEJ Shared Licenses Directory

Note: The SDK Preferences page will be automatically refreshed when building a MicroEJ Standalone Application
n devi

Otherwise, the license key must be installed as follows:
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Go back to the SDK.

Selectthe Window > Preferences > MicroEJ menu.

Press Add... .

Browse the previously downloaded activation key archive file.

Press OK. A new license is successfully installed.

Go to Architectures sub-menu and check that all Architectures are now activated (green check).

Your SDK is successfully activated.

If an error message appears, the license key could not be installed. (see section Troubleshooting). A license key can
be removed from the key-store by selecting it and by clicking on Remove button.

Troubleshooting

Consider this section when an error message appears while adding the Evaluation license key. Before contacting
our support team, please check the following conditions:

Key is corrupted (wrong copy/paste, missing characters, or extra characters)

Key has not been generated for the installed environment

Key has not been generated with the machine UID

Machine UID has changed since submitting license request and no longer matches license key

Key has not been generated for one of the installed Architectures (no license manager able to load this license)

= Invalid activation key &J

| The key could not be installed in this environment. Possible reasons are:

Sl - keyis corrupted,

N - key is valid but does not match any available license manager(s). (Works for an
other edition),

- key has not been generated for this machine,

- old key version,

Fig. 28: Invalid License Key Error Message

3.2.5 Production Licenses

This section should be considered when using Production Architectures, which use hardware license keys stored
on a USB dongle.
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ys\a 12345678

Fig. 29: MicroEJ USB Dongle

Note:

If your USB dongle has been provided to you by your sales representative and you don’t have received an

activation certificate by email, it may be a pre-activated dongle. Then you can skip the activation steps and directly
jump to the Check Activation on SDK section.

Request your Activation Key

Go to license.microej.com.
Click on Create a new account link.

Create your account with a valid email address. You will receive a confirmation email a few minutes after.
Click on the confirmation link in the email and login with your new account.

Click on Activate a License .

Set Product P/N: to The P/N on the activation certificate.

Enter your UID: serial number printed on the USB dongle label (8 alphanumeric char.).
Clickon Activate and check the confirmation message.

Click on Confirm your registration .

Enter the Registration Code provided on the activation certificate.

Clickon Submit .

Your Activation Key will be sent to you by email as soon as it is available (12 business hours max.).

Note:

You can check the My Products page to verify your product registration status, the Activation Key avail-

ability, and download the Activation Key when available.

Once the Activation Key is available, download and save the Activation Key ZIP file to a local directory.
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Activate your USB Dongle

This section contains instructions that will allow you to flash your USB dongle with the proper activation key.
You shall ensure that the following prerequisites are met :

« Your operating system is Windows

« The USB dongle is plugged and recognized by your operating system (see Troubleshooting section)

« No more than one USB dongle is plugged into the computer while running the update tool

« The update tool is not launched from a network drive or a USB key

+ The activation key you downloaded is the one for the dongle UID on the sticker attached to the dongle (each
activation key is tied to the unique hardware ID of the dongle).

You can then proceed to the USB dongle update:
« Unzip the Activation Key file to a local directory
« Enter the directory just created by your ZIP extraction tool.
« Launch the executable program.

« Accept running the unsigned software if requested (Windows 10)

User Account Control .

Do you want to allow this app from an
unknown publisher to make changes to your
device?

update.exe

Publisher: Unknown
File origin: Hard drive on this computer

Show more details

Yes Mo

+ Clickonthe Update button (no password needed)
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[#] Update Tool

K.en[character string)

E.ey

Cancel

Fig. 30: Dongle Update Tool

« On success, an Update successfully message shall appear. On failure, an Error key or no proper
rockey message may appear.

update_E24C0785

& Update successfully

QK

Fig. 31: Successful Dongle Update
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Check Activation on SDK

Note: Production licenses will be shown only if at least one Production Architecture or Platform has been imported

before (see License Manager Overview).

« Go back to the SDK,

« Goto Window > Preferences > MicroEJ ,

« Goto Architectures or Platforms sub-menuand checkthatall Production Architectures or Platforms are

now activated (green check).

type filter text Platforms
BasyantdEclipse " Add or remove platforms.
> Help
. lceTea Platforms, Virtual Devices and Architectures:
> Install/Update ) Narne Version  Lic...
:”Sta”tmessag'”g [} FRDM-KL467 Jakarta Kickstart 125
> vy
. Java ugQ me_ L‘\rchitect:.'re:CMD
4 Microfl [16¥ STM: Hardware Part Number: Jakarta
. [1€¥ STM3 Compilation Toolchain: CMO_ARMCC
Architectures (1€} sTM: Name: KickStart
MNaming Conventior 06 sTv: Provider: 152T
& eny Version: 1.35
; O 7 Core Engine Architecture: 14
Platforms in worksp ]
Updates (14} STM: Usage Level:Fer ]
P 143 STM: Technology Version: 1.6
> Mylyn 143 vLCD License Tag{ISZT_JBFSC
Planning []£3 vicp Build Label: 20T50407-T647
» Plug-in Development Path: .microejrepositories\Full\1.64sd002
Fig. 32: Platform License Status OK
Troubleshooting

Select All
Deselect All
Import...
Uninstall

Get UID

This section contains instructions to check that your operating system correctly recognizes your USB dongle.

GNU/Linux Troubleshooting

For GNU/Linux Users (Ubuntu at least), by default, the dongle access has not been granted to the user, you have to
modify udev rules. Please create a /etc/udev/rules.d/91-usbhdongle.rules file with the following contents:

ACTION!="add", GOTO="usbdongle_end”
SUBSYSTEM=="usb", GOTO="usbdongle_start”
SUBSYSTEMS=="usb", GOTO="usbdongle_start"”
GOTO="usbdongle_end"
LABEL="usbdongle_start”
ATTRS{idVendor}=="096e" , ATTRS{idProduct}=="0006" , MODE="0666"

LABEL="usbdongle_end"

Then, restart udev: /etc/init.d/udev restart
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You can check that the device is recognized by running the 1susb command. The output of the command should
contain a line similar to the one below for each dongle: Bus 002 Device 003: ID 096e:0006 Feitian
Technologies, Inc.

Windows Troubleshooting

« If the dongle activation failed with No rockey message, check there is one and only one dongle recognized
with the following hardware ID :

HID\VID_Q96E&PID_0006&REV_0201

Go tothe Device Manager > Human Interface Devices and check amongthe USB Input Device entries

thatthe Details > Hardwarelds property match the ID mentioned before.

« Ifthe dongle activation was successful with Update successfully message butthe license does not appear
in the SDK or is not updated, try to activate again by starting the executable with administrator privileges:

»  9F2N-HMLPM-94M55-T63KG

Mame Date modified

mj licensexml 18/03/2020 14:16

@update.exe [
Open

m Run as adrninistrator I

« If the following error message is thrown when building a MicroEJ Firmware, either the dongle plugged is a
verbatim dongle or it has not been successfully activated:

Invalid license check (Dongle found is not compatible).

VirtualBox Troubleshooting

In a VirtualBox virtual machine, USB drives must be enabled to be recognized correctly. Make sure to enable the
USB dongle by clicking on it in the VirtualBox menu Devices > USB .

To make this setting persistent, go to Devices > USB > USB Settings... and add the USB dongle in the
USB Devices Filters list.

Remote USB Dongle Connection
When the dongle cannot be physically plugged to the machine running the SDK (cloud builds, virtualization, miss-
ing permissions, ...), it can be configured using USB redirection over IP network.

There are many hardware and software solutions available on the market. Among others, this has been tested with
https://www.net-usb.com/. Please contact our support team for more details.
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3.3 Module Repositories

This chapter describes the module repositories provided by MicroEJ Corp.

3.3.1 Central Repository

The Central Repositoryis the module repository distributed and maintained by MicroEJ Corp. It contains a selection
of production-grade modules such as Libraries and Packs.

Use

By default, the SDK is configured to import modules from the online Central Repository.
You can manually browse the repository at https://repository.microej.com/modules/.

Before starting to develop production code, it is strongly recommended to import the repository to your local en-
vironment. Please follow the steps described at https://developer.microej.com/central-repository/.

Licensing

The Central Repository is a set of modules distributed under various software licenses, including the SDK EULA for
some of them. Please consult the LICENSE. txt file attached to each module.

Changelog
The Central Repository content is versioned. The overall changelog is available at https://repository.microej.com/

and describes modules additions or removals. For module content changes, please consult the CHANGELOG. md file
attached to each module.

Javadoc

To consult the APIs documentation (Javadoc) of all /ibraries available in the repository, please visit https://
repository.microej.com/javadoc/microej_5.x/apis/.

3.3.2 Developer Repository
The developer repository is an online repository hosted by MicroEJ Corp., contains community modules provided
“as-is”. It is similar to what Maven Central Repository are for hosting Java standard modules.
MicroEJ Corp. contributes to the developer repository in the following cases:
« Demos (Platforms, Firmware, Virtual Devices, Applications),
« Incubating Libraries,
+ Former Central Repository versions,

« Hardware specific modules.
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Use

By default, the SDK is configured to import modules from the developer repository'.

You can also manually browse the repository at  https://forge.microej.com/artifactory/
microej-developer-repository-release/.

Before starting to develop production code, it is strongly recommended to transfer the desired modules to your
local environment by creating your own module repository copy.

Licensing

The developer repository is a set of modules distributed under various software licenses. Please consult the
LICENSE. txt file attached to each module.

Changelog

The developer repository is populated from multiple sources, thus there is no changelog for the whole repository
content as it is the case of the Central Repository.

Please consult the CHANGELOG.md file attached to each module.

Javadoc

To consult the APIs documentation (Javadoc) of libraries available in the developer repository, please consult the
javadoc attached to each module.

Community

The developer repository can host modules developed by the community. If your organization plan to develop
such module, please contact our support team to get dedicated credentials for publication.

3.3.3 Content Organization

The following table describes how are organized the modules natures within the repository.

Table 1: Modules Organization

Organization Module Nature
Foundation Library API

ej.api, com.microej.api

) ) ) Architecture
com.microej.architecture —

Pack
com.microej.pack E—

Tool or Add-On processor

ej.tool, com.microej.tool
Any other Add-On Library

1 Require SDK version 5.4.0 or higher.
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3.4 GitHub Repositories

Alarge number of examples, libraries, demos and tools are shared on MicroEJ GitHub account: https://github.com/
MicroEJ.

Most of these GitHub repositories contain projects ready to be imported in MicroEJ SDK.

3.4.1 Repository Import

This section explains the steps to import a Github repository in MicroEJ SDK, illustrated with the MWT Examples
repository.

Note: MicroEJ SDK Distribution includes the Eclipse plugin for Git.

First, from the GitHub page, copy the repository URI (HTTP address) from the dedicated field in the right menu
(highlighted in red):

O Why GitHub? Team Enterprise Explore Marketplace Pricing Search Sign in ‘ Sign up |
i MicroEJ / ExampleJava-MWT O Watch | 2 vrstar 1 Yok 0
<> Code Issues Pull requests Actions Projects Security Insights

#* master - P 1branch 2 tags Go to file About

These projects provide examples
f.@; privron Merge branch ‘develop' into 'master’ ... B Clone @ for MWT

HTTPS  GitHub CLI
By ; @ [0 Readme
com.microej.example.mwt.basic ix api minor version @igne https://github. con/MicroEl/Exampleda | 7]
com.microej.example.mwtbutt...  Fix api minor version @ignc  Use Git or checkout with SVN using the web URL. B View license
com.microej.example.mwt.hello...  Fix api minor version @ignc
) Open with GitHub Desktop
) o . ] Releases
com.microej.example.mwt.mve Fix api minor version @igne
com.microe].example.mwtslidi..  Fix api minor version @igne  [§] Download ZIP © 2 te0s
[ .gh-copyright.template Move mwt example from foundation libraries @ignore_branc... 3 years ago
m eeees AR E A e i e e s s i S Packages

In MicroEJ SDK, to clone and import the project from the remote Git repository into the MicroEJ workspace, select
File > Import > Git > Projectsfrom Git wizard.
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® |mport

Select

Import one or more projects from a Git Repository. Iﬁ

Select an import wizard:

type filter text

= General

= C/C++

= CV5
v = Git

S0 Projects from Git

= Install
= MicroEl
= Plug-in Development
[= Run/Debug
= Tasks
= Teamn
= XML

® < Back Finish Cancel

Click Next , select CloneURI ,click Next and paste the remote repository address in the URI field. For
this repository, the address is https://github.com/MicroEJ/ExampleJava-MWT.git. If the HTTP address is a valid
repository, the other fields are filed automatically.
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® |mport Projects from Git
Source Git Repository GIT
Enter the location of the source repository. :_‘:n‘
Location
URJ: ?| https:.-"fgithul:l.cum.-"MicrDElexampI&lava-M‘."H"T.giﬂ | Lacal File...
Host: | github.com |
Repository path: | /Microbl/Examplelava-MWT.git |
Connection
Protocol: | https
Authentication
User | |
Password: | |
[ ]5tore in Secure Store
® = Back Finish Cancel

Click Next , selectthe master branch, click Next and acceptthe proposed Local Destination by clicking Next

once again.
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® |mport Projects from Git

Local Destination

GIT

Configure the local storage location for Examplelava-MWT. E‘
Destination

Directory: | IC:\Users\user\git\Examplelava-MWT | Browse
Initial branch: K master v

[]Clene submodules

Configuration

Remote name: | crigin

® < Back Finish Cancel

Click Next once more and finally Finish . The Package Explorer view now contains the imported projects.

£ Package Explorer &2 ‘Eg Type Hierarchy % ™

w '[c‘.gl- com.microgj.example.mwt.basic [Examplelava-MWT master]
& src/main/java
B\ Module Dependencies module.ivy [*]
[ src
[%} CHANGELOG.md
5 LICEMSE.txt
ke moduleivy
[#} README.md
'[c".gl- com.microgj.example.mwt.button [Examplelava-MWT master]
'_,fé com.microg).example.rmwt.helloworld [Examplelava-MWT master]
'[;_—'é com.microgj.example.mwt.mve [Examplelava-MWT master]

1—.;‘- com.microg).example.mwt.slidingwidget [Examplelava-MWT master]
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If you want to import projects from another (GitHub) repository, you simply have to do the same procedure using
the Git URL of the desired repository.

3.4.2 MicroEJ GitHub Badges

MicroEJ GitHub Badges are badges embedded in a README at the root of the repository. They highlight the com-
patibilities of the repository at a quick glance with MicroEJ Architecture, MicroEJ SDK and Graphical User Interface
versions.

The color of the badge has the following meaning:
« Green means a current supported version:

+ Orange means a still supported version that will be deprecated in the future:

3.5 Workspaces and MicroEJ Repositories

When starting the SDK, it prompts you to select the last used workspace or a default workspace on the first run. A
workspace is a main folder where to find a set of projects containing MicroEJ source code.

When loading a new workspace, the SDK prompts for the location of the MicroEJ repository, where Architectures,
Platforms or Virtual Devices will be imported. By default, the SDK suggests to point to the default MicroEJ reposi-
tory on your operating system, located at ${user.home}/.microej/repositories/[version].You can selectan
alternative location. Another common practice is to define a local repository relative to the workspace, so that the
workspace is self-contained, without external file system links and can be shared within a zip file.

3.6 SDKVersion

In the SDK, go to Help > About MicroEJ SDK menu.

In case of SDK 4.1.x,the SDK version is directly displayed, suchas 4.1.5:
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o About MicroE) ® SDK

MicroEl® SDE

Version 4.1.5

Copyright ©2016-2018 1527 5.A. All Rights Reserved.

Use of this program is subject to Microk License Agreement.

MicroB)® SDK is built on Eclipse, licensed under the terms of the Commen Public
r License (CPL).

MicroB)® 50K and the MicreE) logos are tradernarks of MicroE) 5.4,

CSPZIOP I BB DFH

® Installation Details

In case of SDK 5. x, the value displayed is the SDK distribution, such as 19.05 or 20.07:

= phout MicroE)® SDE

MicroEl® SDK

Dist. 20.07

Copyright ©2012-2020 Microk) Cerp. All Rights Reserved.

Use of this program is subject to MicroB) License Agreement.

MicroEl® 50K is built on Eclipse, licensed under the terms of the Common
Public License (CPL).

MicroEl® 5DK and the MicrokEl logos are trademarks of MicroBl Corp.

CSCSEOF oI & w

® Installation Details

To retrieve the SDK version that is currently installed in this distribution, proceed with the following steps:
 Clickonthe Installation Details button,
« Clickonthe Installed Software tab,

« Retrieve the version of entry named MicroEJ SDK.

3.6. SDK Version 43



MicroEJ Documentation, Revision d4ede019

‘& MicroE) ® SDK Installation Details

Installed Software  |nstallation History Features Plug-ins Configuration

MNarne Version Id Provider
[ C/C++ Development Toeols 5DK 0.4,3.201802261533  org.eclipse.cdt.sdk.feature.group Eclipse COT
@; C/C++ GCC Cross Compiler Support 0.4.3.201802261533  erg.eclipse.cdt.build.crossgec.feature.group  Eclipse COT
@: C/C++ GDB Hardware Debugging 0.4.3.201802261533  erg.eclipse.cdt.debug.gdbijtag feature.gro...  Eclipse CDT
(- Eclipse Checkstyle Plug-in 6.8.0.201507251301  net.sf.eclipsecs.feature.group http://eclipse-cs.sf.
@: Eclipse Runner Feature 134 com.eclipserunnerfeature.feature.group Eclipse Runner Tean
EE: Eclipse SDK 4.7.3.M20180330-06... org.eclipse.sdk.ide Eclipse.org
Eﬁ Eclipse XML Editors and Tools 3.9.2.:201803221834  erg.eclipse.wstxml_uifeaturefeature.group Eclipse Web Tools P
[{f- Git integration for Eclipse 4.9.2.201712130930-r  org.eclipse.eqgit.feature.group Eclipse EGit
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@ Markdown Editor 0.2.3 markdown.editor.feature.feature.group Winterwell

Ll 2 00728-1306  com.is2t.microe).mpp-feature feature.gro.,.,  Microkl
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3.7 MicroEJ Module Manager

3.7.1 Introduction

Modern electronic device design involves many parts and teams to collaborate to finally obtain a product to be sold
on its market. MicroEJ encourages modular design which involves various stake holders: hardware engineers, UX
designers, graphic designers, drivers/BSP engineers, software engineers, etc.

Modular design is a design technique that emphasizes separating the functionality of an application into inde-
pendent, interchangeable modules. Each module contains everything necessary to execute only one aspect of
the desired functionality. In order to have team members collaborate internally within their team and with other
teams, MicroEJ provides a powerful modular design concept, with smart module dependencies, controlled by the
MicroEJ Module Manager (MMM). MMM frees engineers from the difficult task of computing module dependencies.
Engineers specify the bare minimum description of the module requirements.

The following schema introduces the main concepts detailed in this chapter.
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Fig. 33: MMM Overview

MMM is based on the following tools:
« Apache lvy (http://ant.apache.org/ivy) for dependencies resolution and module publication;

« Apache EasyAnt (https://ant.apache.org/easyant/history/trunk/reference.html) for module build from
source code.

3.7.2 Specification

MMM provides a non ambiguous semantic for dependencies resolution. Please consult the MMM specification
available on https://developer.microej.com/packages/documentation/TLT-0831-SPE-MicroEJModuleManager-2.
0-E.pdf.

3.7.3 Module Project Skeleton

In the SDK, a new MicroEJ module project is created as follows:

+ Select File > New > Project... ,

« Select MicroEJ > Module Project ',

« Fill the module information (project name, module organization, name and revision),

+ Select one of the suggested skeletons depending on the desired module nature,

« Clickon Finish .

11f using SDK versions lower than 5.2.0, please refer to the following section.
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The project is created and a set of files and directories are generated from the selected skeleton.

Note: When an empty Eclipse project already exists or when the skeleton has to be created within an existing
directory, the MicroEJ module is created as follows:

« In the Package Explorer, click on the parent project or directory,

« Select File > New > Other... ,

+ Select EasyAnt > EasyAnt Skeleton .

3.7.4 Module Description File

Amodule descriptionfileis an Ivy configuration file named module. ivy, located at the root of each MicroEJ module
project. It describes the module nature (also called build type) and dependencies to other modules.

<ivy-module version="2.0" xmlns:ea="http://www.easyant.org” xmlns:m="http://ant.apache.org/ivy/extra”
xmlns:ej="https://developer.microej.com” ej:version="2.0.0">
<info organisation="[organisation]” module="[name]" status="integration” revision="[version]">
<ea:build organisation="com.is2t.easyant.buildtypes” module="[buildtype_name]” revision=
—"[buildtype_version]">
<ea:property name="[buildoption_name]"” value="[buildoption_value]"/>
</ea:build>
</info>

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="default” visibility="public"/>
<conf name="provided" visibility="public"/>
<conf name="documentation” visibility="public"/>
<conf name="source" visibility="public"/>
<conf name="dist"” visibility="public"/>
<conf name="test"” visibility="private"/>
</configurations>

<publications>
</publications>

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]"/>

</dependencies>
</ivy-module>

Enable MMM Semantic

The MMM semantic is enabled in a module by adding the MicroEJ XML namespace and the ej:version attribute
inthe ivy-module node:

<ivy-module xmlns:ej="https://developer.microej.com” ej:version="2.0.0">

Note: Multiple namespaces can be declared in the ivy-module node.

MMM semantic is enabled in the module created with the Module Project Skeleton.
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Module Dependencies

Module dependencies are added to the dependencies node as follow:

<dependencies>
<dependency org="[dep_organisation]” name="[dep_name]"” rev="[dep_version]"/>
</dependencies>

When no matching rule is specified, the default matching rule is compatible.

Dependency Matching Rule

The following matching rules are specified by MMM:

Name Range Notation Semantic

compatible [M.m.p-RC, (M+1).0.0-RC][ Equal or up to next major version. Default if
not set.

equivalent [M.m.p-RC, M.(m+1).0-RC [ Equal or up to next minor version

greaterOrEqual [M.m.p-RC, oo Equal or greater versions

perfect [M.m.p-RC, M.m.(p+1)-RC[ Exact match (strong dependency)

Set the matching rule of a given dependency with ej:match="matching rule”.Forexample:

<dependency org="[dep_organisation]” name="[dep_name]” rev="[dep_version]" ej:match="perfect” />

Dependency Visibility

« Adependency declared public is transitively resolved by upper modules. The default when not set.
« Adependency declared private isonly used by the module itself, typically for:

- Bundling the content into the module

- Testing the module

The visibility is set by the configurations declared in the configurations node. For example:
<configurations defaultconfmapping="default->default;provided->provided">

<conf name="[conf_name]” visibility="private"/>
</configurations>

The configuration of a dependency is specified by setting the conf attribute, for example:

<dependency org="[dep_organisation]” name="[dep_name]"” rev="[dep_version]"” conf="[conf_name]->x" />
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Build Options

MMM builds can be configured by settings options in the module.ivy file usingthe ea:property taginside the
ea:build tag:

<ea:build organisation="..." module="..."
<ea:property name="[build_option_namel” value="[build_option_value]"/>

</ea:build>

revision="x.y.z">

Refer to the documentation of Module Natures for the list of available build options for each Module Nature.

The options can also be defined via System Properties. If an option is defined as both System Property and
ea:property tag, the value passed as System Property takes precedence.

Automatic Update Before Resolution

The Easyant plugin ivy-update can be used to automatically update the version (attribute rev) of every module
dependencies declared.

<info organisation="[organisation]” module="[name]"” status="integration” revision="[version]">
<ea:plugin org="com.is2t.easyant.plugins” name="ivy-update” revision="1.+" />
</info>

When the plugin is enabled, for each module dependency, MMM will check the version declared in the module file
and update it to the highest version available which satisfies the matching rule of the dependency.

3.7.5 SDK Configuration

By default, when starting an empty workspace, the SDK is configured to import dependencies from MicroEJ Central
Repository and to publish built modules to a local directory. The repository configuration is stored in a settings file (
ivysettings.xml), and the default oneis located at $USER_HOME\ .microej\microej-ivysettings-[VERSION].

xml
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Preferences Page

The MMM preferences page in the SDK is available at Window > Preferences > MicroEJ > Module Manager

1
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~ MicroE)
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Module Manager
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Platforms in workspace
Settings

Medule Manager

Meodule Repository
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(2) Property files:

Edit...

Add...
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Updates Up
Wirtual Devices 7
Mylyn own
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Run/Debug (3) [1Use Module repository as Build repository
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a o Restore Defaults Apply
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Fig. 34: MMM Preferences Page

This page allows to configure the following elements:

1. Settings File: thefile describing how to connect module repositories. See the settings file section.

2. Options: files declaring MMM options. See the Options section.

3. Use Module repository as Build repository : the settings file for connecting the build repository in
place of the one bundled in the SDK. This option shall not be enabled by default and is reserved for advanced
configuration.

4. Build repository Settings File:the settings file for connecting the build repository in place of the one
bundled in the SDK. This option is automatically initialized the first time the SDK is launched. It shall not be
modified by default and is reserved for advanced configuration.

5. Set verbose mode : to enable advanced debug traces when building a module.
6. Runtime JRE :the Java Runtime Environment that executes the build process.

7. Max build history size:the maximum number of previous builds available in Build Module shortcut
list:
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® workspaceRepository -

File Edit Source Refactor Mavigate Search  Project  Run

o-Dov[@]eis-0-a-iwe-

t% Package Explorer 53 ﬂiﬂuilcl Selected Module (Ctrl+Alt+C, E) h

Settings File

The settings file is an XML file that describes how MMM connects local or online module repositories. The file format
is described in Apache vy documentation.

To configure MMM to a custom settings file (usually from an offline repository):

1. Set Settings file toacustom ivysettings.xml settings file',

2. Clickon Apply and Close button

If the workspace is not empty, it is recommended to trigger a full resolution and rebuild all the projects using this
new repository configuration:

1. Clean caches
« In the Package Explorer, right-click on a project;
« Select Ivy > Cleanall caches .

2. Resolve projects using the new repository

To resolve all the workspace projects, click on the Resolve All button in the toolbar:

® workspaceRepository -
File Edit Source Refactor Mavigate Searc

Awii | g i

To only resolve a subset of the workspace projects:

« In the Package Explorer, select the desired projects,
+ Right-click on a project and select lvy > Clean all caches .
3. Trigger Add-On Library processors for automatically generated source code

» Select Project > Clean... ,
+ Select Clean all projects ,

o Clickon Clean button.
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Options

Options can be used to parameterize a module description file or a settings file. Options are declared as key/value
pairs in a standard Java properties file, and are expanded using the ${my_property} notation.

Atypical usage in a settings file is for extracting repository server credentials, such as HTTP Basic access authenti-
cation:

1. Declare options in a properties file

credentials.properties &3
1# User specific credentials
2 artifactory.username=myusername
3 artifactory.password=AKCKLzp2JHRLDYFvmTPMXocXiiU1Cna47eiaUcCOiERSUdgIrIu24ZTYieXa0wwMaIWykjCDo

a

2. Register this property file to MMM options

Options

Property files: | S{workspace_loc:test/credentials.properties}

3. Use this optionin a settings file

39 <credentials host="artifactory.corp” realm="Artifactory Realm” username="${artifactory.username}"” passwd="${artifactory.password}" />

Atypical usageina module description file is for factorizing dependency versions across multiple modules projects:

1. Declare an option in a properties file

=| versions.properties 3

14# Specify the EDC version used in this workspace
2 edc.version=1.3.8

fu

2. Register this property file to MMM options

Options

Property files: | S{workspace_loc:test/versions.properties)

3. Use this option in a module description file
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<dependencies:
<l--

[, [ S BTy ¥

-
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</dependencies:
g </ivy-modules
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Resolution Logs

Use the EDC version defined by MMM configuration

<dependency org="ej.api" name="edc" rev="%{edc.wersion}" />

Resolution logs of module projects imported in the workspace are available from the console view:

« Select Windows > ShowView > Console ,

+ In the Console view, click on the console window icon and select vy console :

4

Bl Console 53

Mo consoles to display at this time.

=

1 Mew Console View

2 Addon Processor Console
3 C/C++ Build Console
4 Host O5Gi Console

5 vy Console

Om<|o O ol

6 Java Stack Trace Console

7 SonarLint Console

To enable the verbose mode:

.

+ Inthe vy console view, click on the debugicon and select debug instead of info (defaults):

&) Console i3 xﬁ&v|§,‘bﬂ'|=‘
vy Error
| found ej.api#edc;1.3.3 in aaaa-ivyde-workspace-chain-resclver (@-server) warnin
[1.3.3] ej.apittedc;[1.3.3-RC,1.3.4-RC[ g
11 resclution report @@ resclve 821ms :: artifacts d1l 9ms + info
_____________________________________________________________________ .
| | modules || artifacts | VR
| conf | number| search|dwnlded|evicted|| number|dwnlded| l debug
| default | 1 | e | © | e || e | e | hvyDE errer
| provided | » | e | @ | @ || 1 | e | lvyDE warning
| platform | | e | @ | @ || @ | @ | )
< »  |wyDE info
IwyDE verbose
lwyDE debug

This triggers the full workspace resolution with verbose mode enabled.
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3.7.6 Module Build

In the SDK, the build of a MicroEJ module project can be started as follows:

« In the Package Explorer, right-click on the project,
+ Select Build Module .

Awilh B BR-PDHF-O0-QU-FOE- BB
[% Package Explorer 51 T¢ Type Hierarchy s § = E
v'_,ff- module ,
= src/r W
B sre/ Go Into
i f . .
o> srcit Open in New Window
B sroft _
v B\ Moc Open Type Hierarchy F4
e Show In Alt+Shift+ W > broej com-5g).
= STC | =y
- = Co Ctrl+C
) CHa ' CoPY
= Lcg 52 Copy Qualified Name
by moc [ Paste Ctrl+W
REAl 3¢ Delete Delete
Build Path H
Source Alt+Shift+5 »
Refactor Alt+5hift+T >
fxy Import..
iy Export.
i Refresh F5
Close Project
Assign Working Sets...
) PRunAs »
%3 Debug As »
Profile As *
& Build Module
restare trom Local History...
@ JAutodoc ¥

Fig. 35: Module Build

The build of a module can take time depending on

« the module nature to build,

3.7. MicroEJ Module Manager 53



MicroEJ Documentation, Revision d4ede019

« the number and the size of module dependencies to download,
« the repository connection bandwidth, ...
The module build logs are redirected to the integrated console.

Alternatively, the build of a MicroEJ module project can be started from the build history:

Hmi DG P H-Q-Q

[ Package Explorer @ module3

4 module E modulel
'_,_'—,‘f- moduled [Tﬂ maodule
'_,:"f- madule3

Fig. 36: Module Build History

3.7.7 Build Kit

The Module Manager Build Kit is a consistent set of tools, scripts, configuration and artifacts required for build-
ing modules in command-line mode. Starting from SDK 5.4.0, it also contains a Command Line Interface (CLI).
The Build Kit allows to work in headless mode (e.g. in a terminal) and to build your modules using a Continuous
Integration tool.

The Build Kit is bundled with the SDK and can be exported using the following steps:*

+ Select File > Export > MicroEJ > Module Manager Build Kit ,
« Choose an empty Target directory ,

« Clickonthe Finish button.

Once the Build Kit is fully exported, the directory content shall look like:

/

— bin
}»7 mmm
L mmm.bat

— conf

— lib

— microej-build-repository
}— ant-contrib
}»7 com
t ivysettings.xml

— microej-module-repository
L ivysettings.xml

— release.properties

« Add the bin directory of the Build Kit directory to the PATH environment variable of your machine.

2 If using SDK versions lower than 5.4.0, please refer to the following section.
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« Make sure the JAVA_HOME environment variable is set and points to a JRE/JDK installation or that java
executable isin the PATH environment variable (Java 8 is required)

« Confirm that the installation works fine by executing the command mmm --version. The result should
display the MMM CLI version.

The mmm tool can run on any supported Operating Systems:

+ on Windows, either in the command prompt using the Windows batch script mmm.bat orin MinGW environ-
ments such as Git BASH using the bash script mmm .

« on macOS and Linux distributions using the bash script mmm.

The build repository (microej-build-repository directory) contains scripts and tools for building modules. Itis
specific to a SDK version and shall not be modified by default.

The module repository ( microej-module-repository directory) contains a default Settings File for importing
modules from Central Repository and this local repository (modules that are locally built will be published to this
directory). You can override with custom settings or by extracting an offline repository.

To go further with headless builds, please consult the next chapter for command line builds, and this tutorial to
setup MicrokJ modules build in continuous integration environments.

3.7.8 Command Line Interface
Starting from version 5.4.0,the SDK provides a Command Line Interface (CLI). Please refer to the Build Kit section
for installation details.
The following operations are supported by the MMM CLI:
« creating a module project
+ cleaning a module project
+ building a module project
« running a MicroEJ Application project on the Simulator

+ publishing a module in a module repository

Usage

In order to use the MMM CLI for your project:
« go to the root directory of your project

« run the following command

mmm [OPTION]... [COMMAND]

where COMMAND is the command to execute (for example mmm build). The available commands are:
+ help: display help information about the specified command
« init:create a new project
« clean: clean the project
+ build: build the project
« publish: build the project and publish the module

« run:run the MicroEJ Application project on the Simulator
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The available options are:
« ——help (-h): show the help message and exit
« —-version (-V): print version information and exit

o ——build-repository-settings-file (-b): path of the Ivy settings file for build scripts and tools. Defaults
to ${CLI_HOME}/microej-build-repository/ivysettings.xml.

« —-module-repository-settings-file ( -r ): path of the Ivy settings file for modules. Defaults to
${CLI_HOME}/microej-module-repository/ivysettings.xml.

« ——ivy-file (-f): path of the project’s Ivy file. Defaults to ./module.ivy.
« --verbose (-v): verbose mode. Disabled by default. Add this option to enable verbose mode.
« -Dxxx=yyy : any additional option passed as system properties.

When no command is specified, MMM CLI executes Easyant with custom targets using the --targets (-t ) option
(defaultsto clean,verify).

Shared configuration

In order to share configuration across several projects, these parameters can be defined in the file ${user.home}/
.microej/.mmmconfig . This file uses the TOML format. Parameters names are the same than the ones passed
as system properties, except the character _ is used as a separator instead of - . The parameters defined in the
[options] section are passed as system properties. Here is an example:

build_repository_settings_file = "/home/johndoe/ivy-configuration/ivysettings.xml"
module_repository_settings_file = "/home/johndoe/ivy-configuration/ivysettings.xml”
ivy_file = "ivy.xml”
[options]
my.first.property = "valuel”
my.second.property = "value2”

Warning:

« TOML values must be surrounded with double quotes

« Backslash characters ( \ ) must be doubled (for example a Windows path C:\\Users\\johndoe\\
ivysettings.xml)

Command line options take precedence over those defined in the configuration file. So if the same option is defined
in both locations, the value defined in the command line is used.

Commands
init
Thecommand init creates a new project (executes Easyant with skeleton:generate target). The skeleton and
project information must be passed with the following system properties:
« skeleton.org: organisation of the skeleton module. Defaults to com.is2t.easyant.skeletons.
« skeleton.module : name of the skeleton module. Mandatory, defaults to microej-javalib.

+ skeleton.rev : revision of the skeleton module. Mandatory, defaults to + (meaning the latest released
version).
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« project.org: organisation of the project module. Mandatory, defaults to com.mycompany .
« project.module : name of the project module. Mandatory, defaults to myproject.
+ project.rev: revision of the project module. Defaultsto 0.1.0.

« skeleton.target.dir: relative path of the project directory (created if it does not exist). Mandatory, defaults
to the current directory.

For example

mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=microej-javalib -Dskeleton.rev=4.2.
—8 -Dproject.org=com.mycompany -Dproject.module=myproject -Dproject.rev=1.0.0 -Dskeleton.target.
—dir=myproject

If one of these properties is missing, it will be asked in interactive mode:

$ mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=microej-javalib -Dskeleton.rev=4.
2.8 -Dproject.org=com.mycompany -Dproject.module=myproject -Dproject.rev=1.0.0

-skeleton:check-generate:

[input] skipping input as property skeleton.org has already been set.

[input] skipping input as property skeleton.module has already been set.

[input] skipping input as property skeleton.rev has already been set.

[input] The path where the skeleton project will be unzipped [/home/tdelhomenie/microej/working/
—skeleton]

To force the non-interactive mode, the property skeleton.interactive.mode must be setto false. In non-
interactive mode the default values are used for missing non-mandatory properties, and the creation fails if manda-
tory properties are missing.

$ mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=microej-javalib -Dskeleton.rev=4.
—2.8 -Dproject.org=com.mycompany -Dskeleton.target.dir=myproject -Dskeleton.interactive.mode=false

* Problem Report:

expected property 'project.module': Module name of YOUR project

clean

The command clean cleans the project (executes Easyant with clean target). For example

mmm clean

cleans the project.
build

The command build builds the project (executes Easyant with clean,verify targets). For example

mmm build -f ivy.xml -v

builds the project with the Ivy file ivy.xml and in verbose mode.

publish

The command publish buildsthe project and publishes the module. This command accepts the publication target
as a parameter, amongst these values:

3.7. MicroEJ Module Manager 57



MicroEJ Documentation, Revision d4ede019

local (defaultvalue): executesthe clean,publish-local Easyanttarget, which publishes the project with
the resolver referenced by the property local.resolver inthe Settings File.

shared: executes the clean,publish-shared Easyant target, which publishes the project with the resolver
referenced by the property shared.resolver inthe Settings File.

release : executes the clean,release Easyant target, which publishes the project with the resolver refer-
enced by the property release.resolver the Settings File.

For example

mmm publish local

builds the project and publishes the module using the local resolver.

run

The command run runs the application on the Simulator (executes Easyant with compile,simulator:run tar-

gets).

It has the following requirements:
to run on the Simulator, the project must be configured with one of the following Module Natures:

- Sandboxed Application

- Standalone Application

- Add-On Library

the property application.main.class must be set to the Fully Qualified Name of the application main
class (for example com.mycompany.Main)

a MicroEJ Platform must be provided (see Platform Selection section)

Application Options must be defined using properties file underin the build directory (see Using a Properties
File section)

the module must have been built once before running the Simulator. So the mmm build command must be
executed before running the Simulator the first time or after a project clean (mmm clean command).

Note: The next times, it is not required to rebuild the module if source code files have been modified. The
contentof src/main/java and src/main/resources folders are automatically compiled by mmm run com-
mand before running the Simulator.

For example

mmm run -D"platform-loader.target.platform.file"="/path/to/the/platform.zip”

runs the application on the given platform.

The Simulator can be launched in debug mode by setting the property execution.mode of the application file
build/commons.properties to debug:

execution.mode=debug

The debug port can be defined with the property debug.port. Go to Simulator Debug options section for more
details.

help

The command help displays the help for acommand. For example
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mmm help run

displays the help of the command run.

3.7.9 Build System Options

MMM allows to modify the behavior of a build via System options. These options must be passed as system prop-
erties, using CL/ -D option or via the SDK Configuration options. MMM provides the following options:

« mmm.module.organisation ? : defines the organisation of the module. It overrides the organisation at-
tribute defined in the info tagin the Module Description File.

« mmm.module.name 3 : defines the name of the module. It overrides the module attribute defined in the info
tagin the Module Description File.

« mmm.module.revision 3: defines the revision of the module. It overrides the revision attribute defined in
the info taginthe Module Description File.

+ easyant.debug.port : defines the debug port and triggers the debug mode for the build execution.

3.7.10 Meta Build

A Meta Build is a module allowing to build other modules. Itis typically used in a project containing multiple mod-
ules. The Meta Build module serves as an entry point to build all the modules of the project.

Meta Build creation

+ Inthe SDK, select File > New > Module Project .

File Edit Navigate Search Project Run Window Help

New Alt+Shift+N > 2% Sandboxed Application Project
Open File.. #% Standalone Application Project L
. Open Projects from File System... 2 Add-On Library Project
Recent Files > ™ Module Project
) I8 Platform Project
<z ey = @ Front Panel Project [
Close All Editors Ctrl+Shift+W =i Project...

Fig. 37: New Meta Build Project

« Fillin the fields Project name, Organization, Module and Revision,then selectthe Skeleton named
microej-meta-build

« Clickon Finish . Atemplate projectis automatically created and ready to use.

3 Requires SDK version 5.6.0 or higher.
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Meta Build configuration

The main element to configure in a meta build is the list of modules to build. This is done in 2 files, located at the
root folder:

« public.modules.list which contains the list of the modules relative paths to build and publish.

« private.modules.list which contains the list of the modules relative paths to build. These modules are
not published but only stored in a private and local repository in order to be fetched by the public modules.

The format of these files is a plain text file with one module path by line, for example:

modulel
module2
module3

These paths are relative to the meta build root folder, which is set by default to the parent folder of the meta build
module ( .. ). For this reason, a meta build module is generally created at the same level of the other modules to
build. Here is a typical structure of a meta build:

/
— modulel

': module.ivy
— module2
': module.ivy
— module3

': module.ivy

- metabuild
private.modules.list

E public.modules.list
module.ivy

The modules build order is calculated based on the dependency information. If a module is a dependency of an-
other module, it is built first.

For a complete list of configuration options, please refer to Meta Build Module Nature section.

3.7.11 Troubleshooting
Unresolved Dependency

If the following message appears when resolving module dependencies:

: problems summary ::
: WARNINGS
module not found: com.mycompany#mymodule;[M.m.p-RC,M.m. (p+1)-RC[

:: com.mycompany#mymodule; [M.m.p-RC,M.m. (p+1)-RC[: not found

(continues on next page)
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(continued from previous page)

First, check that either a released module com.mycompany/mymodule/M.m.p or a snapshot module com.
mycompany/mymodule/M.m.p-RCYYYYMMDD-HHMM exists in your module repository.

« If the module does not exist,

- ifitis declared as a direct dependency, the module repository is not compatible with your source code.
You can either check if an other module version is available in the repository or add the missing module
to the repository.

- otherwise, this is likely a missing transitive module dependency. The module repository is not consis-
tent. Check the module repository settings file and that consistency check has been enabled during the
module repository build (see Configure Consistency Check).

« If the module exists, this may be either a configuration issue or a network connection error. We have to find
the cause in the resolution logs.

Note:
The activation of the verbose mode depends on how the resolution has been launched:
- if the error occurs during workspace resolution, configure the verbose mode of resolution logs,

- if the error occurs while building a module from workspace, check the verbose mode option in prefer-
ences page,

- if the error occurs while building a module from command line, set the verbose mode option in com-
mand line options.

For URL repositories, find:

trying https://[MY_REPOSITORY_URL]/[MY_REPOSITORY_NAME]/com.mycompany/mymodule/
tried https://[MY_REPOSITORY_URL]/[MY_REPOSITORY_NAME]/com.mycompany/mymodule/

For filesystem repository, find:

trying [MY_REPOSITORY_PATH]/com.mycompany/mymodule/
tried [MY_REPOSITORY_PATH]/com.mycompany/mymodule/

If your module repository URL or filesystem path does not appear, check your settings file. This is likely a
missing resolver.

Otherwise, if your module repository is an URL, this may be a network connection error between MMM (the
client) and the module repository (the server). First, check for Invalid Certificate issue.

Otherwise, the next step is to debug at the HTTP level:

HTTP response status: [RESPONSE_CODE] url=https://[MY_REPOSITORY_URL]/com.mycompany/mymodule/
CLIENT ERROR: Not Found url=https://[MY_REPOSITORY_URL]/com.mycompany/mymodule/
Depending on the HTTP error code:

- 401 Unauthorized: check your settings file credentials configuration.

- 404 Not Found: add the following options to log raw HTTP traffic:
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-Dorg. apache.commons. logging.Log=org.apache.commons.logging.impl.SimplelLog -Dorg.apache.
—commons.logging.simplelog.showdatetime=true -Dorg.apache.commons.logging.simplelog.log.org.
—apache.http=DEBUG -Dorg.apache.commons.logging.simplelog.log.org.apache.http.wire=ERROR

Particularly, lvy requires the HTTP HEAD request which may be disabled by some servers.

Invalid Certificate

If the following message appears when resolving module dependencies:

HttpClientHandler: sun.security.validator.ValidatorException: PKIX path building failed: sun.security.
—provider.certpath.SunCertPathBuilderException: unable to find valid certification path to requested.
—target url=[artifactory address]

This can be raised in several cases, such as:

« an artifact repository configured in the MicroEJ Module Manager settings using a self-signed SSL certificate
or a SSL certificate not trusted by the JDK.

« the requests to an artifact repository configured in the MicroEJ Module Manager settings are redirected to a
proxy server using a SSL certificate not trusted by the JDK.

In all cases, the SSL certificate (used by the artifact repository server or the proxy) must be added to the JDK trust
store that is running MicroEJ Module Manager. Ask your System Administrator, or retrieve the SSL certificate and
add it to the JDK trust store:

« on Windows
1. Install Keystore Explorer,

2. Start Keystore Explorer, and open file [JRE_HOME]/1ib/security/cacerts or [JDK_HOME]/jre/lib/
security/cacerts with the password changeit . You may not have the right to modify this file. Edit
rights if needed before opening it,

3. Clickon Tools ,then Import Trusted Certificate ,
4. Select your certificate,
5. Savethe cacerts file.
« on Linux/macQS
1. Open aterminal,
2. Make sure the JDK’s bin folderisinthe PATH environment variable,

3. Execute the following command:

keytool -importcert -v -noprompt -trustcacerts -alias myAlias -file /path/to/the/certificate.
—pem -keystore /path/to/the/truststore -storepass changeit

If the problem still occurs, set the javax.net.debug propertyto all to enable SSL protocol traces:

+ when using the MMM CLI, add the property in the command line with: -Djavax.net.debug=all

« when using the Build Module button inthe SDK, add the property in the MicroEJ Module Manager options
as described in the section Options

« when resolving the dependencies on a projectin the SDKwith the button lvy > Resolve ,add thefollowing
line at the end of the file MicroEJ-SDK.ini located at the root of the SDK installation:
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-Djavax.net.debug=all

and start the SDK from a terminal.

In all cases, such logs should appear in the terminal or in the SDK console:

javax.net.ssl|DEBUG|01|main|2022-09-09 18:22:20.828 CEST|SSLContextImpl. java:428|System_
—property jdk.tls.client.cipherSuites is set to 'null’
javax.net.ssl|DEBUG|01|main|2022-09-09 18:22:20.871 CEST|SSLCipher. java:464|jdk.tls.
—keyLimits: entry = AES/GCM/NoPadding KeyUpdate 2737. AES/GCM/NOPADDING:KEYUPDATE =_
137438953472

javax.net.ssl|DEBUG|01|main|2022-09-09 18:22:20.892 CEST|SSLContextImpl.java:402|Ignore.
—disabled cipher suite: TLS_ECDHE_ECDSA_WITH_3DES_EDE_CBC_SHA

There should be a trace at the beginning which indicates the path of the truststore used by the JDK:

javax.net.ss1l|FINE|Q1|main|2022-09-05 14:34:38.631 CEST|TrustStoreManager.java:112|trustStore is: /path/
—to/the/truststore

The error very probably occurs during the handshake phase of the SSL negotiation. There should be the following
trace before the error:

Consuming server Certificate handshake message

The traces below this one indicates the SSL certificate (or the SSL certificates chain) presented by the server. This
certificate or one of the root or intermediate certificates must be added in the JDK truststore as explained previ-
ously.

Target “simulator:run” does not exist

If the following message appears when executing the mmm run command:

* Problem Report:

Target "simulator:run” does not exist in the project "my-app”.
it means that the command run is not supported by the build type declared by your module project. Make sure it
is one of the following ones:

+ build-application,with version 7.1.0 or higher

« build-microej-javalib,with version 4.2.0 or higher

« build-firmware-singleapp, with version 1.3.0 or higher
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3.7.12 Former SDK Versions (lower than 5.2.0)

This section describes MMM configuration elements for SDK versions lower than 5.2.0.

New MicroEJ Module Project

The New MicroEJ Module Project wizard is availableat File > New > Project... , EasyAnt > EasyAnt Project

Preferences Pages

MMM Preferences Pages are located in two dedicated pages. The following pictures show the options mapping
using the same options numbers declared in Preferences Page.

lvy Preferences Page

The lvy Preferences Page is available at Window > Preferences > Ivy > Settings .

& preferences

type filter text Settings f=1n - v
General A
Ant [ reload the settings only on demand
C/Ce- (1) Ivy settings path: | C\Users\user\.microej\microej-ivysettings-5xml |
Checkstyle
Copyright Default | Workspace... | | File System... | Variables...

Easyant4Eclipse

Help Ivy user dir: ‘ |
lceTea
Install/Update

Workspace... | | File System... | Variables...

Instant Messagin
v by " (2) property fles:spworkspace loc:easyant-buid-componentivy/wyDE propertes] Edit
Advanced Stworkspace _loc nt-build P fivy/nyDE_windows properties} s
Classpath Container
Security Remove
Settings
Source/Javadoc May Up
Workspace Resolver D
own
XML Editor
Java
JavaScript ~
< B = Restore Defaults Apply
©)
! Apply and Close Cancel

Easyant Preferences Page

The Easyant Preferences Page is available at Window > Preferences > EasyAnt4Eclipse .
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® Dreferences

type filter text EasyantdEclipse e T
ie: eral e Set preferences for EasyAntdEclipse.
gl
C/Ces (5) [[]5et verbose mode
Checkstyle (3) ["]Use IvyDE preferences for lvy settings path
Copyright (4) Ivy settings path: I C:\Program Files\MicroE\MicroE)-SDK-19.05\rcp\configuration\org.eclipse.osgi\ 346\0\.cp\repositories\ivysettings.xml Browse..,
Easyant4Eclipse
Help (7) Max build history size: I 5
leeTea (6) Runtime IRE jre1.80_221 v
Install/Update
Instant Messaging
v vy
Advanced
Classpath Container
Security
Setti
ngs ¥ Restore Defaults Apply
< >
Build Kit

+ Create an empty directory (e.g. mmm_sdk_[version]_build_kit}),

+ Locate your SDK installation plugins directory (by default, C:\Program Files\MicroEJ\MicroEJ
SDK-[version]\rcp\plugins on Windows OS),

Open the file com.is2t.eclipse.plugin.easyant4e_[version].jar with an archive manager,

Extract the directory 1ib to the target directory,

« Openthefile com.is2t.eclipse.plugin.easyant4e.offlinerepo_[version].jar with an archive man-
ager,

+ Navigate to directory repositories,

« Extract the file named microej-build-repository.zip for SDK 5.x or is2t_repo.zip for SDK 4.1.x to
the target directory.

3.7.13 Former SDK Versions (from 5.2.0 to 5.3.x)

Build Kit

The Build Kit is bundled with the SDK and can be exported using the following steps:
+ Select File > Export > MicroEJ > Module Manager Build Kit ,
+ Choose an empty Target directory ,

« Clickonthe Finish button.

Once the Build Kit is fully exported, the directory content shall look like:

v = sdlk_5.2.0_build_kit
w = ant
[= lib
microg)-build-repositony.zip
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3.8 Release Notes

Starting from SDK version 5.0.0, Architectures are distributed separately from the Integrated Development Envi-
ronment. Evaluation Architectures can be downloaded from the Architectures Repository.

The SDK is now packaged into an Eclipse P2 repository (https://repository.microej.com/p2/sdk), allowing partial
updates and installation on any compatible Eclipse version. The historical version ( 5 ) of MicroEJ is reused for the
P2 repository delivery.

MicroEJ Corp. continues to regularly build all-in-one packages, called Distributions, including the SDK and ded-
icated OS installers. This distribution has a separate versioning, which follows modern convention: [YY].[MM]

3.9 SDK Distribution Changelog

3.9.1 [22.06] - 2022-06-29

Note: This release requires a JDK 11 and therefore an Architecture 7.17.0 or higher. Please refer to System Re-
quirements for more details.

« Included SDK 5.6.0.
« Added support for macOS aarch64 (M1 chip).
« Updated to Eclipse version 2022-03 .

« Changed required Java Runtime to JDK 11 (JRE and other versions are not supported anymore).

3.9.2 [21.11] - 2021-11-15

Note: This release prepares for a future JRE 11 support. However, the only officially supported JRE version is still
JRE 8. Please refer to System Requirements for more details.

« Included SDK 5.5.0.
« Updated installer to accept both JRE 8 and JRE 11.
+ Fixed error Error while loading manipulator when installing SDK updates on MacOS.

+ Updated End User License Agreement.
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3.9.3 [21.03] - 2021-03-25

+ Included SDK 5.4.0.
« Updated End User License Agreement.
KNOWN ISSUES:

+ The following error occurs when installing an SDK update on MacOS:

IMESSAGE Error while loading manipulator.
ISTACK @
java.lang.IllegalStateException: Error while loading manipulator.

at org.eclipse.equinox.internal.p2.touchpoint.eclipse.LazyManipulator.
—loadDelegate(LazyManipulator. java:64)

at org.eclipse.equinox.internal.p2.touchpoint.eclipse.LazyManipulator.
—getConfigData(LazyManipulator. java:117)

at org.eclipse.equinox.internal.p2.touchpoint.eclipse.actions.UninstallBundleAction.
—uninstallBundle(UninstallBundleAction. java:57)

at org.eclipse.equinox.internal.p2.touchpoint.eclipse.actions.UninstallBundleAction.
—execute(UninstallBundleAction. java:33)

at org.eclipse.equinox.internal.p2.engine.ParameterizedProvisioningAction.
—execute(ParameterizedProvisioningAction. java:42)

at org.eclipse.equinox.internal.p2.engine.Phase.mainPerform(Phase. java:186)

at org.eclipse.equinox.internal.p2.engine.Phase.perform(Phase. java:99)

at org.eclipse.equinox.internal.p2.engine.PhaseSet.perform(PhaseSet. java:50)

at org.eclipse.equinox.internal.p2.engine.Engine.perform(Engine.java:80)

at org.eclipse.equinox.internal.p2.engine.Engine.perform(Engine. java:48)

at org.eclipse.equinox.p2.operations.ProvisioningSession.
—performProvisioningPlan(ProvisioningSession. java:181)

at org.eclipse.equinox.p2.operations.ProfileModificationJob.
—runModal (ProfileModificationJob. java:76)

at org.eclipse.equinox.p2.operations.ProvisioningJob.run(ProvisioningJob. java:190)

at org.eclipse.core.internal. jobs.Worker.run(Worker. java:63)

The workaround is to replace /eclipse/plugins/ by /Eclipse/plugins/ (capital E ) in
MicroEJ-SDK-21.03.app\Contents\Eclipse\eclipse.ini.

o See SDK 5.4.0 Known Issues section

3.9.4 [20.12] - 2020-12-11

« Included SDK 5.3.1

« Disabled Java version check when updating SDK (see known issues of SDK Distribution 20.10)

3.9.5 [20.10] - 2020-10-30

« Included SDK5.3.0
« Updated to Eclipse version 2020-06
« Fixed low quality MacOS SDK icons

Note: Starting with this release, only 64bits JRE are supported because 32bits JRE support has been removed
since Eclipse version 2018-12. See this link for more details.
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KNOWN ISSUES:

« Projects configured with Null Analysis must be updated to import EDC API1.3.3 or higher in order to avoid an
Eclipse JDT builder error (see also this link for more details).

« The default settings file for connecting MicroEJ Central Repository is not automatically installed. To connect
to the MicroEJ Central Repository, follow the procedure:

- For Windows, create the folder: C:\Users\%USERNAME%\ .microej .

- For Linux, create the folder: /home/$USER/.microej.

For macos, create the folder: /Users/$USER/.microej.

Download and save this file microej-ivysettings-5.xml to the previously created .microej folder.

+ By default, a check is done on the JRE version required by the plugins on install/update. Since CDT
requires JRE 11, it prevents to install/update a newer SDK version. The CDT documentation explains

that this can be bypassed by disabling the option Windows > Preferences > Install/Update >

Verify provisioning operation is compatible with currently running JRE .

3.9.6 [20.07] - 2020-07-28

« Included MicroEJ SDK5.2.0
+ Updated the default microej repository folder name (replaced SDK version by the distribution number)

« Added Dist. prefixininstaller name (e.g. MicroEJ SDK Dist. 20.07)to avoid confusion between SDK
distribution vs SDK version

Updated SDK End User License Agreement

« Disabled popup window when installing a SDK update site (allow to install unsigned content by default)

3.9.7 [19.05] - 2019-05-17

« Included SDK version 5.1.0
« Updated MicroEJ icons ( 16x16 and 32x32)
« Updated the publisher of Windows executables (MicroEJ instead of I1S2T SA.)

« Updated the JRE link to download in case the default JRE is not compatible. ( https://www.java.com is
deprecated)

3.9.8 [19.02] - 2019-02-22

+ Updated to Eclipse Oxygen version 4.7.2
« Included SDK version 5.0.1

« Included Sonarlint version 4.0.0
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3.10 SDK Changelog

3.10.1 [5.6.2] - 2022-08-31

General

« Fixed error when opening some heap dump files.

« Fixed error when saving a EJF file with the Font Designer.
MicroEJ Module Manager

General

« Fixed invalid module name when using spaces in the project name.

Skeletons

« Fixed wrong package name in the class generated when creating a firmware-multiapp project.

3.10.2 [5.6.1] - 2022-07-08

General

+ Removed check on JRE version when opening a workspace.

3.10.3 [5.6.0] - 2022-06-29
General

+ Added support for JDK11.

« Changed Easyant targets executed by mmm build from clean,verify to clean,package.
+ Upgraded Front Panel plugin to version 6.1.3 to remove warning on fp framework.

+ Updated Workspace settings to ignore errors in Ant build files by default.

« Fixed error when opening a Heap Dump file not part of the workspace.

« Fixed error when opening a Map file not part of the workspace.

« Removed Resources Center view.
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MicroEJ Module Manager

General

+ Added the capability to override module organisation/name/revision with Build System Options.

+ Added error message when using non-supported Eclipse Link Folders.
« Updated End User License Agreement.
+ Fixed MMM failure when resolving a dependency with a version containing a number with 4 digits.

« Fixed error when building a meta-build project with public sub-modules and using target verify.
Build Types
« Added support for Kernel Runtime Environments ( build-firmware-multiapp, build-runtime-api and

build-application).

+ Added option javadoc.modules.excludes to exclude modules from Javadoc generation when building a
module repository.

Build Plugins
+ Updated elf-utils pluginto load the ELF related tools from the architecture/platform.

Skeletons

+ Added JUnit dependency to all Java module skeletons (including default JUnit tests pattern).
+ Updated firmware-singleapp and firmware-multiapp skeletons for building the executable by default.

« Updated Sandboxed Application skeleton ( application ) to be compatible with any Kernel (based on KF
FeatureEntryPoint).

3.10.4 [5.5.3]-2022-05-03
MicroEJ Module Manager

+ Fixed error Can't parse module descriptor when building a Module on Windows with a JDK 8.0.331+.

3.10.5 [5.5.2]-2021-12-22
General

+ Fixed Addon Processors of a project in a workspace being applied to others projects.
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MicroEJ Module Manager

Build Plugins

« Updated Log4j in Artifact Checker and Cobertura plugins to version 2.17.0.

3.10.6 [5.5.1] - 2021-12-02

General

» Fixed wrong category namein New Project wizard.

3.10.7 [5.5.0] - 2021-11-15

Note: This release prepares for a future JRE 11 support. However, the only officially supported JRE version is still
JRE 8. Please refer to System Requirements for more details.

General

Added Add-On Processor resolution in workspace.
Updated tools for both JRE 8 and JRE 11 compatibility.
Fixed corrupted font file created by the Font designer when importing large number of glyphs.

Updated Architecture version check during Pack import ( greaterOrEqual instead of compatible). This
allows to import Architecture Specific Pack and Legacy Generic Pack on future Architecture versions 8.x.

Updated End User License Agreement.

MicroEJ Module Manager

Added bin folderto .gitignore file of module natures Java project skeleton.

Added Null Analysis configuration to artifact-checker.When building a module repository, null analysis
configuration is only checked on the highest module version included in the repository.

Added Eclipse Public License v2.0 to the list of default licenses allowed for artifact-checker.
Clarified input messages of mmm init command.

Updated artifact-checker plugin bindingto target verify. This allow module checks to be executed on
builds triggered by a pull request (no publication).

Fixed missing artifact-checker plugin to some module natures ( custom , firmware-multiapp ,
firmware-singleapp, microej-javaimpl, microej-mock, microej-testsuite, product-java).

Fixed mmm run executionona firmware-singleapp module (do not trigger the Firmware build).
Fixed kf-testsuite plugin test project build.
Added support of branch analysis with Sonar.

Added ability to package private dependencies to mock module natures (configuration embedded ).
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+ Added testsuite and javadoc pluginto firmware-singleapp module nature.
+ Added ssh deploymentto microej-kf-testsuite plugin.
« Updated firmware-multiapp to remove the bsp directory in Virtual Devices.

« Updated firmware-multiapp to allow Virtual Devices for launching a specific main class other than the
Kernel main class. This is useful for running JUnit tests using a Virtual Device instead of a Platform.

+ Updated firmware-multiapp to allow Virtual Devices for automatically launching a Sandboxed Application
project in the SDK.

« Updated firmware-multiapp to automatically configure the Virtual Device Kernel UID when a Firmware is
built.

« Fixed firmware-multiapp skeleton default dependencies with only modules available in MicroEJ Central
Repository.

+ Fixed firmware-multiapp unexpected build error when no declared System Application.

« Fixed firmware-multiapp build which may fail an unexpected Unresolved Dependencies error the first
time, for Kernel APIs module dependencies (configuration kernelapi ) or Virtual Device specific modules
dependencies (configuration default-vd).

o Fixed firmware-multiapp unexpected build error when no Application ( .wpk file) found in the dropins
folder.

« Fixed firmware-multiapp unexpected build error when no declared System Application.

« Fixed firmware-singleapp and firmware-multiapp skeletons wrong package name generation for the
default Main class.

+ Fixed artifact-repository changelog check for modules with a snapshot version.

3.10.8 [5.4.1] - 2021-04-16

Note: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous SDK Distribution.

MicroEJ Module Manager
« Fixed missing repository configurationin artifact-repository skeleton (this configuration is required
to include modules bundled in an other module repository)

+ Fixed missing some old build types versions that were removed by error. (introduced in SDK 5.4.0, please
refer to the Known Issues section for more details)

« Fixed wrong version of module built in a meta-build (module was published with the module version instead
of the snapshot version)

« Fixed code coverage analysis on source code (besides on bytecode) thanks to the property cc.src.folders
(only for architectures in version 7.16.0 and beyond)
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3.10.9 [5.4.0] - 2021-03-25

Note: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous SDK Distribution.

Known Issues

« Some older build types versions have been removed by error. Consequently, using SDK 5.4.0, it may be not
possible to build modules that have been created with an older SDK version (For example, MicroEJ GitHub
code). The list of missing build types:

- build-application 7.0.2
- build-microej-javalib 4.1.1
- build-firmware-singleapp 1.2.10

- build-microej-extension 1.3.2

General

+ Added MicroEJ Module Manager Command Line Interface in Build Kit

+ Added ignore optional compilation problems in Addon Processor generated source folders

« Added logs to Standalone Application build indicating the mapping of Foundation Libraries to the Platform
+ Updated End User License Agreement

+ Added the latest HIL Engine APl to mock-up skeleton (native resources management)

« Updated the Architecture import wizard to automatically accept Pack licenses when the Architecture license
is accepted

MicroEJ Module Manager

General

+ Added JSCH library to execute MicroEJ test suites on Device through ssh
+ Added pre-compilation phase before executing Addon Processor to have compiled classes available

« Updated the default settings file to import modules from MicroEJ Developer repository (located at ${user.
dir}\.microej\microej-ivysettings-5.4.xml)
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Build Types

+ Updated all relevant build types to load the Platform using the platform configuration instead of the test
configuration:

Sandboxed Application (application)

Foundation Library Implementation ( javaimpl)

Addon Library ( javalib)

MicroEJ Testsuite ( testsuite)
+ Updated Module Repository to allow to partially include an Architecture module (eval and/or prod)

« Fixed potential Addon Processor error NoClassDefFoundError: ej/tool/addon/util/Message depending
on the resolution order

+ Removed javadoc generation for microej-extension

Build Plugins

+ Updated Addon Processor to fail the build when an error is detected. Error messages are dumped to the build
logs.

« Updated Platform Loader to handle Platform module ( . zip file)

« Updated Platform Loader to handle Virtual Device module ( . vde file) declared as a dependency. It worked
before only by using the dropins folder.

« Updated Platform Loader to list the Platforms locations when too many Platform modules are detected

Skeletons

+ Fixed wrong README.md generation for artifact-repository skeleton

« Removed uselessfilesin microej-javaapi, microej-javaimpl and microej-extension skeletons (intern
changelog and . dbk file)

3.10.10 [5.3.1]-2020-12-1

Note: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous SDK Distribution.
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General

« Fixed missing default settings file for connecting MicroEJ Central Repository when starting a fresh install
(introducedin 5.3.9)

MicroEJ Module Manager
Build Plugins

« Fixed potential build error when computing Sonar classpath from dependencies ( ivy:cachepath task was
sometimes using a wrong cache location)

Skeletons

« Fixed skeleton dependency to EDC-1.3.3 to avoid an Eclipse JDT builder error when Null Analysis is enabled
(see known issues of SDK Distribution 20.10)

3.10.11 [5.3.0] - 2020-10-30

Note: This release is both compatible with Eclipse version 2020-06 and Eclipse Oxygen, so it can still be installed
on a previous SDK Distribution.

Known Issues

« Library module build may lead to unexpected Unresolved Dependencies error in some cases (in
sonar:init target/ ivy:cachepath task). Workaround is to trigger the library build again.

General

« Fixed various plugins for Eclipse version 2020-06 compatibility (icons, project explorer menu entries)
« Fixed closed module.ivy files after an SDK restart that were opened before
« Removed license check before launching an Application on Device

+ Disabled Activate on new event option of the Error Log view to prevent popup of this view when an
internal error is thrown

+ Removed license check before Platform build
« Updated filter of the Launch Group configuration (exclude the deprecated Eclipse CDT one)
+ Fixed inclusion of mock project dependencies in launcher mock classpath

+ Enhance error message in Platform editor ( .platform files) when the required Architecture has not been
imported (displays Architecture information)
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MicroEJ Module Manager

General

« Fixed workspace default settings file when clicking on the Default button

» First wrong resolved dependency when ChainResolver returnFirst option is enabled and the module to re-
solve is already in the cache

« Fixed potential build module crash (Not comparable issue) when resolving module dependencies across
multiple configurations

Build Types

Exclude packs from artifact checker when building a module repository

+ Merged Foundation & Add-On Libraries javadoc when building a module repository

+ Added Module dependency line for each type in module repository javadoc

+ Added an option to skip deprecated types, fields, methods in module repository javadoc
+ Allow to include or exclude Java packages in module repository javadoc

« Added an option skip.publish to skip artifacts publication in build-custom build type

Allow to define Application options from build option using the platform-launcher.inject. prefix

+ Added generation and publication of code coverage report after a testsuite execution. The report generation
is enabled under the following conditions:

at least one test is executed,

- tests are executed on Simulator,

- build option s3.cc.activated issetto true (default),

- the Platform is based on an Architecture version 7.12.0 or higher

- if testing a Foundation Library (using microej-testsuite ), build option microej.testsuite.cc.
jars.name.regex must be set to match the simple name of the library being covered (e.g. edc-*. jar
or microui-*.jar)

Fixed sonar false negative Null Analysis detection in some cases

+ Added a better error message for Studio rebrand build when izpack.microej.product.location option
is missing

Deprecated build-microej-ri and disabled documentation generation (useless docbook toolchains have
been removed to reduce the bundle size: -150MB)
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Skeletons

« Fixed microej-mock content scriptinitialization folder name

3.10.12 [5.2.0] - 2020-07-28

Gen

eral

« Added Dist. prefixin default workspace and repository name to avoid confusion between SDK distribution
vs SDK version

Replaced Version by Dist. in Help > AboutMicroEJ® SDK menu. The SDK version is available in
Installation Details view.

Replaced IS2T S.A. and MicroEJ S.A. by MicroEJ Corp. in Help > AboutMicroEJ® SDK menu.
+ Updated Front Panel plugin to version 6.1.1

» Removed MicroEJ Copyright in Java class template and skeletons files

Fixed Stopping a MicroEJ launch in the progress view doesn’t stop the launch

MicroEJ Module Manager

Gen

eral

+ Added a new configuration page ( Window > Preferences > Module Manager ). This page is a merge of
formerly named Easyant4Eclipse preferences pageand Ivy Settings relevant options for MicroEJ.

« Added Export > MicroEJ > Module Manager Build Kit wizard, to extract the files required for automating
MicroEJ modules builds out of the IDE.

+ Added New > MicroEJ > Module Project wizard (formerly named New Easyant Project), with module
fields content assist and alphabetical sort of the skeletons list

+ Added Import > MicroEJ > Module Repository wizard to automatically configure workspace with a
module repository (directory or zip file)

+ Added New MicroEJ Add-On Library Project wizard to simplify Add-On Library skeleton project creation

Updated the build repository ( microej-build-repository.zip ) to be self contained with its owns
ivysettings.xml

« Updated Virtual Device Player ( firmware-singleapp ) launcher-windows.bat (use

launcher-windows-verbose.bat to get logs)

« Renamed the classpath container to Module Dependencies instead of Ivy

+ Fixed Addon Processor src-adpgenerated folder generation when creating or importing a project with the

same name than a previously deleted one

+ Fixed implementation of settings ChainResolver returnFirst option

« Fixed lvy module resolution being blocked from time to time
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Build Types

Fixed meta build to publish correct snapshot revisions for built dependencies. (Indirectly fixes ADP resolution
issue when an Add-On Library and its associated Addon Processor were built together using a meta build)

« Fixed potential infinite loop when building a Modules Repository with MMM semantic enabled

Fixed javadoc not being generated in artifactory repository build when skip. javadoc issetto false

+ Added the capability to build partial modules repository, by using the user provided ivysettings.xml file
to check the repository consistency

« Added the possibility to partially extend the build repository in a module repository. The build repository
can be referenced by a file system resolver using the property ${microej-build-repository.repo.dir}

+ Added the possibility to include a module repository into an other module repository (using new configura-
tion repository->x)

+ Added the possibility to bundle a set of Virtual Devices when building a branded Studio. They are automati-
cally imported to the MicroEJ repository when booting on a new workspace.

« Added the possibility to bundle a Module Repository when building a branded Studio. It is automatically
imported and settings file is configured when booting on a new workspace.

Build Plugins

+ Added variables @MMM_MODULE_ORGANISATION@ , @MMM_MODULE_NAME@ and @MMM_MODULE_VERSIONE for
README.md file

« Fixed microej-kf-testsuite repository accessissue (introduced in SDK 5.0.0).

« Fixed artifact-checker to accept revisions surrounded by brackets (as specified by https:
//keepachangelog.com/en/1.0.0/)

Skeletons

« Updated module.ivy indentation characters with tabs instead of spaces
+ Updated CHANGELOG.md formatting
« Updated and standardized README.md files

Updated dependenciesin module.ivy to use the latest versions

+ Added .gitignore toignorethe target~ and src-adpgenerated folder where the module is built

Added Sandboxed Application WPK dropins folder ( META-INF /wpk )
« Removed conf provided in module.ivy forfoundation libraries dependencies

« Remove MicroEJ internal site reference in module.ant file

Fixed corrupted library workbenchExtension-api.jar in microej-extension skeleton

« Fixed corrupted library HILEngine. jar in microej-mock skeleton

Fixed javadoc content issue in Main class firmware-singleapp skeleton
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Misc

+ Updated End User License Agreement

« Added support for generating Application Options in reStructured Text format

3.10.13 [5.1.2] - 2020-03-09

MicroEJ Module Manager
« Fixed potential build error when generating fixed dependencies file ( fixdeps task was sometimes using a
wrong cache location)

» Fixed topogical sort of classpath dependencies when building using Build Module (sameasin IvyDE class-
path sorted view)

« Fixed resolution of modules with a version @.m.p when transitively fetched (an error was thrown with the
range [1.m.p-RC,T.m.(p+1)-RC[)

+ Fixed missing classpath dependencies to prevent an error when building a standard JAR with JUnit tests

3.10.14 [5.1.1] - 2019-09-26
General

« Fixedfileslockedin Platform in workspace projects preventingthe Platform from being deleted or rebuilt

3.10.15 [5.1.0] - 2019-05-17

General

« Updated MicroEJ icons ( 16x16 and 32x32)

« Fixed potential long-blocking operation when launching an application on a Virtual Device on Windows 10
(Windows defender performs a slow analysis on a zip file when it is open for the first time since OS startup)

« Fixed missing ADP resolution on a fresh MicroEJ installation

« Fixed ADP source folders order generation in .classpath (alphabetical sort of the ADP id)

« Fixed RunAs... > MicroEJ Application automatic launcher creation: when selecting a Platform in
workspace , an other platform of the repository was used instead

+ Fixed Memory Map Analyzer load of mapping scripts from Virtual Devices
+ Fixed MMM and ADP resolution when importing a zip project in a fresh MicroEJ install
« Fixed ADP crash when a project declares dependencies without a source folder

« Fixed inability to debug an application on a Virtual Device if option execution.mode was specified in
firmware build properties (now SDK options cannot be overridden)

+ Updated Front Panel plugin to comply with the new Front Panel engine

- The Front Panel engine has been refactored and moved from Ul Pack to Architecture (Ul pack 12.0.0
requires Architecture version 7.11.0 or higher)
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- New Front Panel Project wizard now generates a project skeleton for this new Front Panel engine,
based on MMM

- Legacy Front Panel projects for Ul Pack v11.1.0 or higher are still valid

« Updated Virtual Device builder to speed-up Virtual Device boot time (System Applications are now extracted
at build time)

« Fixed inability to selecta Platform in workspace ina MicroEJ Tool launch configuration
« Fixed broken title in MicroEJ export menu (Platform Export)

MicroEJ Module Manager

Build Plugins

+ Added a new option application.project.dir passed to launch scripts with the workspace project direc-
tory

Updated MMM to throw a non ambiguous error message when a module.ivy configured for MMM declares
versions with legacy Ivy range notation

« Updated MicroEJ Central Repository cache directory to ${user.dir}\.microej\caches\repository.
microej.com-[version] instead of ${user.dir}\.ivy2

Updated Update Module Dependencies. .. tobedisabled when module.ivy cannotbeloaded. The menu
entry is now grayed when the project does not declare an IvyDE classpath container

« Fixed wrong resolution order when a module is both resolved in the repository and the workspace (the
workspace module must always take precedence to the module resolved in the repository)

Fixed useless unknown resolver trace when cache is used by multiple lvy settings configurations with
different resolver names.

Fixed slow Add-On Processor generation. The classpath passed to ADP modules could contain the same entry
multiple times, which leads each ADP module to process the same classpath multiple times.

Fixed misspelled recommendation message when a build failed

« Fixed Update Module Dependencies... tool: wrong ej:match="perfect” added where it was expected
to be compatible

« Fixed Update Module Dependencies... tool: parse error when module.ivy contains <artifact
type="rip"/> element

Fixed resolution and publication of a module declared with an Ivy branch
« Fixed character '-' rejected in module organisation (according to MMM specification 2.0-B)
« Fixed ADP resolution error when the Add-On Processor module was only available in the cache

« Fixed potential build crash depending on the build kit classpath order (error was This module requires
easyant [0.9,+])

« Fixed product-java broken skeleton
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Build Types

Updated Platform Loader error message when the property platform-loader.target.platform.dir isset
to aninvalid directory

Fixed meta build property substitutionin *.modules.list files

Fixed missing publications for README.md and CHANGELOG.md files

Update skeletons to fetch latest libraries (Wadapps Framework v1.10.0 and Junit v1.5.0)
+ Updated README.md publication to generate MMM usage and the list of Foundation Libraries dependencies
« Added a new build nature for building platform options pages (microej-extension)

« Updated Virtual Device builder to speed-up Virtual Device boot time (System Applications are now extracted
at build time)

Fixed Virtual Device Player builder (dependencies were not exported into the zip file) and updated
firmware-singleapp skeleton with missing configurations

Skeletons

« Updated CHANGELOG.md based on Keep a Changelog specification (https://keepachangelog.com/en/1.0.0/)

« Updated offline module repository skeleton to fetch in a dedicated cache directory under ${user.dir}/.
microej/caches

3.10.16 [5.0.1] - 2019-02-14

Gen

eral

+ Removed Wadapps Code generation (see migration notes below)

Added support for MicroEJ Module Manager semantic (see migration notes below)

« Added a dedicated view for Virtual Devices in MicroEJ Preferences

Removed Platform related views and menus in the SDK (Import/Export and Preferences)
+ Added Studio rebranding capability (product name, icons, splash screen and installer for Windows)
+ Added a new meta build version, with simplified syntax for multi-projects build (see migration notes below)

+ Added a skeleton for building offline module repositories

Added support for importing extended characters in Fonts Designer

« Allow toimport Virtual Devices with .vde extension (*. jpf importstill available for backward compatibility)

Removed legacy selection for Types, Resources and Immutables in MicroEJ Launch Configuration (replaced
by x.1ist files since MicroEJ 4.0)

Enabled IvyDE workspace dependencies resolution by default
« Enabled MicroEJ workspace Foundation Libraries resolution by default

+ Added possibility for Architectures to check for a minimum required version of SDK ( sdk.min.version prop-
erty)

+ Updated New Standalone Application Project wizard to generate a single-app firmware skeleton

3.10.

SDK Changelog 81


https://keepachangelog.com/en/1.0.0/

MicroEJ Documentation, Revision d4ede019

+ Updated Virtual Device Builder to manage Sandboxed Applications (compatible with Architectures Products
*_7.10.0 or newer)

» Updated Virtual Device Builder to include kernel options (now options are automatically filled for the appli-
cation developer on Simulator)

MicroEJ Module Manager

Build Plugins

+ Added IvyDE resolution from properties defined in Windows > Preferences > Ant > Runtime >
Properties

« Fixed lllegal character in path error that may occur when running an Add-On Processor

« Fixed IvyDE crash when defining an Ant property file with Eclipse variables

Build Types

Kept only latest build types versions (skeletons updated)
« Updated metabuild to execute tests by default for private module dependencies

« Removed remaining build dependencies to JDK (Java code compiler and Javadoc processors). All MicroEJ
code is now compiled using the JDT compiler

Introduced a new plugin for executing custom testsuite using MicroEJ testsuite engine

Fixed MalformedURLException error in Easyant trace

Fixed Easyant build crash when an vy settings file contains a cache definitions with a wildcard

Updated Platform Builder to keep track in the Platform of the architecture on which it has been built (
architecture.properties)

+ Updated Virtual Device Builder to generate with .vde extension

Updated Multi-app Firmware Builder to embed (Sim/Emb) specific modules (Add-On libraries and System
Applications)

Fixed build-microej-ri v1.2.1 missing dependencies (embedded in SDK 4.1.5)

Skeletons

+ Updated all skeletons: migrated to latest build types, added more comments, copyright cleanup and config-
uration for MicroEJ Module Manager semantic)

+ Added the latest HIL Engine APl to mock-up skeleton (Start and Stop listeners hooks)
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3.11 Migration Notes

3.11.1 From 5.2.x to 5.3.x or more

This section applies if MicroEJ SDK 5. 3. x is started on a workspace that was previously created using MicroEJ SDK
5.2.x%.

Workspace migration warning

Starting with the MicroEJ SDK Distribution 20.10, when opening a workspace which has been created with an older
MicroEJ Distribution, a message is displayed with the following warning:

The workspace was written with an older version. Continue and update workspace which may make it._
—incompatible with older versions?

This is a generic warning from Eclipse which can be safely ignored as long as you don’t intend to open it back with
an older MicroEJ SDK Distribution then.

3.11.2 From 5.1.xto 5.2.x

This section applies if MicroEJ SDK 5. 2. x is started on a workspace that was previously created using MicroEJ SDK
5.1.x.

Enable New Wizards Shortcuts in MicroEJ Perspective

Eclipse perspective settings are stored in the workspace metadata, so the new wizards shortcuts (
Add-On Library Project and Module Project ) are notvisibleinthe File > New menu.

The MicroEJ perspective must be reset to its default settings as following:

« Clickon Windows > Perspective > Open Perspective > Other... menu

« Select MicroEJ perspective

« Clickon Windows > Perspective > Reset Perspective... menu

« Clickon Yes button to accept to reset the MicroEJ perspective to its defaults.

The new wizards shortcuts are now visible into File > New menu.

Re-enable the vy Preferences Pages (Advanced Use)

Theoriginal Window > Preferences > Ivy pages can be re-enabled as following:
+ Close all running instances of the SDK
« Edit MicroEJ-SDK.ini and add the property -Dorg.apache.ivy.showAdvancedPrefs=true
« Start the SDK again

+ Goto Window > Preferences > Module Manager page

Anew link Ivy settings should appear on the bottom of the page. It opens a popup window with the original Ivy
preferences pages.
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3.11.3 From 4.1.xto 5.x

This section applies if MicroEJ SDK 5. x is started on a workspace that was previously created using MicroEJ SDK
4.1.x.

Wadapps Application Update
The Wadapps code generator has been moved from IDE to an Addon Processor coming with ej. library.wadapps.
framework module (v1.9.0 orhigher is required).

A Wadapps Application Project can be updated as follows:

+ Right-click on the project, then Configure > Remove Sandboxed Application Nature

+ Right-click on the project, then Configure > Add Sandboxed Application Nature

« Update module.ivy dependency to fetch ej.library.wadapps.framework version 1.9.0 (or perform
MicroEJ Module Manager update as defined below)

+ Delete remaining folder src/.generated~ ifany

+ Check that project compiles and folder src-adpgenerated/wadapps is generated

MicroEJ Module Manager Update
It is highly recommended to migrate module.ivy to the MicroEJ Module Manager semantic, since the default Ivy
resolution will be no more maintained in future versions.

The module.ivy can be updated as follows:
» Right-click on module.ivy,then Update Module Dependencies...

This has for effect to both migrate the module.ivy to the MicroEJ Module Manager semantic and also to update
dependencies version to the latest available in the target repository.

Meta build Project Update

A project using microej-meta-build version 1.x can be updated to version 2.x as follows:
« Edit module.ivy
- Replacethe microej-meta-build versionby 2.0.+

- Update all properties declaration to append the metabuild.inject. prefix (e.g. <ea:property
name="skip.test"” value="true"” /> mustbeupdatedto <ea:property name="metabuild.inject.
skip.test” value="true"” />)

- Optionally remove or comment the root folder declaration as it is the default. ( <ea:property
name="metabuild.root” value=".." />)

+ Delete module.properties . It only contains the property easyant.fork.build=true . This property is
now automatically set by easyant-build-component since version 1.12.0. Otherwise it must be explicitly
injected by the build system as an Ant property: easyant.inject.easyant.fork.build=true

+ Extract from override.module.ant the projects declarations lines:

- Extract the project declarations of local.submodule.dirs.id into a new file named private.
modules.list (one project per line)
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- Extract the project declarations of submodule.dirs.id into a new file names public.modules.list
(one project per line)

« Delete override.module.ant

The new file system structure shall look like:

metabuild-project
module.ivy
private.modules.list
public.modules.list

3.12 Troubleshooting

3.12.1 Windows Specifics

If you are using Windows Defender as your default antivirus software, The SDK may be slowed down as it manipu-
lates lots of JAR files (which are ZIP files) that are regularly analyzed.

To improve the SDK experience, please find below a list of folders that should be excluded from Windows Defender
monitoring:

%USERPROFILE%\.eclipse
%USERPROFILE%\.1ivy?2

%USERPROFILE%\ .microej

%USERPROFILE%\ . p2
%USERPROFILE%\AppData\Local\Temp\microej
C:\Program Files\MicroEJ

your workspace(s) folder(s)

The exclusion page is available in the Settings application ( Windows Security > Virus & threat protection >

Manage settings > Exclusions > Add or remove exclusions ).

3.12.

2 Linux Specifics

Starting the SDK on a linux distribution may produce troubles such as missing content pages. This is related to
incomplete Eclipse SWT configuration (see Eclipse GTK wiki page).

One solution is to configure Eclipse as follows:

Add the next lines to MicroEJ-SDK.ini , before -vmargs argument:

--launcher.GTK_Version 2

Ensure GTK is correctly installed ( 1ibwebkitgtk packet)

Configure the following environment variables

MOZILLA_FIVE_HOME=/usr/lib/mozilla
LD_LIBRARY_PATH=${MOZILLA_FIVE_HOME}: ${LD_LIBRARY_PATH}

Restart the SDK
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« Check there is not more SWT/MOZILLA related errors ( Window > Show View > Other... > General >
Error Log )

3.12.3 MacOS Specifics

When launching the SDK using the .app file, you may encounter the following message:

"MicroEJ-SDK-xx.xx" is damaged and can't be opened. You should move it to the Trash.

This is due to MacOS putting applications in quarantine when downloaded with a browser. Use this command to
remove the SDK application from quarantine:

sudo xattr -rd com.apple.quarantine sdk.app

where sdk.app is the SDK file name.
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CHAPTER

FOUR

APPLICATION DEVELOPER GUIDE

4.1 Introduction

The following sections of this document shall prove useful as a reference when developing applications for MicroEJ.
They cover concepts essential to MicroEJ Applications design.

In addition to these sections, by going to https://developer.microej.com/, you can access a number of helpful re-
sources such as:

« Libraries from the MicroEJ Central Repository (https://developer.microej.com/central-repository/);
« Application Examples as source code from MicroEJ Github Repositories (https://github.com/MicroEJ);
« Documentation (HOWTOs, Reference Manuals, APIs javadoc...).

MicroEJ Applications are developed as standard Java applications on Eclipse JDT, using Foundation Libraries. Mi-
croEJ SDK allows you to run / debug / deploy MicroEJ Applications on a MicroEJ Platform.

Two kinds of applications can be developed on MicroEJ: MicroEJ Standalone Applications and MicroEJ Sanboxed
Applications.

A MicroEJ Standalone Application is a MicroEJ Application that is directly linked to the C code to produce a Mi-
croEJ Firmware. Such application must define a main entry point, i.e. a class containing a public static void
main(String[]) method.

A MicroEJ Sandboxed Application is a MicroEJ Application that can run over a Multi-Sandbox Firmware. It can be
linked either statically or dynamically. If it is statically linked, it is then called a System Application as it is part of
theinitial image and cannot be removed.

4.2 Standalone Application

4.2.1 MicroEJ Platform Import

A MicroEJ Platform is required to run a MicroEJ Standalone Application on the Simulator or build the Firmware
binary for the target device.

The Platform Developer Guide describes how to create a MicroEJ Platform from scratch for any kind of device. In
addition, MicroEJ Corp. provides Platforms for various development boards (see https://repository.microej.com/
index.php?resource=JPF).

MicroEJ Platforms are distributed in two packages:

« Source Platform. The source files are imported into the workspace. This is the default case.
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+ Binary Platform. A . jpf fileisimported into the MicroEJ repository. As of MicroEJ SDK 5. 3.0, this package
is deprecated.

Source Platform Import

Import from Folder

This section applies when the Platform files are already available on a local folder. This is likely the case when the
files are checked out from a Version Control System, such as a local git repository clone.

Note: If you are going to import a Platform from MicroEJ Github, you can follow the specific GitHub Repositories
section instead (the projects will be automatically imported).

« Select File > Import... > General > Existing ProjectsintoWorkspace > Selectrootdirectory =
Browse... .

« Select the root directory. The wizard will automatically discover projects to import.

« Clickonthe Finish button.

Import from Zip File

This section applies when the Platform files are packagedina .zip file.

« Select File > Import... > General > Existing Projectsinto Workspace > Select archive file >
Browse... .

+ Select the zip of the project (e.g., x.zip). The wizard will automatically discover projects to import.

« Clickonthe Finish button.

Platform Build

MicroEJ Platforms are usually shared with only the Platform configuration files. Once the projects are imported,
follow the platform-specific documentation to build the Platform.

Once imported or built, a Platform project should be available as follows:
v 2 myDevice-myPlatform-CMdhardfp_|ARS3-1.0.0
% build
= =ource

= .project

Fig. 1: MicroEJ Platform Project

The source folder contains the Platform content which can be set to the target.platform.dir option.
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Binary Platform Import

After downloading the MicroEJ Platform . jpf file, launch MicroEJ SDK and follow these steps to import the MicroEJ

Platform:

« Open the Platform view in MicroEJ SDK, select Window > Preferences > MicroEJ > Platforms . The
view should be empty on a fresh install of the tool.

o
type filter text
. General A
- Ant
- CfC++
Checkstyle
EasyantdEclipse
- Help
- Install/Update
vy
. Java
4 Microk)
Architectures
Maming Conventicon
Platforms in workspace
Updates
+ Mylyn
» Plug-in Development
. PMD

n o

£ >

@

« Press Import... button.

+ Choose SelectFile... andusethe Browse option to navigate to the
Platform, then read and accept the license agreement to proceed.

Preferences

Platforms

Add or remove platforms.

Platforms, Virtual Devices and Architectures:

MName

Fig. 2: MicroEJ Platform Import

o IEN
<::,v v

Version Lic... Select All
Deselect All
Import...
Uninstall

Get UID

.jpf file containing your MicroEJ
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- oS

('} Import Platforms, Virtual Devices and Architectures

Import Platforms, ¥irtual Devices and Architectures

Select a directory/file to search for available platforms, virtual devices and architectures.

(") Select directory: Browse...
(®) Select file: Ch\Usersh, MicroEJPlatform jpof Browse...
Platforms, Yirtual Devices and Architectures:
Mame Yersion Select All
L} MicroE Platform 2.1.1 Deselect Al

MICROE) LICEMSE AGREEMENT

PREAMELE

THIS SOFTWARE LICEMNSE AGREEMENT (THE « AGREEMENT ») APPLIES TO PRODUCTS LICEMSE
On purchase of any Licensed Product from 52T or an 52T Partner or an [52T Distributor, the relz
THE LICEMSEE, AS A USER OF THE LICEMSED PRODUCTS REFERRED TO ABOVE AND OM THE REI

1 DEFIMITIONS

€ >

[+]1 agree and accept the above terms and conditions and | want to install the copyrighted Software

Fig. 3: MicroEJ Platform Selection

+ The MicroEJ Platform should now appear in the Platforms view, with a green valid mark.
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ﬂ Preferences = n

type filter text Platforms =1 v w

» General ~

At
s CfC++ Platforms, Virtual Devices and Architectures:

Checkstyle Name Version  Lic... Select All

EasyantdEclipse ;
211 >
. Help L} MicroEJ Piatform o Deselect Al

+ Install/Update

> vy

» Java

4 Microk)

Architectures Get UID
Maming Conventicon
Platforms in workspace
Updates

» Mylyn

» Plug-in Development

> PMD

n o Restare Defaults Appl
< > ;

Add or remove platforms.

Import...

Uninstall

Fig. 4: MicroEJ Platform List

4.2.2 Build and Run an Application

Create a MicroEJ Standalone Application

« Create a project in your workspace. Select File > New > Standalone Application Project .

File Edit Source Refactor Mavigate Search Project Run Window Help

Mew Alt+Shift+N * A%  Sandboxed Application Project

Open File... 4% Standalone Application Project
[} Open Projects from File System... 'lf‘ Add-On Library Project

Recent Files > W& Module Project

Close Editor Ctrl+W E Platform Project

Close All Editors CtrleShift-wy | 2 Front Panel Project

™ Project...
Save Ctrl+5
Save As AE:' MicroEl Font

Fig. 5: New MicroEJ Standalone Application Project

« Fill in the Application template fields, the project name field will automatically duplicate in the following

fields. For this tutorial, the project nameis hello. Click on Finish . A template project is automatically
created and ready to use, this project already contains all folders wherein developers need to put content:
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- src/main/java: Folder for future sources
- src/main/resources : Folder for future resources (raw resources, images, fonts, nls)

- module.ivy: Module description file, dependencies description for the current project

« A Main class already exists in the package com.mycompany and prints “Hello World!” :

1] Mainjava i2

2@ Javal]

5 package com.mycompany;

B

70 =+

8 * @Generated by the build-firmware-singleapp-skeleton.<br:
9 * please keep it in sync with the property "application.main.c.
B *

1 public class Main {

2

32 =

14 * Simple main.

15 *

16 * [param args

17 = command line arguments.

18 */

198 public static void main{String[] args) {

2@ system.out.println{"Hello World!™); //SNON-NLS-1%
21 }

22 }

23

Fig. 6: MicroEJ Application Content

The main Application is now ready to be executed. See next sections.

Run on the Simulator

Note: A Platform must have been imported to run the Application. If several Platforms have been imported, the
target Platform can be selected in the Launcher’s Execution tab.

To run the sample project on Simulator, select it in the left panel then right-click and select Run > Runas >
MicroEJ Application .
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|- RICIN B fPﬁf%-Qv%viﬂﬁ\@v;i&E.jvi - > to o ~| %
New b
= .
& p Go Into B [J] Mainjava 2
b 26 Javal]
o Open in New Window 5 package com.mycompany;
Open Type Hierarchy F4 E_
Show In Alt+Shift+W » 8 * Generated by the build-firmware-singleapp-skeleton.<b
9 * Please keep it in sync with the property 'application
[ Copy Ctrl+C 18 */
E=  Copy Qualified Name _: public class Main {
ra
[[& Paste Ctrl+V 3 JE*
3 Delete Delete 4 Simple main.
5 "
Build Path ] 6 args
. command line arguments.
Source Alt+Shift+5 » Y]
Refactor Alt+Shift+T » public static void main(String[] args) {
System,out.println(“Hello World!™); //BNON-NLS-1!
[z_],\._, Import... 2 ¥
7 Export.. b
" Refresh Fs
Close Project
Close Unrelated Project
Assign Working Sets...
{J PRunAs >[I 1Java Application Alt+Shift+X, J
45 Debug As » 7] 2 Microb) Application Alt+5hift+X, M
Profile As »

_ Run Configurations...
# Build Module r

Fig. 7: MicroEJ Launcher Shortcut

MicroEJ SDK console will display Launch steps messages.

SUCCESS

Run on the Device

Build the Application

+ Opentherundialog( Run > Run Configurations... ).
+ Select the MicroEJ Application > Hello Main thatis created by the previous chapter.

+ Open Execution tab and select Execute on Device .

« Set Settings checkboxto Build & Deploy .
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e- Run Cenfigurations

Create, ge, and run ¢

[m]

W

X

CEaEX BT

Name: | Hello Main

L Launch Group
~ [T] Microk) Application
7] Hello Main
@ Microkl Tool

Filter matched 6 of 14 iterns

type filter text Main rﬁ Execution “_ifil Conﬂguratloﬂ B JRE} B Sourca =] Cornmon]
[E] C/C++ Application Target
Jur JUnit

Platferm: MicroEl Platform

Execution
() Execute on Simulator

Settings: |Android

(® Execute on Device
Core Engine Mode: | Default

Settings: | Build & Deploy

Browse...

~

~

The application is generated, linked and deployed.

Options
Output folder: | ${project_loc:hello} Browse...
Clean intermediate files [ Verbose
Options Files
Add...
Remove
Up
Down
Revert Apply

)

iz

o Click Run

[ Deployment ]

Fig. 8: Execution on Device

: The Application is compiled and the Application, the runtime library and the header files are
automatically deployed to the locations defined in your Platform BSP connection settings.

MicroEJ files for the 3rd-party BSP project are generated to '<application-project>/<fully-qualified-
—name-of-main-class>/platform’.

The MicroEJ application (microejapp.o) has been deployed to:
The MicroEJ platform library (microejruntime.a) has been deployed to:
The MicroEJ platform header files (*.h) have been deployed to:
[ Completed Successfully 1]

SUCCESS

'<path-to-deployment-location>".

'<path-to-deployment-location>".
'<path-to-deployment-location>".
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Build the Executable File

If your Platform has configured a build script file, the final Application linking can be triggered from the launcher:

« Open Configuration tab and select Device > Deploy . The options to deploy the Application, runtime
library and header files have already been set in the previous step.

« Check Execute the MicroEJ build script (build.bat) at a location known by the 3rd-party BSP project .

G— Run Cenfigurations

Create, manage, and run cenfigurations

B % B %] 2 || Nome [Hello Main |
type filter text [7] Main | s Execution | i} Configuration - g JRE E Source | ] Common

[E] C/C++ Application || v Device Configuration =

Ju JUnit CoreEngine " - _— ! )

k] Deploy the MicroEJ application (microejapp.o) at a location known by the 3rd-party BSP project.

& Launch Group Deploy [ Deploy pp (i japp.o) ¥ party BSP proj

~ [T] MicroEl Application Libraries
51 Hello Main Runtime

& Microkl Tool

Browse...
Deploy the MicroEJ platform library (microejruntime.a) at a location known by the 3rd-party BSP project.
Browse...
Deploy the MicroE) platform header files (*.h) at a location known by the 3rd-party BSP project.
Browse...
I Execute the MicroE) build script (build.bat) at a location known by the 3rd-party BSP project. I
v
< >
¢ > R Appl
evert
Filter matched & of 15 items EE
'i?:' Run Close

Fig. 9: BSP Connection Application Options

Note: The table MicroEJ Application Options for BSP Connection specifies the Application options that can be set
depending on the BSP connection configured by the Platform.

+ Click Apply and Run :thefinalexecutable application.out fileis generatedinthe directory from where
the script has been executed and can now be deployed on your Device using the appropriate flash tool.
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4.2.3 Build Output Files

When building a Standalone Application, multiple files are generated next to the ELF executable file.

Launch Output Folder

Using a MicroEJ Application Launch, the files are generated in a folder which is named like the main type and which
is located in the output folder specified in the run configuration.

v [ com.microg).demo.widget.common.Mavigation

= bon

= cC

[ externalResources

= fonts

= heapDump

= Images

= logs

= platform

= resourceBuffer

v = soar

=| com.micreej.demo.widget.common.Mavigation.clinitrap
com.micreel.demo.widget.common.MNavigation.o
Ei com.micreel.demo.widget.common.Mavigation.s3infos
|X| com.microg.demowidget.commen.Mavigation.xml
L] sni_intern.h

[ SOAR.map

SOAR.o

Fig. 10: Build Output Files from MicroEJ Application Launch

Published Module Files

After building the Standalone Application, the published module contains the following main files:
o [name]-[version].out : Firmware (ELF Executable)
e [name]-[version].zip: Virtual Device

« [name]-[version]-workingEnv.zip : Build intermediate files, including the content of the launch output
Folder)
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£ 1.0.2
] application-1.0.2.out <— Firmware (ELF Executable)
[ application-1.0.2-workingEnv.zip <= Build Intermediate Files
(8] application-1.0.2.zip <« Virtual Device
£ application-build-meta-1.0.2xml  <+—— MMM metadata
] CHANGELOG-1.0.2.md <+— Changelog
& ivy-1.0.2.xml <+— MMM metadata
] ivy-fixed-1.0.2.xml <+—— MMM metadata
] README-1.0.2.md <+— README

Fig. 11: Published Standalone Application Module Files

The SOAR Map File

The SOAR.map file lists every embedded symbol of the application (section, Java class or method, etc.) and its size
in ROM or RAM. This file can be opened using the Memory Map Analyzer.

The embedded symbols are grouped into multiple categories. For example, the Object class and its methods are
grouped inthe LibFoundationEDC category. For each symbol or each category, you can see its size in ROM ( Image
Size)and RAM (Runtime Size).

The SOAR groups all the Java strings in the same section, which appearsinthe ApplicationStrings category. The
same appliesto the staticfields (Statics category), thetypes (Types category), and the class names (ClassNames
category).

The SOAR Information File

The soar/<main class>.xml file can be opened using any XML editor.
This file contains the list of the following embedded elements:

» method (in selected_methods tag)

« resource (in selected_resources tag)

« system property (in java_properties tag)

« string (in selected_internStrings tag)

« type (in selected_types tag)

« immutable (in selected_immutables tag)
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4.2.4 MicroEJ Launch

The MicroEJ launch configuration sets up the MicroEJ Applications environment (main class, resources, target plat-
form, and platform-specific options), and then launches a MicroEJ launch script for execution.

Execution is done on either the MicroEJ Platform or the MicroEJ Simulator. The launch operation is platform-
specific. It may depend on external tools that the platform requires (such as target memory programming). Refer
to the platform-specific documentation for more information about available launch settings.

Main Tab

The Main tab allows you to setin order:
1. The main project of the application.
2. The main class of the application containing the main method.

3. Typesrequired inyour application that are not statically embedded from the main class entry point. Most re-
quired types are those that may be loaded dynamically by the application, using the Class.forName() method.

4. Binary resources that need to be embedded by the application. These are usually loaded by the application
using the Class.getResourceAsStream() method.

5. Immutable objects’ description files. See the [BON 1.2] ESR documentation for use of immutable objects.
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0 Run Configurations n
Create. manage. and run configurations ;—I
- —*|,
= x| H 5 Name: | HelloWerld
type filter text 3] Main s Execution| 8§ Configuration | g, JRE E Source | [[] Commen
E C/C++ Application Praject ~
Ju JUnit
BI;I La::'1ch Group MyHelloWorld5ample Browse...
4 [7] MicroE) Application Main type, Required types
31 HelloWarld
& MicroE Tool com.is2t.examples.edc.helle. HelloWorld Select Main type...
Add types...
Extra types...
Remove
Resources
Add...
Remove
Immutables v
Revert Apply

Filter matched 6 of 11 items

Fig. 12: MicroEJ Launch Application Main Tab

Execution Tab

The next tab is the Execution tab. Here the target needs to be selected. Choose between execution on a MicroEJ
Platform or on a MicroEJ Simulator. Each of them may provide multiple launch settings. This page also allows you
to keep generated, intermediate files and to print verbose options (advanced debug purpose options).
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G— Run Cenfigurations

Create, manage, and run configurations

©

—*l,

CEX B3P~

| type filter text

Name: | Widget Demo (SIM)

] C/C++ Application
Ju JUnit
L Launch Group
w [T MicroE) Application
31 Widget Dema (EMB)
[3] Widget Demo (SIM])
» g MicroEl Tool

Filter matched 8 of 21 items

3] Main | = Execution

A Configuratioﬂ B JRE} E_/ Source\l i=| Qommoﬂ

Target
Platform: | STM32F746G-DISCO SingleApp Production [K1AU3] (4.0.0-RC202007301413) | Browse... |
Execution
(®) Execute on Simulator () Execute on Device

Core Engine Mode: MDefanl ~
Settings: |Defau|'t V| Settings: |Build 8 Deploy w
The Application is simulated
Cptions
Output folder: | S{project_loc:com.microej.demouwidget} | Browse... |
Clean intermediate files [ Verbose
Opticns Files
Y project_loc:com.microe].demo.widget}/build/commeoen.properties Add...

Y project_loc:com.microgj.demo.widgetl/build/sim/sim.properties

Remowe

U

Apply

©)

Close

Configuration Tab

Fig. 13: MicroEJ Launch Application Execution Tab

The next tab is the Configuration tab. This tab shows the available Application options.
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0 Run Configurations n

Create. manage. and run configurations ; l

S X B2 Name: | HelloWorld

type filter text 37 Main | s Execution | ifif Configuration g, JRE E Source | [[] Commen
[E] C/C++ Application 4 Debug
Ju JUnit Code Coverage
= Launch Group Heap Dumper
a [T MicroEl Application IDWP
Logs
@ MicroE) Tool 4 Simulator
Com Port
F5
HAL
4 Target
Memory

Specify debug options

4 Libraries
EDC
Shielded Plug
. ECOM
FS
> Microll
Met
MNLS
S5L

. . Revert Apply
Filter matched 6 of 11 items

Fig. 14: Configuration Tab

JRE Tab

The next tabisthe JRE tab. Thistab allows you to configure the Java Runtime Environment used for running the
underlying launch script. It does not configure the MicroEJ Application execution. The VM Arguments text field
allows you to set vm-specific options, which are typically used to increase memory spaces:

« To modify heap space to 1024MB, set the -Xmx1024M option.

« To modify string space (also called PermGen space) to 256MB, set the -XX:PermSize=256M
-XX:MaxPermSize=256M options.

To set thread stack space to 512MB, set the -Xss512M option.

« To set an advanced Application option, declare a system property with the following pattern
-D[OPTION_KEY]>=[OPTION_VALUE]
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€+ Run Configurations O X
Create, manage, and run configurations ;—;

B2EX|B Y | Name [ [5IM] MyApplication |
|t}-'pEfi|tEFtB<t | 31 Main | Execution [} Configuration | =) JRE ™. Source| [C] Common

[E] C/C++ Application Runtime JRE:

Ju JUnit (O Project JRE {undefined)

R Launch Group
~ [T] Microk) Application
07 [SIM] MyApplication () Alternate IRE: Installed JREs...
@ Micrekl Tool

(®) Execution environment: | JavaSE-1.8 (jrel.8.0_321) ~ | | Environments...

VM arguments:
-D53.JavaMemary.HeapSize=8182|

Variables...
Rewvert Appl
Filter matched & of 12 items )
':33' Run Close

Source Tab

The nexttabisthe Source tab. Bydefault,itis automatically configured to connect your Add-On Libraries sources
dependencies. To connect your Platform Foundation Library sources, please refer to the section Foundation Library

Sources.

Common Tab

The last tab is the Common tab. This is a default Eclipse tab that allows to configure your launch. Particularly,
you can configure the console encoding. Refer to Eclipse help for more details on other available options.

4.2.5 Application Options

Introduction
To run a MicroEJ Standalone Application on a MicroEJ Platform, a set of options must be defined. Options can be
of different types:

« Memory Allocation options (e.g set the Java Heap size). These options are usually called link-time options.

« Simulator & Debug options (e.g. enable periodic Java Heap dump).

+ Deployment options (e.g. copy microejapp.o to asuitable BSP location).

+ Foundation Library specific options (e.g. embed UTF-8 encoding).
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The following section describes options provided by MicroEJ Architecture. Please consult the appropriate MicroEJ
Pack documentation for options related to other Foundation Libraries (MicroUl, NET, SSL, FS, ...) integrated to the
Platform.

Notice that some options may not be available, in the following cases:

« Option is specific to the MicroEJ Core Engine capability (tiny/single/multi) which is integrated in the targeted
Platform.

« Option is specific to the target (MicroEJ Core Engine on Device or Simulator).

« Option has been introduced in a newer version of the MicroEJ Architecture which is integrated in the targeted
Platform.

+ Options related to Board Support Package (BSP) connection.

Defining an Option

A MicroEJ Standalone Application option can be defined either from a launcher or from a properties file. It is also
possible to use both together. Each MicroEJ Architecture and MicroEJ Pack option comes with a default value,
which is used if the option has not been set by the user.

Using a Launcher

To set an option in a launcher, perform the following steps:

1. In MicroEJ SDK, select Run > Run Configurations... menu,
2. Select the launcher of the application under MicroEJ Application or create a new one,

3. Selectthe Configuration tab,

4. Find the desired option and set it to the desired value. If the option does not appear in the page, there are two
cases: - the option has been introduced in a newer Architecture version, - the option is an advanced option.

Itis set using a system property in the JRE Tab . See the JRE Tab section for more details.

It is recommended to index the launcher configuration to your version control system. To export launcher options
to the filesystem, perform the following steps:

1. Selectthe Common tab,
2. Selectthe Shared file: option and browse the desired export folder,

3. Pressthe Apply button. Afile named [launcher_configuration_name].launch is generated in the ex-
port folder.

Using a Properties File

Options can be also be defined in properties files.

When a MicroEJ Standalone Application is built using the firmware-singleapp skeleton, options are loaded from
properties files located in the build folder at the root of the project.

The properties files are loaded in the following order:

1. Every file matching build/sim/x.properties, for Simulator options only (Virtual Device build). These files
are optional.
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2. Every file matching build/emb/*.properties, for Device options only (Firmware build). These files are
optional.

3. Everyfile matching build/*.properties, bothfor Simulatorand Device options. At least one fileis required.
Usually, the build folder contains a single file named common.properties.

In case an option is defined in multiple properties files, the option of the first loaded file is taken into account and
the same option defined in the other files is ignored (a loaded option cannot be overridden).

The figure below shows the expected tree of the build folder:

v [ build
v [ emb
=| emb.properties
W [~ sim
=| sim.properties

=l commaon.properties

':'I

Fig. 15: Build Options Folder

It is recommended to index the properties files to your version control system.

To set an option in a properties file, open the file in a text editor and add a line to set the desired option to the
desired value. For example: soar.generate.classnames=false.

To use the options declared in properties files in a launcher, perform the following steps:
1. In MicroEJ SDK, select Run > Run Configurations... ,
2. Select the launcher of the application,
3. Selectthe Execution tab,
4. Under Option Files , pressthe Add... button,

5. Browse the sim.properties file for Simulator or the emb.properties file for Device (if any) and press
Open button,

6. Add the common.properties file and pressthe Open button.

Note: An option setin a properties file can not be modified in the Configuration tab. Options are loaded in the
order the properties files are added (you can use Up and Down buttons to change thefile order). In Configuration
tab, hovering the pointer over an option field will show the location of the properties file that defines the option.
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Generating a Properties File

In order to export options defined ina . launch file to a properties file, perform the following steps:
1. Selectthe [launcher_configuration_name].launch file,
2. Select File > Export > MicroEJ > Launcher as Properties File ,
3. Browse the desired output .properties file,

4, Pressthe Finish button.

Warning: The Simulator uses some system properties to configure internal memory limits. See Group: Ad-
vanced Simulation Options for more information.

Category: Runtime

w Device 5
es
w CoreEngine o
Kernel [JEmbed all type names
Watchdog
Deploy Assertions
v Feature [] Execute assertions on Simulator
Dynamic Download
w Libraries [] Execute assertions on Device
w ECOM
Comm Connection Trace
EDC [ Enable execution traces
External Resources Loader
Shielded Plug [ Start execution traces automatically
~ Runtime
Memaory

~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Types
Option(checkbox): Embed all type names

Option Name: soar.generate.classnames
Default value: true
Description:

Embed the name of all types. When this option is disabled, only names of declared required types are embedded.
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Group: Assertions
Option(checkbox): Execute assertions on Simulator

Option Name: core.assertions.sim.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Option(checkbox): Execute assertions on Device

Option Name: core.assertions.emb.enabled
Default value: false
Description:

When this option is enabled, assert statements are executed. Please note that the executed code may produce
side effects or throw java.lang.AssertionError.

Group: Trace
Option(checkbox): Enable execution traces

Option Name: core.trace.enabled

Default value: false

Option(checkbox): Start execution traces automatically

Option Name: core.trace.autostart

Default value: false
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Category: Memory

w Device Heaps

v CoreEngine L
Kernel Java heap size (in bytes) | |
Watchdog
Deploy
w Feature

Immortal heap size (in bytes) | |

Dynamic Download Threads

w Libraries Number of threads | |
v ECOM
Comm Connection Number of blocks in pool | |

EDC
External Resources Loader Block size (in bytes) | |
Shielded Plug

w Runtime Maximum size of thread stack (in blocks) | |
Memory

Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heaps
Option(text): Java heap size (in bytes)

Option Name: core.memory. javaheap.size
Default value: 65536

Description:

Specifies the Java heap size in bytes.

A Java heap contains live Java objects. An OutOfMemory error can occur if the heap is too small.

Option(text): Immortal heap size (in bytes)

Option Name: core.memory.immortal.size
Default value: 4096

Description:

Specifies the Immortal heap size in bytes.

The Immortal heap contains allocated Immortal objects. An OutOfMemory error can occur if the heap is too small.
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Group: Threads

Description:

This group allows the configuration of application and library thread(s). A thread needs a stack to run. This stack
is allocated from a pool and this pool contains several blocks. Each block has the same size. At thread startup the
thread uses only one block for its stack. When the first block is full it uses another block. The maximum number of
blocks per thread must be specified. When the maximum number of blocks for a thread is reached or when there
is no free block in the pool, a StackOverflow error is thrown. When a thread terminates all associated blocks are
freed. These blocks can then be used by other threads.

Option(text): Number of threads

Option Name: core.memory.threads.size
Default value: 5
Description:

Specifies the number of threads the application will be able to use at the same time.

Option(text): Number of blocks in pool

Option Name: core.memory.threads.pool.size
Default value: 15
Description:

Specifies the number of blocks in the stacks pool.

Option(text): Block size (in bytes)

Option Name: core.memory.thread.block.size
Default value: 512
Description:

Specifies the thread stack block size (in bytes).

Option(text): Maximum size of thread stack (in blocks)

Option Name: core.memory.thread.max.size
Default value: 4
Description:

Specifies the maximum number of blocks a thread can use. If a thread requires more blocks a StackOverflow error
will occur.
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Category: Simulator

w Device Options
~ Core Engine

Kernel |:| Use target characteristics

Watchd
arendeg Slowing factor (0 means disabled): |
Deploy
Feat
v reature . HIL Connection
Dynamic Download
~ Libraries [ Specify a port
~ ECOM
Comm Connection Port: | ‘
EDC
External Resources Loader Timeout (s): | ‘
Shielded Plug
+ Runtime Maximum frame size (bytes) : | ‘
Memory
v Simulator Shielded Plug server configuration

Code Coverage
Com Port
Debug

Device

Heap Dumper
Kernel

Server socket port: | ‘

Legs

Group: Options

Description:

This group specifies options for MicroEJ Simulator.

Option(checkbox): Use target characteristics

Option Name: s3.board.compliant
Default value: false
Description:

When selected, this option forces the MicroEJ Simulator to use the MicroEJ Platform exact characteristics. It sets
the MicroEJ Simulator scheduling policy according to the MicroEJ Platform one. It forces resources to be explicitly
specified. It enables log trace and gives information about the RAM memory size the MicroEJ Platform uses.

Option(text): Slowing factor (0 means disabled)

Option Name: s3.slow
Default value: 0
Description:

Format: Positive integer

This option allows the MicroEJ Simulator to be slowed down in order to match the MicroEJ Platform execution
speed. The greater the slowing factor, the slower the MicroEJ Simulator runs.
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Group: HIL Connection

Description:

This group enables the control of HIL (Hardware In the Loop) connection parameters (connection between MicroEJ
Simulator and the Mocks).

Option(checkbox): Specify a port

Option Name: s3.hil.use.port
Default value: false
Description:

When selected allows the use of a specific HIL connection port, otherwise a random free port is used.

Option(text): Port

Option Name: s3.hil.port
Default value: 8001
Description:

Format: Positive integer
Values: [1024-65535]

It specifies the port used by the MicroEJ Simulator to accept HIL connections.

Option(text): Timeout (s)

Option Name: s3.hil.timeout
Default value: 10

Description:

Format: Positive integer

It specifies the time the MicroEJ Simulator should wait before failing when it invokes native methods.

Option(text): Maximum frame size (bytes)

Option Name: com.microej.simulator.hil.frame.size
Default value: 262144
Description:

Maximum frame size in bytes. Must be increased to transfer large arrays to native side.

4.2. Standalone Application 110



MicroEJ Documentation, Revision d4ede019

Group: Shielded Plug server configuration

Description:

This group allows configuration of the Shielded Plug database.

Option(text): Server socket port

Option Name: sp.server.port
Default value: 10082
Description:

Set the Shielded Plug server socket port.

Group: Advanced Simulation Options

When running large applications, the Simulator can abruptly reach a memory limit with the following trace:

[...] An error message [...]
"Internal limits reached. Please contact support@microej.com”
See error log file: /tmp/microej/s3/s3_1616489929186.1log

Depending on the error message, one of the following options must be set to increase the size of the memory area
which is full.

Option: Objects Heap Size

Error Message: java.lang.OutOfMemoryError exception thrown
Option Name: S3.JavaMemory.HeapSize

Default value: 4096 (kilobytes)

Description:

This memory area contains any kind of objects (regular,immortal and immutable objects). If you geta java.lang.
OutOfMemoryError exception but your Java Heap is not full, most likely you should augment this option. It must
be greater than the sum of Java Heap and Immortal Heap.

Option: System Chars Size

Error Message: Failed to allocate internString.
Option Name: S3.JavaMemory.SystemCharsSize
Default value: 1024 (kilobytes)

Description:

This memory area contains system interned strings. System interned strings are likely allocated by the debugger. If
you geta Failed to allocate internString. message while debugging an Application, most likely you should
augment this option.
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Option: Application Chars Size

Error Message: Failed to allocate internString.
Option Name: S3.JavaMemory.ApplicationCharsSize
Default value: 4096 (kilobytes)

Description:

This memory area contains Application interned strings (String literals). If you get a Failed to allocate
internString. message while the Simulator is starting the Application, most likely you should augment this op-
tion.

Option: Methods Size

Error Message: Failed to allocate method's code.
Option Name: S3.JavaMemory.MethodsSize

Default value: 10000 (kilobytes)

Description:

This memory area contains loaded methods code.

Option: Thread Stack Size

Error Message: The simulator has encountered a stack overflow error while analyzing method [...]
Option Name: S3.JavaMemory.ThreadStackSize

Default value: 300 (kilobytes)

Description:

This memory area contains all Application threads stacks.

Option: Icetea Heap End

Error Message: S3 internal heap is full.
Option Name: IceteaRuntimeSupport.S3.HeapEnd
Default value: 64000000 (bytes)

Description:

This is the overall Simulator memory limit. It includes fixed sizes internal structures and all memory areas. The
value must be greater than the size of the memory areas that can be parameterized above.
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Option: Symbol Table Size

Error Message: Symbols table area is full.
Option Name: S3.SymbolTable.MaxNbState
Default value: 500000

Description:

This is the number of symbols that can be handled by the internal symbol table (any kind of names: class names,
method names, ...).

Category: Code Coverage

w Device Code Coverage

w CoreEngine
Kernel
Watchdog

Deploy

[ Activate code coverage analysis

w Feature
Dynamic Download
w Libraries
w ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Code Coverage

Description:

This group is used to set parameters of the code coverage analysis tool.
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Option(checkbox): Activate code coverage analysis

Option Name: s3.cc.activated
Default value: false
Description:

When selected it enables the code coverage analysis by the MicroEJ Simulator. Resulting files are output in the cc
directory inside the output directory. You can process these files to an HTML report afterward with the built-in Code
Coverage Analyzer .

Option(text): Saving coverage information period (in sec.)

Option Name: s3.cc.thread.period
Default value: 15
Description:

It specifies the period between the generation of .cc files.

Category: Debug

v Device Remote Debug
v CoreEngine
Kernel Debug port: | 12000
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Remote Debug
Option(text): Debug port

Option Name: debug.port
Default value: 12000
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Description:
Configures the JDWP debug port.
Format: Positive integer

Values: [1024-65535]

Category: Heap Dumper

w Device Heap Inspection
v CoreEngine i
Kernel [] Activate heap dumper
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Heap Inspection

Description:

This group is used to specify heap inspection properties.

Option(checkbox): Activate heap dumper

Option Name: s3.inspect.heap
Default value: false
Description:

When selected, this option enables a dump of the heap each time the System.gc() method is called by the MicroEJ
Application.
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Category: Logs

w Device

Logs
v CoreEngine L
system thread maonitoring
Kernel 2
Watchdog memory schedule monitors
Deploy
w Feature 2

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Group: Logs

Description:

This group defines parameters for MicroEJ Simulator log activity. Note that logs can only be generated if the
Simulator > Use target characteristics optionis selected.

Some logs are sent when the platform executes some specific action (such as start thread, start GC, etc), other logs
are sent periodically (according to defined log level and the log periodicity).

Option(checkbox): system

Option Name: console.logs.level.low

Default value: false

Description:

When selected, System logs are sent when the platform executes the following actions:
start and terminate a thread

start and terminate a GC

exit
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Option(checkbox): thread

Option Name: console.logs.level.thread
Default value: false
Description:

When selected, thread information is sent periodically. It gives information about alive threads (status, memory
allocation, stack size).

Option(checkbox): monitoring

Option Name: console.logs.level .monitoring
Default value: false
Description:

When selected, thread monitoring logs are sent periodically. It gives information about time execution of threads.

Option(checkbox): memory

Option Name: console.logs.level .memory
Default value: false
Description:

When selected, memory allocation logs are sent periodically. This level allows to supervise memory allocation.

Option(checkbox): schedule

Option Name: console.logs.level.schedule
Default value: false
Description:

When selected, a log is sent when the platform schedules a thread.

Option(checkbox): monitors

Option Name: console.logs.level .monitors
Default value: false
Description:

When selected, monitors information is sent periodically. This level permits tracing of all thread state by tracing
monitor operations.
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Option(text): period (in sec.)

Option Name: console.logs.period
Default value: 2

Description:

Format: Positive integer

Values: [0-60]

Defines the periodicity of periodical logs.

Category: Device

w Device Device Architecture

w CoreEngine
Kernel
Watchdog

Deploy

[] Use a custom device architecture

w Feature

Dynamic Download Device Unique 1D
w Libraries [ Use a custom device unique ID

v ECOM
Comm Cennection

EDC

External Resources Loader

Shielded Plug
w Runtime

Memory
~ Simulator

Code Coverage

Com Port

Debug

Device

Heap Dumper

Logs

Group: Device Architecture

Option(checkbox): Use a custom device architecture

Option Name: s3.mock.device.architecture.option.use

Default value: false
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Option(text): Architecture Name

Option Name: s3.mock.device.architecture.option

Default value: (empty)

Group: Device Unique ID

Option(checkbox): Use a custom device unique ID

Option Name: s3.mock.device.id.option.use

Default value: false

Option(text): Unique ID (hexadecimal value)

Option Name: s3.mock.device.id.option

Default value: (empty)

Category: Com Port

w Device
w CoreEngine
Kernel
Watchdog
Deploy
~ Feature
Dynamic Download
w Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs
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Category: Libraries

w Device
w CoreEngine
Kernel
Watchdog
Deploy
w Feature
Dynamic Download
w Libraries
v ECOM
Comm Cennection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: EDC

w Device Java System.out

v Cor;:rr;gewlne [ Use a custom Java output stream
Watchdog
Deploy
w Feature

Runti ti
Dynamic Download B

~ Libraries Embed UTF-8 enceding
v ECOM .
Comm Connection []Enable SecurityManager checks
EDC
External Resources Loader
Shielded Plug

~ Runtime
Memary

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Java System.out
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Option(checkbox): Use a custom Java output stream

Option Name: core.outputstream.disable.uart

Default value: false

Description:

Select this option to specify another Java System.out print stream.

If selected, the default Java output stream is not used by the Java application. the JPF will not use the default Java
output stream at startup.

Option(text): Class

Option Name: core.outputstream.class

Default value: (empty)

Description:

Format: Java class like packageA.packageB.className
Defines the Java class used to manage System.out.

At startup the JPF will try to load this class using the Class.forName() method. If the given class is not available,
the JPF will use the default Java output stream as usual. The specified class must be available in the application
classpath.

Group: Runtime options

Description:

Specifies the additional classes to embed at runtime.

Option(checkbox): Embed UTF-8 encoding

Option Name: cldc.encoding.utf8.included
Default value: true
Description:

Embed UTF-8 encoding.

Option(checkbox): Enable SecurityManager checks

Option Name: com.microej.library.edc.securitymanager.enabled
Default value: false
Description:

Enable the security manager runtime checks.
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Category: Shielded Plug

v Device Shielded Plug configuration
v CoreEngine
Kernel Database definition: Browse...
Watchdog
Deploy
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Shielded Plug configuration

Description:

Choose the database XML definition.

Option(browse): Database definition

Option Name: sp.database.definition
Default value: (empty)
Description:

Choose the database XML definition.
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Category: ECOM

w Device Device Management

v CoreEngine ] ) -
Kernel [ Enable registration event notifications
Watchdog
Deploy
w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Device Management
Option(checkbox): Enable registration event notifications

Option Name: com.is2t.ecom.eventpump.enabled
Default value: false
Description:

Enables notification of listeners when devices are registered or unregistered. When a device is registered or un-
registered, a new ej.ecom.io.RegistrationEvent isadded to an event queue. Then events are processed by a
dedicated thread that notifies registered listeners.

Option(text): Registration events queue size

Option Name: com.is2t.ecom.eventpump.size
Default value: 5
Description:

Specifies the size (in number of events) of the registration events queue.
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Category: Comm Connection

w Device Comm Connection Options

w CoreEngine

Kernel []Enable comm connections

Watchdog
Deploy Device Management

v Feature Enable dynamic comm ports registration
Dynamic Download
~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
~ Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Comm Connection Options

Description:

This group allows comm connections to be enabled and application-platform mappings set.

Option(checkbox): Enable comm connections

Option Name: use.comm.connection
Default value: false
Description:

When checked application is able to open a CommConnection.

Group: Device Management
Option(checkbox): Enable dynamic comm ports registration

Option Name: com.is2t.ecom.comm.registryPump.enabled
Default value: false
Description:

Enables registration (or unregistration) of ports dynamically added (or removed) by the platform. A dedicated
thread listens for ports dynamically added (or removed) by the platform and adds (or removes) their CommPort
representation to the ECOM DeviceManager .
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Category: External Resources Loader

<

Device External Resources Loader

v CoreEngine

Kernel Folder where are stored the resources which will be pregrammed outside CPU address
space range (storage media like SD card, serial NOR flash, EEPROM).
Watchdog The resources which will be linked into the CPU address space range (internal
Deploy device memeories, external parallel memories) must be listed in the Resources box
w Feature of Main tab.

Dynamic Download

~ Libraries
v ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime

Browse...

Memory

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: External Resources Loader

Description:

This group allows to specify the external resources input folder. The content of this folder will be copied in an
application output folder and used by SOAR and the Simulator. If empty, the default location will be [output
folder]/externalResources, where [output folder] is the location defined in Execution tab.

Option(browse):

Option Name: ej.externalResources.input.dir
Default value: (empty)
Description:

Browse to specify the external resources folder..
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Category: Device

Device

<

« CoreEngine Specify target options

Kernel
Watchdog
Deploy
~ Feature
Dynamic Download
w Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Category: Core Engine

~ Device Memory

~ Core Engine

Kernel
Watchdog
Deploy
~ Feature

Maximum number of menitors per thread | ‘

Maximum number of frames dumped on OutOfMemoryError | ‘

Dynamic Download [[] Enable Java heap usage monitering

~ Libraries Java heap initial size (in bytes) |
v ECOM

Comm Connection
EDC
External Resources Loader [ Enable Bytecode Verifier
Shielded Plug
~ Runtime

SOAR

Memory

~ Simulator
Code Coverage
Corn Port
Debug
Device
Heap Dumper
Kernel
Logs

Group: Memory
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Option(text):

Option Name: core.memory.thread.max.nb.monitors
Default value: 8
Description:

Specifies the maximum number of monitors a thread can own at the same time.

Option(text):

Option Name: core.memory.oome.nb.frames
Default value: 5
Description:

Specifies the maximum number of stack frames that can be dumped to the standard output when Core Engine
throws an OutOfMemoryError.

Option(checkbox): Enable Java heap usage monitoring

Option Name: com.microej.runtime.debug.heap.monitoring.enabled

Default value: false

Option(text):

Option Name: com.microej.runtime.debug.heap.monitoring.init.size
Default value: 0
Description:

Specify the initial size (in bytes) of the Java Heap.

Group: SOAR
Option(checkbox): Enable Bytecode Verifier

Option Name: soar.bytecode.verifier

Default value: false
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Category: Kernel

<

D
sviee [] Check APIs allowed by Kernel
v CoreEngine

Kernel Threads
Watchdog Mazximum number of threads per Feature | |
Deploy
Feat
v reanre Installed Features
Dynamic Download
~ Libraries Mazximum number of installed Features | |
w ECOM
Comm Connection Code Size (in bytes) | |
EDC
External Resources Loader Runtirme Size (in bytes) | |
Shielded Plug

~ Runtime
Memory

w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Check APIs allowed by Kernel

Option Name: apis.check.enable

Default value: true

Group: Threads
Option(text):

Option Name: core.memory.feature.max.threads
Default value: 5
Description:

Specifies the maximum number of threads a Feature is allowed to use at the same time.
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Group: Installed Features

Option(text):

Option Name: core.memory.installed.features.max
Default value: ©

Description:

Specifies the maximum number of installed Features that can be added to this Kernel.

Option(text):

Option Name: core.memory.installed.features.text.size
Default value: 0
Description:

Specifies the size in bytes reserved for installed Features code.

Option(text):

Option Name: core.memory.installed.features.bss.size
Default value: ©
Description:

Specifies the size in bytes reserved for installed Features runtime memory.
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Category: Watchdog

v Device
+ CoreEngine [ Enable watchdog support

Kernel Watchdog
Watchdog Mazximum number of active watchdogs
Deploy

w Feature
Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Option(checkbox): Enable watchdog support

Option Name: enable.watchdog. support

Default value: true

Group: Watchdog
Option(text):

Option Name: maximum.active.watchdogs
Default value: 4

Description:

Specifies the maximum number of active watchdogs at the same time.
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Category: Deploy

~ Device Configuration

v CoreEngine
Kemgel [ Deploy the compiled MicroE) application in a folder in MicroE) application main class project
Watchdog
Deploy
w Feature

Output file: | Browse...

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
Simulator

<

Code Coverage
Com Port
Debug

Device

Heap Dumper
Logs

Description:

Configures the output location where store the MicroEJ Application, the MicroEJ platform libraries and header files.

Group: Configuration

Option(checkbox): Deploy the compiled MicroEJ Application in a folder in MicroEJ Application main class
project

Default value: true
Description:

Deploy the compiled MicroEJ Application in a folder in MicroEJ Application’s main class project.

Option(browse): Output file

Option Name: deploy.copy.filename
Default value: (empty)
Description:

Choose an output file location where copy the compiled MicroEJ Application.
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Category: Feature

e [‘J'ewcc:re Engine Specify Feature options
Kernel
Watchdog
Deploy
~ Feature
Dynamic Download
w Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
w Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Description:

Specify Feature options
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Category: Dynamic Download

w Device Dynamic Download

v CoreEngine

Kernel Output Name: |
Watchdog
Deploy Kernel: |
w Feature

Dynamic Download
~ Libraries
w ECOM
Comm Connection
EDC
External Resources Loader
Shielded Plug
~ Runtime
Memory
w Simulator
Code Coverage
Com Port
Debug
Device
Heap Dumper
Logs

Group: Dynamic Download

Option(text): Output Name

Option Name: feature.output.basename

Default value: application

Option(browse): Kernel

Option Name: kernel.filename

Default value: (empty)

4.2.6 SOAR

Browse...

This chapter describes SOAR capabilities and optimizations from the Application developer’s point of view. To get

more details on its internal structure, please refer to SOAR Build Phases section.
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Class Initialization Code

SOAR complies with the deterministic class initialization ( <clinit>) order specified in [BON] specification. The
application is statically analyzed from its entry points in order to generate a clinit dependency graph. The com-
puted clinit sequence is the result of the topological sort of the dependency graph. An error is thrown if the clinit
dependency graph contains cycles.

Aclinit map file (ending with extension .clinitmap)is generated beside the SOAR object file. It describes for each
clinit dependency:

« the types involved
« the kind of dependency
« the stack calls between the two types

In case of complex clinit code with too many runtime dependencies, the statically computed clinit order may be
wrong.

Itisthen possible to help SOAR by manually declaring explicit clinit dependencies. Such dependencies are declared
in XML files with the .clinitdesc extension in the application classpath.

The file has the following format:

<?xml version='1.0' encoding='UTF-8'?>
<clinit>

<type name="T1" depends="T2"/>
</clinit>

where T1 and T2 are fully qualified names on the form a.b.C. This explicitly forces SOAR to create a dependency
from T1 to T2, and therefore cuts a potentially detected dependency from T2 to T1.

Method Devirtualization

Method devirtualization consists of transforming a virtual method call to a direct method call when possible. A
virtual method call is a call to a non-private instance method declared either in an interface or in a class. The Core
Engine determines the proper method to call at runtime depending on the actual class of the object. A call to a
constructor or a private method is already optimized as a direct method call by the Java compiler.

SOAR automatically optimizes a virtual method call to a direct method call if there is one and only one embedded
implementation method.

Note: SOAR generates the list of the embedded methods in the SOAR Information File.

Method Inlining

Method inlining consists of replacing a direct method call with the content of the method. This avoids the creation
of a new stack frame context, which can be slower than executing the code itself. Method inlining is transitively
applied from leaf to root methods.

The following method code patterns are inlined:

« empty code after processing assertions and if code removal.

« call to a constructor with no parameters.

« call to a private method with no parameters.
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« call to a static method with no parameters, if and only if the caller is also a static method.

Note: Method inliningis performed after method devirtualization, so a virtual method call will be inlined if there is
a unique embedded implementation method that matches one of the inlined method code patterns.

A Standalone Application is a Java Application that is directly linked to the C code to produce a Firmware. Such ap-
plication must define a main entry point, i.e. a class containinga public static void main(String[]) method.

4.3 Sandboxed Application

4.3.1 Create a First Application

Now that the purposes of the Sandboxed Applications have been explained, let’s create a first application.

A Sandboxed Application project can be created in the SDK with the menu File > New >
Sandboxed Application Project .

Q- SandboxedApplication - MicroE)® SDK
File Edit Source Refactor Mavigate Search Project Run Window Help
New Alt+Shift+N > £ Sandboxed Application Project ‘

Open File... 2% Standalone Application Project — -
. ) : ks : = Create a Sandboxed Application project
L. Open Projects from File System... =~ Add-On Library Project
Recent Files > ¥ Module Project
. " [#  Platform Project
Close Editor C=Wm) Front Panel Project
Close All Editors Ctrl+Shift+W | = Project...

Fig. 16: Sandboxed Application Project Creation Menu

The project creation window is displayed:
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& New Sandboxed Application Project O >
Create a Sandboxed Application Project @
Enter a project name and configure your Sandboxed Application.

Project:

Project name : ‘ MyApplication |

Application:

ID: ‘ MyApplication |

Printable name : ‘ MyApplication |

Description : ‘ MyApplication |

Publication :

Organization : ‘ com.mycompany |

Module : ‘ MyApplication |

Revision : ‘ 0.1.0 |
@ Finish Cancel

Fig. 17: Sandboxed Application Project Creation Form

Once the Application information are fulfilled and validated, the project is created with the following structure:
src/main/java Application Java sources;
src/main/resources Application resources (raw resources, images, fonts, nls);

module.ivy Module description file, containing build information and dependencies of the project.

The next sections describe the required files to have your first basic Application.

Entry Point

A Sandboxed Application must contain a class implementing the ej.kf.FeatureEntryPoint interfaceinthe src/
main/java folder:

package com.mycompany;

import ej.kf.FeatureEntryPoint;

public class MyApplication implements FeatureEntryPoint {
@0verride

public void start()
System.out.println("Feature MyApplication started!”);

(continues on next page)
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(continued from previous page)

3

@Override
public void stop() {
System.out.println("Feature MyApplication stopped!");
3
3

This class is the entry point of the Application. The method start is called when the Application is started. It is
considered as the main method of the Sandboxed Application. The method stop is called when the Application is
stopped. Please refer to the Sandboxed Application Lifecycle chapter to learn more about the Applications lifecycle.

The src/main/java folderis also the place to add all the other Java classes of the Application.

Configuration

A Sandboxed Application project must contain a file with the .kf extension inthe src/main/resources folder.
This file contains the configuration of the Application. Here is an example:

name=MyApplication
entryPoint=com.mycompany.MyApplication
types=x*
version=0.1.0
It contains the following properties:
« name: the name of the Application
+ entryPoint: the Full Qualified Name of the class implementing ej.kf.FeatureEntryPoint

« types: this property defined the types included in the Application and must always be * (do not forget the
space at the end)

« version: the version of the Application
SSL Certificate
A Sandboxed Application requires a certificate for identification. It must be located in the src/main/resources

folder of the project. The project created by the SDK provides a sample certificate. This certificate is sufficient for
testing, but it is recommended to provide your own.

Module Descriptor

The module.ivy file is the Module description file which contains the project information and declares all the
libraries required by the Application. See MicroEJ Module Manager for more information.

The dependencies must contain at least a module containing the ej.kf.FeatureEntryPoint class, for example
the KF library:

<dependency org="ej.api” name="kf" rev="1.6.1" />
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4.3.2 Run on the Simulator

Once a Sandboxed Application project has been created, it can be tested on the Simulator.

The Simulator requires a Virtual Device to execute the Application. Please refer to the Kernel Developer Guide to
learn how to get or create one.

From the SDK

In order to test a Sandboxed Application in the SDK, the first thing to do is to import the Virtual Device of the Multi-
Sandbox Firmware:

goto Window > Preferences > MicroEJ > Virtual Devices
clickon Import...

the Virtual Device can be provided as a folder or as a .vde file, select the adequate format and the Virtual
Device resource

check the License checkbox to accept it

clickon Finish
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&’ Import Virtual Devices O ped
Import Virtual Devices ﬁ
Select a directory/file to search for available Virtual Devices.
() Select directory: | ‘ Browse...
@ Select file: | C:\Users\tdeIhDmenie\.micrDej\workspaces\SandbeedApp‘ Browse...
Target:
MName Version Select All
MyK | 0.1.0-RC2...
] € MyKerne Deselect All
MICROEJ STUDIO LICENSE AGREEMENT ~
PREAMBLE
THIS SOFTWARE LICENSE AGREEMENT (THE « AGREEMENT =) APPLIES TO MICROEJ STUDIO (HI
Any installation of MicroEJ Studio, where these terms have been stated or referred to, any clickw
THE LICENSEE, AS A USER OF MICROE) STUDIO, WILL BE BOUND TO THIS AGREEMENT, BY THE
1 DEFINITIONS W
< >
| agree and accept the above terms and conditions and | want to install the copyrighted Software
® Finish Cancel

Fig. 18: Virtual Device Import

Now the Application can be executed by right-clicking on its project, then clickihng on RunAs >
MicroEJ Application .
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<info organisation="com.mycompany
<ea:build organisation="com.1i
<ea:property name="applicatiol
<ea:property name="runtime.ap
<ea:property name="runtime.ap
<ea:property name="platform-1
<ea:property name="virtual.de

<l --
Use property 'platform-lo
or drop a platform into tl
<ea:property name="platfo

-->

</info>

<configurations defaultconfmappin
<conf name="default" visibili
<conf name="default-fw" wvisib
<conf name="default-vd" wvisib
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<conf name="platform”™ wvisibil
<conf name="documentation" vi
<conf name="source" visibilit
ity=

-

Run Configurations...

[@Console 22 1] Problems

Fig. 19: Sandboxed Application Run

If there is only one Virtual Device imported in the SDK, it is automatically used to execute the Application. Other-
wise, you have to select the one you want to use.

With the Application created in the section Create a First Application, the output should be:

KERNEL Hello Wo
=> Starting Fea
Feature MyAppli

SUCCESS

[ Initialization Stage ] ===============

[ Converting fonts ]
= [ Converting images ]

rld!
ture MyApplication
cation started!

[ Completed Successfully ] ===============
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From the Command Line Interface

An Sandboxed Application can also be launched on the Simulator via the Command Line Interface. Before contin-
uing, make sure the Command Line Interface is installed and correctly configured.

In your favorite terminal application, go to the root folder of the Application and execute the following commands:

mmm build
mmm run -Dplatform-loader.target.platform.file=/path/to/the/virtual-device.vde

With the Application created in the section Create a First Application, the output should be:

MicroEJ Simulator is being launched. Relax and enjoy...

=============== [ Initializing Easyant ] ===============

[ Resolving and retrieving dependencies ] ===============
Compiling sources ] ===============

[ Loading platform ] ===============
Initialization Stage ] === =======
Converting fonts ] =======
Converting images ] ======== ===

[ Launching on Simulator ] ===============

KERNEL Hello World!

=> Starting Feature MyApplication

Feature MyApplication started!

=============== [ Completed Successfully ] ===============

SUCCESS

Note that the Virtual Device location can also be configured in the module.ivy file of the Sandboxed Application
project:

<ea:property name="platform-loader.target.platform.file"” value="/path/to/the/virtual-device.vde"/>

The Virtual Device can also be provided differently, for example from a dependency in the module.ivy file. Refer
to the Platform Selection section for the list of available capabilities.

4.3.3 Run on the Device

The deployment of a Sandboxed Application on a device depends on the Kernel implementation. We can group
them in two categories:

« Local Deployment: the device is connected to the developer’s computer, the SDK builds the .fo from the
workspace project classes and transfers it on the device (recommended during application development).

« Remote Deployment: the Application is built, then the device connects a Repository where the Application
is stored, and deploys it over the air using a device management system (production deployment).

In both cases, deploying a Sandboxed Application requires that a Multi-Sandbox Firmware is running on the device.
Please refer to the Kernel Developer Guide to learn how to build it or browse the Resources Repository for Multi-
Sandbox demo Firmware available for popular hardware evaluation kits.
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Local Deployment

Deploying a Application on a device locally is the easiest way to test it since it only requires:
« the Application project sources imported in the SDK,

+ the device programmed with a Multi-Sandbox Firmware that provides the Local Deployment capability (you
can browse the Resources Repository for available demos of such Multi-Sandbox Firmware),

« the device connected to the developer’s computer either on the same network (LAN) or using a serial wire,
depending on the Firmware capabilities.

If these prerequisites are fulfilled:

« duplicate the Run Configuration created in the chapter Run on the Simulator,

\: Run Configurations O X

Create, manage, and run configurations : )

HeExX | B Y~ Name: | MyApplication MyApplication |

1010

type filter text | 51 Main . = Execution | #% Configuration| =4 JRE| &~ Source| ] Common

€] C/C++ Application Project
Ju JUnit | MvAoplicati | B
ication roOwWse...
& Launch Group YAPP
~ [3 MicroEJ Application Main type
0 MyApplication MyApplicatior I B
: i i pn Select Main type...
% MicroEJ Tool New Configuration | yp
New Prototype
& Export..
= Duplicate
ek Duplicates the currently selected launch configuration
Link Prototype...
Unlink Prototype
rReset with Prototype Values
Filter matched 6 of 12 items e APPY
@' Run Close

Fig. 20: Duplicate Run Configuration

« rename the duplicated Run Configuration, for example by prefixing by (Local),

« inthe Execution tab, modifythe Execution modeto Execute on Device ,

« select the option Local Deployment (Socket) in the Settings list. Note that depending on the device
capability, the virtual device may implement a local deployment over a Comm Port.
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¥ Run Configurations O X
Create, manage, and run configurations ; J
I FeEX| BY >

Name: | MyApplication MyApplication (Local) ‘

‘ type filter text

| 51 Main | # Execution - 4 Configuration| & JRE & Source | ] Commaon
[£] C/C++ Application Target A
Ju JUnit
& Launch Group

~ [ MicroEJ Application

Platform: | NyKemel {0.1.0-RC202206171516) Browse...

1 MyApplication MyApplication

- e Execution
LlibtvapnlicatieniMv2eplieationlilozal) () Execute on Simulator @) Execute on Device
& MicroEJ Tool .
Core Engine Mode: Default v
Default Settings:  Local Deployment (Socket) ™
Local deployment over a Socket
Options
Output folder: | ${project locMyApplication} Browse...
Clean intermediate files [ ]Verbose
Options Files v
Filter matched 7 of 13 items Revert Apply
@' Run Close

Fig. 21: Configure Run Configuration

« gotothe Configuration tab,
« selecttheitem Local Deployment (Socket) ,

« set the IP address of the device inthe Host field,

« clickonthe Run button to deploy the Application on the board.

The Console output should be:

Initialization Stage ]
Converting fonts ]
Converting images ] ==
Build Application ] ======

Completed Successfully ] ===== —===
Deploy on 192.168.0.7:4000 ] == =====
Completed Successfully ] ===============

SUCCESS

The Application is deployed on the device and automatically started. You can use a Serial terminal to get the traces
of the Application:

KERNEL Hello World!
=> Starting Feature MyApplication
Feature MyApplication started!
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Remote Deployment

Remote Deployment requires to build and publish the Sandboxed Application module. To do so, in the SDK, right-
click on the Sandboxed Application project and click on Build Module .

The build process will display messages in the console, ending up the following message:

[echo] project hello published locally with version 0.1.0-RC201907091602
BUILD SUCCESSFUL

Total time: 1 minute 6 seconds

The files produced by the build process are located in a dedicated target~/artifacts folderinthe projectandis
published to the target module repository declared in MicroEJ Module Manager settings file.

The file that ends with .wpk (the WPK file) is a portable file that contains all necessary binary data to build .fo files
on any compatible Multi-Sandbox Firmware. Then, the WPK file can be published to a MICROEJ FORGE instance.
Please contact our support team if you want to get more information on MICROEJ FORGE and automated Applica-
tions deployment through a device management system.

4.3.4 Fundamental Concepts

Multi-Sandboxing is based on the the Kernel & Features Specification (KF).

It allows an application code to be split between multiples parts:
« the main application, called the Kernel,
« zero or more applications called Features.

Therefore, a Kernel Application relates to the Kernel concept and a Sandboxed Application relates to the Feature
concept.

Some fundamental points:
« The Kernel is mandatory. It is assumed to be reliable, trusted and cannot be modified.
+ AFeatureis an application “extension” managed by the Kernel.

« AFeatureis fully controlled by the Kernel: it can be installed (dynamically or statically pre-installed), started,
stopped and uninstalled at any time independent of the system state (particularly, a Feature never depends
on another Feature to be stopped).

A Feature is optional, potentially not-trusted, maybe unreliable and can be executed without jeopardizing
the safety of the Kernel execution and other Features.

« Resources accesses (RAM, hardware peripherals, CPU time, ...) are under control of the Kernel.

Note: You can go further by reading the Kernel & Features Specification.
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4.3.5 Shared Interfaces

Principle

The Shared Interface mechanism provided by MicroEJ Core Engine is an object communication bus based on plain
Java interfaces where method calls are allowed to cross MicroEJ Sandboxed Applications boundaries. The Shared
Interface mechanism is the cornerstone for designing reliable Service Oriented Architectures on top of MicroEJ.
Communication is based on the sharing of interfaces defining APIs (Contract Oriented Programming).

The basic schema:
+ Aprovider application publishes an implementation for a shared interface into a system registry.

« Auser application retrieves the implementation from the system registry and directly calls the methods de-
fined by the shared interface.

USER APPLICATION FROVIDER AFFLICALTON

Shared Interface Call
AA.mm() >

MICROEJ CORE ENGINE

Fig. 22: Shared Interface Call Mechanism

Shared Interface Creation

Creation of a Shared Interface follows three steps:
« Interface definition,
« Proxy implementation,

« Interface registration.

Interface Definition

The definition of a Shared Interface starts by defining a standard Java interface.

package mypackage;
public interface MyInterface{
void foo();

}

To declare aninterface as a Shared Interface, it must be registered in a Shared Interfaces identification file. A Shared
Interface identification file is an XML file with the .si suffix with the following format:

<sharedInterfaces>
<sharedInterface name="mypackage.MyInterface"/>
</sharedInterfaces>
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Shared Interface identification files must be placed at the root of a path of the application classpath. For a MicroEJ
Sandboxed Application project, it is typically placed in src/main/resources folder.

Some restrictions apply to Shared Interfaces compared to standard java interfaces:
+ Types for parameters and return values must be transferable types;

« Thrown exceptions must be classes owned by the MicroEJ Firmware.

Transferable Types

In the process of a cross-application method call, parameters and return value of methods declared in a Shared
Interface must be transferred back and forth between application boundaries.

USER APPLICATION FROVIDER AFELICATION

R = AA.mm(P1, P2)

Fig. 23: Shared Interface Parameters Transfer

Shared Interface Types Transfer Rules describes the rules applied depending on the element to be transferred.

Table 1: Shared Interface Types Transfer Rules

Type Owner Instance Rule
Owner

Base type N/A N/A Passing by value. (boolean, byte, short
, char, int, long, double, float)

Any Class, Array or Inter- | Kernel Kernel Passing by reference

face

Any Class, Array or Inter- | Kernel Application Kernel specific or forbidden

face

Array of base types Any Application Clone by copy

Arrays of references Any Application Clone and transfer rules applied again on
each element

Shared Interface Application Application Passing by indirect reference (Proxy cre-
ation)

Any Class, Array or Inter- | Application Application Forbidden

face

Objects created by a Sandboxed Application which type is owned by the Kernel can be transferred to another Sand-
boxed Application provided this has been authorized by the Kernel. The list of Kernel types that can be transferred
is Kernel specific, so you have to consult your Kernel specification. When an argument transfer is forbidden, the
callis abruptly stopped and a java.lang.lllegalAccessError is thrown by the Core Engine.

Note: For these types to be transferable, a dedicated Kernel Type Converter must have been registered in the
Kernel.

The table below lists typical Kernel types allowed to be transferred through a Shared Interface call on Evaluation
Firmware distributed by MicroEJ Corp.
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Table 2: MicroEJ Evaluation Firmware Example of Transfer Types

Type Rule

java.lang.Boolean Clone by copy

java.lang.Byte Clone by copy

java.lang.Character | Clone by copy

java.lang.Short Clone by copy

java.lang.Integer Clone by copy

java.lang.Float Clone by copy

java.lang.Long Clone by copy

java.lang.Double Clone by copy

java.lang.String Clone by copy

java.io.InputStream | Create a Proxy reference

java.util.Date Clone by copy

java.util.List<T> Clone by copy with recursive element conversion
java.util.Map<K,v> Clone by copy with recursive keys and values conversion

Proxy Class Implementation

The Shared Interface mechanism is based on automatic proxy objects created by the underlying MicroEJ Core En-
gine, so that each application can still be dynamically stopped and uninstalled. This offers a reliable way for users
and providers to handle the relationship in case of a broken link.

Once a Java interface has been declared as Shared Interface, a dedicated implementation is required (called the
Proxy class implementation). Its main goal is to perform the remote invocation and provide a reliable implemen-
tation regarding the interface contract even if the remote application fails to fulfill its contract (unexpected excep-
tions, application killed...). The MicroEJ Core Engine will allocate instances of this class when an implementation
owned by another application is being transferred to this application.

USER APPLICATION PROVIDER APPLICATION

R = AA.mm(P1, P2 mm(A, B) {

}

Proxy Class

return C;

MICROEJ CORE ENGINE

Transfer
Shared Interfaces Binding

Fig. 24: Shared Interfaces Proxy Overview

A proxy class is implemented and executed on the client side, each method of the implemented interface must be
defined according to the following pattern:

package mypackage;

public class MyInterfaceProxy extends Proxy<MyInterface> implements MyInterface {

@0verride

public void foo(){

(continues on next page)
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(continued from previous page)

try {
invoke(); // perform remote invocation

} catch (Throwable e) {
e.printStackTrace();
}

3

Each implemented method of the proxy class is responsible for performing the remote call and catching all errors
from the server side and to provide an appropriate answer to the client application call according to the interface
method specification (contract). Remote invocation methods are defined in the super class ej.kf.Proxy and are
named invokeXXX() where XXX is the kind of return type. As this class is part of the application, the application
developer has the full control on the Proxy implementation and is free to insert additional code such as logging
calls and errors for example.

Table 3: Proxy Remote Invocation Built-in Methods

Invocation Method Usage
void invoke() Remote invocation for a proxy method that returns void
Object invokeRef() Remote invocation for a proxy method that returns a reference

boolean invokeBoolean(), byte invokeByte(), | Remote invocation for a proxy method that returns a base type
char invokeChar(), short invokeShort(), int in-
vokelnt(), long invokeLong(), double invoke-
Double(), float invokeFloat()

A Sandboxed Application is a Java Application that can run over a Multi-Sandbox Firmware. Sandboxed Applica-
tions can be linked statically to the Multi-Sandbox Firmware or installed dynamically on the device.

Typical use cases for a Sandboxed Application are:

« over the air provisioning: the Application is dynamically installed or updated on a fleet of heterogenous de-
vices.

« modularization: a monolithic application is split into multiple Sandboxed Applications; each of them can be
started or stopped separately.

The Application development flow requires the following elements:

» a Virtual Device, a software package including the resources and tools required for building and testing an
application for a specific device. A Virtual Device will simulate all capabilities of the corresponding hardware
board:

Computation and Memory

Communication channels (e.g. Network, USB....)

Display

User interaction

« an hardware device that has been previously programmed with a Multi-Sandbox Firmware. Virtual Devices
and Multi-Sandbox Firmware share the same version (there is a 1:1 mapping).

Please refer to the Kernel Developer Guide to learn more on writing Kernel Applications and building Multi-Sandbox
Firmware and Virtual Devices.

The next chapters explain how to create, test and publish Sandboxed Applications.

4.3. Sandboxed Application 148


https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invoke--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeRef--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeBoolean--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeByte--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeChar--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeShort--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeInt--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeInt--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeLong--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeDouble--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeDouble--
https://repository.microej.com/javadoc/microej_5.x/apis/ej/kf/Proxy.html#invokeFloat--

MicroEJ Documentation, Revision d4ede019

4.4 MicroEJ Libraries

A MicroEJ Foundation Library is a MicroEJ Core library that provides core runtime APIs or hardware-dependent
functionality. A Foundation library is divided into an APl and an implementation. A Foundation library APl is com-
posed of a name and a 2 digits version (e.g. EDC-1.3) and follows the semantic versioning (http://semver.org)
specification. A Foundation Library API only contains prototypes without code. Foundation Library implementa-
tions are provided by MicroEJ Platforms. From a MicroEJ Classpath, Foundation Library APIs dependencies are
automatically mapped to the associated implementations provided by the Platform or the Virtual Device on which
the application is being executed.

A MicroEJ Add-On Library is a MicroEJ library that is implemented on top of MicroEJ Foundation Libraries (100%
full Java code). A MicroEJ Add-On Library is distributed in a single JAR file, with a 3 digits version and provides its
associated source code.

Foundation and Add-On Libraries are added to MicroEJ Classpath by the application developer as module depen-
dencies (see MicroEJ Module Manager).

YOUR APPLICATIONS

ADD-ON LIBRARIES

FOUNDATION LIBRARIES

—

Fig. 25: MicroEJ Foundation Libraries and Add-On Libraries

Java code

MicroEJ Corp. provides a large number of libraries through the MicroEJ Central Repository. To consult its libraries
APIs documentation, please visit https://developer.microej.com/microej-apis/.

4.5 Virtual Device

The Virtual Device includes the same custom MicroEJ Core, libraries and System Applications as the real device.
The Virtual Device allows developers to run their applications either on the Simulator, or directly on the real device
through local deployment.

The Simulator runs a mockup board support package (BSP Mock) that mimics the hardware functionality. An ap-
plication on the Simulator is run as a Standalone Application.

Before an application is locally deployed on device, the SDK ensures that it does not depend on any API that is
unavailable on the device.
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YOUR APPLICATIONS

ADD-ON LIBRARIES

Web / REST servers | MQTT /LWM2M clients | JSON | CBOR | Crypto | Widgets | Components | Eclasspath | ...

FOUNDATION LIBRARIES

= BT

2 MICROEJ.VEE

VIRTUALIZATION

e -
Engine Simulator

Linux /[ Windows [ macOS

PLATFORM

D PROCESSOR
CORE Serial Bluetooth

WORKSTATION

Ethernet

Wi-Fi / LTE Display

Fig. 26: MicroEJ Virtual Device Architecture

4.6 MicroEJ Runtime

4.6.1 Language
MicroEJ allows to develop Applications in the Java® Language Specification version 7, and supports code exten-
sions written in JavaScript.

Basically, Java source code is compiled by the Java compiler' into the binary format specified in the JVM specifica-
tion”. This binary code is linked by a tool named SOAR before execution: .class files and some other application-
related files (see Classpath chapter) are linked to produce the final binary file that the Core Engine will execute.

4.6.2 Core Libraries

This section describes the core libraries which make up the runtime. Theses Foundation Libraries are tightly cou-
pled with the Core Engine.

! The JDT compiler from the Eclipse IDE.
2 Tim Lindholm & Frank Yellin, The Java™ Virtual Machine Specification, Second Edition, 1999
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Embedded Device Configuration (EDC)
The Embedded Device Configuration specification defines the minimal standard runtime environment for embed-
ded devices. It defines all default API packages:

* java.io

« java.lang

« java.lang.annotation

« java.lang.ref

« java.lang.reflect

« java.util
Documentation Link
Java APlIs https://repository.microej.com/javadoc/microej_5.x/libraries/edc-1.3-api/
Module https://repository.microej.com/modules/ej/api/edc/

Beyond Profile (BON)

This profile defines a suitable and flexible way to fully control both memory usage and start-up sequences on de-

vices with limited memory resources. It does so within the boundaries of Java semantics. More precisely, it allows:
+ Controlling the initialization sequence in a deterministic way.

« Defining persistent, immutable, read-only objects (that may be placed into non-volatile memory areas), and
which do not require copies to be made in RAM to be manipulated.

« Defining immortal, read-write objects that are always alive.

« Defining and accessing compile-time constants.

Documentation Link

Java APIs https://repository.microej.com/javadoc/microej_5.x/apis/ej/bon/
package-summary.html

Specification http://e-s-r.net/download/specification/ESR-SPE-0001-BON-1.2-F.pdf

Module https://repository.microej.com/modules/ej/api/bon/

Simple Native Interface (SNI)

SNI provides a simple mechanism for implementing native Java methods in the C language.
SNI allows you to:
« Call a C function from a Java method.

« Access an Immortal array in a C function (see the Beyond Profile (BON) to learn about immortal objects).

SNI does not allow you to:
+ Access or create a Java object in a C function (except byte arrays).
« Access Java static variables in a C function.

« Call Java methods from a C function.
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SNI also provides some Java APIs to manipulate some data arrays between Java and the native (C) world.

Documentation Link

Java APIs https://repository.microej.com/javadoc/microej_5.x/apis/ej/sni/
package-summary.html

Specification http://e-s-r.net/download/specification/ESR-SPE-0012-SNI_GT-1.2-H.pdf

Module https://repository.microej.com/modules/ej/api/sni/

Please refer to Simple Native Interface (SNI) section for more details.

Kernel & Features (KF)

The Kernel & Features semantic (KF) extends the runtime for managing Multi-Sandboxed Applications.

Please refer to the Kernel & Features Specification for more details, the Multi-Sandbox capability of the Core Engine
and more generally the Kernel Developer Guide chapter.

4.6.3 Scheduler

The Core Engine features a Green Threads model. The semantic is as follows:
« preemptive for different priorities,
« round-robin for same priorities,
« “priority inheritance protocol” when priority inversion occurs.?

Threads stacks automatically adapt their sizes according to the thread requirements: once a thread terminates, its
associated stack is reclaimed, freeing the corresponding RAM memory.

4.6.4 Garbage Collector

The Core Engine includes a state-of-the-art memory management system, the Garbage Collector (GC). It manages
a bounded piece of RAM memory, devoted to the Java world. The GC automatically frees dead Java objects, and
defragments the memory in order to optimize RAM usage. This is done transparently while the Application keep
running.

4.7 Module Natures

This page describes the most common module natures as follows:
« Skeleton Name: the project skeleton name.

« Build Type Name: the build type name, derived from the module nature name: com.is2t.easyant.
buildtypes#build-[NATURE_NAME] .

« Documentation: a link to the documentation.

« SDK Menu: the menu to the direct wizard in the SDK (if available). Any module nature can be created with
the default wizard from File > New > Module Project .

3 This protocol raises the priority of a thread that is holding a monitor needed by a higher-priority thread, to the priority of that higher-priority
thread (until exiting the monitor).
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+ Configuration: properties that can be defined to configure the module. Properties are defined inside the
ea:build tag of the module.ivy file, using ea:property tag as described in the section Build Options. A

module nature also inherits the build options from the listed Natures Plugins.

4.7.1 Add-On Library

Skeleton Name: microej-javalib
Build Type Name: com.is2t.easyant.buildtypes#build-microej-javalib
Documentation: MicroEJ Libraries
SDK Menu: File > New > Add-On Library Project
Configuration:
This module nature inherits the build options of the following plugins:
« Java Compilation
« Platform Loader
« Javadoc
» Jest Suite
o Artifact Checker

4.7.2 Add-On Processor

Skeleton Name: addon-processor
Build Type Name: com.is2t.easyant.buildtypes#build-addon-processor
Configuration:
This module nature inherits the build options of the following plugins:
« Java Compilation
o J2SE Unit Tests
« Artifact Checker

4.7.3 Foundation Library API

Skeleton Name: microej-javaapi
Build Type Name: com.is2t.easyant.buildtypes#build-microej-javaapi
Documentation: MicroEJ Libraries
Configuration:
This module nature inherits the build options of the following plugins:
« Java Compilation
« Javadoc
« Artifact Checker
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This module nature defines the following dedicated build options:

Name Description Default
microej.lib.name Platform library name on the form: [NAME]-[VERSION]-api . - | Notset
[NAME] : name of the implemented Foundation Library APl module.
- [VERSION] : version of the implemented Foundation Library API
module without patch (Major.minor).

rip.printableName Printable name for the Platform Editor. Not set

4.7.4 Foundation Library Implementation

Skeleton Name: microej-javaimpl

Build Type Name: com.is2t.easyant.buildtypes#build-microej-javaimpl
Documentation: MicroEJ Libraries

Configuration:

This module nature inherits the build options of the following plugins:

« Java Compilation

o Jest Suite
« Artifact Checker?

This module nature defines the following dedicated build options:

Name Description Default
microej.lib.implfor Execution target. Possible values are emb (only on Device), sim (only
Simulator) and common (both).

common

4.7.5 Kernel Application

Skeleton Name: firmware-multiapp
Build Type Name: com.is2t.easyant.buildtypes#build-firmware-multiapp

Documentation: Kernel Developer Guide

Configuration:
This module nature inherits the build options of the following plugins:

« Java Compilation

 Platform Loader
« Javadoc
« Artifact Checker?

This module nature defines the following dedicated build options:

2 Require SDK version 5.5.0 or higher.
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Name Description Default
application.main.class Full Qualified Name of the main class of the kernel. This option is | Not set
required.
runtime.api.name Name of the Runtime API of the kernel. This option is ignored when
a Runtime APl is declared in the dependencies. RUNTIME
runtime.api.version Version of the Runtime API of the kernel. This optionisignored when
a Runtime APl is declared in the dependencies. 1.0
skip.build.virtual.device | When this property is set (any value), the virtual device is not built. | Not set
virtual.device.sim.only | When this property is set (any value), the firmware is not built. Not set
4.7.6 Meta Build
Skeleton Name: microej-meta-build
Build Type Name: com.is2t.easyant.buildtypes#fmicroej-meta-build
Documentation: Meta Build
Configuration:
This module nature defines the following dedicated build options:
Name Description Default
metabuild.root Path of the root folder containing the modules to build.
${basedir}/
private.modules.file Name of thefile listing the private modules to build.
private.
modules.
list
public.modules.file Name of thefile listing the public modules to build. L
public.
modules.
list

4.7.7 Mock

Skeleton Name: microej-mock

Build Type Name: com.is2t.easyant.buildtypes#build-microej-mock

Documentation: Mock

Configuration:

This module nature inherits the build options of the following plugins:

« Java Compilation

o J2SE Unit Tests
« Artifact Checker?
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4.7.8 Module Repository

Skeleton Name: artifact-repository
Build Type Name: com.is2t.easyant.buildtypes#build-artifact-repository

Documentation: Vodule Repository

Configuration:
This module nature inherits the build options of the following plugins:
« Artifact Checker

This module nature defines the following dedicated build options:

Name Description Default
bar.check.as.v2.module | When this property is set to true, the artifact checker uses the Mi-
croEJ Module Manager semantic. false
bar.javadoc.dir Path of the folder containing the generated javadoc.
${target}/
javadoc
bar.notification.email.fromThe email address used as the from address when sending the noti- | Not set
fication emails.
bar.notification.email.host The hostname of the mail service used to send the notification | Not set
emails.
bar.notification.email.pagsWoedassword used to authenticate on the mail service. Not set
bar.notification.email.port The port of the mail service used to send the notification emails Not set
bar.notification.email.ssl| When this property is set to true, SSL/TLS is used to send the notifi- | Not set
cation emails.
bar.notification.email.to | The notification email address destination. Not set
bar.notification.email.user The username used to authenticate on the mail service. Not set
bar.populate.from.resolverName of the resolver used to fetch the modules to populate the
repository. fetchRelease
bar.populate.ivy.settings.fileath of the lvy settings file used to fetch the modules to populate the )
repository. ${prOJeCt'
ivy.
settings.
file}
bar.populate.repository.confy configuration of included repositories. The modules of the )
repositories declared as dependency with this configuration are in- | "€POS1tory
cluded in the built repository.
bar.test.haltonerror When this property is set to true, the artifact checker stops at the
first error. false
javadoc.excludes Comma-separated list of packages to exclude from the javadoc. Empty string
javadoc.includes Comma-separated list of packages to include in the javadoc.
*x (all pack-
ages)
javadoc.modules.excludds'Comma-separated list of modules to exclude from the javadoc. Empty string
skip.artifact.checker When this property is set to true, all artifact checkers are skipped. Not set
skip.email When this property is set (any value), the notification email is not | Not set
sent. Otherwise the bar.notification.* properties are required.
skip.javadoc Prevents the generation of the javadoc. -
alse
skip.javadoc.deprecated | Prevents the generation of any deprecated API at all in the javadoc. .
rue
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4.7.9 Runtime Environment

Skeleton Name: runtime-api
Build Type Name: com.is2t.easyant.buildtypes#build-runtime-api

Documentation: Runtime Environment

Configuration:
This module nature inherits the configuration properties of the following plugins:

o Artifact Checker

4.7.10 Sandboxed Application

Skeleton Name: application
Build Type Name: com.is2t.easyant.buildtypes#build-application

Documentation: Sandboxed Application

SDK Menu: File > New > Sandboxed Application Project
Configuration:
This module nature inherits the build options of the following plugins:
« Java Compilation
« Platform Loader
« Javadoc
o Jest Suite
o Artifact Checker

4.7.11 Standalone Application

Skeleton Name: firmware-singleapp
Build Type Name: com.is2t.easyant.buildtypes#build-firmware-singleapp

Documentation: Standalone Application

SDKMenu: File > New > Standalone Application Project
Configuration:
This module nature inherits the build options of the following plugins:

« Java Compilation

« Platform Loader
« TJest Suijte?

« Artifact Checker?

! Require SDK version 5.6.0 or higher.
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This module nature defines the following dedicated build options:

Name Description Default

application.main.class Full Qualified Name of the main class of the application. This option | Not set
is required.

skip.build.virtual.device | When this property is set (any value), the virtual device is not built. | Not set

virtual.device.sim.only | When this property is set (any value), the firmware is not built. Not set

4.7.12 Natures Plugins

This page describes the most common module nature plugins as follows:

« Documentation: link to documentation.

» Module Natures: list of Module Natures using this plugin.

« Configuration: properties that can be defined to configure the module. Properties are defined inside the
ea:build tagof the module.ivy file, using ea:property tag as described in the section Build Options.

Java Compilation

Module Natures:
This plugin is used by the fol

 Add-On Library
« Foundation Library API

lowing module natures:

« Foundation Library Implementation

« Standalone Application

« Sandboxed Application

Configuration:

This plugin defines the following build options:

Name Description Default
javac.debug.level Comma-separated list of levels for the Java compiler debug mode. L
ines,
source,
vars
javac.debug.mode When this property is set to true, the Java compiler is set in debug
mode. false
src.main.java Path of the folder containing the Java sources.
${basedir}/
src/main/
java
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Platform Loader

Documentation: Platform Selection
Module Natures:
This plugin is used by the following module natures:

 Add-On Library

« Standalone Application

» Sandboxed Application

Configuration:

This plugin defines the following build options:

Name Description Default
platform- Path of the folder to unzip the loaded platform to.
loader.platform.dir ${target}/
platform

platform.loader.skip.load.plétfarrthis property is set to true, the platform is not loaded. It

must be already available in the directory defined by the property | false

platform-loader.platform.dir . Use with caution: the platform

content may be modified during the build (e.g. in case of Testsuite

or Virtual Device build).
platform- The vy configuration used to retrieved the platform if fetched via
loader.target.platform.confdependencies. platform
platform- Path of the root folder of the platform to use in the build. See Plat- | Not set
loader.target.platform.din form Selection section for Platform Selection rules.
platform- Absolute or relative (to the project root folder) path of the folder )
loader.target.platform.dropireere the platform can be found (see Platform Selection). dropins
platform- Path of the platform file to use in the build. See Platform Selection | Not set
loader.target.platform.file section for Platform Selection rules.

Javadoc

Module Natures:
This plugin is used by the following module natures:

« Add-On Library
 Foundation Library API

» Sandboxed Application

Configuration:

This plugin defines the following build options:
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(stored in folder target.artifacts).

Name Description Default
src.main.java Path of the folder containing the Java sources.
${basedir}/
src/main/
java
javadoc.file.encoding Encoding used for the generated Javadoc. UTE-g
javadoc.failonerror When this property is set to true, the build is stopped if an error is
raised during the Javadoc generation. true
javadoc.failonwarning When this property is set to true, the build is stopped if a warning is
raised during the Javadoc generation. false
target.reports Path of the base folder for reports.
${target}/
reports
target.javadoc Path of the base folder where the Javadoc is generated.
${target.
reports}/
javadoc
target.javadoc.main Path of the folder where the Javadoc is generated.
${target.
javadoc}/
main
javadoc- Path of the HTML template file used for the Javadoc overview page.
microej.overview.html ${§rc'
main.
java}/
overview.
html if
exists, oth-
erwise a
default
template.
target.artifacts Path of the packaged artifacts.
${target}/
artifacts
target.artifacts.main.javaddajaenemehe packaged JAR containing the generated Javadoc ${modul
moadule.

name}-javado
jar

(@)

javadoc.publish.conf

Ivy configuration used to publish the Javadoc artifact.

documentatio

Test Suite

Documentation: Jest Suite with JUnit

Module Natures:

This plugin is used by the following module natures:

« Add-On Library

« Foundation Library API

« Foundation Library Implementation

« Standalone Application
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« Sandboxed Application

Configuration:

This plugin defines the following build options:

Name Description Default
microej.testsuite.cc.excludatiessexf classes excluded from the code coverage anal- | Not set
ysis.
microej.testsuite.timeout| The time in seconds before a test is considered as failed.
Setitto 0 todisable the timeout. 60
microej.testsuite.propertie?\#3eocthetipatperty is set to true, the code coverage anal- .
rue

ysisis enabled.

cc.src.folders

Path to the folders containing the Java sources used for
code coverage analysis.

Java source folder (
src/main/java ) and
Add-On Processor gen-
erated source folders (
src-adpgenerated/= )3

microej.testsuite.verbose

When this property is set to true, the verbose trace level
is enabled.

false

test.run.excludes.pattern

Pattern of classes excluded from the test suite execution.

Empty string (no test)

test.run.failonerror

When this property is set to true, the build fails if an error
is raised.

true

test.run.includes.pattern

Pattern of classes included in the test suite execution.

x% /% (all tests)

skip.test

When this property is set (any value), the tests are not ex-
ecuted.

Not set

J2SE Unit Tests

Warning: This plugin is reserved for tools written in Java Standard Edition. Tests classes must be created in
the folder src/test/java of the project. See Test Suite section for MicroEJ tests.

Module Natures:

This plugin is used by the following module natures:

« Add-On Processor
« Mock

Configuration:

This plugin defines the following build options:

3 Option cc.src.folders is not set by default for SDK versions lower than 5.5.0.
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Name Description Default
test.run.excludes.pattern| Pattern of classes excluded from the test suite execution. Empty string
(no test)
test.run.failonerror When this property is set to true, the build fails if an error is raised.
true
test.run.includes.pattern| Pattern of classes included in the test suite execution. , (all
*% /% a
tests)
skip.test When this property is set (any value), the tests are not executed. Not set
Artifact Checker
Module Natures:
This plugin is used by the following module natures:
« Add-On Library
« Foundation Library API
« Standalone Application
« Sandboxed Application
« Module Repository
Configuration:
This plugin defines the following build options:
Name Description Default
run.artifact.checker When this property is set (any value), the artifact checker is exe- | Not set

cuted.
skip.addonconf.checker | When this property is set to true, the addon configurations checker | Not set
is not executed.
skip.changelog.checker | When this property is set to true, the changelog checker is not exe- | Not set
cuted.
skip.foundationconf.checké¥hen this property is set to true, the foundation configurations | Not set
checker is not executed.
skip.license.checker When this property is set to true, the license checker is not executed. | Not set
skip.publicconf.checker | When this property is set to true, the public configurations checker | Not set
is not executed.

skip.readme.checker When this property is set to true, the readme checker is not exe- | Not set
cuted.

skip.retrieve.checker When this property is set to true, the retrieve checker is not exe- | Not set
cuted.
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4.7.13 Global Build Options

The following Build Options are available in any module:

Name Description Default

Path of the build directory target~.
target ${basedir}/target~

4.8 Module Repository

A module repository is a module that bundles a set of modules in a portable ZIP file. It is a tree structure where
modules organizations and names are mapped to folders.
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» = sp
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%) ivysettingsaml «———— LoOcCal (offline) settings file

Fig. 27: Example of MicroEJ Module Repository Tree

A module repository takes its input modules from other repositories, usually the MicroEJ Central Repository which
is itself built by MicroEJ Corp. as a module repository.
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A module repository is often called an offline repository as it includes the settings file for a local configuration in
MicroEJ SDK. It can also be imported in MicroEJ Forge.

4.8.1 Create a Repository Project

In MicroEJ SDK, first create a new module project using the artifact-repository skeleton.

« The ivysettings.xml settings file describes how to import the modules of this repository when it is ex-
tracted locally on file system. This file will be packaged at the root of the zip file and does not need to be
modified.

« The module.ivy file describes how to build repository and lists the module dependencies that will be in-
cluded in this repository.

4.8.2 Configure Resolver for Input Modules

MicroEJ Module Manager (MMM) needs to import dependencies to build the module repository. The location
fetched by MMM is defined by a resolver. The resolver is configured with the parameter bar.populate.from.
resolver . The preset value is the resolver provided by default in MicroEJ SDK configuration, which is connected
to MicroEJ Central Repository.

<ea:property name="bar.populate.from.resolver” value="MicroEJChainResolver"/>

The MicroEJChainResolver is a URL resolver defined in $USER_HOME\ .microej\
microej-ivysettings-[VERSION].xml that points to MicroEJ Central Repository.

4.8.3 Configure Consistency Check

The module repository consistency check consists in verifying that each declared module can be imported using
the settings file provided by the repository. Especially, it ensures that all module transitive dependencies are also
available.

Itis enabled by default to avoid further issues for repository users such as Unresolved Dependency. This is done by
the following option:

<ea:property name="skip.retrieve.checker" value="false"/>

Moreover, to ensure the repository will be compliant with the MMM specification, add the following option:

<ea:property name="bar.check.as.v2.module” value="true"/>

4.8.4 Advanced Options

There are other advanced options that do not need to be modified by default. These options are described in the
module.ivy generated by the skeleton.

See also Module Repository for more details.
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4.8.5 Include Modules

Modules bundled into the module repository must be declared in the dependencies element of the module.ivy
file.

Include a Single Module

To add a module, declare the module dependency using the artifacts configuration:

<dependencies>
<dependency conf="artifacts->*" transitive="false"” org="[module_org]" name="[module_name]"” rev=
—"[module_version]"” />

<!-- ... other dependencies ... -->
</dependencies>

For example, to add the ej.api.edc library version 1.2.3, write the following line:

<dependency conf="artifacts->*" transitive="false"” org="ej.api"” name="edc" rev="1.2.3" />

Note: We recommended to manually describe each dependency of the module repository, in order to keep full
controloftheincluded modules as well asincluded modules versions. Module dependencies can still be transitively
included by setting the dependency attribute transitive to true. In this case, the included module versions are
those that have been resolved when the module was built.

Multiple versions of the same module can be included by declaring each dependency using a different configura-
tion. The artifacts configuration has to be derived with a new name as many times as there are different versions
toinclude.

<configurations defaultconfmapping="default->default;provided->provided">
<conf name="artifacts” visibility="private"/>
<conf name="artifacts_1" visibility="private"/>
<conf name="artifacts_2" visibility="private"/>

<!-- ... other configurations ... -->
</configurations>

<dependencies>

<dependency conf="artifacts->*" transitive="false"” org="[module_org]" name="[module_name]"” rev=
—"[module_version_1]1" />

<dependency conf="artifacts_1->*" transitive="false" org="[module_org]l” name="[module_name]” rev=
—"[module_version_2]" />

<dependency conf="artifacts_2->x" transitive="false" org="[module_org]"” name="[module_name]" rev=
—"[module_version_3]1" />

<!-- ... other dependencies ... -->
</dependencies>
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Include a Module Repository

To add all the modules already included in an other module repository, add the configuration repository if it
does not exist:

<configurations defaultconfmapping="default->default;provided->provided">

<!-- ... other configurations ... -->

<conf name="repository” visibility="private” description="Repository to be embedded in the repository
o>

</configurations>

Then declare the module repository dependency using the repository configuration:

<dependencies>
<dependency conf="repository->*" transitive="false" org="[repository_orgl" name="[repository_name]”_
—rev="[repository_version]" />

<!-- ... other dependencies ... -->
</dependencies>

4.8.6 Generate Javadoc
An overall Javadoc can be generated beside the included modules. Itis built from of all Java elements of all libraries
included in the module repository.

Javadoc generation is disabled in the module.ivy generated by the skeleton. To enable javadoc generation, re-
move skip.javadoc optionorsetitto false.

There are also javadoc specific options such as Java packages exclusion. Please refer to *javadoc* options of
Module Repository reference documentation.

As of SDK 5.3.0, the module dependency line that defines a Java type is shown in the top menu.

All Classes -
Pack OVERVIEW PACKAGE TREE INDEX HELP <dependency org="ej.ap1" name="edc" rev="1.3.3" />
ackages
Copy to clipboard
ej.annctation PREV CLASS NEXT CLASS FRAMES NO FRAMES -
Java.io SUMMARY: NESTED | FIELD | CONSTR | METHOD DETAIL: FIELD | CONSTR | METHOD
java.lang -
e java.lang
Nullable S )
NullPointerException Class Object

Number

Euq'cerForma:Exce:ton java.lang. Object

..‘]elrw"_\-'E".:r public class Object

putStreamWriter Class Object is the root of the class hierarchy. Every class has Object as a superclass. All objects,
Override including arrays, implement the methods of this class.
Package

Darmicrinn b e ael

Fig. 28: Example of Javadoc Module Dependency
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4.8.7 Build the Repository

In the Package Explorer, right-click on the repository project and select Build Module.
The build consists of two steps:

1. Gathers all module dependencies. The whole repository content is created under target~/
mergedArtifactsRepository folder.

2. Checks the repository consistency. For each module, it tries to import it from this repository and fails the
build if at least one of the dependencies cannot be resolved.

The module repository .zip fileis builtinthe target~/artifacts/ folder. This file may be published along with
a CHANGELOG.md, LICENSE. txt and README.md .

4.8.8 Use the Offline Repository

By default, when starting an empty workspace, MicroEJ SDK is configured to import dependencies from MicroEJ
Central Repository.

To configure MicroEJ SDK to import dependencies from a local module repository, follow these steps:

1. Open the MMM preferences page: Window > Preferences > MicroEJ > Module Manager .

2. In Module Manager group, clickon Import Repository .

3. Select the module repository .zip file, and then click on Finish .

The import may take some time. The module repository is unzipped in the folder ${user.dir}/.microej/
repositories, and the settings are updated.

4.9 MicroEJ Classpath

MicroEJ Applications run on a target device and their footprint is optimized to fulfill embedded constraints. The
final execution context is an embedded device that may not even have a file system. Files required by the appli-
cation at runtime are not directly copied to the target device, they are compiled to produce the application binary
code which will be executed by MicroEJ Core Engine.

As a part of the compile-time trimming process, all types not required by the embedded application are eliminated
from the final binary.

MicroEJ Classpath is a developer defined list of all places containing files to be embedded in the final application
binary. MicroEJ Classpath is made up of an ordered list of paths. A path is either a folder or a zip file, called a JAR
file (JAR stands for Java ARchive).

« Application Classpath explains how the MicroEJ Classpath is built from a MicroEJ Application project.

o Classpath Load Model explains how the application contents is loaded from MicroEJ Classpath.

« Classpath Elements specifies the different elements that can be declared in MicroEJ Classpath to describe
the application contents.
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4.9.1 Application Classpath

The following schema shows the classpath mapping from a MicroEJ Application project to the MicroEJ Classpath
ordered list of folders and JAR files. The classpath resolution order (left to right) follows the project appearance
order (top to bottom).

v _f‘p" MyApplication
(® src/main/java Compiled code and copied resources
\;’?} src/main/resources located in folder MyAppllcatlon/bln
v B vy module.ivy [*]
> @9 framework-1.10.0jar - C:\cache\ej.library.wadapps\framework\jars I
{w property-loader-3.1.0ar - C:\cache\gj.library.runtime\property-loader\jars
{5 observable-1.0.2jar - C:\caché\ej library.util\observable\jars
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Fig. 29: MicroEJ Application Classpath Mapping

4.9.2 Classpath Load Model

A MicroEJ Application classpath is created via the loading of :
+ an entry point type,
« all =.[extension].list files declared in a MicroEJ Classpath.

The different elements that constitute an application are described in Classpath Elements. They are searched within
MicroEJ Classpath from left to right (the first file found is loaded). Types referenced by previously loaded MicroEJ
Classpath elements are loaded transitively.
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Fig. 30: Classpath Load Principle

4.9.3 Classpath Elements

The MicroEJ Classpath contains the following elements:

« An entrypoint described in section Application Entry Points;

« Typesin .class files, described in section Types;

« Immutables Object data files, described in Section /mmutable Objects;

+ Raw Resources, Images, Fonts and Native Language Support (NLS) described in Application Resources;

« *.[extension].list files, declaring contents to load. Supported list file extensions and format is specific
to declared application contents and is described in the appropriate section.

At source level, Java types are stored in src/main/java folder of the module project, any other kind of resources
and list files are stored in the src/main/resources folder.
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Application Entry Points

MicroEJ Application entry point declaration differs depending on the application kind:

« In case of a Standalone Application, it is a class that contains a public static void main(String[])
method, declared using the option application.main.class.

« In case of a Sandboxed Application, it is a class that implements ej.kf.FeatureEntryPoint, declared using the
entryPoint propertyinthe .kf fileinthe src/main/resources/ folder.

Types
MicroEJ types (classes, interfaces) are compiled from source code ( . java) to classfiles ( .class ). When a type is
loaded, all types dependencies found in the classfile are loaded (transitively).
A type can be declared as a Required type in order to enable the following usages:
« to be dynamically loaded from its name (with a call to Class.forName(String));
« to retrieve its fully qualified name (with a call to Class.getName()).

A type that is not declared as a Required type may not have its fully qualified name (FQN) embedded. Its FQN can
be retrieved using the stack trace reader tool (see Stack Trace Reader).

Required Types are declared in MicroEJ Classpath using *.types.list files. The file format is a standard Java
properties file, each line listing the fully qualified name of a type. Example:

# The following types are marked as MicroEJ Required Types
com.mycompany .MyImplementation
java.util.Vector

Resources

Resources are binary files that need to be embedded by the application.

Note: For more details on all supported resources types, please refer to Application Resources chapter.

Raw resources are resources that can be dynamically retrieved with a call to
java.lang.Class.getResourceAsStream(String). Raw Resources are declared in *.resources.list files (and
in x.externresources.list forexternal resources, see Application Resources).
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Raw Resource

yes no=external

* resources.list +

« )
.resources.list )
* externresources.list

The file format is a standard Java properties file, each line is a relative / separated name of a file in MicroEJ Class-
path to be embedded as a resource. Example:

# The following resource is embedded as a raw resource
com/mycompany/MyResource. txt

Immutable Objects

Immutables objects are regular read-only objects that can be retrieved with a call to ej.bon.Immutables.get(String).
Immutables objects are declared in files called immutable objects data files, which format is described in the [BON]
specification. Immutables objects data files are declared in MicroEJ Classpath using *. immutables.list files. The
file format is a standard Java properties file, each lineisa / separated name of a relative file in MicroEJ Classpath
to be loaded as an Immutable objects data file. Example:

# The following file is loaded as an Immutable objects data files
com/mycompany/MyImmutables.data

System Properties

System Properties are key/value string pairs that can be accessed with a call to System.getProperty(String).

System Properties are defined when building a Standalone Application, by declaring *.properties.list filesin
MicroEJ Classpath.

The file format is a standard Java properties file. Example:

Listing 1: Example of Contents of a MicroEJ Properties File

# The following property is embedded as a System property
com.mycompany . key=com.mycompany.value
microedition.encoding=IS0-8859-1
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System Properties are resolved at runtime, and all declared keys and values are embedded as intern Strings.

System Properties can also be defined using Application Options. This can be done by setting the option with a
specific prefix in their name:

« Properties for both the MicroEJ Core Engine and the MicroEJ Simulator : name starts with microej. java.
property.x*

« Properties for the MicroEJ Simulator: name starts with sim. java.property.*
« Properties for the MicroEJ Core Engine: name starts with emb. java.property.*

For example, to define the property myProp with the value theValue, set the following option :
Listing 2: Example of MicroEJ System Property Definition as Applica-
tion Option

microej.java.property.myProp=theValue

Option can also be setinthe VM arguments field of the JRE tab of the launch using the -D option (e.g. -Dmicroej.
java.property.myProp=theValue).

Note: When building a Sandboxed Application, *.properties.list files found in MicroEJ Classpath are silently
skipped.

Constants

Note: This feature require [BON] version 1.4 which is available in MicroEJ Runtime starting from MicroEJ Archi-
tectureversion 7.11.0.

Constants are key/value string pairs that can be accessed with a call to ej.bon.Constants.get[Type](String), where
Type if one of:

« Boolean,
» Byte,

« Char,

« Class,

« Double,
« Float,

o Int,
 Long,

« Short,

« String.

Constants are declared in MicroEJ Classpath *.constants.list files. Thefile formatis a standard Java properties
file. Example:
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Listing 3: Example of Contents of a BON constants File

# The following property is embedded as a constant
com.mycompany .myconstantkey=com.mycompany.myconstantvalue
Constants are resolved at binary level without having to recompile the sources.
At link time, constants are directly inlined at the place of Constants.get[Type] method calls with no cost.
The String key parameter must be resolved as an inlined String:

« either a String literal "com.mycompany.myconstantkey"”

« ora static final String field resolved as a String constant

The String value is converted to the desired type using conversion rules described by the [BON] API. A boolean
constant declared in an if statement condition can be used to fully remove portions of code. This feature is
similar to C pre-processors #ifdef directive with the difference that this optimization is performed at binary level
without having to recompile the sources.

Listing 4: Example of if code removal using a BON boolean constant

if (Constants.getBoolean("com.mycompany.myconstantkey”)) {
System.out.println(”"this code and the constant string will be fully removed when the constant is_.
—resolved to 'false'")

}

Please mind that Constants.getXXX must be inlined in the if condition to take effect. The following piece of
code will not remove the code:

static final boolean MY_CONSTANT = Constants.getBoolean(”com.mycompany.myconstantkey");

if (MY_CONSTANT){
System.out.println(”this code will not be removed when MY_CONSTANT is resolved to 'false'")

}

Note: In Multi-Sandbox environment, constants are processed locally within each context. In particular, constants
defined in the Kernel are not propagated to Sandboxed Applications.

4.10 Application Resources

An Application resource is the contents of a file identified its relative path from the Application classpath.
An Application resource is one of the following type:

« Raw Resource,

+ Image,

« Font,

« Internationalized Message (Native Language Support).

The resource may be stored in RAM, flash, or external flash; and it is the responsibility of the Core Engine and/or
the BSP to retrieve and load it.
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There are two ways to store resources:

« Internal resource: The resource is taken into consideration during the Application build. The SOAR step loads
the resource and copies it into the same C library as the Application. Like the Application, the resource is
linked into the CPU address space range (internal device memories, external parallel memories, etc.).

+ External resource: The resource is not taken into consideration during the Application build. It is the respon-
sibility of the BSP project to manage external resources. The resource is often programmed outside the CPU
address space range (storage media like SD card, serial NOR flash, EEPROM, etc.).

The BSP must implement the proper Low Level API (LLAPI) C functions: LLEXT_RES_impl.h. See External
Resources Loader for more information on the implementation.

All resources must be added in the project, usually in src/main/resources/. ..

(internal or external). The following figure summarized how to declare resources:

folder. All resources must be
declared in the appropriate *.1list files depending on the type (raw, image, font, NLS) and the storage location

Add resource to project
in src/main/resources/...

Type of resource?

Raw Resource

o=external

Font

< internal? >

no=externaj es

no=external

NLS

internal?

yes no=external

*resources.list +

¥ .
‘resources.list *.externresources.list

*images.list

* fonts.list

*imagesext.list

* fontsext.list

*nls list +

. ]
-nls.list * externresources.list

For more details on how to use Application resources, refer to the following dedicated sections:

* Raw Resource

« Internationalized String (Native Language Support)

4.11 Native Language Support

4.11.1 Introduction

Native Language Support (NLS) allows the application to facilitate internationalization. It provides support to ma-
nipulate messages and translate them in different languages. Each message to be internationalized is referenced
by a key, which can be used in the application code instead of using the message directly.
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4.11.2 Localization Source Files

Messages must be defined in localization source files, located in the Classpath of the application (i.e. in the src/
main/resources folder).

Localization source files can be either PO files or Android String resources.

Here is an example of a PO file:

msgid "Labell”
msgstr "My label 1"

msgid "Label2”
msgstr "My label 2"

And here is an example of an Android String resource:

<resources>
<string name="Label1">My label 1</string>
<string name="lLabel2">My label 2</string>
</resources>

Note: When using Android String resources, string arrays are also supported. However, plurals are not supported.

4.11.3 NLS List Files

Localization source files are declared in Classpath *.nls.list files (and to *.externresources.list for an
external resource, see Application Resources).

NLS

yes no=external

* nls.list +

« )
.nls.li )
s.list * externresources.list

The file format is a standard Java properties file, each line represents the Full Qualified Name of a Java interface
that will be generated and used in the application. Example:
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com.mycompany .myapp.Labels
com.mycompany . myapp . Messages

4.11.4 Usage

The binary-nls module must be added to the module.ivy of the Application project.

<dependency org="com.microej.library.runtime” name="binary-nls" rev="2.4.2"/>
This module includes an Add-On Processor which parses the localization source files. For each interface declared
in the NLS list files, all the localization source files whose names start with the interface name are used to generate:
« aJava interface with the given FQN, containing a field for each message of the localization source files
« aNLS binary file containing the translations

So, inthe example, the generated interface com. mycompany.myapp.Labels will gatherall the translations from files
named Labelsx and located in any package of the Classpath. The names of the localization source files should be
suffixed by their locale (for example Labels_en_US.po).

The generation is triggered when building the application or after a change done in any localization source file or
x.nls.list files. This allows to always have the Java interfaces up-to-date with the translations and to use them
immediately.

Once the generation is done, the application can use the Java interfaces to get internationalized messages, for
example:

String label = Labels.NLS.getMessage(Labels.lLabell);

4.11.5 NLS External Loader

The NLS External Loader allows to update the PO files of an application executed on a Virtual Device without re-
building it. PO files can be dropped in a given location in the Virtual Device folders to dynamically replace the
language strings packaged in the application.

This is typically useful when testing or translating an application in order to have a quick feedback when changing
the PO files. Once the PO files are updated, a simple restart of the Virtual Device allows to immediately see the
result.

Installation

To enable the NLS External Loader in the Virtual Device, add the following dependency to the module.ivy file of
the Firmware project:

<dependency org="com.microej.tool” name="nls-po-external-loader” rev="2.3.0" transitive="false"/>

Then rebuild the Firmware project to produce the Virtual Device.
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Usage

Once the project built:

« unzip the Virtual Device and create a folder named translations inthe root folder.

+ copy all the PO files from the project into the translations folder. All PO files found in this folder are
processed, no matter their folder level.

« start the Virtual Device with the launcher. The following logs should be printed if the NLS External Loader has
been executed and has found the PO files:

externalPolLoaderInit:init:

externalPolLoaderInit:loadPo:
[mkdir] Created dir: <PATH>\tmp\microejlaunch1307817858\resourcebuffer
[po-to-nls] *.nls files found in <PATH>\output\<FIRMWARE>\resourceBuffer :

[po-to-nls]
[po-to-nls]

- com.mycompany .Messages|1
- com.mycompany .Messages?2

[po-to-nls] Loading *.po files for NLS interface com.mycompany.Messages]

[po-to-nls]

=> loaded locales :

fr_FR,de_DE, ja_JP,en_US

[po-to-nls] Loading *.po files for NLS interface com.mycompany.Messages2

[po-to-nls]

=> loaded locales :

fr_FR,de_DE, ja_JP,en_US

« update the languages strings in the PO files of the Virtual Device (the files in the translations/ folder).

« restart the Virtual Device and check the changes.

It is important to know the following rules about the NLS External Loader:

« the external PO files names must match with the default PO files names of the application to be processed.

+ when PO files with a given name are loaded, the default translations for these PO files are replaced, there is
no merge. It means that:

- if messages are missing in the new PO files, they are not available anymore for the application and may
very probably make it crash.

- iflanguages are missing (the application has 3 PO files for English, French and Spanish, and only PO files
for English and French are available in the translations folder), the messages of the missing languages
are not available anymore for the application and may very probably make it crash.

- if new messages are added in the PO files, it has no impact, they are ignored by the application.

+ External PO files are loaded at Virtual Device startup, so any change requires a restart of the Virtual Device to
be considered

Troubleshooting

java.io.lOException: NLS-PO:S=4

The following error occurs when at least 1 PO file is missing for a language:

[parallel2] NLS-PO:I=6
[parallel2] Exception in thread "main”

[parallel2]
[parallel?2]
[parallel2]
[parallel2]

at java
at java
at java
at java

.lang.Throwable.
.lang.Throwable.
.lang.Exception.
.1i0.I0Exception.

java.io.IOException: NLS-PO:S=4 323463627 -1948548092
fillInStackTrace(Throwable. java:79)

<init>(Throwable. java:30)

<init>(Exception. java:10)

<init>(IOException.java:16)

(continues on next page)
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(continued from previous page)

[parallel2] at com.microej.nls.BinaryNLS.loadBinFile(BinaryNLS. java:310)
[parallel2] at com.microej.nls.BinaryNLS.<init>(BinaryNLS. java:157)
[parallel2] at com.microej.nls.BinaryNLS.newBinaryNLS(BinaryNLS. java:118)

Make sure that all PO files are copied in the translations folder.

Crowdin

Crowdin is a cloud-based localization platform which allows to manage multilingual content. The NLS External
Loader can fetch translations directly from Crowdin to make the translation process even easier. Translators can
then contribute and validate their translations in Crowdin and apply them automatically in the Virtual Device.

A new dependency must be added to the module.ivy file of the Firmware project to enable this integration:

<dependency org="com.microej.tool” name="nls-po-crowdin” rev="1.0.0" transitive="false"/>

Once the module has been built, edit the file platform/tools/crowdin/crowdin.properties to configure the
Crowdin connection:

« set crowdin. token tothe Crowdin APl token. A token can be generated in the Crowdin in Settings > API

>clickon New Token .

« set crowdin.projectsIds to the id of the Crowdin project. The project id can be found in the Details
section on a project page. Multiple projects can be set by separating their id with a comma (for example
crowdin.projectsIds=12,586,874).

When the configuration is done, the fetch of the Crowdin translations can be done by executing the script crowdin.
bat or crowdin.sh located in the folder platform/tools/crowdin/ . The PO files retrieved from Crowdin are
automatically pasted in the folder translations,therefore the new translations are applied after the next Virtual
Device restart.

4.12 Debug an Application

To debug an application on Simulator, select it in the left panel then right-click and select DebugAs >

MicroEJ Application .
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 [mi] &2 e bl WM R E R GG R R Rt =W RS RURE R A CRCR ARl |
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~ [3] TestForDebugger Main [MicroE) Application] 2® * Javal] Name Value
v & Smart Software Simulator [localhost:12000] 5 package con.mycompany; ® ags String[0] (id=7)
~ f# Thread [main] (Suspended (breakpoint at line 21 in Main)) B us o 2

= <VM does ot provide monitor information> 8 * Generated by the build-firmware-singleapp-skeleton.<br>
Main.main(String[]) line: 21 9 Please keep it in sync with the property 'application.main.class’
MainThread.run() line: 914 18 %/

= MainThread(Thread).runWrapper() line: 387

W C\Program Files\AdoptOpenIDKjdk-8.0.265.01-hotspot\binjz

public class Main {

= simple main.

args
command line arguments.

& public static void main(String[] args) {
int i = 42;

System.out.println("Hello World!"); //$NON-NLS-1% =

Fig. 31: MicroEJ Development Tools Overview of the Debugger

All libraries included in MicroEJ SDK are provided with their source code and resources. The way the sources are
retrieved depends on the kind of library (Add-On Library or Foundation Library).

4.12.1 Add-On Library Sources

Add-On Library sources are packaged in a dedicated file named [module_name]-source. jar availableinthe mod-
ule directory:
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repository.microej.com/maodules/ej/librany/runtime/basictool/1.6.0/

] Parent Directory

= CHANGELOG-1.6.0.md

= CHANGELOG-1.6.0.md.mds
E CHANGELOG-1.6.0.md.shal
= LICENSE-1.6.0.6xt

= LICENSE-1.6.0.txt. md5

=] LICENSE-1.6.0.ixt.shal

= README-1.6.0md

= README-1.6.0.md.md5

= README-1.6.0.md.shal

[ basictool-1.6.0-javadoc_jar
K basictool-1.6.0-javadoc_ jarmd5

2 basictool-1.6.0-javadoc jarshal

7 basictool-1.6.0-sources.jar

[F basictool-1.6.0-sources.jar.mds
7 basictool-1.6.0-sources.jarshal
5] basictool-1.6.0 jar

2 basictool-1.6.0.jarmd5

(7 basictool-1.6.0.jarshal

Fig. 32: Add-On Library Sources Location

In MicroEJ SDK, sources are automatically connected to Eclipse JDT when the new Add-On Library is added as a
module dependency.

On any Java element (type, method, field), press F3 or CTRL-Click to open the implementation:

4.12. Debug an Application 181



MicroEJ Documentation, Revision d4ede019

[J] Mainjava 22
I backage com.mycompany;

import ej.basictool.ArrayTools;

(9, [ N WY

public class Main {

= public static ygid foo() {
ArrayTnDlsladd new int[2], @);

Open Declaration

bt 53

WCa

I
[xx]
et

Open Implementation

Fig. 33: Add-On Library Open Implementation

Then the implementation class is open in read-only mode.

[J] Main.java fap ArrayTools.class 52

the input array.
* ([param element
. the element to add.
* @return the output array.
£
public static int[] EEEKint[] array, int element) {
int arraylLength = array.length;
int[] result = grow(array, arraylLength, 1);
result[arrayLength] = element;
return result;

[V, QN WY iy =
1

e 3

ol o e e e e e el
CO 0 CO 00 ©0 CO 0O GO 20 -

]
bt

Fig. 34: Add-On Library Read-Only Source Code

4.12.2 Foundation Library Sources

Foundation Library sources are directly included in the implementation file (JAR file) provided by the Platform.

They are located in the following Platform folders:

+ javalLibs for generic Foundation Libraries (defaults).
+ MICROJVM/javaLibs for Foundation Libraries specific to the MicroEJ Core Engine.

« S3/javalLibs for Foundation Libraries specific to the Simulator.
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v & MyPlatform-MyToclchain-1.0.0
(% build
w = source
= bsp
= documentation
= examples
= include
(= javaAPls
I w [ javalibs I
[£ bon-14jar
| £ device-1.0,jar
| £ ecom-1.1 jar
|£| ecom-comm-1.1.jar
| £ fs-2.0,jar
| £ kF-1.5ar
| £ microui-2.4.jar
[£) net-1.1jar
[£ nls-2.0,ar
| £ purnp.jar
| £ resourcemanager-1.0.jar
| £ =ni-1.4.0,]ar
[ £ ssl-2.0 jar
|=| systemmicroui.properties
| £ systernmicroui-2.4.jar
[£) trace-1.1jar
= lib
= licenseManager
= link
= linker
w == MICROIVM
| ~ (= javalibs |
| £ edc-1.3.jar
= lib
= link
(= soar
= mocks
= plugins
= resources
w [ 53
(= HIL
[£ edc-1.3.ar
| £ profiles-debug-1.1jar
| £ profiles-fs-1.1.jar
= resources

Fig. 35: Foundation Library Platform Folders
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In MicroEJ SDK, sources can be connected while debugging an Application on Simulator. This ensures to get the
exact source code which is executed on your Platform.

Here are the steps to attach Foundation Library sources from a Platform loaded in the workspace:

« Open a MicroEJ Application launch,

« Selectthe Source tab (see also Source Tab),
o Clickon Add... button,

+ Select Archive itemand press OK ,

=)
| Add a container to the source lookup path +E i

A jar or zip in the workspace containing source files

Tz Absolute File Path

I | Archive

L= Compilation Directory
External Archive

(== File System Directory

@ lava Classpath Variable

=\ Java Library

l=FJava Project

[ path Mapping

(22 Program Relative File Path

= Project

I Project - Path Relative to Source Folders

[=Workspace Folder

@

Fig. 36: Add Foundation Library Sources to MicroEJ Application Launch

« Select the Foundation Libraries from Platform folders and press OK ,
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® Archive Selection

Choose archives to add:

v 2 MyPlatform-MyToolchain-1.0.0
w [ source
[= javahAPls
w [= javalibs

=
2
2
2
2
2
2
2
2
2
2
2
2
2
2

bon-1.4.jar
device-1.0,ar
ecam-1.1.jar
ecom-comm-1.1.jar
fs-2.0.jar

kf-1.5.jar
microui-2.4.jar
net-1.1.jar

nls-2.0.jar

purnp.jar
rescurcemanager-1.0,jar
gni-1.4.0,jar

ssl-2.0,jar
systernmicroui-2.4.jar
trace-1.1,jar

[= licenseManager

= linker

= MICROIVM

= mocks

w [= 53
[= HIL

w [= javalibs
[ £ edc-1.3jar
| £ profiles-debug-1.1jar
| £ profiles-fs-1.1 jar

Fig. 37: Select Foundation Libraries Implementation files

tion Platform (s

Warning: You must select the libraries from the Platform project corresponding to the execu-

ee Execution Tab).

In the debug session the implementation sources will be now displayed.
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i v PIEBNIRIRPIDRG Q- H-0-U- S I PARE T IH -G
%5 Debug 52 [ Project Explorer = | i+ § = B [ Mainjava PrintStream.java 2%
w [1] hello Main [MicroE) Application] 214

w (B Smart Software Simulator [localhost:12000] 2158 public void println(Object x) {

synchronized(outWriter.out){ // see implementation note
this.print(x) ;
this.println() ;

¥

~ f# Thread [main] (Suspended)
El <VM does not provide monitor information>
= PrintStream.printin(String) line: 224
= Main.main(String[]) line: 20
= MainThread.run{) line: 914
= MainThread(Thread).runWrapper() line: 387
s C\Program Files\Java\jre1.8.0_281\bin\javaw.exe (29 sept. 2021 13:48:21)

}

public void println(@Nullable String x) {
if(CalibrationConstants.ENABLE_FAST_PRINTLN) {
if(x == null) {

x = NULL;
¥
try{
this.outWriter.writeln(x.chars, x.offset, x.length);
9 }
@ catch(IOException e) {
1 errorflag = true;
2 }
3 ¥
4 else {
5 synchronized(outWriter.out) { // see implementatiocn note
6

this.print(x) ;
this.println() ;

1

Fig. 38: Foundation Library Read-Only Source Code

4.13 Platform Selection

Building or running a Test Suite on an application module requires a MicroEJ Platform.
There are 4 different ways to provide a MicroEJ Platform for a module project:

« Setthe build option platform-loader.target.platform.file tothe path ofa MicroEJ Platformfile (.zip
, .jpf or .vde).

« Setthe build option platform-loader.target.platform.dir tothe pathofthe source folderofanalready
imported Source Platform.

+ Declare a module dependency with the conf platform:

<dependency org="myorg" name="myname" rev="1.0.0" conf="platform->default” transitive="false"/>

« Copy a MicroEJ Platform file to the dropins folder.  The default dropins folder location is
[module_project_dir]/dropins . It can be changed using the build option platform-loader.target.
platform.dropins.

At least 1 of these 4 ways is required to build an application with a platform. If several ways are used, the following
rules are applied:

o If platform-loader.target.platform.file or platform-loader.target.platform.dir isset,the other
options are ignored.

« If the the module project defined several platforms, the build fails. For example the following cases are not
allowed:

- Setting a platform with the option platform-loader.target.platform.file and another one with
the option platform-loader.target.platform.dir

- Declaring a platform as a dependency and adding a platform in the dropins folder

- Declaring 2 platforms as Dependencies
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- Adding 2 platforms in the dropins folder

Refer to the Platform Loader section for a complete list of options.

4.14 Development Tools

MicroEJ provides a number of tools to assist with various aspects of development. Some of these tools are run using
MicroEJ Tool configurations, and created using the Run Configurations dialog of the MicroEJ SDK. A configuration
must be created for the tool before it can be used.

0 Run Configurations n
Create. manage. and run configurations /—
W
= se| = 3 Name: | MyToolConfig
type filter text a6 Execution 31} Configuration| g, JRE| [C] Commeon
[€] C/C++ Application Target
Ju WUnit Platform: | STM32F746GDISCO-example-CM7hardfp_ARMCCS (2.1.0-RC201604072057) Browse...

= Launch Group
. [3] MicroE) Application
a g Microk) Tool
Fd MyToolConfig

Execution
Settings: | MicroElavah ]

Generate C headers and implementation skeletons of Java native methods

Options
Output folder: | S{workspace_locl/MyHelloWerldSample Browse...
[#] Clean intermediate files [Verbose
Filter matched 7 of 12 items — s a
'/?:' Bun Close

Fig. 39: MicroEJ Tool Configuration

The above figure shows a tool configuration being created. In the figure, the MicroEJ Platform has been selected,
but the selection of which tool to run has not yet been made. That selection is made in the Execution Settings...
box. The Configuration tab then contains the options relevant to the selected tool.
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4.14.1 Test Suite with JUnit

MicroEJ allows to run unit tests using the standard JUnit API during the build process of a MicroEJ library or a
MicroEJ Application. The MicroEJ Test Suite Engine runs tests on a target Platform and outputs a JUnit XML report.

Principle

JUnit testing can be enabled when using the microej-javalib (MicroEJ Add-On Library) or the
microej-application (MicroEJ Applications) build type. JUnit test cases processing is automatically enabled
when the following dependency is declared in the module. ivy file of the project.

<dependency conf="test->x" org="ej.library.test” name="junit" rev="1.6.2"/>

When a new JUnit test case classis created inthe src/test/java folder, a JUnit processor generates MicroEJ com-
pliant classes into a specific source folder named src-adpgenerated/junit/java. These files are automatically
managed and must not be edited manually.

JUnit Compliance

MicroEJ is compliant with a subset of JUnit version 4. MicroEJ JUnit processor supports the following annotations:
@After, @AfterClass, @Before, @BeforeClass, @Ignore, @Test.

Each test case entry point must be declared using the org. junit.Test annotation (@Test before a method dec-
laration). Please refer to JUnit documentation to get details on usage of other annotations.

Setup a Platform for Tests

Before running tests, a target platform must be configured.

Execution in SDK

In order to execute the Test Suite in the SDK, a target platform must be configured in the MicroEJ workspace. The
following steps assume that a platform has been previously imported into the MicroEJ Platform repository (or avail-
able in the Workspace):

« Goto Window > Preferences > MicroEJ > Platforms (or Platformsin workspace ).
« Select the desired platform on which to run the tests.
« Press F2 to expand the details.

« Select the the platform path and copy it to the clipboard.

« Goto Window > Preferences > Ant > Runtime and selectthe Properties tab.

« Clickon Add Property... button and seta new property named target.platform.dir with the platform
path pasted from the clipboard.
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Execution during module build

In order to execute the Test Suite during the build of the module, a target platform must be configured in the module
project as described in the section Platform Selection.

Setup a Project with a JUnit Test Case

This section describes how to create a new JUnit Test Case starting from a new MicroEJ library project.

« First create a new module project using the microej-javalib skeleton. A new project named mylibrary is
created in the workspace.

+ Right-click on the src/test/java folderandselect New > Other... menuitem.
+ Selectthe Java > JUnit > New JUnit Test Case wizard.

+ Enteratest name and press Finish . A new JUnit test case class is created with a default failing test case.

Build and Run a JUnit Test Suite
+ Right-clickonthe mylibrary projectandselect Build Module . Afterthelibraryisbuilt, the test suite engine
launches available test cases and the build process fails in the console view.

+ Onthe mylibrary project, right-click and select Refresh . A target~ folder appears with intermediate
build files. The JUnit report is available at target~\test\xmI\TEST-test-report.xml.

« Double-click on the file to open the JUnit test suite report.

+ Modify the test case by replacing
fail(”"Not yet implemented”);
with

Assert.assertTrue(true);

+ Right-clickagainonthe mylibrary projectand select Build Module . The testis now successfully executed
on the target platform so the MicroEJ Add-On Library is fully built and published without errors.

« Double-click on the JUnit test suite report to see the test has been successfully executed.

Test Suite Reports

Once a test suite is completed, the following test suite reports are generated:

« JUnit HTML report in the module project location target~/test/html/test/junit-noframes.html . This
report contains a summary and the execution trace of every executed test.
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Testsuite Results:
Summary
Tests Failures Errors | Ignored Tried Again ‘ Success rate Time ‘
|54 [15 lo lo lo [72.22% |3788.653 |
[ i Failures [ Success [ Success Rate |
|93 |35 |928 [96:37% |
Note: failures are anticipated and checked for with assertions while errors are unanticipated.
Note: ignored tests are executed but not counted on the success rate.
Note: fried again tests are executed but not counted on the success rate.
Packages
Note: package statistics are not computed recursively, they only sum up all of its testsuites numbers,
Name i Tried | Time(s) | Time Stamp |Host|
Again
com.microej.fs.tests 2 0 0 0 0 134.660 |1598001204286|local
com.microej.fs.tests.constructors 4 0 0 0 0 274.761 | 1598001339008 local
com.microej.fs.tests.fields 3 0 1 0 0 194.437 1598001613793 local
com.microej.fs.tests. integration 1 0 0 0 0 66.171 |1598001808250|local
com.microej.fs.tests.methods 31 |0 10 0 0 2181.600| 1598001874436 local
com.microej.fs.tests.properties 1 0 0 0 0 65519 | 1598004056327 | local
com.microej.fs. tests.scenarios 12 0 4 0 0 871.505 |1598004121855(local

Fig. 40: Example of MicroEJ Test Suite HTML Report

« JUnit XML report in the module project location target~/test/xml/TEST-test-report.xml.

X TEST-test-reportxml &

1 <?xml version="1.0" encoding="UTF-8" standalone="no"?>

> errors="0" failures="1" hostname="" ignored="0" name="testsuite-hai
classname=" SingleTest MathTest testFact" name=" SingleTest MathTest
out><! [CD 'i'.'—‘;:ﬁnable to locate tooIs.jar. Expected to find it in C:\Prc

6 Buildfile: C:\Users‘\ARM 2016\.ivy2\cache\com.is2t.easyant.plugins\microej-test

_- buildTest:
Fig. 41: Example of MicroEJ Test Suite XML Report

XML report file can also be open in the JUnit View. Right-click on the file> Open With > JUnit View :

& main
dv JUnit &
& platform
‘& test testsuite-harness-demo test
& classes Runs: 2/2 B Errors: 0 o Failures: 1 ]
& html - . - -
| + @l testsuite-harness-demo test (48.128 5) = Failure Trace
4 = ym

o test e _SingleTest_MathTest_testFact (27.337 s)
& tes

5 TEST-test-reportam & _SingleTest_MathTest_testFact2 (20.791 s)

Fig. 42: Example of MicroEJ Test Suite XML Report in JUnit View

If executed on device, the Firmware binary produced for each test is available in module project location target~/
test/xml/<TIMESTAMP>/bin/<FULLY-QUALIFIED-CLASSNAME>/application.out.

4.14. Development Tools 190



MicroEJ Documentation, Revision d4ede019

Advanced Configurations

Autogenerated Test Classes

The JUnit processor generates test classes into the src-adpgenerated/junit/java folder. This folder contains:

_AllTestClasses.java file A single class with a main entry point that sequentially calls all declared test meth-
ods of all JUnit test case classes.

_AllTests_[TestCase].java files For each JUnit test case class, a class with a main entry point that sequen-
tially calls all declared test methods.

_SingleTest_[TestCase]_[TestMethod]. java files For each test method of each JUnit test case class, a class
with a main entry point that calls the test method.

JUnit Test Case to MicroEJ Test Case

The MicroEJ Test Suite Engine allows to select the classes that will be executed, by setting the following property in
the project module.ivy file.

<ea:property name="test.run.includes.pattern” value="[MicroEJ Test Case Include Pattern]"/>

The following line consider all JUnit test methods of the same class as a single MicroEJ test case (default behavior).
If at least one JUnit test method fails, the whole test case fails in the JUnit report.

<ea:property name="test.run.includes.pattern” value="#*/_AllTests_x%.class"/>

The following line consider each JUnit test method as a dedicated MicroEJ test case. Each test method is viewed
independently in the JUnit report, but this may slow down the test suite execution because a new deployment is
done for each test method.

<ea:property name="test.run.includes.pattern” value="#x/_SingleTest_x*.class"/>

Run a Single Test Manually

Each test can be run independently as each class contains a main entry point.

In the  src-adpgenerated/junit/java  folder, right-click on the desired autogenerated class (
_SingleTest_[TestCase]_[TestMethod].java)andselect RunAs > MicroEJ Application .

The test is executed on the selected Platform and the output result is dumped into the console.

Test Suite Options

The MicroEJ Test Suite Engine can be configured with specific options which can be added to the module.ivy file
of the project running the test suite, within the <ea:build> XML element.

« Application Option Injection

It is possible to inject an Application Option for all the tests, by adding to the original option the microej.
testsuite.properties. prefix:

<ea:property name="microej.testsuite.properties.[application_option_name]"” value="[application_
—option_valuel”/>
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+ Retry Mechanism

A test execution may not be able to produce the success trace for an external reason, for example an unre-
liable harness script that may lose some trace characters or crop the end of the trace. For all these unlikely
reasons, it is possible to configure the number of retries before a test is considered to have failed:

<ea:property name="microej.testsuite.retry.count” value="[nb_of_retries]"/>

By default, when a test has failed, it is not executed again (option value is set to 0).

Test Specific Options

The MicroEJ Test Suite Engine allows to define Application Options specific to each test case. This can be done by
defining a file with the same name as the generated test case file with the .properties extension instead of the
.java extension. The file must be put in the src/test/resources folder and within the same package than the
test case file.

4.14.2 Stack Trace Reader
Principle

Stack Trace Reader is a MicroEJ tool that reads and decodes the MicroEJ stack traces. When an exception occurs,
the MicroEJ Core Engine prints the stack trace on the standard output System.out . The class names, non-required
types names(see Types), and method names obtained are encoded with a MicroEJ internal format. This internal
format prevents embedding all class names and method names in the executable image to save some memory
space. The Stack Trace Reader tool allows you to decode the stack traces by replacing the internal class names and

method names with their real names. It also retrieves the line numbers in the MicroEJ Application.

Functional Description

The Stack Trace Reader reads the debug information from the fully linked ELF file (the ELF file that contains the
MicroEJ Core Engine, the other libraries, the BSP, the OS, and the compiled MicroEJ Application). It prints the
decoded stack trace.

When Multi-Sandbox capability is enabled, the stack trace reader can simultaneously decode heterogeneous stack
traces with lines owned by different MicroEJ Sandboxed Applications and the firmware. Lines owned by the
firmware can be decoded with the firmware debug information file (optionally made available by your firmware
provider).

Dependencies

No dependency.
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Installation

This tool is a built-in platform tool.

Use (Standalone Application)

For example, write the following new line to dump the currently executed stack trace on the standard output.

by module.ivy [J] Testjava &2

package com.mycompany;

<

puoblic class Test {

puoblic =tatic void main (String[] args) {
Svatem.out.println("hello world!"™):
I new Exceptioni].pIintStackTIace(];[]

Fig. 43: Code to Dump a Stack Trace

To decode an application stack trace, the stack trace reader tool requires the application executable ELF file. In the
case of a platform with full BSP connection (see BSP Connection Cases), the fileis application.out inthe output
folder. In the other cases, the ELF file is generated by the C toolchain when building the BSP project (usuallya .out

or .axf file).
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v'_,ijx MyStandalonelpp

# crc/main/java

’_,ﬂ’} src/main/resources

B\ Module Dependencies moduleivy []

[= build

W [ com.mycompany. Test

= cc
= externalResources
= fonts
= heapDump
[= images
[= logs
= platform
= resourceBuffer
[= soar

E application.out j
= deployHookB5PBuild.properties
MM SOAR.map
SOAR.o
[S] SOAR.s

= nvs

= src

= wifi

CHAMGELOG.md
LICENSE. txt

foy moduleivy
README.md

Fig. 44: Application Binary File

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.

Wh START

Hella 'Warld!

Exception inthread "main" jawvalang Exception
at javalang System @0 0x3407778:0: 3407 7822
at javalang Throwahle Eh:0x3408030:0x 34080 462
at javalang Throwahle Eh:0x34089 0o 0x 3408 ek @
at corm.mycompany. Test @ 0x3f40762c:0x3 407652 (2
at javalang MainThread @k 0x3407284:0x3f407 2982
at javalang Thread (@MM:0x3f4080E8:0x 3408094
at javalang Thread. (@M:0x3f408c7 4:0x3f4 08713

WA EMD (exit code = 0)

Fig. 45: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on RunAs... >
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Run Configurations...

Create a new MicroEJ Tool configuration. In the Execution tab, select your target platform, then select the

Stack Trace Reader tool. Set an output folder in the Output folder field.

Iﬁ o = K | = ? T Mame: | Stack Trace Reader
|t5-'pefi|terte>ct | o Execution I Configuration | ®), JRE| (O] Common
[©] C/C++ Application Target
Ju JUnit Platform: | Browse...
L Launch Group
3] MicroE) Application
~ g Microkl Tool Execution
g Stack Trace Reader
Settings: | Stack Trace Reader -
Reads stack trace generated by MicroEl core engine.
Options
Qutput folder: | 5{project_loc:MyStandalonelpp} Browse...
Clean intermediate files [ verbose
Options Files
Add...
Remove
Up
Down

Fig. 46: Stack Trace Reader Tool Configuration (Platform Selection)

In Configuration tab, browse the previously generated application binary file with debug information (

application.out in case of a Standalone Application with full BSP connection)
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CHEeEX BY-

| type filter text

[E] C/C++ Application
Ju Wnit
& Launch Group
» [T Microb) Application
~ g MicroEl Tool
[ig Stack Trace Reader

Name: | Stack Trace Reader

Stack Trace Reader

o Execution | 1! Configuration ™, JRIﬂ = Commonw

Application

Executable file: | :meApp},-‘com.mycompany.Te{cfappIication.out |] Browse...

Additional object files:

Add
Remaove
“Trace pert" interface for Eclipse
Connection type: | Console
Port: | COMOD Baudrate: 115200
Port: | 5555 Address:
Stack trace file: Browse...

Fig. 47: Stack Trace Reader Tool Configuration (Standalone Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.

B Console 32 |_:: Problems & Progress

Stack Trace Reader_ [MicroB) Tool]

[INFO] Paste
Exception in

at
at
at
at
dat
atT
at

[ MicroE] Core Engine Trace ]
the MicroE] core engine stack trace here.
thread "main" java.lang.Exception

java.lang.System. [@M:@x3T407773 :0x3T407732(

java.lang.Throwable.@M:8x3T483830: 0x3T403045
java.lang.Throwable.@M:8x3T4889cc :Bx3T488%e6
com.mycompany . Test.@M:8x3f48762c: 8x3T407652(F

9

@
@

java.lang.MainThread.@M:@x3T487a84 :0x3T407398[

java.lang.Thread.
java.lang.Thread.

Excepticn in thread “"main
java.lang.System.getStackTrace(Unknown Source)
java.lang.Throwable.fillInStackTrace(Throwable. java:82)
java.lang.Throwable.<init>»(Throwable.java:32)
com.mycompany.Test.main(Test.java:21)
java.lang.MainThread.run{Thread. java:855)
java.lang.Thread.runkrapper(Thread. java: 464)
java.lang.Thread.callWrapper(Thread. java:449)

at
at
at
at
at
at
at

-

i

M:ex3T403bE8 r0x3T403bo4E

M:@x3f4e3cT4 :@x3T408c 7T

aw

java.lang.Exception

Fig. 48: Stack Trace Reader Console
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Use (Sandboxed Application)
For example, write the following new line to dump the currently executed stack trace on the standard output.
public class MyBackgroundCode implements BackgroundSerwvice {
@verride

public void onStart() {
i Auto-generated method stub

System.out.println{"MyBackgrcundCode: Hello World"™});
I new Throwable().printStackTrace(); |

h
Fig. 49: Code to Dump a Stack Trace

To decode an application stack trace, the stack trace reader tool requires the application binary file with debug
information (application.fodbg inthe outputfolder). Note that the file uploaded on the deviceis application.

fo (stripped version without debug information).

w 'i‘jd MySandboxedApp
i sro/main/java
“_,E% sre/main/resources
B\ Module Dependencies module.ivy [7]
(8 src-adpgenerated/wadapps/java
=, Referenced Libraries
w = _MySandboxedfpp_.generated. MySandboxedAppEntryPoint
= externalResources
= resourceBuffer
=| application.fo

EE. applicatian.fndbgﬂ
EE application.map
[ settings
[= applications
= com.microe).firrmware.developer.KernelStartup

= filesystem

= META-INF

= SIC

[= src-adpgenerated
|%] .classpath
|= .gitignare
Jproject
CHAMGELOG.md
LICEMSE txt
moduleivy

README.md

FdmEE

Fig. 50: Application Binary File with Debug Information

On successful deployment, the application is started on the device and the following trace is dumped on standard
output.
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com microe]wadapps ki abstractfeaturespplicationstorage INFO: Start MySandhoxedipp
tyBackgroundCode: Hello ‘Warld
Exceptionin thread "ejwadapps.app.default” java lang Throwahle
at javalang. Systemn @hl:0x8052497 c:0x805 295 ol
at javalang Throwakle (Bh4:0x807bBe0 0x807 b5t @
at java.lang. Throwakle. @hi0xE076M4 0807 665E
at comumicroe].example MyBackground Code (2F a5dk2a447701 00000375481 2202 24d0b875ch 9689 36 41:0xc0 38000 @M. 0xcl 38007 c:lxc03600h 2402
at Exception in thread "ejwadapps app.default” javallang/Throwakble
at java/lang/System B 10805497 C:0x0805438CE
at javaglan/Throwable @h:0x0807BEED:0x0807BEFE(R
at java/lang Throwahle. @ 0x08076F4C: 00807 EFEEE
at com/microej{example/ftdyBackground Code (@F abdh2a4477010000d37545(1 e20224d0b87Ech 9889 3641 :0xC03800F0 & EM 0xCO380B 7 C:0xCO380BA4 G
at ejpwadappsfapp/BackgroundServdceProxy @Ffa7a45517201000073783c876987bE5bEe3aaabe 1 d407d 1 :0:300AEBCIEE M: Ix300AB508: 0x300AB51 5@
at com/microejwadapps/managementiutil/Backgroundstdanager (@F fa7a4561720100007378 30876987 hEEbE e 3aaabe1 d407fd1 0xA00AEBCOEE@M: I I00AATE0: 0x00AATIZ (@
at com/microejfwadapps/managementiutil{Backgroundstdanager. @F fa7245517201000073783c876987055h e 3Jaanbe1 d407d1 :0x00ABCOE @M (xI00ABFT 4:0x900ABF52E
at ejjobsersahle/Observable (@F fafa45517201000073783c876987b55h88 3aaafel d407d1:0x300 AEB COE@M 030 0ABAT 0:0xI00ABA4DE
at com/microejwadapps/managementiutil/BackgroundServicaslistimpl (2Ffa7a48617 20100007 37830876987 hA6h8edasalel d407id1: 0x8004EBCOE @ 0x300ADEE4: 0x3004DE94(2
at ejpwadapps/managementBackgroundService sListProxy @F.a5dh2a4477 0100000375481 22022 4d0bE75ckh 96893660 41: 0 COIB00FI @ @M 0xCO380A2E: COIB0AIGE
at __MySandboxeddpp_fgenerated/MySandboxe dAppActvator. @F a5db2a4477010000d 3754611 e20224¢0b8 75chI683 364 1:0:C0 3800F 042 (@M. 0xCO380C54.0xC0380CE2 (@
at ejjcomponentsfregistryimpliabstractRegistry, @h.0x08078E48.0:08078E7 22
at ejfcomponents/registry/util/BundleRegistryHelper @h:0x0806EEE 8:0x0B0BE 7020
at__MySandboxedipp_fgenerated/MySandboxedAppEntryPoint (BF a5db2a4477010000¢ 3754811 2202240 0b875ch 96893614 1 0xC0 3800F0E @M. 0:C0380B04:0:C0 380B2EE
at ejfkikemel$ 2. @ 008055558 (0505589002
at javalanc/Thresd (& 00807 C4F0:0«0807 CE0RE
atjava/lang/Thresd (@ 00807 C333:0x0807 C344(E
atjave/lang/Thresd @i 00807 C485:.0x0807C493(2

Fig. 51: Stack Trace Output

To create a new MicroEJ Tool configuration, right-click on the application project and click on RunAs... >

Run Configurations...

Create a new MicroEJ Tool configuration. In the Execution tab, select your target platform, then select the
Stack Trace Reader tool. Set an output folder in the Output folder field.

ERCEER | B Y- MName: | Stack Trace Reader
type filter text | 4 Execution . I Configuration | =, JRE| [C] Commen
[€] C/C++ Application Target
Ju JUnit Platform: | Browse..,

& Launch Group
3] Microk) Application
v [Og MicroEl Toel
[ Stack Trace Reader

Execution
Settings: | Stack Trace Reader

Reads stack trace generated by MicroEl core engine.

Options
Output felder | Sproject_loc:MySandboxedApp} Browse...
Clean intermediate files [verbose
Options Files
Add...
Remaove
Up
Down

Fig. 52: Stack Trace Reader Tool Configuration (Virtual Device Selection)

In the Configuration tab, if the Kernel executable file is available to you (usually named firmware.out and

located inyour Virtual Device files), you can browse for itin the Executable file field, and then add your previously
generated application binary file with debuginformation (application. fodbg in case of a Sandboxed Application)

in the Additional object files field.
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Mame: | Stack Trace Reader |

i Execution | 33 Configuration . =, JRE| ] Commen

Stack Trace Reader Application

Executable file: | Smicrog)_lock 1.6 d00 firmwarefirmware.out Browse...

Additional object files:

1App_.generated MySandboxed AppEntryPoint/application.fodbg Add

Remove

"Trace port" interface for Eclipse

Cennection type: | Conscle ~

COMO 115200

Browse...

Fig. 53: Select the Kernel Executable File

To check where the Kernel executable file of your Virtual Device is located, if you have access to it, goto Window >
Preferences > MicroEJ > Virtual Devices , hoveroveryourVirtual Device in the listand wait untilaninformation

popup appears. Press F2 to get all the informations and the path to the directory of your Virtual Device should
appear in the list.
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[ G.

| type filker text

C/C++ A
Checkstyle
Help
Install/Update
Java
w Microk)
Architectures

Module Manager
MNaming Conventicn
Platforms
Platforms in workspa
Settings
Updates
Virtual Devices

Mylyn

Plug-in Development

PMD

Run/Debug

SonarLint

Team

Terminal

Validation

XML v

Virtual Devices

Add or remove Virtual Devices.

Target:
Mame Version Lic...
OQ o

[Path: C:\Users\ I\ microej\repositories\MicroEJ-SDK-Dist-20.1241.6\d001 |

Restore Defaults
Apply and Close

Fig. 54: Location of the Virtual Device Directory

Select All
Deselect All
Import...
Uninstall

Get UID

Apply

Cancel

In this directory, the Kernel executable file should be named firmware.out inthe /firmware sub-directory.

If you do not have access to the Kernel executable file, you can still get some information from the Stack Trace
Reader using the application binary file only. In the Configuration tab, browse the previously generated applica-
tion binary file with debug information (application. fodbg in case of a Sandboxed Application)
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O IE 0 [ x| = ? M MName: | Stack Trace Reader

| type filter text | i Bxecution |8 Configuration - =), JRﬂ i Common]
[©] C/C++ Application Stack Trace Reader Application
Ju JUnit - —
# Launch Group Executable file: | rated.MySandboxedAppEntryPom[appllcatlon.fodbg] Browse...
> O Micro) Application Additional object files:
w B MicroEl Tool
O Stack Trace Reader Add
Remove
"Trace port” interface for Eclipse
Connection type: | Console ~
Port: | COMD Baudrate: 115200
Port: | 5555 Address:
Stack trace file: Browse...

Fig. 55: Stack Trace Reader Tool Configuration (Sandboxed Application)

Click on Run button and copy/paste the trace into the Eclipse console. The decoded trace is dumped and the
line corresponding to the application hook is now readable.
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Bl Console 33

Stack Trace Reader_ [MicroE] Tool] C\Program Files\Java'jrel.8.0 ?_21\b|n\Javaw exe (27-lan-2021 15:18:24)
[ MicroEl Core Engine Trace ]
[INFO] Paste the MicroEl core engine stack trace here.

| Problems =g Prograss 4" Search ]

Exception i

thread " wadapps.app.default” java.lang.Throwable

1 085297 c:0x885a98c@
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lang.Throwable. @
lang.Throwable.
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on in thread “ej

4477010000d3754571e20224d6b375cb968936Tb41 : @xCO3B06F :BxCB33887C :0xCB338BA
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BackgroundsManager.{F : fa7a4551720100008737533C5876987b55b3e3aaase1d407Td1: @x9@0@AEBCAHE
7281 EEBB?B?SBCS?FDSFE33b8&3aaa35 a4l B?fd : Bx98@AEBCAHEEM : BxI0RABA1A : BxIBBABALGE
Backgroundser 1 7201@008873783c876967h5508 JaaaBeldanT
@00d3754811e20224d0b875cb368936Fbal : @xCR3800F O
L@F: 3db2a 477010000d37545f1220224d8b375cb968936Tb4l : BxC0O3E0GFBEMEM : 0xCB380C54 : 0xCB330C320
>BBB7E:¥8
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b ery ab e/Obser
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/BackgroundSer
ySandboxedAppAct
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lang/Thread >.BSE7C¢88:E>.8887C¢93£

Exception in thread "ej.wadapps.app.default” java.lang.Throwable
at java.lang.System.getStackTrace(Unknown Source)
at java.lang.Throwable.fillInStackTrace(Throwable.java:82)
at java.lang.Throwable.<init»(Throwahle.{ava:32)
at com.microej.example.MyBackgroundCode.onStart(MyBackgroundCode. java:17)
at Exception in thread "ej.wadapps.app.default” java/lang/Throwable
at java/lang/System.getStackTrace(Unknown Source)
java/lang/Throwable.fillInStackTrace(Throwable.java:82)
at java/lang/Throwable.<init>(Throwable.{ava:32)
at com/microej/example/MyBackgroundCode.onStart(MyBackgroundCede. java:17)
at ej/wadapps/app/BackgroundserviceProxy.8x98BAB5@8 (Unknown Source)
at com/microej/wadapps/management/util/BackgroundsManager.Bx9BBAATER (Unknown Source)
at com/microej/wadapps/management/util/BackgroundsManager.8x98@ABF14(Unknown Source)
at ej/observable/Observable.8x988ABA1B(Unknown Source)
at com/microej/wadapps/management/util/BackgroundServicesListImpl. @x986AD864 (Unknown Source)
ej/wadapps/management/BackgroundservicesListProxy.add(BackgroundservicesiistProxy. fava:39)
at _ _MySandboxedApp__/generated/MySandboxedAppActivator. link(MySandboxedAppActivator. java:21)
at ej/components/registry/impl/AbstractRegistry.link(AbstractRegistry.java:68)
at ej/components/registry/util/BundleRegistryHelper.startup(BundleRegistryHelper.java:52)
at _ MySandboxedApp__/generated/MySandboxedAppEntryPoint.start(MySandboxedAppEntryPoint. java:15)
at ej/kf/Kernel$2.run(Kernel.java:222)
java/lang/Thread.run{Thread. java:3e3)
at java/lang/Thread.runWrapper(Thread.java:454)
at java/lang/Thread.callWrapper(Thread.java:439)

o
=

W
o+

o
=

Fig. 56: Stack Trace Reader Console

Other debug information files can be appended using the 'Additional object files option.

Stack Trace Reader Options

The following section explains MicroEJ tool options.
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Category: Stack Trace Reader

Stack Trace Reader Application

Executable file: Browse...

Additional object files:

Add
Remove
"Trace port" interface for Eclipse
Connectien type: | Console ~
COMO 115200
Browse...

Group: Application
Option(browse): Executable file

Option Name: application.file
Default value: (empty)
Description:

Specify the full path of a full linked elf file.

Option(list): Additional object files

Option Name: additional.application.files

Default value: (empty)

Group: “Trace port” interface for Eclipse

Description:

This group describes the hardware link between the device and the PC.
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Option(combo): Connection type

Option Name: proxy.connection.connection.type
Default value: Console

Available values:

Uart (COM)

Socket

File

Console

Description:

Specify the connection type between the device and PC.

Option(text): Port

Option Name: pcboardconnection.usart.pc.port
Default value: COM0

Description:

Format: port name

Specifies the PC COM port:

Windows - COM1, COM2, ..., COMxn*

Linux- /dev/ttySe, /dev/ttyS1, ..., /dev/ttyS*nx

Option(combo): Baudrate

Option Name: pcboardconnection.usart.pc.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description:

Defines the COM baudrate for PC-Device communication.
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Option(text): Port

Option Name: pcboardconnection.socket.port
Default value: 5555
Description:

IP port.

Option(text): Address

Option Name: pcboardconnection.socket.address
Default value: (empty)
Description:

IP address, on the form A.B.C.D.

Option(browse): Stack trace file

Option Name: pcbhoardconnection.file.path

Default value: (empty)

4.14.3 Code Coverage Analyzer

Principle

The MicroEJ Simulator features an option to output .cc (Code Coverage) files that represent the use rate of functions

of an application. It traces how the opcodes are really executed.

Functional Description

The Code Coverage Analyzer scans the output .cc files, and outputs an HTML report to ease the analysis of methods
coverage. The HTML report is available in a folder named htmlReport in the same folder as the .cc files generated

by enabling the Code Coverage option .
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Classpath

Code Code
Simulator Coverage Coverage
Files

Analyzer

*

Fig. 57: Code Coverage Analyzer Process

Dependencies
In order to work properly, the Code Coverage Analyzer should input the .cc files. The .cc files relay the classpath

used during the execution of the Simulator to the Code Coverage Analyzer. Therefore the classpath is considered
to be a dependency of the Code Coverage Analyzer.

Installation

This tool is a built-in platform tool.

Use

A MicroEJ tool is available to launch the Code Coverage Analyzer tool. The tool name is Code Coverage Analyzer.

Two levels of code analysis are provided, the Java level and the bytecode level. Also provided is a view of the fully
or partially covered classes and methods. From the HTML report index, just use hyperlinks to navigate into the
report and source / bytecode level code.
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Category: Code Coverage

Code Coverage

*.cc files folder: Browse...

Classes filter

Includes:

Add...

Edit...

Remove

Excludes:

Add...

Edit...

Remove

Option(browse): *.cc files folder

Option Name: cc.dir
Default value: (empty)
Description:

Specify a folder which contains the cc files to process (*.cc).

Group: Classes filter
Option(list): Includes

Option Name: cc.includes
Default value: (empty)
Description:

List packages and classes to include to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. * : includes all classes which are in package packageA.packageB

packageA.packageB.className : includes the class packageA.packageB.className
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Option(list): Excludes

Option Name: cc.excludes
Default value: (empty)
Description:

List packages and classes to exclude to code coverage report. If no package/class is specified, all classes found in
the project classpath will be analyzed.

Examples:
packageA.packageB. = : excludes all classes which are in package packageA.packageB

packageA.packageB.className : excludes the class packageA.packageB.className

4.14.4 Heap Usage Monitoring
Introduction
When building a Standalone Application, the Java heap size must be specified as an Application Option (see Op-

tion(text): Java heap size (in bytes)). The value to set in this option depends on the maximum heap usage, and the
developer can estimate it by running the application.

The Core Engine provides a Java API to introspect the heap usage at runtime. Additionally, heap usage monitoring
can be enabled to compute the maximum heap usage automatically.

Here are the descriptions of the different notions related to heap usage:
« Heap: memory area used to store the objects allocated by the application.
« Heap Size: current size of the heap.

+ Maximum Heap Size: maximum size of the heap. The heap size cannot exceed this value. See Option(text):
Java heap size (in bytes).

+ Heap Usage: the amount of the heap currently being used to store alive objects.

Garbage Collector (GC): a memory manager in charge of recycling unused objects to increase free memory.

Heap

Alive Objects Unused Objects Unused Memory

Heap Usage

A
v

Heap Size

A
v

Maximum Heap Size

Fig. 58: Heap Structure Summary

The Java class java.lang.Runtime defines the following methods:
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+ gc(): Runs the garbage collector. System.gc() is an alternative means of invoking this method.

« freeMemory(): Returns the amount of free memory in the heap. This value does not include unused objects
eligible for garbage collection. Calling the gc() method may result in increasing the value returned by this
method.

« totalMemory(): Returns the current size of the heap. The value returned by this method may vary over time.

« maxMemory(): Returns the maximum size of the heap.

Heap Usage Introspection

The methods provided by the Runtime class allow introspecting the heap usage by comparing the heap size and
the free memory size. A garbage collection must be executed before computing the heap usage to recycle all the
unused objects and count only alive objects.

The application can compute the current heap usage by executing the following code:

Runtime runtime = Runtime.getRuntime(); // get Runtime instance
runtime.gc(); // Ensure unused objects are recycled
long heapUsage = runtime.totalMemory() - runtime.freeMemory();

This example gives the heap usage at a given point but not the maximum heap usage of the application.

Note: When heap usage monitoring is disabled, the heap size is fixed, and so totalMemory() and maxMemory()
return the same value.

Automatic Heap Usage Monitoring

The maximum heap usage of an application’s execution can be computed automatically by enabling heap usage
monitoring.

Note: This feature is available in the Architecture versions 7.16.0 or higher for the Applications deployed on hard-
ware devices (not on Simulator).

When this option is activated, an initial size for the heap must be specified, and the Core Engine increases the heap
size dynamically. The value returned by totalMemory() is the current heap size. maxMemory() returns the maximum
size of the heap. A call to gc() decreases the heap size to the higher value of either the heap usage or the initial heap
size.

Atany moment, totalMemory() returns the maximum heap usage of the current execution (assuming the maximum
heap usage is higher than the initial heap size, and gc() has not been called).

See the section Option(checkbox): Enable Java heap usage monitoring to enable this option and configure the initial
heap size.

Even if the heap size can vary during time, a memory section of maxMemory() bytes is allocated at link time or
during the Core Engine startup. No dynamic allocation is performed when increasing the heap size.

Warning: Asmallinitial heap size will impact the performances as the GC will be executed every time the heap
size needs to be increased.
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Furthermore, the smaller the heap size is, the more frequent the GC will occur. This feature should be used only
for heap usage benchmarking.

Heap Usage Analysis

To analyze heap usage and see what objects are alive in the application, use the Heap Dumper & Heap Analyzer
tools.

4.14.5 Heap Dumper & Heap Analyzer
Introduction

Heap Dumper is a tool that takes a snapshot of the heap. Generated files (with the .heap extension) are available
in the application output folder. Note that it works only on simulations. It is a built-in platform tool and has no
dependencies.

The Heap Analyzer is a set of tools to help developers understand the contents of the Java heap and find problems
such as memory leaks. For its part, the Heap Analyzer plugin is able to open dump files. It helps you analyze their
contents thanks to the following features:

« memory leaks detection
« objects instances browse

+ heap usage optimization (using immortal or immutable objects)

The Heap

The heap is a memory area used to hold Java objects created at runtime. Objects persist in the heap until they are
garbage collected. An object becomes eligible for garbage collection when there are no longer any references to it
from other objects.

Heap Dump

A heap dump is an XML file that provides a snapshot of the heap contents at the moment the file is created. It
contains a list of all the instances of both class and array types that exist in the heap. For each instance, it records:

+ The time at which the instance was created

+ The thread that created it

« The method that created it
For instances of class types, it also records:

« Theclass

« Thevalues in the instance’s non-static fields
For instances of array types, it also records:

+ The type of the contents of the array

+ The contents of the array

For each referenced class type, it records the values in the static fields of the class.
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Heap Analyzer Tools

The Heap Analyzer is an Eclipse plugin that adds three tools to the MicroEJ environment.

Tool name Number of | Purpose
input files
Heap Viewer 1 Shows what instances are in the heap, when they were created,
and attempts to identify problem areas
Progressive 10or more Shows how the number of instances in the heap has changed over
Heap Usage time
Compare 2 Compares two heap dumps, showing which objects were created,

or garbage collected, or have changed values

Heap Dumper

When the Heap Dumper option is activated, the garbage collector process ends by performing a dump file that
represents a snapshot of the heap at this moment. Thus, to generate such dump files, you must explicitly call the
System.gc() method in your code, or wait long enough for garbage collector activation.

The heap dump file contains the list of all instances of both class and array types that exist in the heap. For each

instance, it records:

« the time at which the instance was created

« the thread that created it

« the method that created it

For instances of class types, it also records:

« theclass

« the valuesin the instance’s non-static fields

For instances of array types, it also records:

« the type of the contents of the array

« the contents of the array

For each referenced class type, it records the values in the static fields of the class.
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Category: Heap Dumper

Heap Dumper Application

Executable file: Browse...

Resident application files:

Add...

Remove

Memary

Heap memaory file: | Browse...

Output

Heap file name: | application.heap

Group: Application
Option(browse): Executable file

Option Name: application.filename
Default value: (empty)
Description:

Specify the full path of a full linked ELF file.

Option(list): Resident application files

Option Name: additional.application.filenames
Default value: (empty)
Description:

Specify the full path of System Applications .out files linked by the Firmware Linker.
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Group: Memory
Option(browse): Heap memory file

Option Name: heap.filename
Default value: (empty)
Description:

Specify the full path of heap memory dump, in Intel Hex format.

Group: Output
Option(text): Heap file name

Option Name: output.name

Default value: application.heap

Heap Viewer

To open the Heap Viewer tool, select a heap dump XML file in the Package Explorer , right-click on it and select

Open With > Heap Viewer

Alternatively, right-click on it and select Heap Analyzer > Open heap viewer

This will open a Heap Viewer tool window for the selected heap dump'.
The Heap Viewer works in conjunction with two views:

1. The Outline view

2. The Instance Browser view
These views are described below.

The Heap Viewer tool has three tabs, each described below.

Outline View

The Outline view shows a list of all the types in the heap dump, and for each type shows a list of the instances of
that type. When an instance is selected it also shows a list of the instances that refer to that instance. The Outline
view is opened automatically when an Heap Viewer is opened.

! Although this is an Eclipse ‘editor’, it is not possible to edit the contents of the heap dump.
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E Console |[21 Problems [ 0= Outline &3 @ ¥ =0
33 types - 70 instances (from first to last time stamp)

Type name Instances  Referenced instances Method Thread i
. char(] 1 0
@ com.is2t.cldec.s3.DefaultSystemOut 0
» @ com.is2t.test HeapDumpTest 1
PRC) com.isZt.test. HeapDumpTest5TestOhbj 2
<p #99
<p £100
. (@ com.is2t.test.HeapDumpTest$ TestObj2
@ &jbonlmmutables
> @ gj.bonImmutablesFile
. int[]
» L& int(]l]
@ ist.support.lang.Systools

m

@ corm.is2ttest HeapDumpTest.start() : void 3 main
@ com.is2ttest HeapDumpTest.start() : void 5 main

=R = R R R R UV )

D= R -
(=N )

References ’ Type
<&p #98 (C] com.is2ttest. HeapDumpTest

Fig. 59: Outline View

Instance Browser View

The Instance Browser view opens automatically when a type or instance is selected in the Outline view. It has two
modes, selected using the buttons in the top right corner of the view. In ‘Fields’ mode it shows the field values for
the selected type or instance, and where those fields hold references it shows the fields of the referenced instance,
and so on. In ‘Reference’ mode it shows the instances that refer to the selected instance, and the instances that
refer to them, and so on.

El Conzole [3_ Problems EE Cutline LEEE Fields and Reference Hierarchy &2 g]-oe = B
Fields - heap file name: Ch\Users\Jehn\.microgfworkspaces\CM_ARMCC-DEV-1.0.0%HeapDumpT est\ com.isz
Field Type Value
a @ this C com.isZt.test. HeapDumpTest5TestOhbj #100
@ a © int 1
@b O int 0
F I- © int 0

Fig. 60: Instance Browser View - Fields mode
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&l Console (21 Problems EE Cutline T;EE Fields and Reference Hierarchy &2 o[:g =08
References - heap file name : ChUsers'John'umicroefweorkspaces\CM_ARMCC-DEV-1.0.00HeapDumpTest\co
Field Type Value
a @ this C com.isZt.test.HeapDumpTest5TestOhj #100
4 @ testObj C) com.is2t.test.HeapDurmpTest #98
<no references>  <nonex <none:

Fig. 61: Instance Browser View - References mode

Heap Usage Tab

The Heap usage page of the Heap Viewer displays four bar charts. Each chart divides the total time span of the heap
dump (from the time stamp of the earliest instance creation to the time stamp of the latest instance creation) into a
number of periods along the x axis, and shows, by means of a vertical bar, the number of instances created during
the period.

The top-left chart shows the total number of instances created in each period, and is the only chart displayed
when the Heap Viewer is first opened.

When a type or instance is selected in the Outline view the top-right chart is displayed. This chart shows the
number of instances of the selected type created in each time period.

When an instance is selected in the Outline view the bottom-left chart is displayed. This chart shows the
number of instances created in each time period by the thread that created the selected instance.

When an instance is selected in the Outline view the bottom-right chart is displayed. This chart shows the
number of instances created in each time period by the method that created the selected instance.
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[ heap-Oaml 52 =
Instance creation over time, by type, creating thread and creating method Generate graphViz file
Heap usage - Total Instances of type 'com.is2t.test. HeapDumpTest5TestOhy'
Heap usage : 569/569 instance(s) Heap usage: 500/569 instancels)
Instances Instances
489 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp
Created by thread 'main’ Created by method 'com.is2t.test HeapDumpTest.start() « void'
Heap usage: 503/589 instance(s) Heap usage : 500/569 instance(s)
Instances Instances
459 489
326 326
163 163
0 0
47 94 141 188 235 282 329 376 423 470 47 94 141 188 235 282 329 376 423 470
Time stamp Time stamp

Heap usage | Dominator tree | Leak suspects

Fig. 62: Heap Viewer - Heap Usage Tab

Clicking on the graph area in a chart restricts the Outline view to just the types and instances that were created
during the selected time period. Clicking on a chart but outside of the graph area restores the Outline view to
showing all types and instances”.

The button Generate graphViz file in the top-right corner of the Heap Usage page generates a file compatible with
graphviz (www.graphviz.org).

The section Heap Usage Monitoring shows how to compute the maximum heap usage.

2 The Outline can also be restored by selecting the All types and instances option on the drop-down menu at the top of the Outline view.
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Dominator Tree Tab

The Dominator tree page of the Heap Viewer allows the user to browse the instance reference tree which contains
the greatest number of instances. This can be useful when investigating a memory leak because this tree is likely
to contain the instances that should have been garbage collected.

The page contains two tree viewers. The top viewer shows the instances that make up the tree, starting with the
root. The left column shows the ids of the instances - initially just the root instance is shown. The Shallow instances
column shows the number of instances directly referenced by the instance, and the Referenced instances column
shows the total number of instances below this point in the tree (all descendants).

The bottom viewer groups the instances that make up the tree either according to their type, the thread that created
them, or the method that created them.

Double-clicking an instance in either viewer opens the Instance Browser view (if not already open) and shows de-
tails of the instance in that view.

[ heap-Daml 23 =
lf;gf Dominator tree : Instance hierarchy that contains greatest number of instances

Dominator tree instances Type

. |5 98 & com.is2ttest.HeapDumpTest
p p

4 [Tl &

Dorminator tree instances grouped by type, thread or method | Types -

Top consumers I;stances
(@ com.is2t.test.HeapDumpTestSTestObj 500
|E java.ang. Object(] 1
@ java.utilVector 1
& com.is2t.test.HeapDumpTest 1

Heap usage | Dominator tree | Leak suspects

Fig. 63: Heap Viewer - Dominator Tree Tab
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Leak Suspects Tab

The Leak suspects page of the Heap Viewer shows the result of applying heuristics to the relationships between
instances in the heap to identify possible memory leaks.

The page is in three parts.

« The top part lists the suspected types (classes). Suspected types are classes which, based on numbers of
instances and instance creation frequency, may be implicated in a memory leak.

+ The middle part lists accumulation points. An accumulation point is an instance that references a high num-
ber of instances of a type that may be implicated in a memory leak.

+ The bottom part lists the instances accumulated at an accumulation point.

[ heap-Oaml 52 =

19 Types suspected

C] com.is2t.test. HeapDumpTestSTestOhbj

Accumulation points

Instance Type
&p #381 java.lang.Object]]
Accumulated instances

Instance Type i

Gp#123 (C] com.is2t.test.HeapDumpTestSTestObj L4

Ep#124 C com.isZt.test. HeapDumpTestSTestObj

Ay #125 C com.isZt.test.HeapDumpTestSTestObj

G #126 (C] com.is2t.test.HeapDumpTestSTestObj

G #130 C] com.is2t.test. HeapDumpTestSTestOhbj

dp#131 C com.isZt.test. HeapDumpTest5TestOhy

p 132 C com.isZt.test.HeapDumpTestSTestObj

Gp#133 (C] com.is2t.test.HeapDumpTestSTestObj

G #134 C] com.is2t.test. HeapDumpTestSTestOhbj

<y #135 C com.isZt.test. HeapDumpTest5TestOhy 1
B aramm = e o s - -~ A -

Heap usage | Dominator tree | Leak suspects

Fig. 64: Heap Viewer - Leak Suspects Tab
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Progressive Heap Usage

To open the Progressive Heap Usage tool, select one or more heap dump XML filesin the Package Explorer , right-

click and select Heap Analyzer > Show progressive heap usage

This tool is much simpler than the Heap Viewer described above. It comprises three parts.

+ The top-right part is a line graph showing the total number of instances in the heap over time, based on the
creation times of the instances found in the heap dumps.

+ The left part is a pane with three tabs, one showing a list of types in the heap dump, another a list of threads
that created instances in the heap dump, and the third a list of methods that created instances in the heap

dump.

The bottom-left is a line graph showing the number of instances in the heap over time restricted to those

instances that match with the selection in the left pane. If a type is selected, the graph shows only instances
of that type; if a thread is selected the graph shows only instances created by that thread; if a method is
selected the graph shows only instances created by that method.

E”| Progressive Heap Usage %

Progressive heap usage by type, creating thread and creating method

Types | Threads | Methods |

Heap usage - Total

Mame

charf]

C) com.is2t.cldc,s3.DefaultSystem Out
(C] com.is2t.test.HeapDumpTest

C] com.is2t.test. HeapDumpTestiTestObj
@ gj.bonImmutables

C) g.bonImmutablesFile

int{]

int{][]

C ist.supportlang.Systools

(3 ist.support.util EncUS_ASCI

C) ist.support.util EncodingConversion
C) java.o.FileDescriptor

C) java.io.FileQutputStream

(C] java.io,QutputStream

C java.io.QutputStreamWriter

@ java.ic.PrintStream

C) java.ioWriter

C) java.lang.Exception

(C] java.langIndexOutOfBoundsException
C java.lang.MullPointerException

C java.lang.Object

Instances
570

380

190

m

39 78 117 156 195 234 273 312 351 390 429 468

Tirme stamp

Heap usage - Type com.is2t.test HeapDumpTestiTestObj

Instances
501
334
167
]
- 39 T8 117 156 195 234 273 312 351 390 429 468

Type search

Tirne stamp

Fig. 65: Progressive Heap Usage
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Compare Heap Dumps

The Compare tool compares the contents of two heap dump files. To open the tool select two heap dump XML files
in the Package Explorer, right-click and select Heap Analyzer > Compare

The Compare tool shows the types in the old heap on the left-hand side, and the types in the new heap on the
right-hand side, and marks the differences between them using different colors.

Typesinthe old heap dump are colored red if there are one or more instances of this type which are in the old dump
but not in the new dump. The missing instances have been garbage collected.

Types in the new heap dump are colored green if there are one or more instances of this type which are in the new
dump but not in the old dump. These instances were created after the old heap dump was written.

Clicking to the right of the type name unfolds the list to show the instances of the selected type.

EB Heap Comparator &% =0
Show lAII instances v] Array type (@ Class type
[0 Ord heap : heap-0.xml 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
charf] - charf] -
(& com.is2t.clde.s3.DefaultSystemOut (® com.is2t.clde.s3.DefaultSystemOut
(@ com.is2ttest.HeapDumpTest (@ com.is2ttest.HeapDumpTest
(9 com.is2ttest.HeapDumpTestSTestObj (@ com.is2ttest.HeapDumpTestSTestObj
(8 com.is2ttest.HeapDumpTestSTestObj3 {5 com.is2t.test. HeapDumpTestSTestObj2
@ gjbonImmutables (@ com.is2ttest.HeapDumpTestSTestObj3
@ &j.bonImmutablesFile @ &.bonlmmutables
int[] C] g.bonImmutablesFile
int[][] L int[] =
C] ist.supportlang. Systools 1 int[1[]
@ ist.support.util. EnclUS_ASCIT @ ist.support.lang. Systools
(@ ist.support.util EncodingConversion @ ist.support.util EncUS_ASCT
(@ java.io FileDescriptor (@ ist.support.util.EncodingConversion
(@ java.ic.FileOutputStream (@ java.io.FileDescriptor
@ java.o, OutputStream @ java.o. FileOutputStream
® java.ioOutputStreamWriter @ java.io.OutputStream
(& java.io.PrintStream @ java.ie.OutputStreamWriter
@ java.io Writer C] java.ic.PrintStream
(& javalang.Exception ® java.io.Writer
(@ javalangIndexOutOfBoundsException (@ javalang.Exception
(@ java.lang.MullPointerException @ javalangIndexOutOfBoundsException
(@ javalang.Object @ java.lang.MullPointerException
javalang.Object[] @ javalang.Object
@ javalang.OutOfMemoryError il java.lang.Object[] i

Fig. 66: Compare Heap Dumps

The combo box at the top of the tool allows the list to be restricted in various ways:
« Allinstances - no restriction.

+ Garbage collected and new instances - show only the instances that exist in the old heap dump but notin the
new dump, or which exist in the new heap dump but not in the old dump.

« Persistent instances - show only those instances that exist in both the old and new dumps.
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« Persistentinstances with value changed - show only those instances that exist in both the old and new dumps
and have one or more differences in the values of their fields.

Instance Fields Comparison View

The Compare toolworksin conjunction with the Instance Fields Comparison view, which opens automatically when
aninstance is selected in the tool.

The view shows the values of the fields of the instance in both the old and new heap dumps, and highlights any
differences between the values.

£° Heap Comparator &2

= 8
Show ’Persistentinstanceswith value changed vl Array type ® Class type
[0 OId heap : heap-0.xml 34 types - 570 instances [0 New heap : heap-1.xml 35 types - 471 instances
(3 com.is?ttest.HeapDumpTest (& com.is?t.test.HeapDumpTest
(& com.is2ttestHeapDumpTestsTestObj3 (& com.is2ttest.HeapDumpTestsTestOhj3
Xy #625 Jp #625
java.ang.Object[] java.lang.Object[]
(3 javalang.Thread (& java.lang.Thread
@ java.util.Vector (@ java.util.Vector
Type com.is2t.test. HeapDumpTestSTestObj3 : 0 instances garbage collected, 0 new instances, 1 persistent instances.
El Console LS_ Problems EE Outline E Fields and Reference Hierarchy £ Instance Fields Comparison % =
Fields Type Old value  MNew value
a @this O com.is2t.test. HeapDumpTestiTestOhbj3 #5625 #6525
Ga int 0 0
Gb int 0 3
@c int 0 0

Fig. 67: Instance Fields Comparison view

4.14.6 Serial to Socket Transmitter

Principle

The MicroEJ serialToSocketTransmitter is a piece of software which transfers all bytes from a serial port to a tcp
client or tcp server.
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Installation

This tool is a built-in platform tool.

Use

This chapter explains MicroEJ tool options.

Category: Serial to Socket

Serial to Socket Serial Options

Port: | COMD Baudrate: | 115200 v

Server Options

Port: | 5555

Group: Serial Options
Option(text): Port

Option Name: serail.to.socket.comm.port

Default value: COM@

Description: Defines the COM port:

Windows - COM1, COM2, ..., COMxn*

Linux- /dev/ttySe, /dev/ttyUSBo, ..., /dev/ttySxn*, /dev/ttyUSBxnx
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Option(combo): Baudrate

Option Name: serail.to.socket.comm.baudrate
Default value: 115200

Available values:

9600

38400

57600

115200

Description: Defines the COM baudrate.

Group: Server Options
Option(text): Port

Option Name: serail.to.socket.server.port
Default value: 5555

Description: Defines the server IP port.

4.14.7 Memory Map Analyzer
Principle
When a MicroEJ Application is linked with the MicroEJ Workbench, a Memory MAP file is generated. The Memory

Map Analyzer (MMA) is an Eclipse plug-in made for exploring the map file. It displays the memory consumption of
different features in the RAM and ROM.
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Functional Description

MicroEJ
Application

Platform

1. Build the MicroEJ
Application

Map file Executable file

2. Open Memory
Map Analyzer

Fig. 68: Memory Map Analyzer Process

In addition to the executable file, the MicroEJ Platform generates a map file. Double click on this file to open the
Memory Map Analyzer.

Dependencies

No dependency.

Installation

This tool is a built-in platform tool.

Use

The map file is available in the MicroEJ Application project output directory.
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[ Pa. i JgMy. EiTe. iTe. = O | [0 HelloWorldjava &3 =g
= & v 2® * Javall .
. 55} MyHelloWorldSample ; package com.microej.example.hello;
4 4% src/main/java 16% import java.io.Filej[]
4 [ com.microej.example.hello 24
> 47| HelloWorld.java 258
. (™ src/main/resources 26 * Prints the message "Hello World !" an displays MicroE] splash
. 27 */
g fn“ Refe.ranced Libraries 28 public class HelloWorld extends Displayable implements EventHandler{
» [ .settings 29
4 [= commicroej.example.hello.HelloWorld 38 private static final int PADDING TEXT =5;
(&= bon 31 private static final int PADDING BETWEEN IMAGE AND TEXT = 3@;
> B ec ?% . final .
. o fonts ;z private final String[] messages; E -
(= heapDump 35 private Image microejImage;
- (= images L
= logs 378 public static void main(String[] args) {
> (= soar 38 -"?i_crnUI.sturt();
- 39 / new Helloworld().sh H
. (= toolbox -
m 48 try {
SOAR.map & 41 socket s = SSLSocketFactory.getDefoult().createSocket();
SOAR.0 a2 } catch (IOException &) {
> (= filesystem v 43 l Auto-generated catch block
N 44 e.printStackTrace();
[% classpath Z; '
X] project 47 File f = mew File("/s55");

&

Fig. 69: Retrieve Map File

Select an item (or several) to show the memory used by this item(s) on the right. Select “All” to show the memory
used by all items. This special item performs the same action as selecting all items in the list.

[# Pa.. 57 FgMy.. EjTe. = [0 | [0S0ARmap i = B8
< 7 ’ Image 5 Runtime Si
- . ame mage Size untime Size e
“ r" T,,yjrij,:nv:‘o;“;as\fample @ All 1899 KB 51.9 KB =
) L‘“ erc/main/resources . @ ApplicationCode 27KB 0B IMAGE: 49.3 KB /189.9 KB
S @ ApplicationFonts 24.2 KB 0B [ 26.00% ]
» =% Referenced Libraries
. @ Applicationlmages 3.2KB 0B :
g L/ settings > @ Applicationlmmutables 264 B 0B _Ap...l ArplicationSirings l
4= fum.mlcmej.examp\E‘heIIU.HeIIuWurld I 0E 0B
.V,_I/ ben > O ApplicationStrings 189 KB 0B (s
L . @ BSP 600 B 3.7KB
(& fonts . @ ClassesNames 71KB 0B
& heapDump . @ CoreEngine 20KB 7.5KB
© = mages . @ CoreEngineAllocator 08 36.0 KB
£ logs . @ Drivers 56 B 0B
=l ;”Z"bux . @ InstalledFestures 08 64B
E SOARmap > @ LibAddonWadapps 2288 0B
SOARo » & LibFoundationBOMN 856 B 0B
- . @ LibFoundaticnEDC 375KB 486 B
& filesystem . @ LibFoundationFs 01KB 4B
& - . @ LibFoundationkF 100 KB 0B
|%] .classpath . = 5
Project . @ L!hFﬂundat!nanchI 26.7 KB 41KB
- @ LibFoundationNET 26.5 KB 4B
. @ LibFoundationSSL 106 KB 0B

Fig. 70: Consult Full Memory

Select an item in the list, and expand it to see all symbols used by the item. This view is useful in understanding
why a symbol is embedded.
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[l ® = O | ] HelloWorld,java [H SOAR.map &2 = 4
[l v - : —
L MyHalIoWo;\‘:ﬁSamp\a Na'r;nf . Image Size Runtime Size -
“ @ src/main/java 4@ Al 189.9 KB 519 KB 5
o . » @ _java_AAljava_lang_String 208 0B
“ @ chjm;;::{;:ﬁ:amg @ _java_Alcom_is2t_elflw_nodes_Section_name 168 0B
iy e . @ _java_ALcom_is2t java_io_IFileChannelSOpen 08 0B
[ sreimainiresources @ _java_Alcom_is2t_kf_IFeatureloader_nameini 168 0B
=i Referenced Libraries s 5
@ _java_ALcom_is2t_support_net_ss|_AbstractSS 208 0B
[ settings @ _java_ALcom_is2t_support_net_ss|_AbstractsS 168 0B
4 (& com.microgj.examplet . @ _java_Alcom_is2t_suppart_net_ssl_xS09_X509 08 0B
£ ben . @ _java_Alcom is2t support_net_ssl x509_X509 168 0B
l_'_: f“ > @ _java_Aljava_ic_FileSPathStatus 208 0B
l_'_: onts > @ _java_Aljava_io_FileSPathStatus_nameinfo 16B [
& heapDump @ _java_ALjava_lang_Thread 08 0B
+ [ images @ _java_Aljava_lang_Thread_nameinfo 168 0B
(& logs . @ _java_ClinitMethod 08B 0B
L sear @ _java_features _start 648 0B
= t;;g?;ﬂp © _java_kernel_header start 88 0B
@ SOAR:O @ _java_Lcom_is2t_elflw_input_AbstractElfLoad: 808 0B
. filesystem > @ _java_Lcom_is2t_elflw_input_AbstractElfLoad: 1528 0B
= ¥ > @ _java_Lcom_is2t_elflw_input_ElfLoaderError_n 72B [
';' Z(asspam . @ _java_Lcom_is2t_elflw_input_soar_ELoaderS: 88 0B
% project » @ _java_Lcom_is2t_elflw_input_soar_ElfLoaderSc 12B 0B
, @ _java_Lcom,_is2t_elfhw_nodes_Dynamichlloca 248 0B
, @ _java_Lcom_is2t_elfbw_nodes_EfRelocatablell %68 0B
» @ _java_Lcom_is2t_elflw_nodes_ProgAllocation! 3B 0B T A T DT e S
> @ _java_Lcom_is2t_elflw_nodes RelocationEntry 208 0B o
@ _java_Lcom_is2t_elflw_nodes RelocationSecti 168 [1]:] Browse.. | | Run
> @ _java_Lcom_is2t_elflw_nodes_SymbolTableEn 288 0B _ || Select a Memory Map Script to run
- e wL. o cC._i_riic 130 no
B Console 52 3«"""5';:4':‘3
Memory Map Analyzer Console SOAR map
# ALl = 194516 bytes -
APPLICATION: £

ApplicationCode = 278@ bytes

ApplicaticnFents = 24868 bytes

ApplicaticnImages = 3284 bytes

ApplicaticnResources = 28 bytes

ApplicationImmutables = 264 bytes

ApplicationStrings = 19372 bytes i

Fig. 71: Detailed View

4.14.8 Event Tracing
Description

Event Tracing allows to record integer based events for debugging and monitoring purposes without affecting ex-
ecution performance too heavily. Basically, it gives access to Tracer objects that are named and can produce a
limited number of different event types.

Arecord is an event type identified by an eventID and can have a list of values. It can be a single event or a period
of time with a start and an end.

Event Tracing can be accessed from two APIs:

+ A Java API, provided by the Trace APl module. The following dependency must be added to the module.ivy
of the MicroEJ Application project:

<dependency org="ej.api" name="trace" rev="1.1.0"/>

« ACAPI, provided by the Platform header file named LLTRACE_impl.h.
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Event Recording

Events are recorded if and only if:
« the MicroEJ Core Engine trace system is enabled,
« and trace recording is started.

To enable the MicroEJ Core Engine trace system, set the Application Option named core.trace.enabled to true
(see also launch configuration).

Then, multiple ways are available to start and stop the trace recording:

+ by setting the Application Option named core.trace.autostart to true to automatically start at startup
(see also launch configuration),

« using the Java APl methods ej.trace.Tracer.startTrace() and ej.trace.Tracer.stopTrace(),

« using the C API functions LLTRACE_IMPL_start(void) and LLTRACE_IMPL_stop(void).

Java APl Usage

The detailed Trace APl documentation is available here.

First, you need to instantiate a Tracer object by calling its constructor with two parameters. The first parameter,
name, is a String that will represent the Tracer object group’s name. The second parameter, nbEventTypes,isan
integer representing the maximum number of event types available for the group.

Tracer tracer = new Tracer("MyGroup”, 10);

Then, you can record an event by calling the recordEvent(int eventld) method. The event ID needs to be in the
range 0 to nbEventTypes-1 with nbEventTypes the maximum number of event types set when initializing the
Tracer object. Methods named recordEvent(...) always needs the eventID as the first parameter and can have
up to ten integer parameters as custom values for the event.

To record the end of an event, call the method recordEventEnd(int eventlD). It will trace the duration of an event
previously recorded with one of the recordEvent(int eventID) methods. The recordEventEnd(...) method can
also have another integer parameter for a custom value for the event end. One can use it to trace the returned value
of a method.

The Trace API also provides a String constant TracerTRACE_ENABLED_CONSTANT_PROPERTY representing the
Constant value of core.trace.enabled option. This constant can be used to remove at build time portions of
code when the trace system is disabled. To do that, just surround tracer record calls with a if statement that checks
the constant’s state. When the constantis setto false, the codeinside the if statement will not be embedded with
the application and thus will not impact the performances.

if(Constants.getBoolean(Tracer.TRACE_ENABLED_CONSTANT_PROPERTY)) {
// This code is not embedded if TRACE_ENABLED_CONSTANT_PROPERTY is set to false.
tracer.recordEventEnd(0);

}
Examples:
+ Trace a single event:

private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();

(continues on next page)
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(continued from previous page)
tracer.recordEvent(0);

3

Standard Output:

VM START
[TRACE] [1] Declare group "Application”
[TRACE] [1] Event 0x0

+ Trace a method with a start event showing the parameters of the method and an end event showing the
result:

private static final Tracer tracer = new Tracer("Application”, 100);

public static void main(String[] args) {
Tracer.startTrace();

int a = 14;
int b = 54;
add(a, b);

}

public static int add(int a, int b) {
tracer.recordEvent(1, a, b);
int result = a + b;
tracer.recordEventEnd(1, result);
return result;

3

Standard Output:

VM START

[TRACE] [1] Declare group "Application”
[TRACE] [1] Event ox1 (14 [@OxE],54 [0x36])
[TRACE] [1] Event End 0x1 (68 [0x44])

Platform Implementation
By default, when enabled, the Trace API displays a message in the standard output for every recordevent(...)
and recordEventEnd(...) method calls.

It does not print a timestamp when displaying the trace message because it can drastically affect execution perfor-
mances. It only prints the ID of the recorded event followed by the values given in parameters.

A Platform can connect its own implementation by overriding the functions defined in the LLTRACE_impl.h file.

MicroEJ Corp. provides an implementation that redirects the events to SystemView tool, the real-time recording
and visualization tool from Segger. Itis perfect for a finer understanding of the runtime behavior by showing events
sequence and duration.

A implementation example for the NXP OM13098 development board with SystemView support is available here.

Please contact our support team for more information about how to integrate this Platform module.
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Advanced Event Tracing

Method invocation can be profiled.

Note: This feature requires Architecture version 7.17.0 or higher and is only available on MicroEJ Core Engine,
not on Simulator.

MicroEJ Corp. provides an implementation on Linux targets to profile an Application and generate a flamegraph
for the Trace Compass tool.

Please contact our support team for more information about how to generate flamegraph.

4.14.9 Null Analysis

NullPointerException thrown at runtime is one of the most common causes for failure of Java programs. The Null
Analysis tool can detect such programming errors (misuse of potential null Java values) at compile-time.

The following example of code shows a typical Null Analysis error detection in MicroEJ SDK.

& Mainjava I3 = 8
1 package nullanalysis; ~ N
3 public class Main {
= public static void example() {
6 // The following ‘getProperty' method can return a 'null' value
7 /f [@Nullable String java.lang.System.getProperty(String key)
Sstring myValue = System.getProperty("APropertyThatMayBeUndefined™);
// The following ‘println’ method allows Nullable argument
/f woid java.io.PrintStream.println{@Nullable String x)
System.out.println({myValue); .

// ERROR: 'Potential null peinter access: The variable myValue may be null at this location’

myValus. tolpperCase();

gL Problems &3
1 error, 0 warnings, 0 others

Description

~ @ Errors (1 itemn)
3 Potential null pointer access: The variable myValue may be null at this location

Fig. 72: Example of Null Analysis Detection

Principle
The Null Analysis tool is based on Java annotations. Each Java field, method parameter and method return value
must be marked to indicate whether it can be null or not.

Once the Java code is annotated, module projects must be configured to enable Null Analysis detection in MicroEJ
SDK.
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Java Code Annotation

MicroEJ defines its own annotations:

« @NonNullByDefault: Indicates that all fields, method return values or parameters can never be null in the
annotated package or type. This rule can be overridden on each element by using the Nullable annotation.

« @Nullable: Indicates that a field, local variable, method return value or parameter can be null.
« @NonNull: Indicates that a field, local variable, method return value or parameter can never be null.
MicroEJ recommends to annotate the Java code as follows:

« In each Java package, create a package-info.java file and annotate the Java package with
@ onNullByDefault . Thisis a common good practice to deal with non null elements by default to avoid
undesired NullPointerException. It enforces the behavior which is already widely outlined in Java coding
rules.

[ Package Explorer 51 = B [ package-infojava &3

@Ej.annntatiun.chHullByDEfaultI
2 package nullanalysis;

v",_'—‘/J- nullanalysis ~

L

w [ sro/main/java

v nullanalysis
package-info java |

VB srcfmain/resources

+ Ineach Javatype, annotate allfields, methods returnvalues and parameters that can be null with @Nullable.
Usually, this information is already available as textual information in the field or method Javadoc comment.
The following example of code shows where annotations must be placed:

@Mullable
public Object thisFieldCanBeNullj;

@Nullable

public Object thisMethodCanReturnNull() {
return null;
¥

public wvoid thisMethodParameterCanBeNull{@Nullable Object param) {

}

Note: MicroEJ SDK 5.3.0 or higher requires annotations declared in EDC-1.3.3 or higher. See EDC 1.3.3 Changelog
for more details.
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Module Project Configuration

To enable the Null Analysis tool, a module project must be configured as follows:

+ In the Package Explorer, right-click on the module project and select Properties ,

+ Navigateto Java Compiler > Errors/Warnings ,

« Inthe Null analysis

® Properties for

section, configure options as follows:

| | | Errors/Warnings w2 v 8
RE%DWCE [] Enable project specific settings Configure Workspace Settings...
Builders
Checkstyle Select the severity level for the following optional problems:

Git
hy | type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off) |
JAutodoc + Null analysis ~
Java Build Path Mull pointer access: Error ~
Java Code Style
v Java Compiler Potential null pointer access: Error ~
Annotation Processing
. Redundant null check: Error ~
Building
Errors/Warnings nclude “assert’ in null analysis
Javadoc nable annotation-based null analysis
Task Tags . Viclation of null specification: Error ~
Javadoc Location
Java Editor Conflict between null annotations and null inference: Error ~
PMD .
Project Natures Unchecked conversion from non-annotated type to @NonMull type: Error ~
Project References Unsafe conversion of annotated parametenzed type to less-annotated type: Error ~
Run/Debug Settings
SonarLint Problems detected by pessimistic analysis for free type variables: Error ~
Task Repositery Unsafe '@MNennull’ interpretation of free type variable from library: Error w
WikiText
Redundant null annotation: Error ~
"@MonMull’ parameter not annotated in overniding method: Error ~
Missing '@MNonMNullByDefault’ annotation on package: Error ~
se default annotations for null specificatiun
nherit null annotations
nable syntactic null analysis for fields
v
Restore Defaults Apply
@ Apply and Close Cancel
+ Click onthe Configure... link to configure MicroEJ annotations:
- ej.annotation.Nullable
- ej.annotation.NonNull
- ej.annotation.NonNullByDefault
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Enter customn annotation names for null specifications.

Primary annctations are for active use in source and class files, whereas secondary annotations are
intended only for interpreting API of third-party libraries,

‘Mullable' annotations:

Elements annotated with the '@Mullable’ annotation can be null,

Primary annotation: lej.annotation.Mullable]

Secondary annotations: | [ Add
‘MonMull' annotations:

Elements annctated with '@MNenMull' must never be null,

Primary annotation: lej.annotation.MonMull |

Secondary annotations: | [ Add

‘MonMullByDefault’ annotations:

The '@MNonMNullByDefault’ annotation sets ‘'non-null’ as default for all elements in a package, type,
or method. When using Eclipse's default '@MonMullByDefault’ annetation, an optional annotation
argument is evaluated, allowing to cancel or fine-tune the 'non-null’ default.

Primary annotation: |e_i.annu:utatiu:ur1.NDnNuIIB}rEIEfauIt|

Secondary annotations: | | [ Add
@' Restore Defaults] [ oK ] ’ Cancel l

« Inthe Annotations section, check Suppress optional errors with ‘@SuppressWarnings’ option:
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®¥ Properties for nullana

[l | | Errors/Warnings MR
Re_snurce ~ Enable project specific settings Configure Workspace Settings...
Builders
Checkstyle Select the severity level for the following optional problems:
hvy . - . .

IAutodoc | type filter text (use ~ to filter on preference values, e.g. ~ignore or ~off) |
Java Build Path ~ Annotations ~
Java Code Style Missing '@Override’ annotation: lgnore

~ Java Compiler

Annatation Processin Include implementations of interface methods (1.6 or higher)

Building Missing '@Deprecated’ annotation: Ignore
Errors/Warnings o . -
Annotation is used as super interface: Warning ~
Javadoc
Task Tags Unhandled teken in '@5uppressWarnings': Warning
Ja\radnr? Location Enable '@5SuppressWarnings' annotations
lava Editor
PMD Unused '@5SuppressWarnings' token: Warning
Pm_!ect Natures ‘Unused’ status is not fully known because a relevant option is set to 'lgnore”: Info ~
Project References
Refactoring History I Suppress optional errors with '@5uppressWamings'| v
Run/Debug Settings
< J J 5 v Restore Defaults Apply

?\ Apply and Close Cancel

This option allows to fully ignore Null Analysis errors in advanced cases using @SuppressWarnings("null")
annotation.

If you have multiple projects to configure, you can then copy the content of the .settings folder to an other
module project.
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v '_.'j‘J nullanalysis
w [ cro/main/java
B nullanalysis
P src/main/resources
B sroftest/java
8 sroftest/resources
Bl Module Dependencies moduleivy [*]

w [ .settings
org.eclipse.jdt.core.prefs

org.eclipse.jdt.ui.prefs

= internal

= src

[= src-adpgenerated
.classpath
.gitignore

.project
[%] CHANGELOG.md
= LICEMSE txt

by module.ivy
[#] README.md

Fig. 73: Null Analysis Settings Folder

Warning: You may lose information if your target module project already has custom parameterization or if it
was created with another MicroEJ SDK version. In case of any doubt, please configure the options manually or
merge with a text file comparator.

MicroEJ Libraries

Many libraries available on Central Repository are annotated with Null Analysis. If you are using a library which is
not yet annotated, please contact our support team.

For the benefit of Null Analysis, some APIs have been slightly constrained compared to the Javadoc description.
Here are some examples to illustrate the philosophy:

« System.getProperty(String key, String def) does not accept a null default value, which allows to ensure the
returned value is always non null.

+ Collections of the Java Collections Framework that can hold null elements (e.g. HashMap) do not accept
null elements. This allows APIs to return null (e.g. HashMap.get(Object)) only when an element is not
contained in the collection.

Implementations are left unchanged and still comply with the Javadoc description whether the Null Analysis is
enabled or not. So if these additional constraints are not acceptable for your project, please disable Null Analysis.
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Advanced Use

For more information about Null Analysis and inter-procedural analysis, please visit Eclipse JDT Null Analysis doc-
umentation.

4.14.10 Dependency Discoverer
Introduction

Dependency Discoverer is a tool that lists unresolved dependencies (types, methods and fields) of a
set of Java ARchive (JAR) files and .classfiles. It is a versatile tool and can be used in other contexts, for
instance, to list every dependency of a JAR file.

It can be used through a command-line interface, with the possibility to output the result in JSON or
XML format, allowing an easy scripting process.

Installation

This tool is available at https://github.com/MicroEJ/Tool-ApiDependencyDiscoverer. A JAR and Win-
dows executable version can be downloaded from the release page. It is also possible to clone and
import the project in the SDK and use it from sources.

Use

For usage information, see https://github.com/MicroEJ/Tool-ApiDependencyDiscoverer/blob/master/
README.md.

4.15 Advanced Tools

4.,15.1 MicroEJ Linker
Overview

MicroEJ Linker is a standard linker that is compliant with the Executable and Linkable File format (ELF).

MicroEJ Linker takes one or several relocatable binary files and generates an image representation using a descrip-
tion file. The process of extracting binary code, positioning blocks and resolving symbols is called linking.

Relocatable object files are generated by SOAR and third-party compilers. An archive file is a container of Relocat-
able object files.

The description file is called a Linker Specific Configuration file (Isc). It describes what shall be embedded, and how
those things shall be organized in the program image. The linker outputs :

+ An ELF executable file that contains the image and potential debug sections. This file can be directly used by
debuggers or programming tools. It may also be converted into a another format (Intel* hex, Motorola* s19,
rawBinary, etc.) using external tools, such as standard GNU binutils toolchain (objcopy, objdump, etc.).

« Amap file, in XML format, which can be viewed as a database of what has been embedded and resolved by
the linker. It can be easily processed to get a sort of all sizes, call graphs, statistics, etc.

« The linker is composed with one or more library loaders, according to the platform’s configuration.
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ELF Overview

An ELF relocatable file is split into several sections:
« allocation sections representing a part of the program
« control sections describing the binary sections (relocation sections, symbol tables, debug sections, etc.)

An allocation section can hold some image binary bytes (assembler instructions and raw data) or can refer to an
interval of memory which makes sense only at runtime (statics, main stack, heap, etc.). An allocation section is an
atomic block and cannot be split. A section has a name that by convention, represents the kind of data it holds.
For example, .text sections hold binary instructions, .bss sections hold read-write static data, .rodata hold
read-only data, and .data holds read-write data (initialized static data). The nameis used in the .Isc file to organize
sections.

A symbol is an entity made of a name and a value. A symbol may be absolute (link-time constant) or relative to a
section: Its value is unknown until MicroEJ Linker has assigned a definitive position to the target section. A symbol
can be local to the relocatable file or global to the system. All global symbol names should be unique in the system
(the name is the key that connects an unresolved symbol reference to a symbol definition). A section may need the
value of symbols to be fully resolved: the address of a function called, address of a static variable, etc.

Linking Process

The linking process can be divided into three main steps:

1. Symbols and sections resolution. Starting from root symbols and root sections, the linker embeds all sec-
tions targeted by symbols and all symbols referred by sections. This process is transitive while new symbols
and/or sections are found. At the end of this step, the linker may stop and output errors (unresolved symbols,
duplicate symbols, unknown or bad input libraries, etc.)

2. Memory positioning. Sections are laid out in memory ranges according to memory layout constraints de-
scribed by the Isc file. Relocations are performed (in other words, symbol values are resolved and section
contents are modified). At the end of this step, the linker may stop and output errors (it could not resolve
constraints, such as not enough memory, etc.)

3. Anoutput ELF executable file and map file are generated.

A partial map file may be generated at the end of step 2. It provides useful information to understand why the link
phase failed. Symbol resolution is the process of connecting a global symbol name to its definition, found in one of
the linker input units. The order the units are passed to the linker may have an impact on symbol resolution. The
rules are:

+ Relocatable object files are loaded without order. Two global symbols defined with the same name result in
an unrecoverable linker error.

« Archive files are loaded on demand. When a global symbol must be resolved, the linker inspects each archive
unit in the order it was passed to the linker. When an archive contains a relocatable object file that declares
the symbol, the object file is extracted and loaded. Then the first rule is applied. It is recommended that you
group object files in archives as much as possible, in order to improve load performances. Moreover, archive
files are the only way to tie with relocatable object files that share the same symbols definitions.

+ Asymbol name is resolved to a weak symbol if - and only if - no global symbol is found with the same name.
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Linker Specific Configuration File Specification

Description

A Linker Specific Configuration (Lsc) file contains directives to link input library units. An Isc file is written in an XML
dialect, and its contents can be divided into two principal categories:

« Symbols and sections definitions.

« Memory layout definitions.

Listing 5: Example of Relocation of Runtime Data from FLASH to RAM

<?xml version="1.0" encoding="UTF-8"?>
<l--
An example of linker specific configuration file
-=>
<lsc name="MyAppInFlash">
<include name="subfile.lscf"/>
<l--
Define symbols with arithmetical and logical expressions
-—>
<defSymbol name="FlashStart” value="0"/>
<defSymbol name="FlashSize" value="0x10000"/>
<defSymbol name="FlashEnd” value="FlashStart+FlashSize-1"/>
<l--
Define FLASH memory interval
-—>
<defSection name="FLASH" start="FlashStart” size="FlashSize"/>

==
Some memory layout directives

-—>

<memoryLayout ranges ="FLASH">
<sectionRef name ="x.text"/>
<sectionRef name ="x.data"/>

</memorylLayout>

</lsc>

File Fragments

An Isc file can be physically divided into multiple Isc files, which are called Isc fragments. Lsc fragments may be
loaded directly from the linker path option, or indirectly using the include tag in an lsc file.

Lsc fragments start with the root tag 1scFragment . By convention the lsc fragments file extensionis . 1scf. From
here to the end of the document, the expression “the Isc file” denotes the result of the union of all loaded (directly
and indirectly loaded) Isc fragments files.
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Symbols and Sections

A new symbol is defined using defSymbol tag. A symbol has a name and an expression value. All symbols defined
in the lsc file are global symbols.

A new section is defined using the defSection tag. A section may be used to define a memory interval, or define
a chunk of the final image with the description of the contents of the section.

Memory Layout

A memory layout contains an ordered set of statements describing what shall be embedded. Memory positioning
can be viewed as moving a cursor into intervals, appending referenced sections in the order they appear. A symbol
can be defined as a “floating” item: Its value is the value of the cursor when the symbol definition is encountered.
In the example below, the memory layout sets the FLASH section. First, all sections named . text are embedded.
The matching sections are appended in a undefined order. To reference a specific section, the section shall have a
unique name (for example a reset vector is commonly called .reset or .vector,etc.). Then, the floating symbol
dataStart is set to the absolute address of the virtual cursor right after embedded .text sections. Finally all
sections named .data are embedded.

A memory layout can be relocated to a memory interval. The positioning works in parallel with the layout ranges,
as if there were two cursors. The address of the section (used to resolve symbols) is the address in the relocated
interval. Floating symbols can refer either to the layout cursor (by default), or to the relocated cursor, using the
relocation attribute. A relocation layout is typically used to embed data in a program image that will be used
at runtime in a read-write memory. Assuming the program image is programmed in a read only memory, one of
the first jobs at runtime, before starting the main program, is to copy the data from read-only memory to RAM,
because the symbols targeting the data have been resolved with the address of the sections in the relocated space.
To perform the copy, the program needs both the start address in FLASH where the data has been put, and the
start address in RAM where the data shall be copied.

Listing 6: Example of Relocation of Runtime Data from FLASH to RAM

<memorylLayout ranges="FLASH"” relocation="RAM" image="true">
<defSymbol name="DataFlashStart"” value="."/>
<defSymbol name="DataRamStart” value=" ." relocation="true"/>
<sectionRef name=".data"/>
<defSymbol name="DataFlashLimit"” value="."/>

</memorylLayout>

Note: the symbol DataRamStart is defined to the start address where .data sections will be inserted in RAM
memory.

Tags Specification

Here is the complete syntactical and semantical description of all available tags of the .1sc file.
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Table 4: Linker Specific Configuration Tags

Tags Attributes Description
Defines a new section. A floating section only holds a declared size
attribute. A fixed section declares at least one of the start / end at-
tributes. When this tag is empty, the section is a runtime section, and
must define at least one of the start, end or size attributes. When
this tag is not empty (when it holds a binary description), the section
is an image section.
name Name of the section. The section name may not be unique. However,
it is recommended that you define a unique name if the section must
be referred separately for memory positioning.
start Optional. Expression defining the absolute start address of the sec-
tion. Must be resolved to a constant after the full load of the Isc file.
end Optional. Expression defining the absolute end address of the section.
Must be resolved to a constant after the full load of the lsc file.
size Optional. Expression defining the size in bytes of the section. Invari-
ant: (end-start)+1=size . Must be resolved to a constant after the
full load of the Isc file.
align Optional. Expression defining the alignment in bytes of the section.
rootSection | Optional. Boolean value. Sets this section as a root section to be em-
bedded even if it is not targeted by any embedded symbol. See also
rootSection tag.
symbolPrefix | Optional. Used in collaboration with symbolTags . Prefix of symbols
embedded in the auto-generated section. See Auto-generated Sec-
tions.
symbolTags Optional. Used in collaboration with symbolPrefix . Comma sepa-
rated list of tags of symbols embedded in the auto-generated section.
See Auto-generated Sections.
Defines a new global symbol. Symbol name must be unique in the
linker context
name Name of the symbol.
type Optional. Type of symbol usage. This may be necessary to set the type
of a symbol when using third party ELF tools. There are three types: -
none : default. No special type of use. - function: symbol describes
a function. - data: symbol describes some data.
value The value ".” defines a floating symbol that holds the current cur-
sor position in a memory layout. (This is the only form of this tag that
can be used as a memorylLayout directive) Otherwise value is an ex-
pression. A symbol expression must be resolved to a constant after
memory positioning.
relocation Optional. The only allowed value is true . Indicates that the value
of the symbol takes the address of the current cursor in the memory
layout relocation space. Only allowed on floating symbols.
rootSymbol Optional. Boolean value. Sets this symbol as a root symbol that must
be resolved. See also rootSymbol tag.
weak Optional. Boolean value. Sets this symbol as a weak symbol.
memorylLayout directive. Defines a named group of sections. Group
name may be used in expression macros START, END, SIZE.All mem-
oryLayout directives are allowed within this tag (recursively).
name The name of the group.
Includes an lsc fragment file, semantically the same as if the fragment
contents were defined in place of the include tag.

continues on next page

defSection

defSymbol

group

include
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Table 4 - continued from previous page
Tags Attributes Description
name Name of the file to include. When the name is relative, the file sepa-
rator is /, and the file is relative to the directory where the current
[sc file or fragment is loaded. When absolute, the name describes a
platform-dependent filename.
Root tag for an .Isc file.
name Name of the Isc file. The ELF executable output will be {name}.out,
and the map file will be {name}.map
1scFragment Root tag for an Isc file fragment. Lsc fragments are loaded from the
linker path option, or included from a master file using the include
tag.
Describes the organization of a set of memory intervals. The memory
layouts are processed in the order in which they are declared in the
file. The same interval may be organized in several layouts. Each lay-
out starts at the value of the cursor the previous layout ended. The fol-
lowing tags are allowed within a memoryLayout directive: defSymbol
(under certain conditions), group, memoryLayoutRef, padding,and
sectionRef .
ranges Exclusive with default. Comma-separated ordered list of fixed sections
to which the layout is applied. Sections represent memory segments.
image Optional. Boolean value. false if not set. If true, the layout de-
scribes a part of the binary image: Only image sections can be embed-
ded. If false, only runtime sections can be embedded.
relocation Optional. Name of the section to which this layout is relocated.
name Exclusive with ranges. Defines a named memorylLayout directive in-
stead of specifying a concrete memory location. May be included in a
parent memoryLayout using memoryLayoutRef.
memorylLayout directive. Provides an extension-point mechanism to
include memorylLayout directives defined outside the current one.
name All directives of memoryLayout defined with the same name are in-
cluded in an undefined order.
memorylLayout directive. Append padding bytes to the current cursor.
Either size or align attributes should be provided.
size Optional. Expression must be resolved to a constant after the full load
of the Isc file. Increment the cursor position with the given size.
align Optional. Expression must be resolved to a constant after the full load
of the lsc file. Move the current cursor position to the next address that
matches the given alignment. Warning: when used with relocation,
the relocation cursor is also aligned. Keep in mind this may increase
the cursor position with a different amount of bytes.
address Optional. Expression must be resolved to a constant after the full load
of the Isc file. Move the current cursor position to the given absolute
address.
fill Optional. Expression must be resolved to a constant after the full load
of the Isc file. Fill padding with the given value (32 bits).
References a section name that must be embedded. This tagis not a
definition. It forces the linker to embed all loaded sections matching
the given name.
name Name of the section to be embedded.
References a symbol that must be resolved. This tag is not a definition.
It forces the linker to resolve the value of the symbol.
name Name of the symbol to be resolved.

1sc

memorylLayout

memorylLayoutRef

padding

rootSection

rootSymbol

continues on next page
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Table 4 - continued from previous page
Tags Attributes Description
Memory layout statement. Embeds all sections matching the given
name starting at the current cursor address.
file Select only sections defined in a linker unit matching the given file
name. Thefile nameis the simple name without any file separator, e.g.
bsp.o or mylink.lsc. Link units may be object files within archive
units.
name Name of the sections to embed. When the name ends with *, all sec-
tions starting with the given name are embedded (name completion),
except sections that are embedded in another sectionRef using the ex-
act name (without completion).
symbol Optional. Only embeds the section targeted by the given symbol. This
is the only way at link level to embed a specific section whose name is
not unique.
force Optional. Deprecated. Replaced by the rootSection tag. The only
allowed value is true. By default, for compaction, the linker embeds
only what is needed. Setting this attribute will force the linker to em-
bed all sections that appear in all loaded relocatable files, even sec-
tions that are not targeted by a symbol.
sort Optional. Specifies that the sections must be sorted in memory. The
value can be: - order : the sections will be in the same order as the
input files - name : the sections are sorted by their file names - unit
: the sections declared in an object file are grouped and sorted in the
order they are declared in the object file
Binary section statement. Describes the four next raw bytes of the
section. Bytes are organized in the endianness of the target ELF ex-
ecutable.
value Expression must be resolved to a constant after the full load of the Isc
file (32 bits value).
Binary section statement. Fills the section with the given expression.
Bytes are organized in the endianness of the target ELF executable.
size Expression defining the number of bytes to be filled.
value Expression must be resolved to a constant after the full load of the Isc
file (32 bits value).

sectionRef

u4

fill

Expressions

An attribute expression is a value resulting from the computation of an arithmetical and logical expression. Sup-
ported operators are the same operators supported in the Java language, and follow Java semantics:

« Unaryoperators: + , - , ~ | |

« Binaryoperators: + , -, %, / | %, <<, >>> 0>> <> <= >= === & |0
&& , ||

« Ternary operator: cond ? ifTrue : ifFalse
« Built-in macros:

- START(name) : Get the start address of a section or a group of sections

END(name) : Get the end address of a section or a group of sections

SIZE(name) : Get the size of a section or a group of sections. Equivalent to END(name)-START (name)

TSTAMPH() , TSTAMPL () : Get 32 bits linker time stamp (high/low part of system time in milliseconds)

4.15. Advanced Tools 241



MicroEJ Documentation, Revision d4ede019

- SUM(name, tag) : Get the sum of an auto-generated section (Auto-generated Sections) column. The col-
umn is specified by its tag name.

An operand is either a sub expression, a constant, or a symbol name. Constants may be written in decimal (127) or
hexadecimal form (@x7F ). There are no boolean constants. Constant value @ means false, and other constants’
values mean true . Examples of use:

value="symbol+3"
value="((symbol1%4)-(symbol2%3)"

Note: Ternary expressions can be used to define selective linking because they are the only expressions that may
remain partially unresolved without generating an error. Example:

<defSymbol name="myFunction” value="condition ? symbl : symb2"/>

No error will be thrown if the condition is true and symb1 is defined, or the condition is false and symb2 is
defined, even if the other symbol is undefined.

Auto-generated Sections

The MicroEJ Linker allows you to define sections that are automatically generated with symbol values. This is com-
monly used to generate tables whose contents depends on the linked symbols. Symbols eligible to be embedded
in an auto-generated section are of the form: prefix_tag_suffix.Anauto-generated section isviewed as a table
composed of lines and columns that organize symbols sharing the same prefix. On the same column appear sym-
bols that share the same tag. On the same line appear symbols that share the same suffix. Lines are sorted in the
lexical order of the symbol name. The next line defines a section which will embed symbols starting with zeroinit
. The first column refers to symbols starting with zeroinit_start_;the second column refers to symbols starting
with zeroinit_end_.

<defSection
name=".zeroinit"
symbolPrefix="zeroInit"
symbolTags="start,end”
/>

Consider there are four defined symbols named zeroinit_start_xxx |, zeroinit_end_xxx ,
zeroinit_start_yyy and zeroinit_end_yyy . The generated section is of the form:

0x00: zeroinit_start_xxx
0x04: zeroinit_end_xxx
0x08: zeroinit_start_yyy
0x0C: zeroinit_end_yyy

If there are missing symbols to fill a line of an auto-generated section, an error is thrown.

Execution

MicroEJ Linker can be invoked through an ANT task. The task is installed by inserting the following code in an ANT
script

<taskdef
name="1linker"
classname="com.is2t.linker.GenericLinkerTask"
classpath="[LINKER_CLASSPATH]"

/>
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[LINKER_CLASSPATH] is a list of path-separated jar files, including the linker and all architecture-specific library
loaders.

The following code shows a linker ANT task invocation and available options.

<linker
doNotLoadAlreadyDefinedSymbol="[true|false]"
endianness="[little|big|none]”
generateMapFile="[true|false]”
ignoreWrongPositioningForEmptySection="[true|false]”
lsc="[filename]”
linkPath="[path1:...pathN]"
mergeSegmentSections="[true|false]”
noWarning="[true|false]"
outputArchitecture="[tag]"
outputName="[name]"”
stripDebug="[true|false]”
toDir="[outputDir]”
verboselLevel="[0...9]"

>
<!-- ELF object & archives files using ANT paths / filesets -->
<fileset dir="xxx" includes="*.0">
<fileset file="xxx.a">
<fileset file="xxx.a">
<!-- Properties that will be reported into .map file -->
<property name="myProp"” value="myValue"/>

</linker>
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Table 5: Linker Options Details

Option Description
_ Silently skip the load of a global symbol if it has already
doNotLoadAlreadyDefinedSymbol been loaded before. ( false by default. Only the first

loaded symbol is taken into account (in the order input
files are declared). This option only affects the load se-
mantic for global symbols, and does not modify the se-
mantic for loading weak symbols and local symbols.

Explicitly declare linker endianness [little, big] or

endianness [none] for auto-detection. All input files must declare
the same endianness or an error is thrown.
Generate the .map file ( true by default).
generateMapFile

Silently ignore wrong section positioning for zero size
sections. ( false by default).
Provide a master Iscfile. This optionis mandatory unless

ignoreWrongPositioningForEmptySection

lsc the linkPath option is set.
) Provide a set of directories into which to load link file
linkPath fragments. Directories are separated with a platform-
path separator. This option is mandatory unless the 1sc
option is set.
Silently skip the output of warning messages.
noWarning

(experimental). Generate a single section per segment.
This may speed up the load of the output executable file
into debuggers or flasher tools. ( false by default).

Set the architecture tag for the output ELF file (ELF ma-
outputArchitecture chineid).

mergeSegmentSections

Specify the output name of the generated files. By de-
fault, take the name provided in the Isc tag. The output
ELF executable filename will be name.out. The map file-
name will be name.map.

Remove all debug information from the output ELF file.
A stripped output ELF executable holds only the binary
image (no remaining symbols, debug sections, etc.).
Specify the output directory in which to store generated
files. Output filenames are inthe form: od + separator
+ value of the lsc name attribute + suffix.
By default, without this option, files are generated in the
directory from which the linker was launched.

Print additional messages on the standard output about
linking process.

outputName

stripDebug

toDir

verboselLevel
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Error Messages

This section lists MicroEJ Linker error messages.

Table 6: Linker-Specific Configuration Tags

Message ID Description
0 The linker has encountered an unexpected internal error. Please contact the support hot-
line.

1 A library cannot be loaded with this linker. Try verbose to check installed loaders.

2 No Isc file provided to the linker.

3 Afile could not be loaded. Check the existence of the file and file access rights.

4 Conflictinginput libraries. A global symbol definition with the same name has already been
loaded from a previous object file.

5 Completion (*) could not be used in association with the force attribute. Must be an exact
name.

6 A required section refers to an unknown global symbol. Maybe input libraries are missing.

7 Alibrary loader has encountered an unexpected internal error. Check input library file in-
tegrity.

8 Floating symbols can only be declared inside memorylLayout tags.

9 Invalid value format. For example, the attribute relocation in defSymbol must be a
boolean value.

10 Missing one of the following attributes: address, size, align.

1 Too many attributes that cannot be used in association.

13 Negative padding. Memory layout cursor cannot decrease.

15 Not enough space in the memory layout intervals to append all sections that need to be

embedded. Check the output map file to get more information about what is required as
memory space.

16 A block is referenced but has already been embedded. Most likely a block has been espe-
cially embedded using the force attribute and the symbol attribute.

17 A block that must be embedded has no matching sectionRef statement.

19 An 10 error occurred when trying to dump one of the output files. Check the output direc-
tory option and file access rights.

20 size attribute expected.

21 The computed size does not match the declared size.

22 Sections defined in the lsc file must be unique.

23 One of the memory layout intervals refers to an unknown Isc section.

24 Relocation must be done in one and only one contiguous interval.

25 force and symbol attributes are not allowed together.

26 XML char data not allowed at this position in the lsc file.

27 A section which is a part of the program image must be embedded in an image memory
layout.

28 A section which is not a part of the program image must be embedded in a non-image
memory layout.

29 Expression could not be resolved to a link-time constant. Some symbols are unresolved.

30 Sections used in memory layout ranges must be sections defined in the lsc file.

31 Invalid character encountered when scanning the lsc expression.

32 Arecursive include cycle was detected.

33 An alignment inconsistency was detected in a relocation memory layout. Most likely one
of the start addresses of the memory layout is not aligned on the current alignment.

34 An error occurs in a relocation resolution. In general, the relocation has a value that is out
of range.

continues on next page
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Table 6 - continued from previous page

35 symbol and sort attributes are not allowed together.

36 Invalid sort attribute value is not one of order, name, or no.

37 Attribute start or end in defSection tagis notallowed when defining a floating section.

38 Autogenerated section can build tables according to symbol names (see Auto-generated
Sections). A symbol is needed to build this section but has not been loaded.

39 Deprecated feature warning. Remains for backward compatibility. It is recommended that
you use the new indicated feature, because this feature may be removed in future linker
releases.

40 Unknown output architecture. Either the architecture ID is invalid, or the library loader has
not been loaded by the linker. Check loaded library loaders using verbose option.

41...43 Reserved.

44 Duplicate group definition. A group name is unique and cannot be defined twice.

45 Invalid endianness. The endianness mnemonic is not one of the expected mnemonics (
little,big,none).

46 Multiple endiannesses detected within loaded input libraries.

47 Reserved.

48 Invalid type mnemonic passed to a defSymbol tag. Must be one of none, function, or
data.

49 Warning. A directory of link path is invalid (skipped).

50 No linker-specific description file could be loaded from the link path. Check that the link
path directories are valid, and that they contain .1sc or .1scf files.

51 Exclusive options (these options cannot be used simultaneously). For example,
-linkFilename and -linkPath are exclusive; either select a master Isc file or a path from
which to load .1scf files.

52 Name given to a memorylLayoutRef ora memoryLayout isinvalid. It must not be empty.

53 A memorylLayoutRef with the same name has already been processed.

54 A memorylLayout must define ranges orthe name attribute.

55 No memory layout found matching the name of the current memoryLayoutRef .

56 Anamed memorylLayout is declared with a relocation directive, but the relocation interval
is incompatible with the relocation interval of the memorylLayout that referenced it.

57 A named memoryLayout has not been referenced. Every declared memorylLayout must
be processed. Anamed memorylLayout must be referenced by a memorylLayoutRef state-
ment.

58 SUM operator expects an auto-generated section.

59 SUM operator tag is unknown for the targetted auto-generated section.

60 SUM operator auto-generated section name is unknown.

61 An option is set for an unknown extension. Most likely the extension has not been set to
the linker classpath.

62 Reserved.

63 ELF unit flags are inconsistent with flags set using the -forceFlags option.

64 Reserved.

65 Reserved.

66 Found an executable object file as input (expected a relocatable object file).

67 Reserved.

68 Reserved.

69 Reserved.

70 Not enough memory to achieve the linking process. Try to increase JVM heap that is run-
ning the linker (e.g. by adding option -Xmx1024M to the JRE command line).
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Map File Interpretor

The map file interpretor is a tool that allows you to read, classify and display memory information dumped by
the linker map file. The map file interpretor is a graph-oriented tool. It supports graphs of symbols and allows
standard operations on them (union, intersection, subtract, etc.). It can also dump graphs, compute graph total
sizes, list graph paths, etc.

The map file interpretor uses the standard Java regular expression syntax.

It is used internally by the graphical Memory Map Analyzer tool.

Commands:

e createGraph graphName symbolRegExp ... section=regexp

createGraph all section=.=*

Recursively create a graph of symbols from root symbols and sections described as regular expressions. For
example, to extract the complete graph of the application:

e createGraphNoRec symbolRegExp ... section=regexp

The above lineis similar to the previous statement, but embeds only declared symbols and sections (without
recursive connections).

¢ removeGraph graphName

Removes the graph for memory.

listGraphs

Lists all the created graphs in memory.

listSymbols graphName

Lists all graph symbols.

¢ listPadding

Lists the padding of the application.

e listSections graphName

Lists all sections targeted by all symbols of the graph.

e inter graphResult g1 ... gn
Creates a graph which is the intersection of g1/\ ... /\gn.
e union graphResult g1 ... gn

Creates a graph which is the union of g1\/ ...\/ gn.

e substract graphResult gl ... gn

Creates a graph which is the substract of g1\ ... \ gn.
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¢ reportConnections graphName

Prints the graph connections.

e totalImageSize graphName

Prints the image size of the graph.

¢ totalDynamicSize graphName

Prints the dynamic size of the graph.

accessPath symbolName

The above line prints one of the paths from a root symbol to this symbol. This is very useful in helping you
understand why a symbol is embedded.

* echo arguments

Prints raw text.

e exec commandFile

Execute the given commandFile. The path may be absolute or relative from the current command file.

4.15.2 MicroEJ Test Suite Engine

Introduction

The MicroEJ Test Suite Engine is a generic tool made for validating any development project using automatic test-
ing.
This section details advanced configuration for users who wish to integrate custom test suites in their build flow.

The MicroEJ Test Suite Engine allows the user to test any kind of projects within the configuration of a generic Ant
file.
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TESTSUITE ENGINE

FOR EACH TEST CASE
-

R/
Test Build & Link
Test Deployment Trace Redirection

©

15/

Trace Analysis

Test Execution

The MicroEJ Test Suite Engine is already pre-configured for running test suites on a MicroEJ Platform (either on
Simulator or on Device).

« For Application and Libraries, refer to Test Suite with JUnit section.

« For Foundation Libraries Test Suites, refer to Platform Test Suite section.

Using the MicroEJ Test Suite Ant Tasks

Multiple Ant tasks are available in the testsuite-engine.jar provided in the Build Kit:
« testsuite allowsthe usertoruna given test suite and to retrieve an XML report document in a JUnit format.

« javaTestsuite is asubtask of the testsuite task, used to run a specialized test suite for Java (will only
run Java classes).

« htmlReport is atask which will generate an HTML report from a list of JUnit report files.

The testsuite Task

The following attributes are mandatory:
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Table 7: testsuite task mandatory attributes

Attribute Name | Description

The output folder of the test suite. The final report will be generated at [outputDirl]/
outputDir [label]l/[reportName].xml , see the testsuiteReportFileProperty and

testsuiteReportDirProperty attributes.

The harness script must be an Ant script and it is the script which will be called for each test
harnessScript

by the test suite engine. It is called with a basedir located at output location of the current
test.

The test suite engine provides the following properties to the harness script giving all the informations to start the

test:

Table 8: harnessScript properties

Attribute Name

Description

The output name of the current test in the report. Default value is the relative path of the

report.dir

testsuite. test. It can be manually set by the user. More details on the output name are available in the
test.name section Specific Custom Properties.
The current test absolute path in the filesystem.
testsuite.
test.path
. The absolute path to the custom properties of the current test (see the property
testsuite. customPropertiesExtension)
test.
properties
. The absolute path to the common properties of all the tests (see the property
testsuite. commonProperties )
common.
properties
The absolute path to the directory of the final report.
testsuite.

The following attributes are optional:
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Table 9: testsuite task optional attributes

Attribute | Description Default value
Name
) The time in seconds before any test is considerated as un-
timeOut | knhown. Setitto ¢ to disable the time-out. 60
The required level to output messages from the test suite.
verboselevedan be one of those values: error , warning , info, | 1NfO
verbose, debug.
The final report name (without extension).
reportName testsuite-report
The extension of the custom properties for each test. For in-
customPropegifestifitis s8tto .options , a test named xxx/Testl. | -Properties
class will be associated with xxx/Test1.options. If afile
exists for a test, the property testsuite.test.properties
is set with its absolute path and given to the harnessScript
If the test path references a directory, then the custom
properties path is the concatenation of the test path and the
customPropertiesExtension value.
The properties to apply to every test of the test suite. Those | no common properties
commonPropedtibas might be overridden by the custom properties of
each test. If this option is set and the file exists, the prop-
erty testsuite.common.properties is set to the absolute
path of the harnessScript file
The build label. timestamp of when the test suite
label was invoked.
The name of the current tested product.
productName TestSuite
The location of your Java VM to start the test suite (the o
jvm harnessScript is called asis: [jvm] [...1 -buildfile | Java.home locationif the property
[harnessScript]). is set, java otherwise.
_ The arguments to pass to the Java VM started for each test. | None.
jvmargs
The name of the Ant property in which the path of the
teStSUiteRqﬂ?‘aﬂtﬁéﬂJSP{‘?é’eﬁWed. Path is [outputDir]/[label]/ | testsuite. report.file
[reportName].xml
The name of the Ant property in which is store the path of the
testsulteRefpedtoty ortheTial report. Pathis [outputDir]/[label]. | testsuite.report.dir
_ The name of the Ant property in which you want to have the | None
testsuite

RGael (TSP test suite (true or false), depending if every
tests successfully passed the test suite or not. Ignored tests
do not affect this result.

Finally, you have to give as nested element the path containing the tests.

Table 10: testsuite task nested elements

Element Name

Description

Containing all the file of the tests which will be launched by the test suite.

testPath

Any test in the intersection between testIgnoredPath and testPath will be executed by
testignoredPath the test suite, but will not appear in the JUnit final report. It will still generate a JUnit re-
(optional) port for each test, which will allow the HTML report to let them appears as “ignored” if it is

enough to appears on the HTML report.

generated. Mostly used for known bugs which are not considered as failure but still relevant
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Listing 7: Example of test suite task invocation

<!-- Launch the testusite engine -->

<testsuite:testsuite
timeOut="${microej.kf.testsuite.timeout}”
outputDir="${target.test.xml}/testkf”
harnessScript="${com.is2t.easyant.plugins#microej-kf-testsuite.microej-kf-testsuite-harness-jpf-emb.

—xml.file}"”
commonProperties="${microej.kf.launch.propertyfile}"
testsuiteResultProperty="testkf.result"
testsuiteReportDirProperty="testkf.testsuite.report.dir”
productName="${module.name} testkf"”
jvmArgs="${microej.kf.testsuite.jvmArgs}"
lockPort="${microej.kf.testsuite.lockPort}"
verboselLevel="${testkf.verbose.level}"

>
<testPath refid="target.testkf.path"/>

</testsuite:testsuite>

The javaTestsuite Task

This task extends the testsuite task, specializing the test suite to only start real Java class. This task retrieves
the classname of the tests from the classfile and provides new properties to the harness script:

Table 11: javaTestsuite task properties

Property Name | Description

) The classname of the current test. The value of the property testsuite.test.name isalso
testsuite. set to the classname of the current test.
test.class

) The classpath of the current test.
testsuite.
test.
classpath

Listing 8: Example of javaTestsuite task invocation
<!-- Launch test suite -->

<testsuite:javaTestsuite
verboselLevel="${microej.testsuite.verboselLevel}”
timeOut="${microej.testsuite.timeout}"
outputDir="${target.test.xml}/@{prefix}"
harnessScript="${harness.file}"
commonProperties="${microej.launch.propertyfile}"
testsuiteResultProperty="@{prefix}.result”
testsuiteReportDirProperty="@{prefix}.testsuite.report.dir”
productName="${module.name} @{prefix}"
jvmArgs="${microej.testsuite.jvmArgs}”
lockPort="${microej.testsuite.lockPort}"
retryCount="${microej.testsuite.retry.count}”
retryIf="${microej.testsuite.retry.if}"
retryUnless="${microej.testsuite.retry.unless}"”

<testPath refid="target.@{prefix}.path"/>

(continues on next page)
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(continued from previous page)

<testIgnoredPath refid="tests.@{prefix}.ignored.path” />
</testsuite:javaTestsuite>

The htmlReport Task

This task allow the user to transform a given path containing a sample of JUnit reports to an HTML detailed report.
Here is the attributes to fill:

« Anested fileset element containing all the JUnit reports of each test. Take care to exclude the final JUnit
report generated by the test suite.

« Anested element report:

- format : The format of the generated HTML report. Must be noframes or frames. When noframes
format is choosen, a standalone HTML file is generated.

- todir: The output folder of your HTML report.

- The report tagaccepts the nested tag param with name and expression attributes. These tags can
pass XSL parameters to the stylesheet. The built-in stylesheets support the following parameters:

* PRODUCT : the product name that is displayed in the title of the HTML report.
* TITLE :the comment thatis displayed in the title of the HTML report.

Note: It is advised to set the format to noframes if your test suite is not a Java test suite. If the format is set to
frames, with anon-Java MicroEJ Test Suite, the name of the links will not be relevant because of the non-existency
of packages.

Listing 9: Example of htmlReport task invocation

<!-- Generate HTML report -->
<testsuite:htmlReport>
<fileset dir="${@{prefix}.testsuite.report.dir}">
<include name="x*/x.xml"/> <!-- include unary reports -->
<exclude name="*x/bin/*x*/%*.xml"/> <!-- exclude test bin files -->
<exclude name="x.xml"/> <!-- exclude global report -->
</fileset>
<report format="noframes” todir="${target.test.html}/@{prefix}"/>
</testsuite:htmlReport>

Using the Trace Analyzer

This section will shortly explains how to use the Trace Analyzer . The MicroEJ Test Suite comes with an archive
containing the Trace Analyzer which can be used to analyze the output trace of an application. It can be used
from different forms;

« The FileTraceAnalyzer will analyze a file and research for the given tags, failing if the success tag is not
found.

« The SerialTraceAnalyzer will analyze the data from a serial connection.
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The TraceAnalyzer Tasks Options

Here is the common options to all TraceAnalyzer tasks:
+ successTag: the regular expression which is synonym of success when found (by default . *PASSED. x ).
« failureTag: the regular expression which is synonym of failure when found (by default . *FAILED.*).
« verboselLevel :int value between 0 and 9 to define the verbose level.
« waitingTimeAfterSuccess : waiting time (in s) after success before closing the stream (by default 5).

« noActivityTimeout : timeout (in s) with no activity on the stream before closing the stream. Set it to 0 to
disable timeout (default value is 0).

« stopEOFReached: boolean value. Setto true to stop analyzing when input stream EOF is reached. If false
, continue until timeout is reached (by default false).

« onlyPrintableCharacters:booleanvalue. Setto true toonly dump ASCII printable characters (by default
false).

The FileTraceAnalyzer Task Options

Here is the specific options of the FileTraceAnalyzer task:

« traceFile: path to the file to analyze.

The SerialTraceAnalyzer Task Options

Here is the specific options of the SerialTraceAnalyzer task:
+ port:the comm port to open.
« baudrate : serial baudrate (by default 9600).
« databits: databits (5]6|7|8) (by default 8).
+ stopBits: stopbits (0[1|3 for (1_5)) (by default 1).

« parity: none | odd | event (bydefault none).

Appendix

The goal of this section is to explain some tips and tricks that might be useful in your usage of the test suite engine.

Specific Custom Properties

Some custom properties are specifics and retrieved from the test suite engine in the custom properties file of a test.

« The testsuite.test.name property is the output name of the current test. Here are the steps to compute
the output name of a test:

- If the custom properties are enabled and a property named testsuite.test.name isfind on the cor-
responding file, then the output name of the current test will be set to it.

- Otherwise, if the running MicroEJ Test Suite is a Java test suite, the output name is set to the class name
of the test.
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- Otherwise, from the path containing all the tests, a common prefix will be retrieved. The output name
will be set to the relative path of the current test from this common prefix. If the common prefix equals
the name of the test, then the output name will be set to the name of the test.

- Finally, if multiples tests have the same output name, then the current name will be followed by _XXX
, an underscore and an integer.

« The testsuite.test.timeout property allow the userto redefine the time out for each test. If it is negative
or not an integer, then global timeout defined for the MicroEJ Test Suite is used.

4.16 Graphical User Interface

This section presents libraries relative to the user interface.

The following schema shows the overall architecture and modules:

Widget Examples Applications APP

ADD-ON LIBRARIES

LIBRARIES
VIRTUALIZATION

Graphical Engine

ABSTRACTION LAYERS

BSP Drivers Drivers Drivers

RTOS/OS

PLATFORM

D PROCESSOR
CORE LCD

HARDWARE

Fig. 74: Graphical User Interface Overview
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Note: This chapter describes the current Graphical User Interface version 3, provided by Ul Pack version 13.0.0
or higher. If you are using the former Graphical User Interface version 2 (provided by MicroEJ Ul Pack version up
to 12.4.x), please refer to this MicroEJ Documentation Archive.

4.16.1 MicroUl

Introduction

MicroUl Foundation Library provides access to a pixel-based display and inputs.
The aim of this library is to enable the creation of user interface in Java by reifying hardware capabilities.

To use the MicroUl Foundation Library, add MicroUl APl module to a module description file:

<dependency org="ej.api" name="microui” rev="3.1.0"/>

Drawing Foundation Library extends MicroUI drawing APIs' with more complex ones such as:
« thick line, arc, circle and ellipse
+ polygon
« image deformation and rotation

To use the Drawing Foundation Library, add Drawing AP module to a module description file:

<dependency org="ej.api" name="drawing" rev="1.0.3"/>

Images

Immutable Images
Overview

Immutable images are graphical resources that can be accessed with a call to ej.microui.display.Image.getimage()
orej.microui.display.Resourcelmage.loadimage(). As their name suggests, immutable images can not be modified.
Therefore, there is no way to get a Graphics Context to draw into these images. To be displayed, these images have
to be converted from their source format to a RAW format. The conversion can either be done at:

« build-time (using the image generator tool),
« run-time (using the relevant decoder library).

Immutable images are declared in Classpath *.images.list files (orin *.imagesext.list for an external re-
source, see Application Resources).

! These APIs were formerly included in MicroUl 2.x
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Image

es no=external

*.images.list *.imagesext.list

The file format is a standard Java properties file, each line representing a / separated resource path relative to the
Classpath root referring to a standard image file (e.g. .png, .Jjpg). The resource may be followed by an optional
parameter (separated by a : ) which defines and/or describes the image output file format (RAW format). When no
option is specified, the image is embedded as-is and will be decoded at run-time. Example:

# The following image is embedded
# as a PNG resource (decoded at run-time)
com/mycompany/MyImagel.png

# The following image is embedded
# as a 16 bits format without transparency (decoded at build-time)
com/mycompany/MyImage?2.png:RGB565
# The following image is embedded

# as a 16 bits format with transparency (decoded at build-time)
com/mycompany/MyImage3.png:ARGB1555

Configuration File

Here is the format of the *.images.list files.

ConfigFile ::= Line [ 'EOL' Line J*

Line ::= ImagePath [ ':' ImageOption Jx
ImagePath ::= Identifier [ '/' Identifier Jx
ImageOption =R EA

Identifier ::= Letter [ LetterOrDigit Jx
Letter ::= 'a-zA-Z_$'

LetterOrDigit ::= 'a-zA-Z_$0-9'
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Unspecified Output Format

When no output format is set in the images list file, the image is embedded without any conversion / compression.
This allows you to embed the resource as-is, in order to keep the source image characteristics (compression, bpp,
etc.). This option produces the same result as specifying an image as a resource in the MicroEJ launcher (i.e. in a
.resources.list file).

Advantages

+ Preserves the image characteristics;

+ Preserves the original image compression.
Disadvantages

+ Requires an image runtime decoder;

+ Requires some RAM in which to store the decoded image;

+ Requires execution time to decode the image.

imagel

Standard Output Formats

Depending on the target hardware, several generic output formats are available. Some formats may be directly
managed by the BSP display driver. Refer to the platform specification to retrieve the list of natively supported
formats.

Advantages
« The pixels layout and bits format are standard, so it is easy to manipulate these images on the C-side;
« Drawing an image is very fast when the display driver recognizes the format (with or without transparency);
« Supports or not the alpha encoding: select the most suitable format for the image to encode.
Disadvantages

+ No compression: the image size in bytes is proportional to the number of pixels, the transparency, and the
bits-per-pixel;

« Slower than display format when the display driver does not recognize the format: a pixel conversion is
required at runtime.

Select one the following format to use a generic format among this list: ARGB8888, RGB888, ARGB4444 , ARGB1555
, RGB565, A8, A4, A2, A1, C4, C2, C1, AC44, AC22 and AC11. The following snippets describe the color
conversion for each format:

« ARGB8888: 32 bits format, 8 bits for transparency, 8 per color.

int convertARGB8888toRAWFormat(int c){
return c;

3

« RGB888: 24 bits format, 8 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return c & Oxffffff;

3

4.16. Graphical User Interface 258



MicroEJ Documentation, Revision d4ede019

ARGB4444: 16 bits format, 4 bits for transparency, 4 per color.

int convertARGB8888toRAWFormat(int c){
return 0

| ((c & 0xf000E00) >> 16)

| ((c & 0x00f00000) >> 12)

| ((c & 0x0000f000) >> 8)

| ((c & 0x0000000) >> 4)

)

3

ARGB1555: 16 bits format, 1 bit for transparency, 5 per color.

int convertARGB8888toRAWFormat(int c){
return @
| (((c & 0xffo0000R0) == Oxff0O000RQ) ? 0x8000 : 0)
| ((c & 0xf80000) >> 9)
| ((c & 0x00f800) >> 6)
| ((c & 0x0000f8) >> 3)

’

RGB565: 16 bits format, 5 or 6 per color. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return @
| ((c & 0xf80000) >> 8)
| ((c & 0x00fco0) >> 5)
| ((c & 0x0000f8) >> 3)

’

A8: 8 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return oxff - (toGrayscale(c) & 0xff);
}

A4: 4 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & oOxff)) / ox11;
}

A2: 2 bits format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.

int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0xff)) / @x55;
3

Al: 1 bit format, only transparency is encoded. The color to apply when drawing the image, is the current
GraphicsContext color.
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int convertARGB8888toRAWFormat(int c){
return (Oxff - (toGrayscale(c) & 0oxff)) / oxff;

3

« C4: 4 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / 0x11;

}

« C2:2 bits format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & 0xff) / 0x55;
3

« C1:1bit format with grayscale conversion. Image is always fully opaque.

int convertARGB8888toRAWFormat(int c){
return (toGrayscale(c) & Oxff) / Oxff;

3

+ AC44: 4 bits for transparency, 4 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return 0
| ((color >> 24) & 0xf0Q)
| ((toGrayscale(color) & oxff) / ox11)

’

« AC22: 2 bits for transparency, 2 bits with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return @
| ((color >> 28) & 0xc0)
| ((toGrayscale(color) & oxff) / 0x55)

’

+ ACT1: 1 bit for transparency, 1 bit with grayscale conversion.

int convertARGB8888toRAWFormat(int c){
return @
| ((c & 0xff000000) == 0xff000O0O ? 0x2 : 0x0)
| ((toGrayscale(color) & Oxff) / Oxff)

’

Examples:

image1:ARGB8888
image2:RGB565
image3:A4
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Display Output Format

This format encodes the image into the exact display memory representation. If the image to encode contains
some transparent pixels, the output file will embed the transparency according to the display’s implementation
capacity. When all pixels are fully opaque, no extra information will be stored in the output file in order to free up
some memory space.

Note: When the display memory representation is standard, the display output format is automatically replaced
by a standard format.

Advantages
+ Drawing an image is very fast because no pixel conversion is required at runtime;
«+ Supports alpha encoding when display pixel format allow it.

Disadvantages

« No compression: the image size in bytes is proportional to the number of pixels.

imagel:display

RLE1 Output Format

Theimage engine can display embedded images that are encoded into a compressed format which encodes several
consecutive pixels into one or more 16-bit words. This encoding manages a maximum alpha level of 2 (alpha level
is always assumed to be 2, even if the image is not transparent).

« Several consecutive pixels have the same color (2 words):

- First 16-bit word specifies how many consecutive pixels have the same color (pixels colors converted in
RGB565 format, without opacity data).

- Second 16-bit word is the pixels’ color in RGB565 format.
« Several consecutive pixels have their own color (1 +n words):
- First 16-bit word specifies how many consecutive pixels have their own color;
- Next 16-bit word is the next pixel color.
« Several consecutive pixels are transparent (1 word):
- 16-bit word specifies how many consecutive pixels are transparent.
Advantages
« Supports fully opaque and fully transparent encoding.
« Good compression when several consecutive pixels respect one of the three previous rules.
Disadvantages
» Drawing an image is slightly slower than when using Display format.

+ Not designed forimages with many different pixel colors: in such case, the output file size may be larger than
the original image file.

image1:RLE1
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Image Generator Error Messages

These errors can occur while preprocessing images.

Table 12: Static Image Generator Error Messages

ID | Type Description

0 | Error The image generator has encountered an unexpected internal error.

1 Error The images list file has not been specified.

2 | Error The image generator cannot create the final, raw file.

3 | Error The image generator cannot read the images list file. Make sure the system allows reading of
this file.

4 | Warning The image generator has found no image to generate.

5 | Error The image generator cannot load the images list file.

6 | Warning The specified image path is invalid: The image will be not converted.

7 | Warning There are too many or too few options for the desired format.

8 | Error The display format is not generic; a MicroUIRawlmageGeneratorExtension implementation is
required to generate the MicroUl raw image.

9 | Error The image cannot be read.

10 | Error The image generator has encountered an unexpected internal error (invalid endianness).

11 | Error The image generator has encountered an unexpected internal error (invalid bpp).

12 | Error The image generator has encountered an unexpected internal error (invalid display format).

13 | Error The image generator has encountered an unexpected internal error (invalid pixel layout).

14 | Error The image generator has encountered an unexpected internal error (invalid output folder).

15 | Error The image generator has encountered an unexpected internal error (invalid memory
alignment).

16 | Error The input image format and / or the ouput format are not managed by the image generator.

17 | Error The image has been already loaded with another output format.

Mutable Images

Overview

Unlike immutable images, mutable images are graphical resources that can be created and modified at runtime.
The application can draw into such images using the Painter classes with the image’s Graphics Context as the des-
tination. Mutable images can be created with a call to constructor ej.microui.display.Bufferedimage().

BufferedImage image = new BufferedImage (320,

240);

GraphicsContext g = image.getGraphicsContext();
g.setColor(Colors.BLACK);
Painter.fillRectangle(g, 0, 0, 320, 240);
g.setColor(Colors.RED);
Painter.drawHorizontallLine(g, 50, 50, 100);
image.close();
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Transparency

The output format of Bufferedimage matches the pixel organization (layout, depth, etc.) of the display. The algo-
rithms used to draw in such an image are the same as those used to draw on the display (for footprint purposes).
Since the display buffer is opaque, the algorithms cannot draw transparent pixels.

In addition, GraphicsContext.setColor() does not take the alpha channel into account and only accepts RGB values.
The given color value is interpreted as a 24-bit RGB color, where the high-order byte is ignored, and the remaining
bytes contain the red, green, and blue channels, respectively.

Images Heap

The images heap is used to allocate the pixel data of:
« mutable images (i.e. Bufferedimage instances)

« immutable images decoded at runtime, typically a PNG: the heap is used to store the decoded image and
the runtime decoder’s temporary buffers, required during the decoding step. After the decoding step, all the
temporary buffers are freed. Note that the size of the temporary buffers depend on the decoder and on the
original image itself (compression level, pixel encoding, etc.)

« immutable images which are not byte-addressable, such as images opened with an input stream (i.e. Re-
sourcelmage instances)

« immutable images which are byte-addressable but converted to a different output format (i.e. Resourcelm-
age instances)

In other words, every image which can not be retrieved using Image.getimage() is saved on the images heap.

The size of the images heap can be configured with the ej.microui.memory.imagesheap.size property.

Warning: AResourcelmage allocated on the images heap must be closed manually by the application (Resour-
celmage.close()); otherwise, a memory leak will occur on the images heap.

Fonts

Overview

Fonts are graphical resources that can be accessed with a call to ej.microui.display.Font.getFont(). Fonts are de-
clared in Classpath .fonts.list files (orin *.fontsext.list for an external resource, see Application Re-
sources).
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Font

yes no=external

* fonts.list * fontsext.list

The file format is a standard Java properties file, each line representing a / separated resource path relative to
the Classpath root referring to a Font file (usually with a .ejf file extension). The resource may be followed by
optional parameters which define :

« some ranges of characters to embed in the final raw file;
« the required pixel depth for transparency.

By default, all characters available in the input font file are embedded, and the pixel depthis 1 (i.e 1 bit-per-pixel).
Example:

# The following font is embedded with all characters
# without transparency
com/mycompany/MyFont1.ejf

# The following font is embedded with only the latin
# unicode range without transparency
com/mycompany/MyFont2.ejf:1latin

# The following font is embedded with all characters

# with 2 levels of transparency
com/mycompany/MyFont2.ejf::2

Font files conventionally end with the .ejf suffix and are created using the Font Designer (see Font Designer).

4.16. Graphical User Interface 264



MicroEJ Documentation, Revision d4ede019

Configuration File

Here is the format of the *.fonts.list files.

ConfigFile ::= Line [ 'EOL' Line Jx

Line ::= FontPath [ ':' [ Ranges 1 [ ':' BitsPerPixel ] ]
FontPath ::= Identifier [ '/' Identifier 1%
Ranges ::= Range [ ';' Range J*

Range ::= CustomRangelList | KnownRange
CustomRangelist ::= CustomRange [ ',' CustomRange Jx
CustomRange ::= Number | Number '-' Number
KnownRange ::= Name [ SubRangelList ]17?
SubRangelList ::= "(' SubRange [ ',' SubRange Jx ')'
SubRange ::= Number | Number - Number
Identifier c:= 'a-zA-Z_$' [ 'a-zA-Z_$0-9' J*
Number ::= Number16 | Number10@

Number16 ::= 'ox' [ Digitl6 ]+

Number10 ::= [ Digitio J+

Digitl16 ::= 'a-fA-Fo-9'

Digit10 i:= '0-9'

BitsPerPixel ci= "1 "2t ) 4t | '8!

Font Range

The first parameter is for specifying the font ranges to embed. Selecting only a specific set of characters to embed
reduces the memory footprint. If unspecified, all characters of the font are embedded.

Several ranges can be specified, separated by ; . There are two ways to specify a character range: the custom range
and the known range.

Custom Range

Allows the selection of raw Unicode character ranges.
Examples:
« myfont:0x21-0x49 : Defines one range: embed all characters from 0x21 to 0x49 (included);

« myfont:0x21-0x49,0x55-0x75 : Defines a set of two ranges: embed all characters from 0x21 to 0x49 and
from 0x55 to 0x75.

« myfont:0x21-0x49,0x55 : Defines a set of one range and one character: embed all characters from 0x21 to
0x49 and character 0x55.

Known Range

A known range is a range available in the following table.
Examples:
« myfont:basic_latin:Embed all Basic Latin characters;
« myfont:basic_latin;arabic: Embed all Basic Latin characters, and all Arabic characters.

The following table describes the available list of ranges and sub-ranges (processed from the “Unicode Character
Database” version 9.0.0 available on the official unicode website https://home.unicode.org/).
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Table 13: Ranges

Name Tag Start End
Basic Latin basic_latin 0x0 ox7f
Latin-1 Supplement latin-1_supplement 0x80 Oxff
Latin Extended-A latin_extended-a 0x100 ox17f
Latin Extended-B latin_extended-b 0x180 0x24f
IPA Extensions ipa_extensions 0x250 | Ox2af
Spacing Modifier Letters spacing_modifier_letters 0x2b0 | Ox2ff
Combining Diacritical Marks combining_diacritical_marks 0x300 | Ox36f
Greek and Coptic greek_and_coptic 0x370 0ox3ff
Cyrillic cyrillic 0x400 | Ox4ff
Cyrillic Supplement cyrillic_supplement 0x500 | Ox52f
Armenian armenian 0x530 | Ox58f
Hebrew hebrew 0x590 | Ox5ff
Arabic arabic 0x600 | Ox6ff
Syriac syriac 0x700 | Ox74f
Arabic Supplement arabic_supplement 0x750 | Ox77f
Thaana thaana 0x780 | Ox7bf
NKo nko 0x7c0 | OxT7ff
Samaritan samaritan 0x800 | 0x83f
Mandaic mandaic 0x840 | 0x85f
Arabic Extended-A arabic_extended-a 0x8a0 | Oxsff
Devanagari devanagari 0x900 | 0x97f
Bengali bengali 0x980 | Oxoff
Gurmukhi gurmukhi 0xa00 | OxaTf
Gujarati gujarati 0xa80 | Oxaff
Oriya oriya 0xb00 | Oxb7f
Tamil tamil 0xb80 | Oxbff
Telugu telugu 0xc00 | Oxc7f
Kannada kannada 0xc80 | Oxcff
Malayalam malayalam 0xd00 | Oxd7f
Sinhala sinhala 0xd80 | Oxdff
Thai thai 0xe00 | Oxe7f
Lao lao 0xe80 | Oxeff
Tibetan tibetan 0xfo0 | Oxfff
Myanmar myanmar 0x1000 | 0x109f
Georgian georgian 0x10a0 | Ox10ff
Hangul Jamo hangul_jamo 0x1100 | Ox11ff
Ethiopic ethiopic 0x1200 | 0x137f
Ethiopic Supplement ethiopic_supplement 0x1380 | 0x139f
Cherokee cherokee 0x13a0 | Ox13ff
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics 0x1400 | ox167f
Ogham ogham 0x1680 | 0x169f
Runic runic 0x16a0 | Ox16ff
Tagalog tagalog 0x1700 | ox171f
Hanunoo hanunoo 0x1720 | 0x173f
Buhid buhid 0x1740 | 0x175f
Tagbanwa tagbanwa 0x1760 | Ox177f
Khmer khmer 0x1780 | Ox17ff
Mongolian mongolian 0x1800 | Ox18af

continues on next page
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Table 13 - continued from previous page

Name Tag Start End
Unified Canadian Aboriginal Syllabics | unified_canadian_aboriginal_syllabics_extended| 0x18b0 | 0x18ff
Extended

Limbu limbu 0x1900 | 0x194f
Tai Le tai_le 0x1950 | Ox197f
New Tai Lue new_tai_lue 0x1980 | 0x19df
Khmer Symbols khmer_symbols 0x19e0 | Ox19ff
Buginese buginese 0x1a00 | Oxlalf
Tai Tham tai_tham 0x1a20 | Oxlaaf
Combining Diacritical Marks Extended | combining_diacritical_marks_extended Ox1ab0 | Oxlaff
Balinese balinese 0x1b00 | Ox1b7f
Sundanese sundanese 0x1b80 | 0x1bbf
Batak batak 0x1bcO | Ox1bff
Lepcha lepcha 0x1c00 | Ox1c4f
Ol Chiki ol_chiki 0x1c50 | Oxic7f
Cyrillic Extended-C cyrillic_extended-c 0x1c80 | Ox1c8f
Sundanese Supplement sundanese_supplement 0x1ccO | Oxlccf
Vedic Extensions vedic_extensions 0x1cdO | Oxlcff
Phonetic Extensions phonetic_extensions 0x1d00 | ox1d7f
Phonetic Extensions Supplement phonetic_extensions_supplement 0x1d80 | 0x1dbf
Combining Diacritical Marks Supple- | combining_diacritical_marks_supplement Ox1dcO | ox1idff
ment

Latin Extended Additional latin_extended_additional 0x1e00 | Oxleff
Greek Extended greek_extended 0x1f00 | OxIfff
General Punctuation general_punctuation 0x2000 | 0x206f
Superscripts and Subscripts superscripts_and_subscripts 0x2070 | 0x209f
Currency Symbols currency_symbols 0x20a0 | 0x20cf
Combining Diacritical Marks for Sym- | combining_diacritical_marks_for_symbols 0x20d0 | Ox20ff
bols

Letterlike Symbols letterlike_symbols 0x2100 | 0x214f
Number Forms number_forms 0x2150 | 0x218f
Arrows arrows 0x2190 | Ox21ff
Mathematical Operators mathematical_operators 0x2200 | 0x22ff
Miscellaneous Technical miscellaneous_technical 0x2300 | 0x23ff
Control Pictures control_pictures 0x2400 | 0x243f
Optical Character Recognition optical_character_recognition 0x2440 | 0x245f
Enclosed Alphanumerics enclosed_alphanumerics 0x2460 | 0x24ff
Box Drawing box_drawing 0x2500 | 0x257f
Block Elements block_elements 0x2580 | 0x259f
Geometric Shapes geometric_shapes 0x25a0 | 0x25ff
Miscellaneous Symbols miscellaneous_symbols 0x2600 | Ox26ff
Dingbats dingbats 0x2700 | 0x27bf
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-a 0x27c0 | Ox27ef
Symbols-A

Supplemental Arrows-A supplemental_arrows-a 0x27f0 | Ox27ff
Braille Patterns braille_patterns 0x2800 | 0x28ff
Supplemental Arrows-B supplemental_arrows-b 0x2900 | 0x297f
Miscellaneous Mathematical | miscellaneous_mathematical_symbols-b 0x2980 | 0x29ff
Symbols-B

continues on next page
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Table 13 - continued from previous page

Name Tag Start End
Supplemental Mathematical Opera- | supplemental_mathematical_operators 0x2a00 | Ox2aff
tors

Miscellaneous Symbols and Arrows miscellaneous_symbols_and_arrows 0x2b00 | Ox2bff
Glagolitic glagolitic 0x2c00 | 0x2c5f
Latin Extended-C latin_extended-c 0x2c60 | Ox2c7f
Coptic coptic 0x2c80 | Ox2cff
Georgian Supplement georgian_supplement 0x2d00 | 0x2d2f
Tifinagh tifinagh 0x2d30 | 0x2d7f
Ethiopic Extended ethiopic_extended 0x2d80 | 0x2ddf
Cyrillic Extended-A cyrillic_extended-a 0x2de0 | Ox2dff
Supplemental Punctuation supplemental_punctuation 0x2e00 | Ox2eT7f
CJK Radicals Supplement cjk_radicals_supplement 0x2e80 | Ox2eff
Kangxi Radicals kangxi_radicals 0x2f00 | ox2fdf
Ideographic Description Characters ideographic_description_characters 0x2ff0 | Ox2fff
CJK Symbols and Punctuation cjk_symbols_and_punctuation 0x3000 | 0x303f
Hiragana hiragana 0x3040 | 0x309f
Katakana katakana 0x30a0 | 0x30ff
Bopomofo bopomofo 0x3100 | 0x312f
Hangul Compatibility Jamo hangul_compatibility_jamo 0x3130 | 0x318f
Kanbun kanbun 0x3190 | 0x319f
Bopomofo Extended bopomofo_extended 0x31a0 | 0x31bf
CJK Strokes cjk_strokes 0x31c0 | Ox3lef
Katakana Phonetic Extensions katakana_phonetic_extensions 0x31f0 | Ox31ff
Enclosed CJK Letters and Months enclosed_cjk_letters_and_months 0x3200 | 0x32ff
CJK Compatibility cjk_compatibility 0x3300 | 0x33ff
CJK Unified Ideographs Extension A cjk_unified_ideographs_extension_a 0x3400 | 0x4dbf
Yijing Hexagram Symbols yijing_hexagram_symbols 0x4dc0 | 0x4dff
CJK Unified Ideographs cjk_unified_ideographs 0x4e00 | 0xofff
Yi Syllables yi_syllables 0xa000 | Oxa48f
Yi Radicals yi_radicals 0xa490 | Oxa4cf
Lisu lisu 0xa4d0 | Oxa4ff
Vai vai 0xa500 | 0xa63f
Cyrillic Extended-B cyrillic_extended-b 0xa640 | Oxa69f
Bamum bamum 0xa6a0 | Oxab6ff
Modifier Tone Letters modifier_tone_letters 0xa700 | OxaTif
Latin Extended-D latin_extended-d 0xa720 | OxaTff
Syloti Nagri syloti_nagri 0xa800 | 0xa82f
Common Indic Number Forms common_indic_number_forms 0xa830 | Oxa83f
Phags-pa phags-pa 0xa840 | 0xa87f
Saurashtra saurashtra 0xa880 | 0xa8df
Devanagari Extended devanagari_extended Oxa8e0 | Oxa8ff
Kayah Li kayah_li 0xa900 | 0xa92f
Rejang rejang 0xa930 | 0xa95f
Hangul Jamo Extended-A hangul_jamo_extended-a 0xa960 | 0xa97f
Javanese javanese 0xa980 | 0xa9df
Myanmar Extended-B myanmar_extended-b 0xa9e0 | Oxaoff
Cham cham 0xaa00 | Oxaa5f
Myanmar Extended-A myanmar_extended-a 0xaa60 | OxaaT7f
Tai Viet tai_viet Oxaa80 | Oxaadf

continues on next page
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Table 13 - continued from previous page

Name Tag Start End
Meetei Mayek Extensions meetei_mayek_extensions Oxaae0 | Oxaaff
Ethiopic Extended-A ethiopic_extended-a 0xab00 | Oxab2f
Latin Extended-E latin_extended-e 0xab30 | Oxabé6f
Cherokee Supplement cherokee_supplement 0xab70 | Oxabbf
Meetei Mayek meetei_mayek OxabcO | Oxabff
Hangul Syllables hangul_syllables Oxac00 | Oxd7af
Hangul Jamo Extended-B hangul_jamo_extended-b 0xd7b0 | Oxd7ff
High Surrogates high_surrogates 0xd800 | 0xdb7f
High Private Use Surrogates high_private_use_surrogates 0xdb80 | Oxdbff
Low Surrogates low_surrogates 0xdc00 | Oxdfff
Private Use Area private_use_area 0xe000 | Oxf8ff
CJK Compeatibility Ideographs cjk_compatibility_ideographs 0xf900 | Oxfaff
Alphabetic Presentation Forms alphabetic_presentation_forms 0xfb00 | Oxfb4af
Arabic Presentation Forms-A arabic_presentation_forms-a 0xfb50 | Oxfdff
Variation Selectors variation_selectors 0xfe00 | OxfeoOf
Vertical Forms vertical_forms Oxfe10 | Oxfelf
Combining Half Marks combining_half_marks Oxfe20 | Oxfe2f
CJK Compeatibility Forms cjk_compatibility_forms 0xfe30 | Oxfe4f
Small Form Variants small_form_variants 0xfe50 | Oxfe6f
Arabic Presentation Forms-B arabic_presentation_forms-b Oxfe70 | Oxfeff
Halfwidth and Fullwidth Forms halfwidth_and_fullwidth_forms 0xffo0 | Oxffef
Specials specials Oxfffo | Oxffff
Transparency

The second parameter is for specifying the font transparency level (1, 2, 4 or 8). If unspecified, the encoded

transparency levelis 1 (does not depend on transparency level encoded in EJF file).

Examples:

« myfont:latin:4:Embed all latin characters with 16 levels of transparency

« myfont::2:Embed all characters with 4 levels of transparency
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Font Generator Error Messages

Table 14: Static Font Generator Error Messages

ID | Type Description
0 Error The font generator has encountered an unexpected internal error.
1 Error The Fonts list file has not been specified.
2 Error The font generator cannot create the final, raw file.
3 Error The font generator cannot read the fonts list file.
4 | Warning The font generator has found no font to generate.
5 Error The font generator cannot load the fonts list file.
6 Warning The specified font path is invalid: The font will be not converted.
7 Warning There are too many arguments on a line: the current entry is ignored.
8 Error The font generator has encountered an unexpected internal error (invalid output format).
9 | Error The font generator has encountered an unexpected internal error (invalid endianness).
10 | Error The specified entry is invalid.
11 | Error The specified entry does not contain a list of characters.
12 | Error The specified entry does not contain a list of identifiers.
13 | Error The specified entry is an invalid width.
14 | Error The specified entry is an invalid height.
15 | Error The specified entry does not contain the characters’ addresses.
16 | Error The specified entry does not contain the characters’ bitmaps.
17 | Error The specified entry bits-per-pixel value is invalid.
18 | Error The specified range is invalid.
19 | Error There are too many identifiers. The output RAW format cannot store all identifiers.
20 | Error The font’s name is too long. The output RAW format cannot store all name characters.
21 | Error There are too many ranges. The output RAW format cannot store all ranges.
22 | Error Output list files cannot be created.
23 | Error Dynamic styles are not supported. Only a PLAIN font can be encoded.
24 | Error Underlined style is not supported. Only a BOLD and ITALIC font can be set.
Default Character

The application may request the rendering of a string where some characters are not available in the selected font.
In that case, a default character is drawn instead: it is the first available character in the font. For example, the first
available character for a font where the range matches the ASCII printable characters ( 9x21-0x7E ) would be the
exclamation mark (0x21).

The characters of a font are referenced by their Unicode value. For a given font range, the default character is the
first character of the first range. Consequently, the default character may not be the same for two given fonts of an
application: it depends on the specified character range for each font.

To help developers identify quickly why a string is rendered with unexpected characters, it is recommended that
the font maker sets a default character that is easy to recognize (a symbol, for example, a rectangle). This character
must have the first character index (index ¢ is allowed).
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Font Designer

Principle

The Font Designer module is a graphical tool (Eclipse plugin) that runs within the MicroEJ IDE used to build and
edit MicroUl fonts. It stores fonts in a platform-independent format.

Functional Description

font
*ttf |

font Font

*.ejf |H

Designer

font
.png

Fig. 75: Font Generation

Font Management
Create a MicroEJ Font

To create a MicroEJ font, follow the steps below:
1. Open the Eclipse wizard: File > New > Other... > MicroEJ > MicroEJ Font .
2. Select a directory and a name.
3. Click Finish.

Once the font is created, a new editor is opened: the MicroEJ Font Designer.

Edit a MicroEJ Font

You can edit your font with the MicroEJ Font Designer (by double-clickingona x.ejf file or after running the new
MicroEJ Font wizard).

This editor is divided into three main parts:
+ The top left part manages the main font properties.
+ The top right part manages the character to embed in your font.

« The bottom part allows you to edit a set of characters or an individual character.
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Main Properties

The main font properties are:
« fontsize: height and width (in pixels).
« baseline (in pixels).
« space character size (in pixels).
« styles and filters.
« identifiers.

Refer to the following sections for more information about these properties.

Font Height

A font has a fixed height. This height includes the white pixels at the top and at the bottom of each character
simulating line spacing in paragraphs.

N height
[ ]

Fig. 76: Font Height

Font Width: Proportional and Monospace Fonts

A monospace font is a font in which all characters have the same width. For example a ‘!’ representation will be
the same width as a ‘w’ (they will be in the same size rectangle of pixels). In a proportional font, a ‘w’ will be wider
thana ‘"

A monospace font usually offers a smaller memory footprint than a proportional font because the Font Designer
does not need to store the size of each character. As a result, this option can be useful if the difference between the
size of the smallest character and the biggest one is small.

Baseline

Characters have a baseline: an imaginary line on top of which the characters seem to stand. Note that characters
can be partly under the line, for example, ‘g’ or ‘}.

[ [1] L[] L] L] (1] 1 (1]
| | - = - [} [} [} - = | ] 1] L -
| . amE n = _IN [LL1] N um N (wEE . ..
L L] LL L] | - L LIl - | L1l - - L L]
| . L ] [ ] | L1l . = N EEEE (111} .
] L L L L] [ | u N | [ | u
=== aE = = e e

Fig. 77: The Baseline
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Space Character

The Space character (0x20) is a specific character because it has no filled pixels. From the Main Properties Menu
you can fix the space character size in pixels.

Note: When the font is monospace, the space size is equal to the font width.

Styles

Font Designer allows creating a font file that holds several combinations of built-in styles (styles hardcoded in pixels
map) and runtime styles (styles rendered dynamically at runtime). However, since MicroUl 3, a MicroUl font holds
only one style: PLAIN, BOLD, ITALIC or BOLD + ITALIC.

Font Designer features three drop-downs, one for each of BOLD, ITALIC,and UNDERLINED . Each drop-down has
three options: None, Built-in and Dynamic . The font options must be adjusted to be compatible with MicroUl
3:

+ The style option Dynamic (that targets the runtime style) is forbidden; select None instead.
+ The syle UNDERLINED is forbidden; select None instead.

The styles options Built-in tagthefontasbold, italic, or bold and italic. This style can be retrieved by the MicroEJ
Application thanks the methods Font.isBold() and Font.isltalic(). Adjust the styles options according to the font:

« The fontis a plain font: select None option for each style.
« Thefontis a bold font: select Built-in for the style bold and None for the other styles.
« Thefontis an italic font: select Built-in for the style italic and None for the other styles.

« Thefontis a bold and italic font: select Built-in for the styles bold and italic and None for UNDERLINED.

Warning: When a font holds a dynamic style or when the style UNDERLINED is not None, an error at MicroEJ
application compile-time is thrown (incompatible font file).

Identifiers

A number of identifiers can be attached to a MicroUl font. At least one identifier is required to specify the font.
Identifiers are a mechanism for specifying the contents of the font - the set or sets of characters it contains. The
identifier may be a standard identifier (for example, LATIN) or a user-defined identifier. Identifiers are numbers,
but standard identifiers, which are in the range 0 to 80, are typically associated with a handy name. A user-defined
identifier is an identifier with a value of 81 or higher.
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Character List

The list of characters can be populated through the import button, which allows you to import characters from
system fonts, images or another MicroEJ font.

Import from System Font

This page allows you to select the system font to use (left part) and the range of characters. There are predefined
ranges of characters below the font selection, as well as a custom selection picker (for example 0x21 to Oxfe for
Latin characters).

The right part displays the selected characters with the selected font. If the background color of a displayed char-
acter is red, it means that the character is too large for the defined height, or in the case of a monospace font, it
means the character is too high or too wide. You can then adjust the font properties (font size and style) to ensure
that characters will not be truncated.

When your selection is done, click the Finish button to import this selection into your font.

Import from Images

This page allows the loading of images from a directory. The images must be named as follows: 0x[UTF-87.
[extension].

When your selection is done, click the Finish button to import the images into your font.

Character Editor

When a single character is selected in the list, the character editor is opened.
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Preview Character Pixmap (11 * 20)
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Fig. 78: Character Editor

You can define specific properties, such as left and right space, or index. You can also draw the character pixel by
pixel - a left-click in the grid draws the pixel, a right-click erases it.

The changes are not saved until you click the Apply button. When changes are applied to a character, the editor
shows that the font has changed, so you can now save it.

The same part of the editor is also used to edit a set of characters selected in the top right list. You can then edit
the common editable properties (left and right space) for all those characters at the same time.

Working With Anti-Aliased Fonts

By default, when characters are imported from a system font, each pixel is either fully opaque or fully transparent.
Fully opaque pixels show as black squares in the character grid in the right-hand part of the character editor; fully
transparent pixels show as white squares.

However, the pixels stored inan ejf file cantake one of 256 grayscale values. A fully-transparent pixel has the value
255 (the RGB value for white), and a fully-opaque pixel has the value 0 (the RGB value for black). These grayscale
values are shown in parentheses at the end of the text in the Current alpha field when the mouse cursor hovers over
a pixel in the grid. That field also shows the transparency level of the pixel, as a percentage, where 100% means
fully opaque.

Itis possible to achieve better-looking characters by using a combination of fully-opaque and partially-transparent
pixels. Thistechniqueis called anti-aliasing. Anti-aliased characters can be imported from system fonts by checking
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the anti aliasing box in the import dialog. The ‘&’ character shown in the screenshot above was imported using anti
aliasing, and you can see the various gray levels of the pixels.

When the Font Generator converts an ejf file into the raw format used at runtime, it can create fonts with char-
acters that have 1, 2, 4 or 8 bits-per-pixel (bpp). If the raw font has 8 bpp, then no conversion is necessary and the
characters will render with the same quality as seen in the character editor. However, if the raw font has less than
8 bpp (the default is 1 bpp) any gray pixels in the input file are compressed to fit, and the final rendering will be of
lower quality (but less memory will be required to hold the font).

Itis useful to be able to see the effects of this compression, so the character editor provides radio buttons that allow
the user to preview the characterat 1, 2, 4, or 8 bpp. Furthermore, when 2, 4 or 8 bpp is selected, a slider allows the
user to select the transparency level of the pixels drawn when the left mouse button is clicked in the grid.

Previewing a Font

You can preview your font by pressing the Preview... button, which opens the Preview wizard. In the Preview
wizard, press the Select File button, and select a text file which contains text that you want to see rendered using
your font. Characters that are in the selected text file but not available in the font will be shown as red rectangles.

4.16. Graphical User Interface 276



MicroEJ Documentation, Revision d4ede019
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Fig. 79: Font Preview
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Removing Unused Characters

In order to reduce the size of a font file, you can reduce the number of characters in your font to be only those char-
acters used by your application. To do this, create a file which contains all the characters used by your application
(for example, concatenating all your NLS files is a good starting point). Then open the Preview wizard as described
above, selecting that file. If you select the check box Delete unused on finish, then those characters that are in the
font but not in the text file will be deleted from the font when you press the Finish button, leaving your font contain-
ing the minimum number of characters. As this font will contain only characters used by a specific application, it is
best to prepare a “complete” font, and then apply this technique to a copy of that font to produce an application
specific cut-down version of the font.

Use a MicroEJ Font

A MicroEJ Font must be converted to a format which is specific to the targeted platform. The Font Generator tool
performs this operation for all fonts specified in the list of fonts configured in the application launch.

Dependencies

No dependency.

Installation

The Font Designer module is already installed in the MicroEJ environment.

Use

Create anew ejf fontfile or open an existing one in order to open the Font Designer plugin.

Application Options

MicroUl libraries and its tools provide a set of options. See Application Options to have more information about the
application options.

Note: MicroUl implementation requires one thread (MicroUl Pump) and at least 100 bytes in the immortals heap.
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Category: Libraries

w Libraries
w Micrell
Font
Image

Category: MicroUl

w Libraries Memary
v Microll
Font Pump events (inputs and display) queue size (in number of events): | 100 ‘
Image

Pump events thread priority: |3

Images heap size (in bytes): | 131072

Group: Memory
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Option(text): Pump events (inputs and display) queue size (in number of events)

Option Name: ej.microui.memory.queue.size
Default value: 100
Description:

Specifies the size of the pump events queue.

Option(combo): Pump events thread priority

Option Name: com.microej.library.microui.pump.priority
Default value: 5

Available values: 1 to 10

Description:

Specifies the priority of the pump events queue.

Option(text): Images heap size (in bytes)

Option Name: ej.microui.memory.imagesheap.size
Default value: 131072
Description:

Specifies the size of the images heap. This heap is used to store the dynamic user images, the decoded images
and the working buffers of embedded image decoders (for instance the PNG decoder). A too small value can cause
OutOfMemory errors and incomplete drawings.
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Category: Font

v Libraries Fonts to Process
~ Micrell X i i i X
Font List the fonts for the font pre-processing tool. This tool will convert them into
an internal memory format at build time,
Image

Activate the font pre-processing step

Fonts list file which will be linked (after pre-processing step) into the CPU
address space range (internal device memories, external parallel memories).

[[] Define an explicit list file

Group: Fonts to Process

Description:

This group allows to select a file describing the font files which need to be converted into a RAW format. At Mi-
croUl runtime, the pre-generated fonts will be read from the flash memory without any modifications (see MicroUl
specification).

Option(checkbox): Activate the font pre-processing step

Option Name: ej.microui.fontConverter.uselt
Default value: true
Description:

When checked, enables the next option Fonts 1list file. When the next option is disabled, there is no check on
the file path validity.
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Option(checkbox): Define an explicit list file

Option Name: ej.microui.fontConverter.file.enabled
Default value: false
Description:

By default, list files are loaded from the classpath. When checked, only the next option Fonts list fileis processed.
Option(browse):

Option Name: ej.microui.fontConverter.file
Default value: (empty)
Description:

Browse to select a font list file. Refer to Font Generator chapter for more information about the font list file format.

Category: Image

v Libraries Images to Process
v Microll
Font List the images for the image pre-processing tool. This tool will convert them into
| the display memory format (BPP, layout) at build time.
mage

Activate the image pre-processing step

Images list file which will be linked (after pre-processing step) into the CPU
address space range (internal device memories, external parallel memories).

[ Definean explicit list file

m
a
e

Group: Images to Process

Description:

This group allows to select a file describing the image files which need to be converted into a RAW format. At
MicroUl runtime, the pre-generated images will be read from the flash memory without any modifications (see
MicroUl specification).
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Option(checkbox): Activate the image pre-processing step

Option Name: ej.microui.imageConverter.uselt
Default value: true
Description:

When checked, enables the next option Images list file. When the next option is disabled, there is no check on
the file path validity.

Option(checkbox): Define an explicit list file

Option Name: ej.microui.imageConverter.file.enabled
Default value: false
Description:

By default, list files are loaded from the classpath. When checked, only the next option Images list fileis pro-
cessed.

Option(browse):

Option Name: ej.microui.imageConverter.file
Default value: (empty)
Description:

Browse to select an image list file. Refer to Image Generator chapter for more information about the image list file
format.

Debug Traces

MicroUl logs several actions when traces are enabled. This chapter explains the traces identifiers.

Trace format

The trace output format is the following:
[TRACE: MicroUI] Event AA(BB[CC],DD[EE])
where:

+ AAisthe event identifier. See next table.

« BBis the first event data.

« CCistheindex of the first event data (0x0).

« DD is the second event data.

+ EEis the index of the second event data (0x1).

» etc.
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For example, given the following trace output:

[TRACE: MicroUI] Event @x2(1[0x0],2[0x1],117571586[0x2])
« 0x2 -> Execute native input event
« 1->Event “Button” (index 0x0)
« 2 ->Generator Id (index 0x1)

« 117571586 -> event data (index 0x2)

Trace identifiers

The following tables describe some events data.

Table 15: MicroUl Traces

Event | Description End of event
ID
0x0 Execute EventGenerator event %0% (see Event Type). Generatoridis | End of %0% (see Event Type).
(0) %1% and datais %2%.
0x1(1) | Dropevent %0%.
0x2 (2) | Execute native inputevent %0% (see Event Type). Generatoridis %1% | End of %0% (see Event Type).
and datais %2%.
0x3 (3) | Execute display event %0% (see Event Type). Eventis %1%. End of %0% (see Event Type).
0x4 (4) | Execute user event %0%. End of %0%.
0x5 (5) | Create new image using %0% algorithm (see Create Image). Image created, image identi-
fieris %0%.
0x6 (6) | New image characteristics %0% (see Image Type), identifier is %1%
and memory size is %2%.
Oxa Flush back buffer; position ( %0%, %1% ) size ( %2% * %3%).
(10)
Oxb Flush done.
(11)
0xc Start internal drawing operation %0% (see Drawing Type). End of drawing %0% (see
(12) Drawing Type)
0Oxd Start drawing operation %0% (see Drawing Type). End of drawing %0% (see
(13) Drawing Type)
Oxe Unknown event.
(14)
oxf Asynchronous drawing operation done.
(15)
0x14 Invalid input event %0% .
(20)
0x15 Event queue is full, cannot add event %0%.
(21)
0x16 Add event %0% atindex %1% ; queue length is %2%.
(22)
0ox17 Replace event %0% by %1% atindex %2%; queue length is %3%.
(23)
0x18 Read event %0% atindex %1%.
(24)
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Table 16: Event Type

Event ID | Description
0x0 (0) Event “Command”
0x1 (1) Event “Button”
0x2 (2) Event “Pointer”
0x3 (3) Event “State”
0x4 (4) Event “Unknwon”
0x5 (5) Event “Call Serially”
0x6 (6) Event “MicroUl Stop”
0x7 (7) Event “Input”
0x8 (8) Event “Show Displayable”
0x9 (9) Event “Hide Displayable”
Oxb (11) Event “Pending Flush”
Oxc (12) | Event “Force Flush”
0xd (13) | Event “Repaint Displayable”
Oxe (14) | Event “Repaint Current Displayable”
0xf (15) Event “KF Stop Feature”
Table 17: Create Image
Event ID | Description
0x0 (0) Create Bufferedlmage
0x1(1) Create Image from path
0x2 (2) Create Image from InputStream
Table 18: Image Type
EventID | Description
0x0 (0) New Bufferedimage
0x1 (1) Load MicroEJ Image from RAW file
0x2 (2) New MicroEJ Image from encoded image
0x3 (3) New MicroEJ Image from RAW image in external memory
0x4 (4) New MicroEJ Image from encoded image in external memory
0x5 (5) New MicroEJ Image from memory InputStream
0x6 (6) New MicroEJ Image from byte array InputStream
Ox7 (7) New MicroEJ Image from generic InputStream
0x8 (8) Link Image

Table 19: Drawing Type

Event ID Description

0x1 (1) Write pixel

0x2 (2) Draw line

0x3 (3) Draw horizontal line
0x4 (4) Draw vertical line

0x5 (5) Draw rectangle

0x6 (6) Fill rectangle

0x7 (7) Unknown

0x8 (8) Draw rounded rectangle
0x9 (9) Fill rounded rectangle

continues on next page
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SystemView Integration

Table 19 - continued from previous page

EventID Description

Oxa (10) Draw circle arc

Oxb (11) Fill circle arc

0xc (12) Draw ellipse arc

0xd (13) Fill ellipse arc

Oxe (14) Draw ellipse

0xf (15) Fill ellipse

0x10 (16) Draw circle

0x11 (17) Fill circle

0x12 (18) Draw ARGB array

0x13 (19) Draw image

0x32 (50) Draw polygon

0x33 (51) Fill polygon

0x34 (52) Get ARGB image data

0x35 (53) Draw string

0x36 (54) Draw deformed string

0x37 (55) Draw deformed image

0x38 (56) Draw character with rotation (bilinear)
0x39 (57) Draw character with rotation (simple)
0x3a (58) Get string width

0x3b (59) Get pixel

0x64 (100) | Draw thick faded point

0x65 (101) | Draw thick faded line

0x66 (102) | Draw thick faded circle

0x67 (103) | Draw thick faded circle arc

0x68 (104) | Draw thick faded ellipse

0x69 (105) | Draw thick line

0x6a (106) | Draw thick circle

0x6b (107) | Draw thick ellipse

0x6¢ (108) | Draw thick circle arc

0xc8 (200) | Draw image with fli

0xc9 (201) | Draw image with rotation (simple)
Oxca (202) | Draw image with rotation (bilinear)
Oxcb (203) | Draw image with scalling (simple)
Oxcc (204) | Draw image with scalling (bilinear)

The traces are SystemView compatible.

# Timestamp Context Event Detail
128131 22.482 134 140 Scheduler J/* xQueueGenericSend. xQueus=0x00005670 pvItemToQueus=0x2004FFD4 pxHigherPriorityTaskWoken=0 xCopyPosition=0
120132 22.482 207 380 Scheduler Task Ready [MEJ] UIPump, runs after 29.8 us (5 964 cycles)
129133 22.482 237 200 [MEJ] UI_ Task Run Runs for 2.6524 ms (530 494 cycles)
1258134 22.482 278 470 [MEJ] UI.. s.;‘-‘ GE_Draw {MicroUI GraphicalEngine) Drawing operation DRAW_IMAGE
128135 22.482 370 105 [MEJ] UI. Jfy GE_ Draw (MicroUI GraphicalEngine) Drawing operation DRAW_IMAGEdone after 91.6 us.
129136 22.482 525 170 [MEJ] UI. J/ xQueueGenericSend. xQueue=0x00005636 pvIitemToQueue=0x2004FFCC pxHigherPriorityTaskiWoken=0 xCopyPosition=0
129137 22.482 544 990 [MEJ] UI. / GE_GFUDrawDone {MicroUI GraphicalEngine) Asynchronous drawing operation done
129138 22.482 554 455 [MEJ] UI_ J/* x(QueusGenericSend. xQueue=0x00005670 pvItemToQueue=0x2004FFD4 pxHigherPriorityTaskiWoken=0 xCopyPosition=0
128139 22.482 €70 435 [MEJ] UI.. s.;‘-‘ GE_Draw {MicroUI GraphicalEngine) Drawing operation STRING_WIDTH
125140 22.482 75€ 045 [MEJ] UI. Jfy GE Draw (MicroUI GraphicalEngine) Drawing operation STRING WIDTHdone after £5.6 us.
128141 22.482 859 140 [MEJ] DI ’f-" GE Draw (MicroUI GraphicalEngine) Drawing operation DRAW STRING
128142 22.484 418 845 [MEJ] UI. Jfy GE Draw (MicroUI GraphicalEngine) Drawing operation DRAW_STRINGdone after 1.5587 ms.
12814 424 £a2 245 eI T M GF e MiprallT GrarhicalFnaine) Drawing onerarion FTLL BECTRNGLE

Fig. 80: MicroUl Traces displayed in SystemView
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Thefollowing text can be copied in afile called SYSVIEW_MicroUI. txt and copiedin SystemView installation folder
(e.g. SEGGER/SystemView_V252a/Description/)

NamedType UIEvent 0=COMMAND

NamedType UIEvent 1=BUTTON

NamedType UIEvent 2=POINTER

NamedType UIEvent 3=STATE

NamedType UIEvent 4=UNKNOWN

NamedType UIEvent 5=CALLSERIALLY
NamedType UIEvent 6=STOP

NamedType UIEvent 7=INPUT

NamedType UIEvent 8=SHOW_DISPLAYABLE
NamedType UIEvent 9=HIDE_DISPLAYABLE
NamedType UIEvent 11=PENDING_FLUSH
NamedType UIEvent 12=FORCE_FLUSH
NamedType UIEvent 13=REPAINT_DISPLAYABLE
NamedType UIEvent 14=REPAINT_CURRENT_DISPLAYABLE
NamedType UIEvent 15=KF_STOP_FEATURE

NamedType UINewImage 0=MUTABLE_IMAGE
NamedType UINewImage 1=IMAGE_FROM_PATH
NamedType UINewImage 2=IMAGE_FROM_INPUTSTREAM

NamedType UIImageData O=NEW_IMAGE

NamedType UIImageData 1=LOAD_MICROEJ
NamedType UIImageData 2=NEW_ENCODED

NamedType UIImageData 3=NEW_MICROEJ_EXTERNAL
NamedType UIImageData 4=NEW_ENCODED_EXTERNAL
NamedType UIImageData 5=MEMORY_INPUTSTREAM
NamedType UIImageData 6=BYTEARRAY_INPUTSTREAM
NamedType UIImageData 7=GENERIC_INPUTSTREAM
NamedType UIImageData 8=LINK_IMAGE

NamedType GEDraw 1=WRITE_PIXEL

NamedType GEDraw 2=DRAW_LINE

NamedType GEDraw 3=DRAW_HORIZONTALLINE
NamedType GEDraw 4=DRAW_VERTICALLINE
NamedType GEDraw 5=DRAW_RECTANGLE
NamedType GEDraw 6=FILL_RECTANGLE
NamedType GEDraw 7=UNKNOWN

NamedType GEDraw 8=DRAW_ROUNDEDRECTANGLE
NamedType GEDraw 9=FILL_ROUNDEDRECTANGLE
NamedType GEDraw 10=DRAW_CIRCLEARC
NamedType GEDraw 11=FILL_CIRCLEARC
NamedType GEDraw 12=DRAW_ELLIPSEARC
NamedType GEDraw 13=FILL_ELLIPSEARC
NamedType GEDraw 14=DRAW_ELLIPSE
NamedType GEDraw 15=FILL_ELLIPSE
NamedType GEDraw 16=DRAW_CIRCLE
NamedType GEDraw 17=FILL_CIRCLE
NamedType GEDraw 18=DRAW_ARGB

NamedType GEDraw 19=DRAW_IMAGE

NamedType GEDraw 50=DRAW_POLYGON
NamedType GEDraw 51=FILL_POLYGON
NamedType GEDraw 52=GET_IMAGEARGB
NamedType GEDraw 53=DRAW_STRING
NamedType GEDraw 54=DRAW_DEFORMED_STRING

(continues on next page)
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NamedType
NamedType
NamedType
NamedType
NamedType

NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType
NamedType

NamedType
NamedType
NamedType
NamedType
NamedType

#

# MicroUI
#

0

—data =
1

2

—%p)

#

GEDraw
GEDraw
GEDraw
GEDraw
GEDraw

GEDraw
GEDraw
GEDraw
GEDraw
GEDraw
GEDraw
GEDraw
GEDraw
GEDraw

GEDraw
GEDraw
GEDraw
GEDraw
GEDraw

UI_EGEvent

%p) |

UI_DROPEvent
UI_InputEvent

UI_DisplayEvent

UI_UserEvent

UI_OpenImage

UI_ImageData

55=DRAW_IMAGE_DEFORMED
56=DRAW_CHAR_ROTATION_BILINEAR
57=DRAW_CHAR_ROTATION_SIMPLE
58=STRING_WIDTH

59=GET_PIXEL

100=DRAW_THICKFADEDPOINT
101=DRAW_THICKFADEDLINE
102=DRAW_THICKFADEDCIRCLE
103=DRAW_THICKFADEDCIRCLEARC
104=DRAW_THICKFADEDELLIPSE
105=DRAW_THICKLINE
106=DRAW_THICKCIRCLE
107=DRAW_THICKELLIPSE
108=DRAW_THICKCIRCLEARC

200=DRAW_FLIPPEDIMAGE

201=DRAW_ROTATEDIMAGENEARESTNEIGHBOR

202=DRAW_ROTATEDIMAGEBILINEAR

203=DRAW_SCALEDIMAGENEARESTNEIGHBOR

204=DRAW_SCALEDIMAGEBILINEAR

# MicroUI Graphics Engine

#

10
11
12

13

—(MicroUI GraphicalEngine) Drawing operation %GEDraw done
(MicroUI GraphicalEngine) Unknown event
(MicroUI GraphicalEngine) Asynchronous drawing operation done

14
15

#

GE_FlushStart
GE_FlushDone
GE_DrawInternal

GE_Draw

GE_Unknown
GE_GPUDrawDone

(continued from previous page)

(MicroUI) Execute EventGenerator event %UIEvent (generatorID = %u,.
(MicroUI) EventGenerator event %UIEvent done
(MicroUI) Drop event %p
(MicroUI) Execute native input event %UIEvent (generatorID = %u, event =
| (MicroUI) Native input event %UIEvent done
(MicroUI) Execute display event %UIEvent (event = %p) o
(MicroUI) Display event %UIEvent done
(MicroUI) Execute user event %p
| (MicroUI) User event %p done
(MicroUI) Create %UINewImage
| (MicroUI) Image created; id = %p
(MicroUI) %UINewImage ( %UIlmageData ): id = %p; size = %d*%d

(MicroUI GraphicalEngine) Flush back buffer (%u,%u) (%u*%u)

(MicroUI GraphicalEngine) Flush done

(MicroUI GraphicalEngine) Drawing operation %GEDraw [
s (MicroUI GraphicalEngine) Drawing operation %GEDraw done

(MicroUI GraphicalEngine) Drawing operation %GEDraw [

# MicroUI Input Engine

#

20
21
22

IE_InvalidEvent
IE_QueueFull
IE_AddEvent

(MicroUI Input Engine) Invalid event: %p
(MicroUI Input Engine) Queue full, cannot add event %p
(MicroUI Input Engine) Add event %p (index = %u / queue length = %u)

(continues on next page)
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(continued from previous page)

23 IE_ReplaceEvent (MicroUI Input Engine) Replace event %p by %p (index = %u / queue length =
fa%u)
24 IE_ReadEvent (MicroUI Input Engine) Read event %p (index %u)

Error Messages
When an exception is thrown by the implementation of the MicroUl API, the exception MicroUlException with the

error message MicroUI:E=<messageld> is issued, where the meaning of <messageld> is defined in following
table:

Table 20: MicroUl Error Messages

Message ID Description

1 Another EventGenerator cannot be added into the system pool (max 254).

0 [platform issue] Result of MicroUl static initialization step seems invalid. MicroUl cannot
start. Please fix MicroUl static initialization step (see Static Initialization) and rebuild the
platform.

-1 MicroUl is not started; call MicroUl.start() before using a MicroUl API.

-2 Unknown event generator class name.

-3 Deadlock. Cannot wait for an event in the same thread that runs events. Dis-

play.waitFlushCompleted() must not be called in the MicroUl thread (for example in
render method).

-4 Resource’s path must be relative to the classpath (start with ‘/’) or resource is not available.

-5 The resource data cannot be read for unknown reason.

-6 The resource has been closed and cannot be used anymore.

-7 Out of memory. Not enough memory to allocate the Image’s buffer. Try to close some
uselessimages and retry opening the new image, or increase the size of the MicroUl images
heap.

-8 The platform cannot decode this kind of image, because the required runtime image de-
coder is not available in the platform.

-9
This exception is thrown when the FIFO of the internal MicroUl thread is full. In this case,
no more event (such as requestRender, input events, etc.) can be added into it.

Most of time this error occurs when:

- There is a user thread which performs too many calls to the method requestRender
without waiting for the end of the previous drawing.

- Too many input events are pushed from an input driver to the MicroUl thread (for
example some touch events).

-10 There is no display on the platform.

-1 There is no font (platform and application).

-12 The maximum number of event generators in the pool (254) has been reached.
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Migration Guide

The MicroUl implementation is provided by the MicroEJ Ul Pack. According the MicroEJ Ul Pack used to build the
MicroEJ Platform, the application has to be updated.

« Referto the table that illustrates the implemented MicroUl API for each MicroEJ Ul Pack.

+ Refer to the latest MicroUl API Changelog.
+ Refer to the latest Drawing APl Changelog.

The following chapters describe the changes to perform in the application according the MicroEJ Ul Pack used to
build the MicroEJ Platform.

From 12.x to 13.x

« Update ej.api#microui dependency to the latest available version 3.x.

« Add ej.api#drawing dependency.

<dependencies>
<dependency org="ej.api" name="microui"” rev="3.1.0"/>
<dependency org="ej.api” name="drawing"” rev="1.0.3"/>
</dependencies>

From 10.x to 12.x

« In MicroEJ application launcher > Configuration tab > MicroUl: check Use Flying Images when the
application is using the flying images (property com.microej.library.microui.flyingimage.enabled).

« In MicroEJ application launcher, increase the Java heap: it now contains MicroUl images metadata (size,
format, clip etc.). The iceatea heap has been automatically decreased.

From 9.xto0 10.x

« In MicroEJ application launcher > Configuration tab > MicroUl: set the image heap size (property
ej.microui.memory.imagesheap.size).

4.16.2 MicroVG

Introduction

MicroVG Foundation Library provides vector drawing capabilities.

To use the MicroVG Foundation Library, add MicroVG APl module to a module description file:

<dependency org="ej.api” name="microvg" rev="1.1.1"/>

The MicroVG Library brings the following features:
« the creation and drawing of paths with color or linear gradient.
+ the drawing of texts using vector fonts with color or linear gradient.

« the drawing of vector images.
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« the transformation of paths, texts, images with affine transformation matrices.

Note: The MicroVG library natives use different drawing engines, font rendering and layout engines for embedded
and simulator implementations.

This can lead to some slightly drawing differences, like for instance in the antialiasing processing of font glyphs.

Path

Path Creation

The MicroVG library enables the creation of vector paths composed of the following commands:
» Move
« Line
+ Cubic Bezier Curve
+ Quadratic Bezier Curve
+ Close

The coordinates of the points associated with these commands can be absolute or relative.

Path path = new Path();

path.moveTo(70, 20);
path.cubicTo(0@, @, 10, 50, 80, 90);
path.lineTo(95, 75);
path.quadTo(12, 40, 80, 50);
path.close();

Path path = new Path();

path.moveTo(70, 20);

path.cubicToRelative(-70, -20, -60, 30, 10, 70);
path.lineToRelative(15, -15);
path.quadToRelative(-83, -35, -15, -25);
path.close();

Path Drawing

A path can be drawn with a call to ej.microvg.VectorGraphicsPainter.fillPath().
The drawn path will be filled with the graphic context color or with a linear gradient.

The path can be transformed by a transformation matrix (this concept is explained in Matrix section) before draw-
ing.
A FillType and an Alpha Blending Mode can be applied during the drawing.
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Fill Path With Graphics Context Color

The default alpha channel value of the drawing is 0xFF (opaque opacity).

g.setColor(Colors.GRAY);
VectorGraphicsPainter.fillPath(g, path, 0, 0);

Fill Path With a Linear Gradient

Refer to Linear Gradient section for more details about the definition of a linear gradient.

The opacity value of the drawing is defined by the Alpha channel of the ARGB color values of the each linear gradient
stop point.

LinearGradient gradient = new LinearGradient(@, 0, 100, 0, new int[] { oxffff0000, oxffffffoo,.
SOXFFFFFfff 3);
VectorGraphicsPainter.fillPath(g, path, new Matrix(), gradient);
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Fill Type

A path can be drawn with a FillType argument. This argument defines the way a path will be filled.

The following values are a available:

« FillType.Winding: Specifies that “inside” is computed by a non-zero sum of signed edge crossings.

« FillType.EVEN_ODD: Specifies that “inside” is computed by an odd number of edge crossings.

Path

path.
path.
path.
path.
path.
path.

path = new Path();

moveTo(50, 0);
lineTo(21, 90);
lineTo(98, 35);
lineTo(2, 35);
lineTo(79, 90);
close();
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Opacity and Blending Mode

The opacity of the drawing can be provided to the fillPath method with a blending mode.
When the drawing is done with graphic context color, the given alpha value replaces the default value ( 0xFF ).

When the drawing is done with a linear gradient, the given alpha is applied above each gradient colors alpha chan-
nel values(0x80 alpha value on #80FFFFFF ARGB color leads to #40FFFFFF color).

The supported blending modes are:
« SRC:The source pixels replace the destination pixels.
+ SRC_OVER : The source pixels are drawn over the destination pixels.
+ DST_OVER : The source pixels are drawn behind the destination pixels.

« SRC_IN : Keeps the source pixels that cover the destination pixels, discards the remaining source and desti-
nation pixels.
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Matrix

A Matrix is composed of an array of numbers with three rows and three columns. It is used to apply an
affine transformations to Path points. (Refer to <https://en.wikipedia.org/wiki/Transformation_matrix#Affine_
transformations> to get more information about affine transformations).

The available transformations are:
« translation
« rotation
« scaling

Scaling and rotation are always performed around the (0,0) pivot point. In order to rotate or scale a Path with a
pivot point, the matrix must be translated before and after the rotation/scaling.

A Matrix is created as an identity matrix, which means that a Path resulting of a transformation with this matrix is
identical to the original Path.

The Matrix can be initialized with a transformation with set methods:
« setTranslate(translateX, translateyY)
« setRotate(angle)
« setScale(scaleX, scaleY)
A transformation can be prepended to a Matrix with the prepend methods:
« preTranslate(translateX, translateY)
+ preRotate(angle)
« preScale(scaleX, scaleY)
A transformation can be appended to a Matrix with the append methods:
« postTranslate(translateX, translateY)

+ postRotate(angle)
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« postScale(scaleX, scaleY)
A Matrix can also get transformations from an other Matrix with the concatenate and set methods:
« preConcat(matrix)
« postConcat(matrix)
« set(matrix)
« setConcat(matrix0, matrixi)

Once a Matrix has been computed, it can be used to draw an object (Path, String, Vectorlmage). All the points of the
drawn object will be transformed by the Matrix.

When a Matrix has been computed with multiple type of transformation, the sequence order of the transformation
is important. Chaining the transformations in a different order will not provide the same Matrix. The result of the
previous transformation is the input to the next transformation.

The following examples use the Path created in the section Path Creation with different transformations.

Translation

Matrix matrix = new Matrix();
matrix.setTranslate(200, 150);

Rotation

Around point (0,0).

Matrix matrix = new Matrix();
matrix.setRotate(40);
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Around a pivot point (80,50).

Matrix matrix = new Matrix();
matrix.setRotate(40);

float pivotX = 80;
float pivotY = 50;
matrix.preTranslate(-pivotX, -pivotY);
matrix.postTranslate(pivotX, pivotY);
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Scale

From point (0,0).

Matrix matrix = new Matrix();
matrix.setScale(2,3);

Concatenate Matrixes

Sequence order has an incidence on the rendering.

Matrix matrix@ = new Matrix();
matrix@.setScale(2, 3);

Matrix matrix1 = new Matrix();
matrixl.setTranslate(100, 40);

Matrix matrix2 = new Matrix();
matrix2.setConcat(matrix@, matrix1);

g.setColor(Colors.GRAY);

VectorGraphicsPainter.fillPath(g, path, matrix2);

matrix2.setConcat(matrix1, matrixo);

g.setColor(Colors.YELLOW);

VectorGraphicsPainter.fillPath(g, path, matrix2);
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Linear Gradient

The MicroVG library supports the drawing of shapes with a linear gradient of color.
Alinear gradient is specified by a linear segment and a set of ARGB colors associated with points on that segment.

The colors along the segment between those points are calculated using linear interpolation, then extended per-
pendicular to that line.

The position of the color points on the segment are given from 0.0f (start of point) to 1.0f (end of the segment).
There are two ways to create a gradient:

« with a start point, an end point and a color table: the first color will be applied to the start point, the second
color to the end point and other colors distributed evenly along the gradient segment.

Path path = new Path();
path.moveTo(@, 0);
path.lineTo(100, 0);
path.lineTo(100, 100);
path.lineTo(@, 100);
path.close();

LinearGradient gradient = new LinearGradient(0, 0, 99, 0,
new int[] { oxffffeeeo, oxffffffee, Oxffffffff });

VectorGraphicsPainter.fillPath(g, path, new Matrix(), gradient);
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« with a start point, an end point, a color table and a position table: the colors are applied to their correspond-
ing relative positions on the segment. If the first point is not the start point of the segment, then first color is
applied from the start of the segment to the first point. If the last point is not the end point of the segment,
then last color is applied from the last point to the end of the segment.

LinearGradient gradient = new LinearGradient(0, @, 99, 0,

new int[] { Oxffffeeee, oxffffffeo, oxffffffff 3},
new float[] { 0.4f, 0.6f, 0.8f });

VectorGraphicsPainter.fillPath(g, path, new Matrix(), gradient);

The transformation applied to the object (Path or String) to draw with a gradient is also applied to that gradient.
The LinearGradient is not updated after the drawing.
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LinearGradient gradient = new LinearGradient(0, 0, 99, 0,
new int[] { oxffffoeeo, oxffffffeo, oxffffffff });

Matrix matrix = new Matrix();
matrix.setScale(2, 2.5f);
matrix.postRotate(30);
matrix.postTranslate(100, 100);

VectorGraphicsPainter.fillPath(g, path, matrix, gradient);

Vector Fonts

Overview

The MicroVG library enables the usage of Vector Fonts.

Compared to MicroUl Fonts, Vector Fonts brings the following features:
« the text strings are scalable and can be transformed using a Matrix object.
« the TTF/OTF font files don’t need to be preprocessed.
« the text strings can be drawn with opacity, a color or a linear gradient.

The library also considers the Kerning space described in the font file kerning table, and allows a fine adjustement
of the inter-letters spacing.

It also provides metrics measurement methods to correctly place the text within the surrounding drawing elements
(i.e.in alabel).
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Loading a Font File

Font files must be declared as ressources in a.resources.list file available in the classpath(Application Resources).

ThenthefonthastobeloadedinaVectorFont object with a callto ej.microvg.VectorFont.loadFont(). This VectorFont
object can then be used to draw text strings.

Text String Drawing

A string can be drawn in the graphics context with a call to ej.microvg.VectorGraphicsPainter.drawString().

The text string height is scalable, and multiple font files can be used in parrallel.

VectorFont font@ = VectorFont.loadFont(”/fonts/Arial.ttf");
VectorFont font1 = VectorFont.loadFont("”/fonts/RAVIE.ttf");

int x = 20;
int y = 30;
int yOffset = 150;

g.setColor(Colors.LIME);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ"”, font@, 20, x, y);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ”, fontl1, 20, x, y + yOffset);

g.setColor(Colors.RED);

y += 20;

VectorGraphicsPainter.drawString(g, "Hello MicroEJ", font@, 30, x, y);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ"”, fontl, 30, x, y + yOffset);

g.setColor(Colors.WHITE);

y += 30;

VectorGraphicsPainter.drawString(g, "Hello MicroEJ", font@, 40, x, y);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ"”, fontl, 40, x, y + yOffset);

g.setColor(Colors.YELLOW);

y += 40;

VectorGraphicsPainter.drawString(g, "Hello MicroEJ"”, font@, 50, x, y);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ"”, fontl, 50, x, y + yOffset);

display.flush();
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Hello MicroEJ

Hello MicroEJ
Hello MicroEJ

Helle WicrcEd

Hello miegoEa
Hello Wicre

Text Color

The text string can be colored with the graphics context color or a with a linear gradient(Linear Gradient).

FillType and Alpha Blending Mode are also managed similarly to Path drawing (refer to Fill Type and Opacity and
Blending Mode).

g.setColor(Colors.LIME);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ"”, font, 50, x, y);

LinearGradient gradient = new LinearGradient(@, 0, 250, 50,
new int[] { oxffffoeeo, oxffffffee, oxffffffff });

Matrix matrix = new Matrix();

matrix.setTranslate(x, y + 60);

VectorGraphicsPainter.drawGradientString(g, "Hello MicroEJ", font, 50, matrix, gradient, 0Oxff,
BlendMode.SRC_OVER, 0);
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Hello MicrokEJ
>llo MicroEJ

Text Transformations

The text string can also be transformed with a Matrix to translate, rotate, scale the drawing.

Matrix matrix@ = new Matrix();

matrix0.setTranslate(20, 60);
VectorGraphicsPainter.drawString(g,

matrix@.preRotate(180);
matrix0.postTranslate(300, 120);
VectorGraphicsPainter.drawString(g,

Matrix matrix1 = new Matrix();
matrix1.setScale(0.5f, 1.2f);
matrix1.postRotate(45);
matrixl.postTranslate(80, 200);

VectorGraphicsPainter.drawString(g,

matrix1.setScale(@.5f, 1.2f);
matrix1.postRotate(-45);
matrix1.postTranslate(200, 300);
VectorGraphicsPainter.drawString(g,

"Hello MicroEJ", font,

"Hello MicroEJ", font,

"Hello MicroEJ"”, font,

"Hello MicroEJ", font,

50,

50,

50,

50,

matrix@, oxff,

matrix@, oxff,

matrix1, Oxff,

matrix1, Oxff,

BlendMode

BlendMode

BlendMode

BlendMode

.SRC_OVER,

.SRC_OVER,

.SRC_OVER,

.SRC_OVER,

0);

0);

0);

0);
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Letter Spacing

The inter character distance can be adjusted for each string drawing. By default, the inter character distance is
computed from the font file metrics, considering kerning, if the font file includes a kerning table. It can be adjusted
with the letterSpacing parameter of drawString(). Its default value is 0 pixel, a positive/negative value will in-
crease/reduce the inter space distance by the corresponding pixel value.

Matrix matrix = new Matrix();

matrix.setTranslate(20, 60);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ", font, 50, matrix, 0xff, BlendMode.SRC_OVER, 0);

matrix.postTranslate(@, 60);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ", font, 50, matrix, 0xff, BlendMode.SRC_OVER, 5f);

matrix.postTranslate(@, 60);
VectorGraphicsPainter.drawString(g, "Hello MicroEJ", font, 50, matrix, 0xff, BlendMode.SRC_OVER, -2);
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Colored Emajis

The library supports the drawing of colored multilayer glyphs, but only for the embedded implementation. The
simulator implementation draws the full emoji glyph with the color of the graphics context.

Only font files with CPAL/COLR tables are supported.
Font files with CBDT/CBLC tables are not supported.

Metrics and Text Positioning

All metrics provided by the ej.microvg.VectorFont class are given for a specific font size. The font size defines the
height to which each character bounding box will be scaled.

The following figure presents some concepts of font metrics standarts:

When a string is drawn with a call to ej.microvgVectorGraphicsPainter.drawString() or
ej.microvg.VectorGraphicsPainter.drawGradientString(), the anchor point of the string is the top left corner
of the text rendering box. This anchor point is located horizontally on the first pixel of the first drawn glyph and
vertically on the max ascent line.
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Anchor Point

The ej.microvg.VectorFont.getBaselinePosition() method can be used to position the text baseline on a horizontal
line.

The ej.microvg.VectorFont.getHeight() method can be used to center a text inside a label, by positionning the an-
chor point in order to have the same space above and below the text string.

Two other methods are available to position a known text in a label:
+ ej.microvg.VectorFont.measureStringHeight()
+ ej.microvg.VectorFont.measureStringWidth()

These methods return the width and height of a string drawing. They are computed from the width and height of
the glyphs composing the string.

measureStringHeight()

measureStringWidth()
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These methods can measure a specific glyph width and height using a one character string.

Note: The metrics are extracted from the character glyph metrics without considering the antialiasing introduced
by the glyphs rasterizer.

Drawing a Text on a Circle

Thelibrary proposes the drawing of atext on a circle by a callto ej.microvg.VectorGraphicsPainter.drawStringOnCircle().
The string is rendered as if the baseline of the string was a circle arc.

The string direction can be either clockwise or counter clockwise.

Allthe features described above are still available (linear gradient, transformations, letter spacing, kerning, colored
emojis).

int x = 196;

int y = 196;

int diameter = 250;
g.setColor(Colors.YELLOW);

Painter.drawCircle(g, x - diameter / 2, y - diameter / 2, diameter);

g.setColor(Colors.PURPLE);
Matrix matrix = new Matrix();

matrix.setTranslate(x, y);

VectorGraphicsPainter.drawStringOnCircle(g, "Hello MicroEJ"”, font, 50, matrix, diameter / 2,
Direction.CLOCKWISE);

diameter = 100;

g.setColor(Colors.YELLOW);
Painter.drawCircle(g, x - diameter / 2, y - diameter / 2, diameter);

g.setColor(Colors.RED);
VectorGraphicsPainter.drawStringOnCircle(g, "Hello MicroEJ"”, font, 20, matrix, diameter / 2,
Direction.COUNTER_CLOCKWISE);
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The anchor point of the drawing is the center of the circle.

The position where the text starts along the circle is the 3 o’clock position (positive X axis). This starting position
can be modified by specifying a rotation into the transformation Matrix.

g.setColor(Colors.PURPLE);
Matrix matrix = new Matrix();

matrix.setTranslate(x, y);

VectorGraphicsPainter.drawStringOnCircle(g,
Direction.CLOCKWISE);

matrix.preRotate(90);

g.setColor(Colors.RED);

VectorGraphicsPainter.drawStringOnCircle(g,
Direction.CLOCKWISE);

matrix.preRotate(90);

g.setColor(Colors.GREEN);

VectorGraphicsPainter.drawStringOnCircle(g,
Direction.CLOCKWISE);

matrix.preRotate(90);

g.setColor(Colors.WHITE);

VectorGraphicsPainter.drawStringOnCircle(g,
Direction.CLOCKWISE);

"Hello MicroEJ", font,

"Hello MicroEJ", font,

"Hello MicroEJ", font,

"Hello MicroEJ", font,

20

)

20,

20,

20

)

matrix, diameter

matrix, diameter

matrix, diameter

matrix, diameter

/2,

/ 2,

/2,

/2,
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Complex Text Layout

Some scripts like Arabic or Thai scripts request a specific text layout mode where the shape or positioning of
a grapheme depends on its relation to other graphemes (Refer to https://en.wikipedia.org/wiki/Complex_text_
layout).

The MicroVG library provides two different layout modes:

« the simple layout mode for latin scripts and other scripts where character unicodes and glyphs are one-to-
one associated.

« the complex layout mode for complex text layout scripts like arabic or thai.

The simple layout mode draws the text character as described in the previous sections. It uses the font Kerning
table and the glyphs advanceX parameter to position the glyphs one after the other.

The complex layout mode uses the GPOS and GSUB font tables to substitute and position the character glyph.

The complex layout mode can be selected while loading the glyph with ej.microvg.VectorFont.loadFont by passing
a supplementary boolean argument with value true.

Next example shows the same arabic string drawn with the same font but with simple (in white) and complex lay-
out(in RED).

VectorFont font@ = VectorFont.loadFont(FONT_NAME, false);
VectorFont font1l = VectorFont.loadFont(FONT_NAME, true);

String s = "";

g.setColor(Colors.WHITE);
VectorGraphicsPainter.drawString(g, s, font@, 20, 50, 50);

g.setColor(Colors.RED);
VectorGraphicsPainter.drawString(g, s, fontl, 20, 50, 100);
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Text Measurement and Positioning

The measurement of string in complex layout mode respects the requirements presented in Metrics and Text Posi-
tioning.

Strings from script where text is read from right to left, like arabic, are still drawn with the anchor point located on
the top left of the string.

Bidirectional Text

The complex layout mode does not support bidirectional text. A bidirectional text has to be splitted in multiple
strings and each string has to be drawn to the correct location.

Limitations

The simulator rendering of complex layout mode for Drawing a Text on a Circle feature is done with many approxi-
mations. This rendering can still be used to have an overview of the text positionning on the display.

The letterSpacing feature is not supported by the simulator implementation. Texts will be displayed with a let-
terspacing value of 0.

Vector Images

Overview

Vector Images are graphical resources that can be accessed with a call to ej.microvg.Vectorimage.getimage(). The
images are converted at build-time (using the image generator tool) to immutable resources.

Images that must be processed by the image generator tool are declared in *.vectorimages.list files. The file
formatis a standard Java properties file, each line representing a / separated resource path relative to the MicroEJ
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classpath root referring to a vector image file (e.g. .svg, .xml). The resource must be followed by a parameter
(separated by a : ) which defines and/or describes the image output file format (raw format).

Currently accepted formats are :
+ :VGF : vglite compatible format with coordinates encoded as float numbers (32 bits).
+ :VG32: vglite compatible format with coordinates encoded as signed int numbers (32 bits).
+ :VG16 : vglite compatible format with coordinates encoded as signed short numbers (16 bits).
« :VG8 : vglite compatible format with coordinates encoded as signed char numbers (8 bits).

Example:

/com/mycompany/MyImagel.svg:VGF
/com/mycompany/androidVectorDrawable.xml:VG8

Supported Input Files

The image generator tool supports the following input file formats:
+ Android Vector Drawable
+ SVG

Refer to the Limitations / Supported Features section for the list of supported features for these file formats.

The vector image objects are extracted and converted to paths made of Move, Line and Curve commands.

Each path is associated with either afill color or a linear gradient. All object strokes are converted to filled paths at
build-time.

Objects group transformations are also extracted from the input file and applied at run-time.

Drawing Images
Drawing and Transforming Images

Once an image has been loaded it can be drawn in the graphic context with a «call to
ej.microvg.VectorGraphicsPainter.drawlmage().

The image is associated with a transformation Matrix that will be applied in order to translate, scale and/or rotate
the image.

The application can get the width and the height of the image with ej.microvg.\Vectorimage.getWidth() and
ej.microvg.Vectorlmage.getHeight() to correctly scale and position the image in the application window.

The following example describes how an Android Vector Drawable file can be drawn and positioned on the display.

« Android Vector Drawable file:

<vector xmlns:android="http://schemas.android.com/apk/res/android” xmlns:aapt="http://schemas.android.
—com/aapt”

android:width="100dp" android:height="100dp" android:viewportWidth="100" android:viewportHeight="100
s TS

<path android:pathData="M @ @ h50 v50 h-50 z" android:fillColor="#FFFFAA"/>

<path android:pathData="M 50 50 h50 v50 h-50 z">

<aapt:attr name="android:fillColor">
(continues on next page)
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<gradient
android:startColor="#0000ff" android:startX="50" android:startY="50"
android:endColor="#ff00ff" android:endX="100" android:endY="100"
android: type="linear">

</gradient>
</aapt:attr>
</path>
</vector>

public static void main(String[] args) {
MicroUI.start();

Display display = Display.getDisplay();
GraphicsContext g = display.getGraphicsContext();

VectorImage image = VectorImage.getImage("/images/myImage.xml"”); //$NON-NLS-1$
Matrix matrix@ = new Matrix();

matrix@.setTranslate(20, 20);

matrix@.preScale(50 / image.getWidth(), 50 / image.getHeight());

Matrix matrix1 = new Matrix();

matrix1.setTranslate(150, 150);

matrix1.preRotate(45);

VectorGraphicsPainter.drawImage(g, image, matrixo);
VectorGraphicsPainter.drawImage(g, image, matrix1);

display.flush();

4.16. Graphical User Interface 313



MicroEJ Documentation, Revision d4ede019

Drawing With Opacity

The vector image can be drawn with a global opacity level.

VectorImage image = VectorImage.getImage("/images/myImage.xml"); //$NON-NLS-1%

// the global opacity rendering value, between @ (transparent) and 255 (opaque)
int opacity = 0x80;

VectorGraphicsPainter.drawImage(g, image, new Matrix(), opacity);

Warning: As paths are drawn one after the other, images that contain overlapping paths are not correctly
colored when a global opacity is applied. The rendering of these images will throw an exception. The images
must be reworked to suppress overlapping.

Color Filtering

AVectorlmage object can be derived from another Vectorimage object, keeping the paths and transformations but
updating the colors using a color matrix.

This color matrix is a 4x5 float matrix. It is organized like that:
+ Each lineis used to compute a component of the resulting color, in this order: red, green, blue, alpha.

« The four first columns are multipliers applied to a component of the initial color, in this order: red, green,
blue, alpha.

« The last column is a constant value.

Let A, R, G, B be the components of the initial color and the following array a color matrix:
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{ rRy rGr rBy rA; rC, // red
gR’ gG! gB) gA, gC, // green
bR’ bGy bBy bA; bc, // blue

aR, aG, aB, aA, aC } // alpha

The resulting color components are computed as:

resultRed = rR * R+ rG =G+ rBxB +rA*A+ rC

resultGreen = gR * R + g6 x G + gB * B + gA = A + gC
resultBlue = bR * R + bG * G + bB * B + bA * A + bC
resultAlpha = aR * R + aG * G + aB * B + aA * A + aC

If the resulting component value is below 0 or above 255, the component value is clamped to these limits.

4.16. Graphical User Interface

A Vectorlmage object can also be drawn associated to a color matrix by a «call to
ej.microvg.VectorGraphicsPainter.drawFilteredimage().
The following example illustrates this feature.
VectorImage image = VectorImage.getImage("/images/myImage.xml”); //$NON-NLS-1%
// Derive a new VectorImage
float[] colorMatrix@ = new float[] { //
1f, @, 0, 0, 0, // red
0, 0, 0, 0, @, // green
0, o, 1f, @, @, // blue
9, 0, 0, 1f, 0, // alpha
}
VectorImage imageFiltered = image.filterImage(colorMatrix®);
VectorGraphicsPainter.drawImage(g, imageFiltered, new Matrix());
float[] colorMatrix1 = new float[] { //
of, o, 0, 0, 0, // red
0.5f, 0.5f, @, @, @, // green
0, o0, 1f, -0.5f, @, // blue
0, 0, 0, 1f, @, // alpha
}
Matrix matrix1 = new Matrix();
matrix1.setTranslate(image.getWidth(), 0);
VectorGraphicsPainter.drawFilteredImage(g, image, matrix1, colorMatrix1);
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Animated Vector Images

The Android Vector Drawable format provides the ability to change the properties of vector graphics over time, in
order to create animated effects.

The transformations of the objects over the time are embedded in the Vec-
tor image file and a call to ej.microvgVectorGraphicsPainter.drawAnimatedimage()  or
ej.microvg.VectorGraphicsPainter.drawFilteredAnimatedimage() will draw the image for a specific time frame.

The application can get the duration of the image animation with a call to ej.microvg.Vectorimage.getDuration().

Every image object that is animated outside the image viewbox is clipped at the image boundary. In any cases, es-
pecially when the image is rotated, the image boundary is the rectangle that contains all the corners of the original
image.

The supported file format is an Animated Vector Drawable xml file with animations and vector definition in the
same file as described in Android API.

The SVG format also supports the animation of vector graphics objects, but this feature is not yet implemented in
the MicroVG library for this file format.

SVG files that need to be animated should be converted to Android Vector Drawable format with the Android Vector
Asset tool and then animated manually or with a tool like Shapeshifter.

Supported animations

This section will present the different available animations with an example.

For each example, this simple java code will be used.

VectorImage image = VectorImage.getImage("/images/myImage.xml"); //$NON-NLS-1%
Matrix matrix = new Matrix();

matrix.setTranslate(100,100);

matrix.preScale(2,2);

(continues on next page)
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long elapsed = 0;
long step = 10;
while (true) {
// Clear Screen
g.setColor(Colors.BLACK);
Painter.fillRectangle(g, 0, @, display.getWidth(), display.getHeight());

VectorGraphicsPainter.drawAnimatedImage(g, image, matrix, elapsed);
display.flush();

// Pause the current thread

try {
Thread.sleep(step);

} catch (InterruptedException e) {
e.printStackTrace();

3

// Update current image time

if (elapsed < image.getDuration()) {
elapsed += step;

} else {
elapsed = 0;

TranslateX and TranslateY

Any group in the Android Vector Drawable can be translated in X or Y direction with an object animator.

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android”
xmlns:aapt="http://schemas.android.com/aapt">
<aapt:attr name="android:drawable">
<vector android:width="100dp" android:height="100dp"
android:viewportWidth="100" android:viewportHeight="100">
<group android:name="yellow_group">
<path android:pathData="M @ @ h50 v50 h-50 z" android:fillColor="#FFFFAA"/>
</group>
<group android:name="gradient_group”>
<path android:pathData="M 50 50 h50 v50 h-50 z">
<aapt:attr name="android:fillColor">
<gradient
android:startColor="#0000ff" android:startX="50" android:startY="50"
android:endColor="#ff00ff" android:endX="100" android:endY="100"
android: type="linear">
</gradient>
</aapt:attr>
</path>
</group>
</vector>
</aapt:attr>
<target android:name="yellow_group">
<aapt:attr name="android:animation">
<set android:ordering="together">
<objectAnimator android:propertyName="translateX”" android:valueType="floatType"
(continues on next page)
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android:duration="1000" android:startOffset="0" android:valueFrom="0" android:valueTo="50
H”/>
<objectAnimator android:propertyName="translateX" android:valueType="floatType"
android:duration="1000" android:startOffset="1500" android:valueFrom="50"_
—android:valueTo="0"/>
</set>
</aapt:attr>
</target>
<target android:name="gradient_group">
<aapt:attr name="android:animation">
<set android:ordering="together">
<objectAnimator android:propertyName="translateX"” android:valueType="floatType"
android:duration="1000" android:startOffset="0" android:valueFrom="@" android:valueTo="-
—50"/>
<objectAnimator android:propertyName="translateX"” android:valueType="floatType"
android:duration="1000" android:startOffset="1500" android:valueFrom="-50"_
—android:valueTo="0"/>
<objectAnimator android:propertyName="translateY"” android:valueType="floatType"
android:duration="1000" android:startOffset="0" android:valueFrom="@" android:valueTo="-
—50"/>
<objectAnimator android:propertyName="translateY"” android:valueType="floatType"
android:duration="1000" android:startOffset="1500" android:valueFrom="-50"_
—android:valueTo="0"/>
</set>
</aapt:attr>
</target>
</animated-vector>

TranslateXY over a path

Any group in the Android Vector Drawable can be translated over a path.

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android”
xmlns:aapt="http://schemas.android.com/aapt">
<aapt:attr name="android:drawable">
<vector android:width="100dp" android:height="100dp"
android:viewportWidth="100" android:viewportHeight="100">
. same as previous example
</vector>
</aapt:attr>
<target android:name="gradient_group">
<aapt:attr name="android:animation">
<set android:ordering="together">
<objectAnimator
android:propertyName="translateXY"” android:duration="5000"
android:propertyXName="translateX"” android:propertyYName="translateY"
android:pathData="M -0.143 0.479 C -30.355 28.02 -153.405 -111.8 -39.441 -70.818
C -48.423 -63.52 70.593 -18.608 -91.09 -15.802 Z2"/>
</set>
</aapt:attr>
</target>
</animated-vector>
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ScaleX and ScaleY

Agroup in the Android Vector Drawable can be scaled on X or Y direction. The scaling pivot point is the one defined
in the group attributes. By default, the pivot point is (0,0).

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android”
xmlns:aapt="http://schemas.android.com/aapt">
<aapt:attr name="android:drawable">
<vector android:width="10@dp" android:height="100dp"
android:viewportWidth="100" android:viewportHeight="100">
<group android:name="yellow_group” android:pivotX="25" android:pivotY="25">
<path android:pathData="M @ @ h50 v50 h-50 z" android:fillColor="#FFFFAA"/>
</group>
<group android:name="gradient_group” >
<path android:pathData="M 50 50 h50 v50 h-50 z">
<aapt:attr name="android:fillColor">
<gradient
android:startColor="#0000ff" android:startX="50" android:startY="50"
android:endColor="#ff0off" android:endX="100" android:endY="100"
android:type="1linear">
</gradient>
</aapt:attr>
</path>
</group>
</vector>
</aapt:attr>
<target android:name="yellow_group">
<aapt:attr name="android:animation">
<set android:ordering="together">
<objectAnimator android:propertyName="scaleX" android:valueType="floatType"
android:duration="1000" android:startOffset="0" android:valueFrom="1"
android:valueTo="0.5"/>
<objectAnimator android:propertyName="scaleX" android:valueType="floatType"
android:duration="1000" android:startOffset="1500" android:valueFrom="0.5"
android:valueTo="1"/>
</set>
</aapt:attr>
</target>
<target android:name="gradient_group">
<aapt:attr name="android:animation">
<set android:ordering="together">
<objectAnimator android:propertyName="scaleX" android:valueType="floatType"
android:duration="1000" android:startOffset="0"
android:valueFrom="0.2" android:valueTo="1"/>
<objectAnimator android:propertyName="scaleX" android:valueType="floatType"
android:duration="1000" android:startOffset="1500"
android:valueFrom="1" android:valueTo="0.2"/>
<objectAnimator android:propertyName="scaleY" android:valueType="floatType"
android:duration="1000" android:startOffset="0"
android:valueFrom="0.2" android:valueTo="1"/>
<objectAnimator android:propertyName="scaleY" android:valueType="floatType"
android:duration="1000" android:startOffset="1500"
android:valueFrom="1" android:valueTo="0.2"/>
</set>
(continues on next page)
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</aapt:attr>
</target>
</animated-vector>

Rotate

A group in the Android Vector Drawable can be rotated around a pivot point. The pivot point is the one defined in
the group attributes. By default, the pivot point is (0,0).

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android”
xmlns:aapt="http://schemas.android.com/aapt">
<aapt:attr name="android:drawable">
<vector android:width="10@dp" android:height="100dp"
android:viewportWidth="100" android:viewportHeight="100">
. same as previous example
</vector>
</aapt:attr>
<target android:name="yellow_group">
<aapt:attr name="android:animation">
<set android:ordering="together">
<objectAnimator android:propertyName="rotation” android:valueType="floatType"
android:duration="1000" android:startOffset="0"
android:valueFrom="0" android:valueTo="720"/>
<objectAnimator android:propertyName="rotation” android:valueType="floatType"
android:duration="1000" android:startOffset="1500"
android:valueFrom="720" android:valueTo="0"/>
</set>
</aapt:attr>
</target>
</animated-vector>

Morphing

The Android Vector Drawable format supports the animation of the pathData attribute of a path. With this type of
animation a shape can be transformed to a totally different other shape. The only constraint is that the origin and
destination pathData must have the same commands format.

Lets take, for instance, the morphing of a rectangle to a circle which have the following commands.

Circle: M 11.9 9.8 C 11.9 8.1 13.3 6.7 14.9 6.7 C 16.6 6.7 18 8.1 18 9.8 C 18 11.6 16.6 13 14.9 13 C 13.
-3 13 11.9 11.6 11.9 9.8 Z

Rectangle: M 11.9 6.7 H 18 V 13 H 11.9 Z

The rectangle path has to be reworked to match with the sequence of commands of the circle path.
The following tools can be used to manipulate the paths to create the wanted animation effect:

» Shapeshifter

« SVGPathEditor
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Thereis an infinity of possibilities to create the new path, and the association of each points of the paths will induce
a specific morphing animation. As an example, let’s define two rectangles very similar visually but with different
definitions:

New Rectangle path1: M 11.9 9.8 C 11.897 7.735 11.906 7.995 11.906 6.697 C 16.6 6.7 16.601 6.706 17.995_
—6.697 C 18 11.6 17.995 11.587 18.004 13.006 C 13.3 13 13.852 13.006 11.897 13.006 Z

New Rectangle path2: M 11.906 6.697 C 11.953 6.698 12.993 6.698 17.995 6.697 C 17.999 8.331 17.997 9.93_
—18.002 13.004 C 16.239 13.007 16.009 13.001 11.893 13.007 C 13.3 13 13.852 13.006 11.893 13.007 Z

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android”
xmlns:aapt="http://schemas.android.com/aapt">
<aapt:attr name="android:drawable">
<vector android:width="2@dp" android:height="20dp"
android:viewportWidth="20" android:viewportHeight="20">
<path android:fillColor="#FFQ@00" android:pathData="M @ @ h40 v40 h-40"/>
<path android:fillColor="#FFQ000" android:pathData="M @ @ h40 v40 h-40"/>
<group android:name="group1” android:translateX="-10">
<path
android:name="circlel”
android:pathData="M 11.9 9.8 C 11.9 8.1 13.3 6.7 14.9 6.7
C 16.6 6.7 18 8.1 18 9.8
C 18 11.6 16.6 13 14.9 13
C 13.3 13 11.9 11.6 11.9 9.8 2"
android: fillColor="#FFFFAA"/>
</group>
<group android:name="group2">
<path android:name="circle2"
android:pathData="M 11.9 9.8 C 11.9 8.1 13.3 6.7 14.9 6.7
C16.6 6.7 18 8.1 18 9.8
C 18 11.6 16.6 13 14.9 13
C 13.3 13 11.9 11.6 11.9 9.8 2"
android:fillColor="#0QFFAA" />
</group>
</vector>
</aapt:attr>

<target android:name="circlel">
<aapt:attr name="android:animation">

<set>
<objectAnimator
android:propertyName="pathData"
android:duration="2000"
android:valueFrom="M 11.9 9.8 C 11.9 8.1 13.3 6.7 14.9 6.7
C 16.6 6.7 18 8.1 18 9.8
C 18 11.6 16.6 13 14.9 13
C13.31311.9 11.6 11.9 9.8 Z"
android:valueTo="M 11.9 9.8 C 11.897 7.735 11.906 7.995 11.906 6.697
C 16.6 6.7 16.601 6.706 17.995 6.697
C 18 11.6 17.995 11.587 18.004 13.006
C 13.3 13 13.852 13.006 11.897 13.006 Z"
android:valueType="pathType"/>
</set>
</aapt:attr>
</target>

<target android:name="circle2">
<aapt:attr name="android:animation">

(continues on next page)
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<set>
<objectAnimator
android:propertyName="pathData"
android:duration="2000"
android:valueFrom="M 11.9 9.8 C 11.9 8.1 13.3 6.7 14.9 6.7
C 16.6 6.7 18 8.1 18 9.8
C 18 11.6 16.6 13 14.9 13
C 13.3 13 11.9 11.6 11.9 9.8 2"
android:valueTo="M 11.906 6.697 C 11.953 6.698 12.993 6.698 17.995 6.697
C 17.999 8.331 17.997 9.93 18.002 13.004
C 16.239 13.007 16.009 13.001 11.893 13.007
C 13.3 13 13.852 13.006 11.893 13.007 Z"
android:valueType="pathType"/>
</set>
</aapt:attr>
</target>

</animated-vector>

Warning: As path strokes are converted at build-time to filled path, the morphing of stroked paths is not sup-
ported. Any image with a path morphing animation on a stroked path will be rejected. Path strokes must be
manually converted to filled path and the morphing of these new filled paths must be created.

Color and Opacity

Any path fillColor, strokeColor, fillAlpha and strokeAlpha attributes in the Android Vector Drawable can be ani-
mated.

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android”
xmlns:aapt="http://schemas.android.com/aapt">
<aapt:attr name="android:drawable">
<vector android:width="55dp" android:height="55dp"
android:viewportWidth="55" android:viewportHeight="55">
<group android:translateX="5">
<path android:name="fillColor"” android:fillColor="#FFQQFF"
android:pathData="M @ @ h20 v20 h-20 Z2"/>
<path android:name="fillAlpha" android:fillColor="#FF0000"
android:pathData="M 25 @ h20 v20 h-20 72"/>
<path android:name="strokeColor"” android:strokeWidth="5"
android:strokeColor="#FFFFQQ" android:pathData="M @ 25 h20 v20 h-20 7"/>
<path android:name="strokeAlpha"” android:strokeWidth="5" android:strokeColor="#00FF00"
android:pathData="M 25 25 h20 v20 h-20 7"/>
</group>
</vector>
</aapt:attr>

<target android:name="fillColor">
<aapt:attr name="android:animation">
<set><objectAnimator
android:propertyName="fillColor"

(continues on next page)
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android:duration="3000"
android:valueFrom="#FFQQFF"
android:valueTo="#FFFF00Q" />
</set>
</aapt:attr>
</target>
<target android:name="strokeColor">
<aapt:attr name="android:animation">
<set><objectAnimator

android:propertyName="strokeColor"”

android:duration="3000"
android:valueFrom="#FFFF0Q"
android:valueTo="#FFQQFF" />
</set>
</aapt:attr>
</target>

<target android:name="fillAlpha">
<aapt:attr name="android:animation">
<set> <objectAnimator
android:propertyName="fillAlpha"
android:duration="3000"
android:valueFrom="0.2"
android:valueTo="1"
android:valueType="floatType"/>
</set>
</aapt:attr>
</target>
<target android:name="strokeAlpha">
<aapt:attr name="android:animation”>
<set> <objectAnimator

android:propertyName="strokeAlpha”

android:duration="3000"
android:valueFrom="1"
android:valueTo="0.2"
android:valueType="floatType"/>
</set>
</aapt:attr>
</target>
</animated-vector>

(continued from previous page)

Warning: The color of paths colored with a linear gradient can not be animated.
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Easing Interpolators

Every animation is associated with an easing interpolator. By default, the animation transition is linear, but the
rate of change in the animation can be defined by an interpolator. This allows the existing animation effects to be
accelerated, decelerated, repeated, bounced, etc.

The supported Android interpolators are:
« accelerate_cubic
« accelerate_decelerate
« accelerate_quad
« anticipate
« anticipate_overshoot
+ bounce
« cycle
« decelerate_cubic
« decelerate_quad
« decelerate_quint
» fast_out_extra_slow_in
« fast_out_linear_in
« fast_out_slow_in
« linear
« linear_out_slow_in
« overshoot
Any other vectorial path can also be used as the interpolator easing function.
Following examples show the behavior of some of the interpolators for a simple translation animation.
» Image:

<animated-vector xmlns:android="http://schemas.android.com/apk/res/android” xmlns:aapt="http://schemas.
—android.com/aapt">
<aapt:attr name="android:drawable"”>
<vector android:width="100dp" android:height="100dp" android:viewportWidth="100"_
—android:viewportHeight="100">
<path android:pathData="M @ @ h100 v20 h-100 Z" android:strokeColor="#FFFFFF" android:strokeWidth=
S"1"/>
<group android:name="translate">
<path android:pathData="M @ 0 h20 v20 h-20 7" android:fillColor="#335566"/>
</group>
</vector>
</aapt:attr>

<target android:name="translate">
<aapt:attr name="android:animation">
<set><objectAnimator
android:propertyName="translatex"
android:duration="2000"

(continues on next page)
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(continued from previous page)

android:valueFrom="0"
android:valueTo="80"
android:interpolator = "@android:interpolator/linear” />
</set>
</aapt:attr>
</target>
</animated-vector>

android:interpolator = "@android:interpolator/linear”
android:interpolator = "@android:interpolator/accelerate_cubic”
android:interpolator = "@android:interpolator/bounce”
android:interpolator = "@android:interpolator/fast_out_slow_in"

<aapt:attr name="android:interpolator">
<pathInterpolator android:pathData="M @ @ C 0.371 2.888 ©.492 -1.91 1 1"/>
</aapt:attr>

<aapt:attr name="android:interpolator">

<pathInterpolator android:pathData="M @ @ C ©.333 1.939 0.171 -0.906 0.601 0.335 C 0.862 ©.998 0.83 -
—0.771 1 1"/>
</aapt:attr>
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Limitations / Supported Features

Android Vector Drawable

The MicroVG library supports most of the Android Vector Drawable features with the following limitations:
« clip-path feature is only supported for static images.
« trim-path animation is not supported.
« morphing animations are not supported for paths with stroke.
« usage of path opacity is limited
- drawimage with alpha is not supported if the image contains overlapping paths.

- images with global alpha(android:alpha attribute of vector element) and overlapping paths are not sup-
ported.

- Beware that using android:fillColor and android:strokeColor attributes on the same path leads to over-
lapping paths.

« radial and sweep gradient types are not supported.
« tint, tintMode and autoMirrored features are not supported.

« trimPath feature is not supported.

SVG

The MicroVG library supports a subset of SVGTiny: https://www.w3.org/TR/SVGTiny12/ including:
+ Path
+ Basic shape
« Painting filling
« Painting stroking

Painting gradient (only linear gradient with one pattern)

Painting color formats : #RRGGBB, #RGB, rgb(r,g,b), keywords
« Transforms

o Text
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+ Fonts (the text fonts used in the SVG file has to be installed on the operating system)

Android Vector Drawable Loader

Overview

The AVD Loader is an Add-on Library that can load vector images from Android Vector Drawable XML files. Unlike
immutable vector images, the XML parsing and interpreting is done at runtime. This is useful for loading a vector
image as an external resource, especially when the resource has to be loaded dynamically (i.e., not known at build-
time).

To use the AVD Loader library, add the following dependency to a module description file:

<dependency org="ej.library.ui"” name="vectorimage-loader"” rev="1.0.0"/>

Note: The AVD Loader library requires MicroVG library 1.1 and above.

Supported Format

The library supports the vector drawables with the following elements (in that order):
<vector> Used to define a vector drawable
android:viewportWidth The width of the image (must be a positive value).
android:viewportHeight The height of the image (must be a positive value).
<path> Defines a path.

android:fillColor (optional) The color used to fill the path. Color is specified as a
32-bit ARGB value in hexadecimal format ( #AARRGGBB ). This attribute is optional
when a gradient color is specified (see below).

android: fillType ThefillType for the path, can be either evenOdd or nonZero.

android:pathData The path data, using the commandsin{M, L, C, Q, Z}(match
upper-case).

A linear gradient can also be used as color fill for a <path>. This element is optional if a solid color fill has been
specified.

<gradient> Used to define a linear gradient
android:endX The x-coordinate for the end of the gradient vector.
android:endY The y-coordinate for the end of the gradient vector.
android:startX The x-coordinate for the start of the gradient vector.
android:startY They-coordinate for the start of the gradient vector.
<item> Defines an item of the gradient (minimum two items for a gradient).

android:color Thecoloroftheitem. Colorisspecified as a32-bit ARGB value
in hexadecimal format ( #AARRGGBB ).

android:offset The position of the item inside the gradient (value in [0..1]).
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Here is an example of a Vector Drawable myImage.xml that complies with that format. It defines a 100 x 100 image
with two paths: the first one with a solid color fill, the second one with a linear gradient.

<vector xmlns:aapt="http://schemas.android.com/aapt” xmlns:android="http://schemas.android.com/apk/res/
—android” android:height="100.0dp" android:viewportHeight="100.0" android:viewportWidth="100.0"_
—android:width="100.0dp">
<path android:fillColor="#FFFFFFAA" android:fillType="nonZero" android:pathData="M0,0L50,0L50,50L0,
=50z " />
<path android:fillType="nonZero" android:pathData="M50,50L100,50L100,100L50,100Z ">
<aapt:attr name="android:fillColor">
<gradient android:endX="100.0" android:endY="100.0" android:startX="50.0" android:startY="50.0
—" android:type="android:linear">
<item android:color="#FF0Q@OFF" android:offset="0.0" />
<item android:color="#FFFFQOFF" android:offset="1.0" />
</gradient>
</aapt:attr>
</path>
</vector>

The library only supports a subset of the Vector Drawable specification, to optimize the CPU time and memory
needed for parsing and interpreting Vector Drawables in resource-constrained embedded devices. If the input Vec-
tor Drawable does not comply with this format, the library will throw an exception.

Note: The image generator tool provides a way to make a Vector Drawable compatible with the library. See this
section for more information.

Loading a Vector Drawable

Thefollowing code loads the Vector Drawable myImage . xml withthe AvdImagelLoader.loadImage() method. This
method has one parameter which is the path to the Vector Drawable file, provided as a resource of the application.
The resulting vector image can then be drawn on the display:

public static void main(String[] args) {
MicroUI.start();

Display display = Display.getDisplay();
GraphicsContext g = display.getGraphicsContext();

VectorImage image = AvdImageloader.loadImage("/images/myImage.xml");
VectorGraphicsPainter.drawImage(g, image, 100, 100);

display.requestFlush();
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Note: The image must be provided as a resource of the application, either internal or external. For external re-
source loading, the BSP must implement the proper Low Level API (LLAPI), see External Resources Loader for more
information on the implementation.

Limitations

The AVD Loader can only load static images (i.e., no animations). The other limitations are the same as for im-
mutable vector images.

Advanced
Make a Vector Drawable compatible with the library

To ensure that a Vector Drawable can be loaded by the AVD Loader library at runtime, the image generator tool can
generate a compatible version of the drawable.

The tool comes with the VG pack installed in the platform, use the following command line to run it:

java -cp [path_to_platform]/source/tools/imagegenerator-vectorimage.jar com.microej.converter.
—vectorimage.Main --input originallmage.xml --avd myImage.xml

This processes theinputVector Drawable originalImage.xml and outputsaVector Drawable myImage.xml which
is compliant with the library and optimized for runtime loading.
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The processing does the following:
« Normalize the output
« Limit the size of the XML file (e.g., minification)

+ Pre-process the resource-consuming operations (e.g., transformations, stroking)

Convert a SVG into a compatible Vector Drawable

It is possible to convert a SVG into a compatible Vector Drawable using the platform tooling. Use the following
command:

java -cp [path_to_platform]/source/tools/imagegenerator-vectorimage.jar com.microej.converter.
—vectorimage.Main --input originallmage.svg --avd myImage.xml

This processes the input SVG originalImage.svg and outputs a Vector Drawable myImage.xml .

Memory Usage

The loading of a Vector Drawable at runtime uses Java heap:

« forthe working buffers and intermediate objects used during the loading phase. The XML parser is optimized
to stream the data and uses as few heap as possible.

« for the image data.

Simplify the Path Data

The loading time and heap usage grow linearly with the number of path commands in the Vector Drawable. To
achieve optimal performances, it is recommended to reduce the number of path commands, by “simplifying” the
paths. The simplification algorithm will determine the optimal amount of anchor points to use in the artwork. Most
of the modern Graphic Design Software have an option to simplify a path (check this article for Adobe Illustrator
for example).

Monitor the Number of Path Commands

To print the number of paths and path commands declared in a Vector Drawable, set the constant ej.
vectorimage.loader.debug.enabled to true. This will output the numbers in the console when loading a file.

Output example:

avdimageloader INFO: Parsed a path data with a number of 5 commands
avdimageloader INFO: Parsed a path data with a number of 5 commands
avdimageloader INFO: Parsed a path data with a number of 28 commands
avdimageloader INFO: Number of paths in loaded image: 3
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Troubleshooting
The Image Cannot Be Parsed

A error can be raised when the parsing fails:

Exception in thread "main” ej.microvg.VectorGraphicsException: MicroVG: The image cannot be parsed. The_
—»image must be a valid AVD image, converted with the platform's image generator.

This error indicates that the file is not a compatible Vector Drawable, as specified in this section.

4.16.3 MWT (Micro Widget Toolkit)

Introduction

MWT is a toolkit that simplifies the creation and use of graphical user interface widgets on a pixel-based display.

The aim of this library is to be sufficient to create complex applications with a minimal framework. It provides the
main concepts without managing particular needs. Specific needs can be met by a MWT expert by creating new
widgets, adding more complex concepts, etc. The flexibility of the MWT open framework allows the selection of
only what is necessary for the application in order to guarantee lightweight applications and fast execution.

To use the MWT library, add the following line to a module description file:

<dependency org="ej.library.ui” name="mwt" rev="3.3.0"/>

Concepts

Graphical Elements

A Widget
O intx

) Animator animator Wldg t O int
2 EventDispatcher eventDispatcher ; o intiridth

i RenderPolicy renderPaolicy

C Desktop

2 int height
0 Styleshest styleshest O Stylestyle
children
C Displayable A Container
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Widget

Awidget is an object that is intended to be displayed on a screen. A widget occupies a specific region of the display
and holds a state. A user may interact with a widget (using a touch screen or a button for example).

Widgets are arranged on a desktop. A widget can be part of only one desktop hierarchy, and can appear only once
on that desktop.

Container

A container follows the composite pattern: it is a widget composed of other widgets. It also defines the layout
policy of its children (defining their bounds). The children’s positions are relative to the position of their parent.
Containers can be nested to design elaborate user interfaces.

By default, the children are rendered in the order in which they have been added in the container. And thus if the
container allows overlapping, the widgets added last will be on top of the widgets added first. A container can also
modify how its children are rendered.

Desktop

A desktop is a displayable intended to be shown on a display (cf. MicroUl). At any time, only one desktop can be
displayed per display.

A desktop contains a widget (or a container). When the desktop is shown, its widget (and all its hierarchy for a
container) is drawn on the display.

Rendering

A new rendering of a widget on the display can be requested by calling its requestRender() method. The rendering
is done asynchronously in the MicroUl thread.

When a container is rendered, all its children are also rendered.

A widget can be transparent, meaning that it does not draw every pixel within its bounds. In this case, when this
widget is asked to be rendered, its parent is asked to be rendered in the area of the widget (recursively if the parent
is also transparent). Usually a widget is transparent when its background (from the style) is transparent.

A widget can also be rendered directly in a specific graphics context by calling its render(GraphicsContext) method.
It can be useful to render a widget (and its children) in an image for example.

Render Policy

Arender policy is a strategy that MWT uses in order to repaint the entire desktop or to repaint a specific widget.

The most naive render policy would be to render the whole hierarchy of the desktop whenever a widget has
changed. However DefaultRenderPolicy is smarter than that: it only repaints the widget, and its ancestors if the
widget is transparent. The result is correct only if there is no overlapping widget, in which case OverlapRenderPol-
icy should be used instead. This policy repaints the widget (or its non-transparent ancestor), then it repaints all the
widgets that overlap it.

When using a partial buffer, these render policies can not be used because they render the entire screen in a single
pass. Instead, a custom render policy which renders the screen in multiple passes has to be used. Refer to the
partial buffer demo for more information on how to implement this render policy and how to use it.
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The render policy can be changed by overridding Desktop.createRenderPolicy().

Lay Out

All widgets are laid out at once during the lay out process. This process can be started by Desktop.requestLayOut(),
Widget.requestLayOut(). The layout is also automatically done when the desktop is shown (Desktop.onShown()).
This processis composed of two steps, each step browses the hierarchy of widgets following a depth-first algorithm:

« compute the optimal size for each widget and container (considering the constraints of the lay out),
« set position and size for each widget.

Once the position and size of a widget is set, the widget is notified by a call to onLaidOut().

Event Dispatch

Events generated in the hardware (touch, buttons, etc.) are sent to the event dispatcher of the desktop. It is then
responsible of sending the event to one or several widgets of the hierarchy. A widget receives the event through
its handleEvent(int) method. This method returns a boolean that indicates whether or not the event has been
consumed by the widget.

Widgets are disabled by default and don’t receive the events.

Pointer Event Dispatcher

By default, the desktop proposes an event dispatcher that handles only pointer events.

Pointer events are grouped in sessions. A session starts when the pointer is pressed, and ends when the pointer is
released or when it exits the pressed widget.

While no widget consumes the events, they are sent to the widget that is under the pointer (see Desk-
top.getWidgetAt(int, int)), then sent to all its parent hierarchy recursively.
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Once a widget has consumed an event, it will be the only one to receive the next events during the session.

L

Pointer released within widget bounds - DRAGGED event
e -
Pointer dragged or released consumed by another widget - EXITED event
< : : ST IEY O Pointer dragged within widget bounds - DRAGGED event
Pointer dragged or released outside widget bounds - EXITED event
Pointer pressed within widget bounds - PRESSED event

A widget can redefine its reactive area by subclassing the contains(int x, int y) method. It is useful when a widget
does not fill fully its bounds.

NOT PRESSED STATE
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Style

A style describes how widgets must be rendered on screen. The attributes of the style are strongly inspired from
CSS.

Dimension

The dimension is used to constrain the size of the widget.
MWT provides multiple implementations of dimensions:

« NoDimension does not constrain the dimension of the widget, so the widget will take all the space granted
by its parent container.

+ OptimalDimension constrains the dimension of the widget to its optimal size, which is given by the compute-
ContentOptimalSize() method of the widget.

« FixedDimension constrains the dimension of the widget to a fixed absolute size.

« RelativeDimension constrains the dimension of the widget to a percentage of the size of its parent container.

Alignment

The horizontal and vertical alignments are used to position the content of the widget within its bounds.

The alignment is used by the framework to position the widget within its available space if the size of the widget
has been constrained with a Dimension.

The alignment can also be used in the renderContent() method in order to position the drawings of the widget
(such as a text or an image) within its content bounds.

Outlines

The margin, border and padding are the 3 outlines which wrap the content of the widget. The widget is wrapped
in the following sequence: first the padding, then the border, and finally the margin.

Margin

Border
Padding

Content

MWT provides multiple implementations of invisible outlines which are usually used for margin and padding:

« NoOutline does not wrap the widget in an outline.

4.16. Graphical User Interface 335


https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/style/dimension/NoDimension.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/style/dimension/OptimalDimension.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/Widget.html#computeContentOptimalSize-ej.mwt.util.Size-
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/Widget.html#computeContentOptimalSize-ej.mwt.util.Size-
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/style/dimension/FixedDimension.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/style/dimension/RelativeDimension.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/style/dimension/Dimension.html
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/Widget.html#requestRender-int-int-int-int-
https://repository.microej.com/javadoc/microej_5.x/apis/ej/mwt/style/outline/NoOutline.html

MicroEJ Documentation, Revision d4ede019

« UniformOutline wraps the widget in an outline which thickness is equal on all sides.

« FlexibleOutline wraps the widget in an outline which thickness can be configured for each side.
MWT also provides multiple implementations of visible outlines which are usually used for border:

« RectangularBorder draws a plain rectangle around the widget.

+ RoundedBorder draws a plain rounded rectangle around the widget.

Background

The background is used to render the background of the widget. The background covers the border, the padding
and the content of the widget, but not its margin.

MWT provides multiple implementations of backgrounds:
« NoBackground leaves a transparent background behind the widget.
+ RectangularBackground draws a plain rectangle behind the widget.
» RoundedBackground draws a plain rounded rectangle behind the widget.

« ImageBackground draws an image behinds the widget.

Color

The color is not used by the framework itself, but it may be used in the renderContent() to select the color of the
drawings.

Font

The fontis not used by framework itself, but it may be used in the renderContent () to select the fontto use when
drawing strings.

Extra fields

Extra fields are not used by framework itself, but they may be used in the renderContent() to customize the
behavior and the appearance of the widget.

See chapter How to Define an Extra Style Field for more information on extra fields.

Stylesheet

A stylesheet allows to customize the appearance of all the widgets of a desktop without changing the code of the
widget subclasses.

MWT provides multiple implementations of stylesheets:
« VoidStylesheet assigns the same default style for every widget.
« CascadingStylesheet assigns styles to widgets using selectors, similarly to CSS.

For example, the following code customizes the style of every Label widget of the desktop:
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CascadingStylesheet stylesheet = new CascadingStylesheet();

EditableStyle labelStyle = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
labelStyle.setColor(Colors.RED);
labelStyle.setBackground(new RectangularBackground(Colors.WHITE));

desktop.setStylesheet(stylesheet);

Animations

MWT provides a utility class in order to animate widgets: Animator. When a widget is being animated by an anima-
tor, the widget is notified each time that the display is flushed. The widget can use this interrupt in order to update
its state and request a new rendering.

See chapter How to Animate a Widget for more information on animating a widget.

Partial buffer considerations

Rendering a widget in partial buffer mode may require multiple cycles if the buffer is not big enough to hold all the
pixels to update in a single shot. This means that rendering is slower in partial buffer mode, and this may cause
performance being significantly affected during animations.

Besides, the whole screen is flushed in multiple times instead of a single one, which means that the user may see
the display at a time where every part of the display has not been flushed yet.

Due to these limitations, it is not recommended to repaint big parts of the screen at the same time. For example, a
transition on a small part of the screen will look better than a transition affecting the whole screen. A transition will
look perfect if the partial buffer can hold all the lines to repaint. Since the buffer holds a group of lines, a horizontal
transition may not look the same as a vertical transition.

Desktop and widget states

Desktop and widgets pass through different states. Once created, they can be attached, then they can be shown.

Adesktop is attached automatically as soon asitis shown on the display. It can also be attached manually by calling
Desktop.setAttached(). It could be used to render the desktop (and its widgets) on an image for example.

A widget is considered as attached when it is contained by a desktop that is attached.

In the same way, by default, a widget is shown when its desktop is shown. But for optimization purpose, a container
can control when its children are shown or hidden. A typical use case is when the widgets are moved outside the
display.

Once awidgetis attached, it means that it is ready to be shown (for instance, the necessary resources are allocated).
In other words, once attached a widget is ready to be rendered (on an image or on the display).

Once a widget is shown, it means that it is intended to be rendered on the display. While shown, it may start a
periodic refresh or an animation.
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The following sections will present several ways to customize and extend the framework to better fit your needs.

How to Create a Widget

A widget is the main way to render information on the display. A set of pre-defined widgets is described in the
Widgets and Examples section.

If the needed widget does not already exist, it is possible to create it from scratch (or by derivating another one).

To create a custom widget, a new class should be created, extending the Widget class. Widget subclasses have to
implement two methods and may override optional methods, as explained in the following sections.

Implementing the mandatory methods
Computing the optimal size of the widget

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size of
the widget.

The optimal size of the widget is the size of the smallest possible area which would still allow to represent the
widget. Unless the widget is using an OptimalDimension in its style, the actual size of the widget will most likely be
bigger than the optimal size returned in this method.

The size parameter of the computeContentOptimalSize() method initially contains the size available for the
widget. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be com-
puted without considering any restriction on the respective axis. Before the method returns, the size object should
be set to the optimal size of the widget.

When implementing this method, the getStyle() method may be called in order to retrieve the style of the widget.

For example, the following snippet computes the optimal size of an image widget:

@Override

protected void computeContentOptimalSize(Size size) {
size.setSize(this.image.getWidth(), this.image.getHeight());

}

Rendering the content of the widget

The renderContent() method is called by the MWT framework in order to render the content of the widget.

The g parameteris used to draw the content of the widget. Itis already configured with the translation and clipping
area which match the widget’s bounds. The contentWidth and contentHeight parameters indicate the actual
size of the content of the widget (excluding its outlines). Unless the widgetis usingan OptimalDimension inits style,
the given content size will most likely be bigger than the optimal size returned in computeContentOptimalSize().
If the drawings do not take the complete content area, the position of the drawings should be computed using the
horizontal and vertical alignment values set in the widget’s style.

When implementing this method, the getStyle() method may be called in order to retrieve the style of the widget.

For example, the following snippet renders the content of an image widget:

@0verride
protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
Style style = getStyle();
(continues on next page)
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(continued from previous page)

int imageX = Alignment.computeleftX(this.image.getWidth(), 0@, contentWidth, style.
—getHorizontalAlignment());

int imageY = Alignment.computeTopY(this.image.getHeight(), @, contentHeight, style.
—getVerticalAlignment());

Painter.drawImage(g, this.image, imageX, imageY);

}

Handling events

When a widget is created, it is disabled and it will not receive any event. A widget may be enabled or disabled by
calling setEnabled(). Acommon practice is to enable the widget in its constructor.

Enabled widgets can handle events by overriding handleEvent(). MicroUl event APIs may be used in order to know
more information on the event, such as its type. The handleEvent() method should return whether or not the
event was consumed by the widget.

For example, the following snippet prints a message when the widget receives an event:

@Override

public boolean handleEvent(int event) {
System.out.println("Event type:
return false;

n

+ Event.getType(event));

Consuming events

To indicate that an event was consumed by a widget, handleEvent() should return true. Usually, once an event is
consumed, it is not dispatched to other widgets (this behavior is controlled by the event dispatcher). The widget
that consumed the event is the last one to receive it.

The following guidelines are recommended to decide when to consume an event and when not to consume an
event:

« If the widget triggers an action when receiving the event, it consumes the event.

« If the widget does not trigger an action when receiving the event, it does not consume the event.

Note: If the eventis Pointer.PRESSED, do not consume the event unless it is required that the subsequent widgets
in the hierarchy do not receive it. The Pointer.PRESSED event is special because pressing a widget is usually not
the deciding factor to trigger an action. The user has to release or to drag the widget to trigger an action. If the user
presses a widget and then drags the pointer (e.g. their finger or a stylus) out of the widget before releasing it, the
action is not triggered.
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Listening to the life-cycle hooks

Widget subclasses may override the following methods in order to allocate and free the necessary resources:
« onAttached()
« onDetached()
« onlLaidOut()
« onShown()
« onHidden()

For example, the onAttached() method may be overridden to load an image:

@Override
protected void onAttached() {
this.image = Resourcelmage.loadImage(this.imagePath);

}

Likewise, the onDetached() method may be overridden to close the image:

@0verride
protected void onDetached() {
this.image.close();

}

For example, the onShown() method may be overridden to start an animation:

@0verride

protected void onShown() {
Animator animator = getDesktop().getAnimator();
animator.startAnimation(this);

Likewise, the onHidden() method may be overridden to stop an animation:

@Override

protected void onHidden() {
Animator animator = getDesktop().getAnimator();
animator.stopAnimation(this);

How to Create a Container

To create a custom container, a new class should be created, extending the Container class. This new class may
define a constructor and setter methods in order to provide a way for the user to configure the container, such
as its orientation. Container subclasses have to implement two methods and may override optional methods, as
explained in the following sections.
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Implementing the mandatory methods

This section explains how to implement the two mandatory methods of a container subclass.

Computing the optimal size of the container

The computeContentOptimalSize() method is called by the MWT framework in order to know the optimal size of
the container. The optimal size of the container should be big enough so that each child can be laid out with a size
at least as big as its own optimal size.

The containeris responsible for computing the optimal size of every child. To do so, the computeChildOptimalSize()
method should be called for every child. After this method is called, the optimal size of the child can be retrieved
by calling getWidth() and getHeight() on the child widget.

The Size parameter of the computeContentOptimalSize() method initially contains the size available for the
container. An available width or height equal to Widget.NO_CONSTRAINT means that the optimal size should be
computed without considering any restriction on the respective axis. Before the method returns, the size object
should be set to the optimal size of the container.

For example, the following snippet computes the optimal size of a simple wrapper:

@Override

protected void computeContentOptimalSize(Size size) {
Widget child = getChild(@);
computeChildOptimalSize(child, size.getWidth(), size.getHeight());
size.setSize(child.getWidth(), child.getHeight());

Laying out the children of the container

The layOutChildren() method is called by the MWT framework in order to lay out every child of the container, i.e. to
set the position and size of the children. If a child is laid out outside the bounds of the container (partially or fully),
only the part of the widget which is within the container bounds will be visible.

The container is responsible for laying out each child. To do so, the layOutChild() method should be called for
every child. Before this method is called, the optimal size of the child can be retrieved by calling getWidth() and
getHeight() on the child widget.

When laying out a child, its bounds have to be passed as parameter. The position will be interpreted as relative to
the position of the container content. This means that the position should not include the outlines of the con-
tainer. This means that the (0, ©) coordinates represent the top-left pixel of the container content and the
(contentWidth-1, contentHeight-1) coordinates represent the bottom-right pixel of the container content.

For example, the following snippet lays out the children of a simple wrapper:

@Override

protected void layOutChildren(int contentWidth, int contentHeight) {
Widget child = getChild(0);
layOutChild(child, @, 0, contentWidth, contentHeight);
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Managing the visibility of the children of the container

By default, when a container is shown, each of its children is shown too. This behavior can be changed by overriding
the setShownChildren() method of Container . When implementing this method, the setShownChild() method
should be called for each child which should be shown when the container is shown.

At any time while the container is visible, children may be shown or hidden by calling setShownChild() or setHid-
denChild().

When a container is hidden, each of its children is hidden too (unless it is already hidden). It is not necessary to
override setHiddenChildren(), except for optimization.

Providing APIs to change the children list of the container

The Container classintroduces protected APlsin order to manipulate the list of children of the container. These
methods may be overridden in the container subclass and set as public in order to make these APIs available for
the user.

Each of the following methods may be overridden individually:
+ addchild()
« removeChild()
« removeAllChildren()
« insertChild()
« replaceChild()
+ changeChildIndex()

For example, the following snippet allows the user to call the addChild() method on the container:

@Override

public void addChild(Widget child) {
super.addChild(child);

}

How to Animate a Widget

Starting and stopping the animation

To animate awidget, an Animator instanceis required. Thisinstance can be retrieved from the desktop of the widget
by calling Desktop.getAnimator(). Make sure that your widget subclass implements the Animation interface so that
it can be used with an Animator .

An animation can be started at any moment, provided that the widget is shown. For example, the animation can
start on a click event. Likewise, an animation can be stopped at any moment, for example a few seconds after the
animation has started. Once the widget is hidden, its animation should always be stopped to avoid memory leaks
and unnecessary operations.

To start the animation of the widget, call the startAnimation() method of the Animator instance. To stop it, call the
stopAnimation() method of the same Animator instance.

Forexample, the following snippet starts the animation as soon as the widget is shown and stops it once the widget
is hidden:
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public class MyAnimatedWidget extends Widget implements Animation {

private long startTime;
private long elapsedTime;

@Override

protected void onShown() {
// start animation
getDesktop().getAnimator().startAnimation(this);
// save start time
this.startTime = Util.platformTimeMillis();
// set widget initial state
this.elapsedTime = 0;

}

@verride

protected void onHidden() {
// stop animation
getDesktop().getAnimator().stopAnimation(this);

Performing an animation step

The tick() method is called by the animator in order to update the widget. It is called in the Ul thread once the
display has been flushed. This method should not render the widget but should update its state and request a new
render if necessary. The tick() method should return whether or not the animation should continue after this
increment.

For example, the following snippet updates the state of the widget when it is ticked, requests a new render and
keeps the animation going until 5 seconds have passed:

@Override

public boolean tick(long platformTimeMillis) {
// update widget state
this.elapsedTime = platformTimeMillis - this.startTime;
// request new render
requestRender();
// return whether to continue or to stop the animation
return (this.elapsedTime < 5_000);

The renderContent() method should render the widget by using its current state (saved in the fields of the widget).
This method should not call methods such as Util.platformTimeMillis() because the widget could be rendered in
multiple passes, for example if a partial buffer is used.

For example, the following snippet renders the current state of the widget by displaying the time elapsed since the
start of the animation:

@0verride

protected void renderContent(GraphicsContext g, int contentWidth, int contentHeight) {
Style style = getStyle();
g.setColor(style.getColor());
Painter.drawString(g, Long.toString(this.elapsedTime), style.getFont(), 0, 0);
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How to Define an Outline or Border

To create a custom outline or border, a new class should be created, extending the Outline class. Outline subclasses
have to implement two methods, as explained in the following sections.

Applying the outline on an outlineable object

The apply(Outlineable) method is called by the MWT framework in order to subtract the outline from a Size or
Rectangle object.

The Outlineable parameter of the method initially contains the size or bounds of the box, including the outline.
Before the method returns, the outlineable object should be modified by subtracting the outline. In order to remove
the outline from the object, the removeOutline() method of Outlineable should be used, passing as argument
the thickness on each side.

For example, the following snippet applies an outline of 1 pixel on every side:

@0verride
public void apply(Outlineable outlineable) {
outlineable.removeOutline(1, 1, 1, 1);

}

Applying the outline on a graphics context

The apply(GraphicsContext, Size) method is called by the MWT framework in order to render the outline (only rel-
evant if it is a border) and to update the translation and clip of a graphics context.

The Size parameter of the method initially contains the size of the box, including the outline. Before the method
returns, the size object should be modified by subtracting the outline. In order to remove the outline from the
object, the removeOutline() method of Outlineable should be used, passing as argument the thickness on each
side.

For example, the following snippet applies an outline of 1 pixel on every side:

@Override

public void apply(GraphicsContext g, Size size) {
size.removeOutline(1, 1, 1, 1);
g.translate(1, 1);
g.setClip(@, 0, size.getWidth(), size.getHeight());

How to Define a Background

To create a custom background, a new class should be created, extending the Background class. Background sub-
classes have to implement two methods, as explained in the following sections.
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Informing whether the background is transparent

The isTransparent() method is called by the MWT framework in order to know whether or not the background is
transparent. A background is considered as transparent if it does not draw every pixel with maximal opacity when
itis applied.

For example, the following snippet informs that the background is completely opaque regardless of its size:
@0verride

public boolean isTransparent(int width, int height) {

return false;

3

Applying the background on a graphics context

The apply(GraphicsContext g, int width, int height) method is called by the MWT framework in order to render the
background and to set or remove the background color of subsequent drawings.

For example, the following snippet applies a white background:

@Override

public void apply(GraphicsContext g, int width, int height) {
g.setColor(Colors.WHITE);
Painter.fillRectangle(g, @, 0, width, height);
g.setBackgroundColor(Colors.WHITE);

How to Create a Desktop Event Dispatcher

Creating a custom event dispatcher can help you address two use cases:

« [Dispatch] Extending an EventDispatcher is used to dispatch the events. For example, the FocusEventDis-
patcher will send the events to the widget owning the focus.

« [Handle] Overriding the desktop is used to directly trigger a behavior. For example “BACK” command shows
the previous page.

To create a custom event dispatcher, a new class should be created, extending the EventDispatcher class. Event dis-
patcher subclasses have to implement a method and may override optional methods, as explained in the following
sections.

Dispatching the events to the widgets

The dispatchEvent() method is called by the MWT framework in order to dispatch a MicroUl event to the widgets
of the desktop. The getDesktop() method may be called in order to retrieve the desktop with which the event
dispatcher is associated. This is useful in order to browse the widget hierarchy of the desktop, for example by using
the getWidget() and getWidgetAt() methods of Desktop.

In order to send an event to one of the widgets of the hierarchy, the sendEventToWidget() method should be used.
The dispatchEvent() method should return whether or not the event was dispatched and consumed by a widget.

For example, the following snippet dispatches every event to the widget of the desktop:
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@0verride
public boolean dispatchEvent(int event) {
Widget desktopWidget = getDesktop().getWidget();
if (desktopWidget != null) {
return sendEventToWidget(desktopWidget, event);
} else {
return false;
}
3

In addition to dispatching the provided events, an event dispatcher may generate custom events. This may be done
by using a DesktopEventGenerator. Its buildEvent() method allows to build an event which may be sent to a widget
using the sendEventToWidget() method.

Initializing and disposing the dispatcher

EventDispatcher subclasses may override the initialize() and dispose() methods in order to allocate and free the
necessary resources.

Forexample, the initialize() method maybe overriddento create an event generatorand to add it to the system
pool of MicroUl:

@Override

public void initialize() {
this.eventGenerator = new DesktopEventGenerator();
this.eventGenerator.addToSystemPool();

3

Likewise, the dispose() method may be overridden to remove the event generator from the system pool of Mi-
croUl:

@Override
public void dispose() {
this.eventGenerator.removeFromSystemPool();

}

How to Define an Extra Style Field

Extra style fields allow to customize a widget by configuring graphical elements of the widget from the stylesheet.
Extra fields are only relevant to a specific widget type and its subtypes. A widget type can support up to 7 extra
fields. The value of an extra field may be represented asan int,a float orany object, and it can not be inherited
from parent widgets.

Defining an extra field ID

The recommended practice is to add a public constant for the ID of the new extra field in the widget subtype. This
ID should be an integer with a value between ¢ and 6.

Every extra field ID has to be unique within the widget type. However, two unrelated widget types may define an
extra field with the same ID.

For example, the following snippet defines an extra field for a secondary color:
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public static final int SECONDARY_COLOR_FIELD = 0;

Setting an extra field in the stylesheet

The value of an extra field may be set in the stylesheet in a similar fashion to built-in style fields, using one of the
setExtraxxX() methods of EditableStyle.

For example, the following snippet sets the value of an extra field for all the instances of a widget subtype:

EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(MyWidget.class));
style.setExtraInt(MyWidget.SECONDARY_COLOR_FIELD, Colors.RED);

Getting an extra field during rendering

The value of an extra field may be retrieved from the style of a widget in a similar fashion to built-in style fields,
using one of the getExtraXxxX() methods of Style. When calling one of these methods, a default value has to be
given in case the extra field is not set for this widget.

For example, the following snippet gets the value of an extra field of the widget:

Style style = getStyle();
int secondaryColor = style.getExtralnt(SECONDARY_COLOR_FIELD, Colors.BLACK);

How to Use the Overlap Render Policy

The MWT library implements two render policies: the DefaultRenderPolicy and the OverlapRenderPolicy:

+ DefaultRenderPolicy : renders the specified widget. If the widget is transparent, it renders its parent (and
recursively).

« OverlapRenderPolicy : renders the specified widget but also the other widgets that overlap with it.

While the DefaultRenderPolicy will be fine for most GUIs, it will not handle properly the case where widgets
overlap. In this case, the OverlapRenderPolicy will be the best match.

Making Widgets Overlap

Awidget is said to overlap with another when:
« their boundaries intersect
« it comes after in the widget tree (depth-first search)

The following snippet displays two widgets that overlap:

public static void main(String[] args) {
MicroUI.start();

Desktop desktop = new Desktop();

// make two widgets overlap in a Canvas container
Canvas rootWidget = new Canvas();
final Button overlapped = new Button("Overlapped widget");

(continues on next page)
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(continued from previous page)

rootWidget.addChild(overlapped, 50, 50, 200, 200);

final Label overlapping = new Label("Overlapping widget");
rootWidget.addChild(overlapping, 125, 75, 100, 50);
desktop.setWidget(rootWidget);

// the overlapping widget is silver

CascadingStylesheet stylesheet = new CascadingStylesheet();

EditableStyle style = stylesheet.getSelectorStyle(new TypeSelector(Label.class));
style.setBackground(new RectangularBackground(Colors.SILVER));

// the overlapped widget is orange

style = stylesheet.getSelectorStyle(new TypeSelector(Button.class));
style.setBackground(new RectangularBackground(@xee502e));
desktop.setStylesheet(stylesheet);

desktop.requestShow();

As expected from the addChild() sequence, the widget overlapping overlaps the widget overlapped:

So far, the DefaultRenderPolicy is being used and it seems to look fine: the widgets of the desktop are rendered
successively in depth-first order after the call to desktop.requestShow().

Requesting a New Render

Let’s see how the DefaultRenderPolicy performs when the widget overlapped is requested to render again.
In most cases, a widget is requested to render when its content has been updated (e.g. the value displayed has
changed). For demonstration purposes, let’s introduce a mean to trigger a new render: each time the user clicks
on the widget overlapped, it will request the widget to render.

The snippet above shows how to do that, by adding an OnClickListener to the overlapped widget:

overlapped.setOnClicklListener(new OnClickListener() {

@verride
public void onClick() {
overlapped.requestRender();

}
DN

When the user clicks on the widget overlapped, the widget is rendered again but not the widget overlapping.
As a consequence, the widget that overlaps is not displayed anymore:
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When using the DefaultRenderPolicy , widgets are rendered regardless of their order in the widget hierarchy.
However, the OverlapRenderPolicy will take account of the relative order of the other widgets: widgets that
come after in the widget tree will be rendered if their boundaries intersect those of the widget.

Using the OverlapRenderPolicy

Overriding the method createRenderPolicy() of the Desktop, as follows, will cause the OverlapRenderPolicy to
be used when rendering widgets:

Desktop desktop = new Desktop() {
@Override
protected RenderPolicy createRenderPolicy() {
return new OverlapRenderPolicy(this);
}
5
Now, both widgets will be displayed correctly when they are requested to render.

As a conclusion, favor the OverlapRenderPolicy when a GUI uses overlapping elements. Note that this render
policy is slightly more time-consuming because it traverses the widget tree to determine which widgets are over-
lapping with each other.

How to Debug

Highlighting the Bounds of the Widgets

When designing a Ul, it can be pretty convenient to highlight the bounds of each widget. Here are some cases where
it helps:

« Verify if the layout fits the expected design.
« Set the outlines (margin, padding, border).
+ Check the alignment of the widget content inside its bounds.

Setting the ej.mwt.debug.bounds.enabled constantto true will add a rectangle overlay over each widget and
container. For more information about constants, see the Constants section.

By default, the rectangles around the widgets are magenta. But their color can be adjusted by modifying the ej.
mwt . debug.bounds.color constant.

Here is an example of a xxx.constants.list file with the resultin an application:

ej.mwt.debug.bounds.enabled=true
ej.mwt.debug.bounds.color=0x00ff00
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4.16.4 Widgets and Examples
Widget Library

The widget library provides very common widgets with basic implementations. These simple widgets may not
provide every desired feature, but they can easily be forked since their implementation is very simple.

The widget library does not provide any example. However, the widget demo provides examples for these widgets.

Source

To use the widgets provided by the widget library, add the following line to a module description file:

<dependency org="ej.library.ui"” name="widget"” rev="4.1.0"/>

To fork one of the provided widgets, duplicate the associated Java class from the widget library JAR into the source
code of your application. It is recommended to move the duplicated class to an other package and to rename the
class in order to avoid confusion between your forked class and the original class.

Provided Widgets

Widgets:

+ Label: displays a text.

« ImageWidget: displays an image which is loaded from a resource.

« Button: displays a text and reacts to click events.

« ImageButton: displays an image which is loaded from a resource and reacts to click events.
Containers:

« List: lays out any number of children horizontally or vertically.

+ Flow: lays out any number of children horizontally or vertically, using multiple rows if necessary.

+ Grid: lays out any number of children in a grid.

« Dock: lays out any number of children by docking each child one by one on a side.

« SimpleDock: lays out three children horizontally or vertically.

+ OverlapContainer: lays out any number of children by stacking them.

« Canvas: lays out any number of children freely.

Color Utilities

The widget library offers some color utilities.

The ColorHelper is helpful for decomposing colors into components (alpha, red, blue, green) and building back a
color from components.

The GradientHelper can blend two colors and create a gradient from two colors.

The resulting gradient is a list of distinct colors from the start color to the end color. The colors are truncated to the
display color depth. As a consequence, for the same start and end colors, a gradient created for a 32-bit display will
contain more colors than on a 16-bit display.
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The LightHelper proposes several primitives concerning the luminance of the colors. The luminance of a color is
computed from the luminance and the quantity of each of its components. The green being the brighter, then the
red and finally the blue.

Debug Utilities

A few utilities useful for debugging are available in the package ej.widget.util.debug of the widget library.

Print the Hierarchy of Widgets

The method Hierarchylnspector.hierarchyToString(Widget) returns a String representing the hierarchy of a widget.
In other words, it prints the widget and its children recursively in a tree format.

It may be used to analyse the content of a page and have a quick estimation of the number of widgets and the depth
of the hierarchy.

For example:

Scroll
+--Scrollablelist

| +--Label

| +--Dock

[ | +--ImageWidget
| | +--Label

| +--Label

Print the Path to a Widget

The method Hierarchylnspector.pathToWidgetToString(Widget) returns a String representing the list of ancestors
of the widget. For example: Desktop > Scroll > ScrollablelList > Label.

It may be used to identify a widget in a trace.

It is also possible to choose the separator by using Hierarchylnspector.pathToWidgetToString(Widget, char)
method. For example: Desktop ; Scroll ; ScrollablelList ; Label.

Count the Number of Widgets or Containers

The methods Hierarchylnspector.countNumberOfWidgets(Widget) and Hierarchylnspec-
tor.countNumberOfContainers(Widget) respectively count the number of widgets and containers in a hierarchy.

It may be used to evaluate the complexity of a hierarchy of widgets.
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Count the Maximum Depth of a Hierarchy

The method Hierarchylnspector.countMaxDepth(Widget) counts the maximum depth of a hierarchy. In other
words, the depth of the widget with the biggest number of parents recursively.

It may be used to evaluate the complexity of a hierarchy of widgets.

Print the Bounds of a Widget

The method BoundsInspector.boundsToString(Widget) returns a String with the widget type and its bounds. The
returned String contains:

« the simple name of the class of the widget,
« its position relative to its parent,

« itssize,

« its absolute position.

Forexample: Label: 0,0 7x25 (absolute: 75,75)

Print the bounds of all the widgets in a hierarchy

The method Boundsinspector.boundsRecursiveToString(Widget) returns a String representing the type and
bounds of each widget in the hierarchy of a widget.

For example:

Scroll: 0,0 480x272 (absolute: 0,0)
+--Scrollablelist: 0,0 480x272 (absolute: 0,0)

|  +--Label: 0,0 480x50 (absolute: 0,0)

| +--Dock: 0,50 480x50 (absolute: 0,50)

| | +--ImageWidget: 0,0 70x50 (absolute: 0,50)
| | +--Label: 70,0 202x50 (absolute: 70,50)

| +--Label: 0,100 480x50 (absolute: 0,100)

Widget Demo

The widget demo provides some widget implementations as well as usage examples for these widgets and for the
widgets of the Widget library. The widgets and usage examples are intended to be duplicated by the developersin
order to be adapted to their use-case.

Source

To use the widgets provided by the widget demo, clone the following GitHub repository: https://github.com/
MicroEJ/Demo-Widget. You can then import the com.microej.demo.widget projectinto your workspace to see
the source of the widgets and their associated examples.

Each subpackage contains the source code for a specific widget and for a page which showcases the widget. For ex-
ample, the com.microej.demo.widget.checkbox package containsthe Checkbox widget and the CheckboxPage
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Provided Widgets

The showcased widgets are listed in the README of the project.

MWT Examples

The MWT Examples repository provides various examples which extend or customize the MWT framework.

Source

To run the examples and read the source code of these examples, clone the following GitHub repository: https:
//github.com/MicroEJ/ExampleJava-MWT. You can then import the multiple projects into your workspace to see
the source of each example and to run it on Simulator or on your board.

Provided Examples

The showcased examples are listed in the README of the repository.

4.16.5 Advanced

How to Detect Text Overflow

Widgets that display a text may experience text overflow when the strings are too long to fit into the available area.
It can be the case, for example, in applications that support multiple languages because widgets have to deal with
texts of different lengths.

Instrumenting the Widget

The goal is to check whether the text to be displayed is within the content bounds of the widget. A way to test this
is to extend or modify the widget. In this article, the widget MyLabel will extend the type Label from the Widget
library, which displays a text:

import ej.widget.basic.Label;
public class MyLabel extends Label {
public MylLabel(String text) {

super(text);
}
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Overriding the onLaidOut() Method

Once the position and size of a wigdet are set during the lay out process, the onLaidOut() method is called to notify
the widget. Overriding onLaidOut() of class MyLabel isa good place to check whether the text overflows or not.

For example, the following snippet compares the text width with the available width: it will print a message if an
overflow is detected.

@Override
protected void onLaidOut() {
super.onlLaidOut();

// compute the width of the text with the specified font
final Font font = getStyle().getFont();

final String text = getText();

final int textWidth = font.stringWidth(text);

// compare to the width available for the content of the widget
final int contentWidth = getContentBounds().getWidth();
if (textWidth > contentWidth) {

System.out.println(”Overflow detected:\n > Text: \"" + text + "\"\n > Width = " + textWidth + "_
—px (available: " + contentWidth + " px)");
}
3
Testing

Here is a case where the widget size is set manually to be a little shorter than the text width:

public static void main(String[] args) {
MicroUI.start();
Desktop desktop = new Desktop();
Canvas canvas = new Canvas();
// add a label with an arbitrary fixed width of 25 pixels (which is too short)
canvas.addChild(new MyLabel("Some text"), 20, 20, 25, 10);
desktop.setWidget(canvas);
desktop.requestShow();

STM32F7508DK - VirtualDevice-50€a65821966 - o X

2 B
2

2B

£

13

The text is cropped and the console logs that a text overflow has been detected:

[ Initialization Stage ] =
[ Converting fonts ] =====

[ Launching on Simulator‘ ] e
Overflow detected:

(continues on next page)
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(continued from previous page)

> Text: "Some text”
> Width = 47 px (available: 25 px)

Improving the Detection

To ease the correction process, it is best to add some additional debug information to locate the issue. Let’s extract
the text overflow detection into a helper class, so that it is available for all classes across the application.

The following snippet:
« extracts the text overflow detection into the class MyTextHelper .
« prints the part of the text that is displayed.
« prints the path to the widget in the widget tree to help the tester locate the affected widget in the GUI.

public class MyLabel extends Label {

public MylLabel(String text) {
super(text);

@verride
protected void onLaidOut() {
super.onLaidOut();

final Font font = getStyle().getFont();
final String text = getText();
MyTextHelper.checkTextOverflow(this, text, font);

3
public class MyTextHelper {

/**

* Checks whether the given text overflows for the specified widget and font. In the case where an_.
—overflow is

* detected, the method prints a message that details the error.

@param widget

the widget that displays the text.
@param text

the text to display.
@param font

the font used for drawing the text.

X %X % X % X %

*/

public static void checkTextOverflow(final Widget widget, final String text, final Font font) {
final int textWidth = font.stringWidth(text);
final int contentWidth = widget.getContentBounds().getWidth();

if (textWidth > contentWidth) {
String displayedText = buildDisplayedText(text, font, contentWidth);
String widgetPath = buildWidgetPath(widget);
System.out.println(
"Overflow detected:\n > Text: \"" + text + "\"\n > Width = " + textWidth + " px._

—(available:
(continues on next page)
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(continued from previous page)

+ contentWidth + " px) \n > Displayed: \"" + displayedText + "\"\n > Path :
—" + widgetPath);
}
}

private static String buildDisplayedText(String text, Font font, int width) {
for (int i = text.length() - 1; i > 0; i--) {
if (font.substringWidth(text, @, i) <= width) {
return text.substring(@, i);

nn,

return

3

private static String buildWidgetPath(Widget widget) {
StringBuilder builder = new StringBuilder();

Widget ancestor = widget;

do {
builder.insert(@, " > " + ancestor.getClass().getSimpleName());
ancestor = ancestor.getParent();

} while (ancestor != null);

builder.insert(@, widget.getDesktop().getClass().getSimpleName());

return builder.toString();

When the application is launched again, the console shows more information about the text overflow:

== [ Initialization Stage ]
== [ Converting fonts ]
== [ Converting images ]
== [ Launching on Simulator ]
Overflow detected:

> Text: "Some text”

> Width = 47 px (available: 25 px)

> Displayed: "Some”

> Path : Desktop > Canvas > MylLabel

To keep control over the extra verbosity and code size, one option is to use BON constants to enable/disable this
debug code at will. In the following snippet, when the constant com.mycompany.check. text.overflow is setto
false, the debug code will not be embedded in the application.

public static void checkTextOverflow(final Widget widget, final String text, final Font font) {
if (Constants.getBoolean("com.mycompany.check.text.overflow")) {
final int textWidth = font.stringWidth(text);
final int contentWidth = widget.getContentBounds().getWidth();

if (textWidth > contentWidth) {
String displayedText = buildDisplayedText(text, font, contentWidth);
String widgetPath = buildWidgetPath(widget);
System.out.println(
"Overflow detected:\n > Text: \""” + text + "\"\n > Width = " + textWidth + " px._

n

—(available:

(continues on next page)
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(continued from previous page)

+ contentWidth + " px) \n > Displayed: \"" + displayedText + "\"\n > Path :
—" + widgetPath);
}
}

4.17 JavaScript

MicroEJ allows to develop parts of an application in JavaScript. Basically, a MicroEJ Application boots in Java, then
it initializes the JavaScript runtime to run a mix of Java and JavaScript code.

SANDBOXED
APPLICATIONS
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Fig. 81: MicroEJ JavaScript Overview

It supports the ECMAScript 5.1 specification, with some limitations. You can start playing with it by following the

Getting Started page.
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4.17.1 Getting Started

Let’s walk through the steps required to use Javascript in your MicroEJ application:

« install the MMM CLI (Command Line Interface)

« create your Standalone Application project with the init command:

mmm init -Dskeleton.org=com.is2t.easyant.skeletons -Dskeleton.module=firmware-singleapp -Dskeleton.
—rev=1.1.12 -Dproject.org=com.mycompany -Dproject.module=myproject -Dproject.rev=1.0.0 -Dskeleton.
—target.dir=myproject

Adapt the properties values to your need. See the MMM CLI init command documentation for more details.

Javascript is supported in the following Module Natures page: - Add-On Library, - Standalone Application, - Sand-
boxed Application.

« add the js dependency in the module.ivy file:

<dependency org="com.microej.library.runtime” name="3js" rev="0.13.0"/>

« add the following lines in your application main class:

import com.microej.js.JsErrorWrapper;
import com.microej.js.JsCode;
import com.microej.js.JsRuntime;

JsCode.initJs();
JsRuntime.ENGINE. runOneJob();
JsRuntime.stop();

« create afile named hello.js inthefolder src/main/js with the following content:

function hello() {
var message = "MicroEJ Javascript application!”;
print("My first”, message);

3

hello()

« follow the steps described in the run command documentation

+ inaterminal, go to the folder containing the module.ivy file and build the project with the command:

mmm build

You should see the following message at the end of the build:

BUILD SUCCESSFUL

Total time: 20 seconds

« now that your application is built, you can run it in the simulator with the command:

mmm run

You should see the following output:
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My first MicroEJ Javascript application!

You can now go further by exploring the capabilities of the MicroEJ Javascript engine and discovering the commands
available in the CLI.

4.17.2 Sources Management

JavaScript Sources Location

The JavaScript sources of an application must be located in the project folder src/main/js . All JavaScript files (
%.js ) found in this folder, at any level, are processed.

JavaScript Sources Load Order

When several JavaScript files are found in the sources folder, they are loaded in alphabetical order of their relative
path. For example, the following source files:

src
L— main

L s
— components

|: componentl.js

component2.js

— ui

L widgets. js
— app.js
— featurel.js
L— feature2.js

are loaded in this order:

1. app.js
components/componentl.js
components/component2.js
featurel.js

feature2.js

o v M w N

ui/widgets.js

JavaScript Sources Load Scope

All the code of the JavaScript source files are loaded in the same scope. It means a variable or function defined in
a source file can be used in another one if it has been loaded first. In this example:

Listing 10: src/main/js/lib.js

function sum(a, b) {
return a + b;

3
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Listing 11: src/main/js/main.js

print("5 + 3 = " + sum(5, 3));

the file src/main/js/1ib.js is loaded before src/main/js/main.js so the function sum can be usedin src/
main/js/main.js.

JavaScript Sources Processing

JavaScript sources need to be processed before being executed. This processing is done in the following cases:
« when building the project with MMM.

« when developing the project in MicroEJ SDK. The MicroEJ SDK detects any change in JavaScript sources
folder (addition/update/deletion) to trigger the processing.

4.17.3 Examples

This section is intended to provide a set of examples to cover most of the use cases when developing JavaScript
applications with MicroEJ:

Simple Application

Note: Before trying this example, make sure you have the MMM CLI (Command Line Interface) installed.

This example shows the minimal code for a MicroEJ JavaScript application:

« create an Add-On Library project or a Sandboxed Application project

+ add the MicroEJ JavaScript dependency in the module.ivy file of your project:

<dependency org="com.microej.library.runtime” name="js" rev="0.13.0"/>

« init the JavaScript code in your Java application with:

import com.microej.js.JsCode;

JsCode.init();

Theclass com.microej.js.JsCode isthe Java class generated from the JavaScript sources.

« ask the MicroEJ JavaScript engine to start processing the job queue with:

import com.microej.js.JsRuntime;

JsRuntime.ENGINE. run();

This makes the JavaScript engine process the job queue forever until the program is stopped.
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« create a file with the js extension in the src/main/js folder (for example app.js ) with the following
content:

print(”"My Simple Application”);

« build and execute the application with the MMM CLI:

$ mmm build
$ mmm run

The message My Simple Application should be displayed.

Use a Java APl in JavaScript

Note: Before trying this example, make sure you have the MMM CLI (Command Line Interface) installed.

It is also recommended to follow the Getting Started page and/or the Simple Application example before.

In this example the JavaScript code calls a Java API. The Java APl can come from the application or from any library
used by the application. Let’s create it in the project for this example, in a class Calculator (src/main/java/com/
mycompany/Calculator. java):

public class Calculator {
public int sum(int x, int y) {
return x + y;

}

public int mul(int x, int y) {
return x * y;
3
3

Then in the Java Main class of the application, add the glue to expose the Calculator Java API to the JavaScript
code and init the JavaScript engine:

public static void main(String[] args) throws Exception {
// Add the "getCalculator” function in the JavaScript global object
JsRuntime.JS_GLOBAL_OBJECT.put("getCalculator”, JsRuntime.createFunction(new JsClosure() {
@0verride
@Nullable
public Object invoke(Object thisBinding, int argslLength, Object... arguments) {
return new Calculator();
}
}), false);

// Init the JavaScript code
JsCode.initJs();
// Start the JavaScript engine
JsRuntime.ENGINE. run();

}

You can now call the API from the JavaScript code:
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var calc = getCalculator();

print(calc.sum(1, 2));

print(calc.mul(5, 3));

As you can see, the methods of the Java API Calculator can be used directly from the JavaScript code.

Finally, build and execute the application with the MMM CLI:

$ mmm build
$ mmm run
The sum and multiply results should be displayed.

For more information about communication between Java and JavaScript please refer to the Communication Be-
tween Java and JS page.

Create a JavaScript API from Java

Note: Before trying this example, make sure you have the MMM CLI (Command Line Interface) installed.

Itis also recommended to follow the Getting Started page and/or the Simple Application example before.

In this example a JavaScript API is exposed from Java. This can be useful when a specific APl must be defined in
JavaScript or when adapting an existing Java API to a JavaScript API.

Create a class MyApiHostObject (src/main/java/com/mycompany/MyApiHostObject. java):

public class MyApiHostObject extends JsObject {
public MyApiHostObject(Object thisBinding) {

this.put(”count”, new DataPropertyDescriptor(JsRuntime.createFunction(new JsClosure() {
@Override
@Nullable
public Object invoke(@Nullable Object thisBinding, int argslLength, Object..._
—arguments) {
String data = (String) arguments[0];
return Integer.valueOf(data.length());

DI

This class defines a JavaScript object using the MicroEJ JavaScript API by extending the class JsObject . It also
definesa count method which accepts a String parameter and returns its length.

Then in the Java Main class of the application, add the glue to expose the MyApi object to the JavaScript code and
init the JavaScript engine:

public static void main(String[] args) throws Exception {
// Add the "MyApi" function in the JavaScript global object
JsRuntime.JS_GLOBAL_OBJECT.put("MyApi"”, JsRuntime.createFunction(new JsClosure() {
@0verride
@Nullable
public Object invoke(Object thisBinding, int argslLength, Object... arguments) {
(continues on next page)
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(continued from previous page)

return new MyApiHostObject(thisBinding);

3
}), false);

// Init the JavaScript code
JsCode.initJs();
// Start the JavaScript engine
JsRuntime.ENGINE.run();

}

You can now call the new API from the JavaScript code:

var myApi = new MyApi();
print(myApi.count(”"Hello World!"));

Finally, build and execute the application with the MMM CLI:

$ mmm build
$ mmm run

The length of the string Hello World! (12) should be displayed.

For more information about communication between Java and JavaScript please refer to the Communication Be-
tween Java and JS page.

4.17.4 API

This page lists the API provided by the MicroEJ JavaScript engine.

Built-in Objects

The built-in objects are the API objects defined by the ECMAScript specification. This section lists all the JavaScript
built-in objects and their support status in the MicroEJ JavaScript engine. For the complete reference about these
built-in objects, consult the ECMAScript 5.1 specification.

For a description and usage examples of each method or property, consult a JavaScript documentation such as
Mozilla Developer Reference.

Array

« Array (len)

isArray (arg)

toString ()

[excluded] toLocaleString ()

o concat ([item1[,item2[,...111)
+ join (separator)

* pop ()

« push ([item1[,item2[,...]]1])

« reverse ()

4.17. JavaScript 365


https://www.ecma-international.org/ecma-262/5.1/#sec-15
https://developer.mozilla.org/en-US/docs/Web/JavaScript/Reference/Global_Objects

MicroEJ Documentation, Revision d4ede019

« shift ()

« slice (start, end)

« sort (comparefn)

+ [excluded] splice (start, deleteCount [, item1 [, item2[,... ]1])
o unshift ([item1[,item2[,...1]11])

« indexOf ( searchElement [, fromindex])

« lastindexOf ( searchElement [, fromindex])

« every ( callbackfn [, thisArg])

+ some ( callbackfn [, thisArg])

« forEach ( callbackfn [, thisArg])

« map ( callbackfn [, thisArg])

« filter ( callbackfn [, thisArg])

+ [excluded] reduce ( callbackfn [, initialValue])

+ [excluded] reduceRight ( callbackfn [, initialValue])
+ length

Boolean

« Boolean (value)
+ Boolean.prototype.toString ()

+ Boolean.prototype.valueOf ()

Date

o [excluded]

Error

o [excluded]

Function

+ [excluded] Function (p1, p2, ... , pn, body)
« length

+ [excluded] toString ()

« apply (thisArg, argArray)

« call (thisArg [, argl[,arg2,...]1)

[excluded] bind (thisArg [, argl [, arg2, ...]])
« [[Call]]
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[[Construct]]

Global

JSON

Math

NaN

Infinity

undefined

[excluded] eval (x)

parselnt (string , radix)

parseFloat (string)

isNaN (number)

isFinite (number)

[excluded] escape (string)
[excluded] unescape (string)
[excluded] decodeURI (encodedURI)
[excluded] decodeURIComponent (encodedURIComponent)
[excluded] encodeURI (uri)

[excluded] encodeURIComponent (uriComponent)

parse (text[, reviver])

stringify (value, [ replacer [, space]])

E

LN10
LN2
LOG2E
LOGI0E
Pl
SQRT1_2
SQRT2
abs (x)
acos (x)
asin (x)

atan (x)
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« atan2 (y, x)

o ceil (x)

o oS (x)

* exp (x)

« floor (x)

+ log (x)

o max ([valuel[,value2[,...1]1])
« min([valuel[,value2[,...111)
* pow (x,)

« random ()

« round (x)

« sin (x)

« sqrt (x)

« tan (x)

Number

Number (value)

« MAX_VALUE

« MIN_VALUE

« NaN

« NEGATIVE_INFINITY

« POSITIVE_INFINITY

+ [excluded] toString ([ radix])

+ [excluded] toLocaleString()

« valueOf ()

+ [excluded] toFixed (fractionDigits)
+ [excluded] toExponential (fractionDigits)

+ [excluded] toPrecision (precision)

Object

+ Object ([value])

+ Object.getPrototypeOf (O)

+ Object.getOwnPropertyDescriptor (O, P)
+ Object.getOwnPropertyNames (O )

+ Object.create (O [, Properties] )
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Object.defineProperty ( O, P, Attributes )
Object.defineProperties ( O, Properties)
[excluded] Object.seal (O)

[excluded] Object.freeze (0O)
[excluded] Object.preventExtensions (O )
Object.isSealed (O)

Object.isFrozen (0)

Object.isExtensible (O)

Object.keys (0)

toString ()

[excluded] toLocaleString ()

valueOf ()

hasOwnProperty (V)

isPrototypeOf (V)
propertylsEnumerable (V)

Regex

RegExp (pattern, flags)
exec (string)

test (string)

toString ()

String

String (value)

fromCharCode ([ charO [, char1[,...1]1])
toString ()

valueOf ()

charAt (pos)

charCodeAt (pos)

concat ([ stringl [, string2[,...11])
indexOf (searchString, position)
lastindexOf (searchString, position)
[excluded] localeCompare (that)
match (regexp)

replace (searchValue, replaceValue)
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+ [excluded] search (regexp)

slice (start, end)

« split (separator, limit)

[excluded] substr (start [, length])

substring (start, end)

« toLowerCase ()

[excluded] toLocaleLowerCase ()

toUpperCase ()

[excluded] toLocaleUpperCase ()
o trim ()

+ length

+ [[GetOwnProperty]] (P)

Host Objects

Host objects are not part of the ECMAScript specification, they are additional API provided by the MicroEJ
JavaScript engine.

Global
setTimeout(function|, delay, argl, arg2, ...])

« description: sets a timer which executes a function once the timer expires.

+ arguments:
- function : the function to execute when the delay expires.
- delay (optional): the time in milliseconds that the timer must wait before executing the given function.
- argl, arg2, ... (optional): additional arguments passed to the given function.

« returns: the timer object. This object can be passed to the function clearTimeout to cancel the timer.

setinterval(function[, delay, argl, arg2,...])

« description: repeatedly calls a function, with a fixed time delay between each call.
+ arguments:
- function:the function to execute when the delay expires.

- delay (optional): the timein milliseconds that the timer must wait between each execution of the given
function.

- argl, arg2, ... (optional): additional arguments passed to the given function.

« returns: the timer object. This object can be passed to the function clearInterval to cancel the timer.
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clearTimeout(timer)

« description: cancels the given timer created by a call to setTimeout.
+ arguments:

- timer :the timer to cancel.

clearinterval(timer)

« description: cancels the given timer created by a call to setInterval.
+ arguments:

- timer:the timer to cancel.

print([argl, arg2,...])

« description: prints the given arguments in the standard output. The arguments are concatenated and sep-
arated by a space. Anew line is added at the end.

« arguments:

- argl, arg2, ...:thelistof elements to print.

4.17.5 Communication Between Java and JS

The MicroEJ engine allows to communicate between Java and JavaScript: Java APl can be used from JavaScript
code and vice-versa.

JavaScript Engine

The JavaScript code is executed in a single-threaded engine, which means only one JavaScript statement is exe-
cuted at a given time. Each piece of JavaScript code that must be executed is pushed in a job queue. Itis up to the
engine to manage the job queue and execute the jobs.

One consequence of this design is that Java code called from a JavaScript code must not be blocker. When calling
a Java API from a Javascript code, in order to avoid blocking the JavaScript engine, the Java code must return as
quick as possible. Otherwise the JavaScript engine is stuck and cannot execute other JavaScript jobs. It is espe-
cially harmfull when the Java operation takes time, for example for network or |0 operations. In such a case, it is
therefore recommended to execute it in a new thread and return immediately.

Another consequence of the JavaScript engine design is that JavaScript code must always be executed by the en-
gine, by the single thread. Therefore, any call to a JavaScript code from a Java code must create a job and add it to
the job queue.
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Calling Java from JavaScript

The MicroEJ engine allows to expose Java objects or methods to the JavaScript code by using the engine APl and
creating the adequate JavaScript object.

Import Java Types from JavaScript

Java objects can be exposed to JavaScript using the JavaImport mechanism. It takes a Java fully qualified name
as argument and returns an object that gives access to the constructors, static methods and static fields. All the
classes from the project’s classpath can be imported (project’s own classes and its dependencies).

For instance, the following code imports java.lang.System and prints a string calling System.out.println():

var System = Javalmport(”java.lang.System")
System.out.println(”foo");

Here we instantiate a Java File object and check that it exists:

var File = JavaImport(”java.io.File")
var myFile = new File("myFile.txt")

if (myFile.exists()) {
print("myFile.txt exists")
} else {
print("myFile.txt does not exist")

}

Warning: You cannot instantiate an anonymous class from an interface or an abstract class with the new key-
word and Javalmport . Nevertheless, you can still access to static fields and methods.

Implement JavaScript Functions in Java

We can also implement JavaScript functionsin Java by adding theirimplementation to the global object from Java.
For example, here is the code to create a JavaScript function named javaPrint in the global scope:

JsRuntime.JS_GLOBAL_OBJECT.put(”javaPrint"”, JsRuntime.createFunction(new JsClosure() {
@Override
public Object invoke(Object thisBinding, Object... arguments) {
System.out.println("Print from Java: " + arguments[0@]);
return null;

3
}), false);

The function is created with a com.microej.js.objects.JsObjectFunction object created with the API
JsRuntime.createFunction(JsClosure jsClosure),andinjected inthe object JsRuntime.JS_GLOBAL_OBJECT
which maps to the JavaScript global scope.

The function javaPrint canthen be usedin JS:

javaPrint("foo")

This technique can also be used to share any Java object to JavaScript. It is achieved by returning the Java object
in the invoke method of the JsClosure object. For example, a Java Date object can be exposed as follows:
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JsRuntime.JS_GLOBAL_OBJECT.put("getCurrentDate”, JsRuntime.createFunction(new JsClosure() {
@verride
public Object invoke(Object thisBinding, Object... arguments) {
return Calendar.getInstance().getTime();

3
}), false);

When a Java object is exposed in JavaScript, all its public methods can be called, therefore the JavaScript code can
then use this Date object and get the time:

var date = getCurrentDate()
var time = date.getTime()
print("Current time: ", time)

for more information on how these called are managed by the MicroEJ JavaScript engine, please go to the Foreign

Function Interface section.

Java objects can also be shared using one of the other Java JS adapter objects. With this solution, the code of the
Java object is executed at engine initialisation, contrary to the previous solution where it is executed only when the
JavaScript code is called. For example, here is the code to expose a Java string named javaString in the JavaScript
global scope:

JsRuntime.JS_GLOBAL_OBJECT.put("javaString”, "Hello World!"”, false);

The string javaString canthen be used in JS:

var myString = javaString;

The available Java JS adapter objects are:
« com.microej.js.objects.JsObject : exposes a Java object as a JavaScript object

« com.microej.js.objects.JsObjectFunction : exposes a Java “process” as a JavaScript function (using a
JsClosure object)

« com.microej.js.objects.JsObjectString : exposes a Java String as a JavaScript String
« com.microej.js.objects.JsObjectArray : exposes a Java items collection as a JavaScript Array
« com.microej.js.objects.JsObjectBoolean : exposes a Java Boolean as a JavaScript Boolean

e com.microej.js.objects.JsObjectNumber : exposes a Java Number as a JavaScript Number

Calling JavaScript from Java

The MicroEJ JavaScript engine APl allows to call JavaScript code from Java code. For example, given the following
JavaScript functionin afilein src/main/js:

function sum(a, b) {
print(a + " + " + b+ " =" + (atb));

}

it can be called from a Java piece of code with:

JsObjectFunction functionObject = (JsObjectFunction) JsRuntime.JS_GLOBAL_OBJECT.get("sum");
JsRuntime.ENGINE.addJob(functionObject, JsRuntime.JS_GLOBAL_OBJECT, new Integer(5), new Integer(3));

Thefirst line gets the JavaScript function from the global scope. The second line adds a job in the JavaScript engine
queue to execute the function, in the global scope, with the arguments 5 and 3.
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Passing Values Between JavaScript and Java

JavaScript base types are represented by Java objects and not Java base types. The following table shows the
mapping between types in both languages:

JavaScript Java

Number java.lang.Integer or java.lang.Double

Boolean java.lang.Boolean

String java.lang.String

Null
null value

Undefined )
JsRuntime.JS_UNDEFINED_OBJECT singleton

In JavaScript, a Number typeis a 64-bits floating-point value. Nevertheless, Kifaru may use integer values ( Integer
Java type) when possible for performance reasons. Otherwhise, Double type will be used.

Note: Prefer passing Integer values as argument to a job added to the JavaScript execution queue, or return
Integer values whenimplementinga JsClosure instead of Double when possible.

It is not possible to retrieve the returned value of a JavaScript function from Java. For instance, consider the fol-
lowing JavaScript function:

function sum(a, b) {
return a + b;

3

When calling this function from Java, we have no way to get the result back:

JsObjectFunction functionObject = (JsObjectFunction) JsRuntime.JS_GLOBAL_OBJECT.get("sum");
JsRuntime.ENGINE.addJob(functionObject, JsRuntime.JS_GLOBAL_OBJECT, new Integer(5), new Integer(3));

A workaround is to modify the JavaScript function so it takes a callback object as argument:

function sum(a, b, callback) {
callback.returnValue(a + b);

3
Here is a possible implementation of the callback object:
public class Callback<T> {

@Nullable
private T value;

private boolean returned;

* Gets the value returned by this callback function when ready.
* <p>

* A call to this method waits for the value to be ready.

*

*

@return the value return by the callback

@Nullable

(continues on next page)
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(continued from previous page)
public T getValue() {
synchronized (this) {
while (!this.returned) {

try {
wait();
} catch (InterruptedException e) {
throw new JsErrorWrapper(”"); //$NON-NLS-1$

3

return this.value;

3

/*%

* Sets the value to return by this callback function.
*

* @param value

* the value to return

*/

public synchronized void returnValue(@Nullable T value) {
this.value = value;
this.returned = true;
notify();

We can now pass the callback to the job. The Java code will wait on the callback.getValue() until the resultis
ready.

JsObjectFunction functionObject = (JsObjectFunction) JsRuntime.JS_GLOBAL_OBJECT.get("sum");
Callback<Integer> callback = new Callback<>();

JsRuntime.ENGINE.addJob(functionObject, JsRuntime.JS_GLOBAL_OBJECT, new Integer(5), new Integer(3),.
—callback);

Integer returnedValue = callback.getValue();

System.out.println("Result is " + returnedValue);

4.17.6 Tests

JavaScript applications can be tested with tests written in JavaScript. The JavaScript test files must be located in
the project folder src/test/js. All JavaScript files ( *. js) found in this folder, at any level, are considered as test
files.

In order to setup JavaScript tests for your application, follow these steps:

« create an Add-On Library project or a Standalone Application project

« define the following properties in the module.ivy file of the project inside the ea:build tag (if the properties
already exist, replace them):

<ea:property name="test.run.includes.pattern” value="*%/_JsTest_x*Code.class"/>
<ea:property name="target.main.classes” value="${basedir}/target~/test/classes”"/>

+ add the MicroEJ JavaScript dependency in the module.ivy file of the project:
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<dependency org="com.microej.library.runtime” name="js" rev="0.13.0"/>

« define the platform to use to run the tests with one of the options described in Platform Selection section

« create afile assert.js inthefolder src/test/resources with the following content:

var assertionCount = 0;

function assert(value) {

assertionCount++;
if (value == 0) {

print(”assert " + assertionCount + " - FAILED");
} else {

print("assert " + assertionCount + " - PASSED");
}

This method assert will be available in all tests to do assertions.

« create afile test.js inthefolder src/test/js and write your first test:
var a = 5;
var b = 3;
var sum = a + b;
assert(sum === 8);

« build the application in the SDK or in command line with the MMM CL/

The execution of the tests produces a report available in the folder target~/test/html for the project.

4,17.7 Limitations

The MicroEJ engine supports the version 5.1 of the ECMAScript specification, with the limitations described in this
page.

Unsupported Directives

Directives, such as 'use strict',are notsupported and are considered as literal statements. Literal statements
are just ignored.

Unsupported Statements

The following syntaxes are not supported by the MicroEJ JavaScript engine:

« with (x) { } :the with statement is not supported in MicroEJ since its usage is not recommended. See
the reference documentation for more information.
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Unsupported Built-in Objects

The unsupported built-in objects are listed in the AP/ section.

4.17.8 Troubleshooting

Compilation error cannot be resolved to a type inFFlclass

A compilation error can be raised when the classpath contains unexpected classes, for example:

Exception in thread "main” java.lang.Error: Unresolved compilation problems:
ArrayComparisonFailure cannot be resolved to a type
ArrayComparisonFailure cannot be resolved to a type

at java.lang.Throwable.fillInStackTrace(Throwable.java:82)
at java.lang.Throwable.<init>(Throwable. java:37)

at java.lang.Error.<init>(Error.java:18)

at com.microej.js.JsFfi.ffi_toString_0(JsFfi.java:54)

at com.microej. js.JsCode$1%1.invoke(JsCode. java:50)

As described in the FFl section, in order to call Java methods from JavaScript code, all the methods with the given
names are searched in the classpath. Since the classpath can contain test dependencies which are not available
at compile time, the generated FFl can contain classes from these dependencies and therefore fail to compile. The
following classes are excluded by default:

e ej.junit.*

e Org.junit.*

e junit.*

e org.hamcrest.*

e java.lang.String
* java.lang.Number

This list can be changed by setting the system property js.ffi.excludes.classes toacomma-separated list of
FQN patterns. For example:

js.ffi.excludes.classes=ej.junit.*,org.junit.*,junit.x,org.hamcrest.*, java.lang.String, java.lang.Number,
—com.mycompany . test.*

Warning: Defining this property overwrites the default value, so do not forget to keep the default excluded
classes (unless you know what you are doing).
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4.17.9 Internals

JavasScript Sources Processing

The JavaScript code is not executed directly, it is first translated in Java code and compiled with the Java appli-
cation code. This transpilation is done by the JavaScript Add-On Processor. This processor uses the Java Nashorn
library (extracted from jrel.8.0_92) to parse the Javascript files.

The operations performed by this processor are summarized in this diagram:

[_H = = . . - - EVEN ) - Java

= Parsing rH“ _JS . rH“ Lonverm.on m Conversion -'_l_'- Cleanup / -'_l_'- Sources =]

JavaScript Iyl Validation VXS preparation JSAST Java Optim Java G — Java
sources AST AST sources

« Parsing: all JavaScript source files located in the folder src/main/js and src/test/js are parsed by the
Nashorn library to provide a JavaScript AST.

J@g

JS Validation: validation on the JavaScript AST to detect unsupported language features (for example eval
).

« Conversion preparation: before actually converting the JavaScript AST to a Java AST, a preparation opera-
tion is done to initialize all the lexical environments (done by JsIrVisitor).

« Conversion: conversion of the JavaScript AST to a Java AST.

+ Java AST cleanup/optim: post-conversion step to cleanup and optimize the Java AST. The following opera-
tions are done: - fiximports - remove dead code - remove literal statements

+ Java sources generation: generation of the Java sources from the Java AST.

Foreign Function Interface

As said in the section Calling Java from JavaScript, a JavaScript code can manipulate Java objects and call methods
on Java objects. This chapter describes how does the call to methods on Java objets work.

Let getValue() a Java method called from JavaScript on a Java object. As long as the type of the object is not
known at compile-time in the JavaScript code, all the types containing a method with the same signature are
searched in the classpath. Then the JavaScript pre-processor generates a JsFfi class and a method that dy-
namically tries to find the type of the receiver object. So, when the getValue() method is called from JavaScript,
this generated method is called.

Warning: Calling a method whose name is very common could result in a delay while calling it, and some
useless methods embedded.

This example shares a Java Date of the current time:

JsRuntime.JS_GLOBAL_OBJECT.put("getCurrentDate"”, JsRuntime.createFunction(new JsClosure() {
@0verride
public Object invoke(Object thisBinding, Object... arguments) {
return Calendar.getInstance().getTime();

3
}), false);

The JavaScript can then use this Date to print the current time:
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var date = getCurrentDate()
var time = date.getTime()
print("Current time: ", time)

In this case, the generated method in JsFfi looks like:

public static Object ffi_getTime_0(Object function, @ej.annotation.Nullable Object this_) {

try {
if (this_ instanceof JsObject || this_ instanceof String)
return JsRuntime.functionCall(((Reference) function).getValue(), this_);
if (this_ instanceof Calendar) {
return ((Calendar) this_).getTime();
}
if (this_ instanceof Date) {
return new Double(((Date) this_).getTime());
3
} catch (JsErrorWrapper e) {
throw e;

} catch (Throwable t) {
throw new JsErrorWrapper(new JsObjectError.TypeError("A Java exception has been thrown.

—in generated FFI code of getTime"), t);
}

throw new JsErrorWrapper(new JsObjectError.TypeError(“getTime"”));

4,18 Networking

This section presents networking libraries.

The following schema shows the overall architecture and modules:
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Example Applications | APP
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ADD-ON
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Fig. 82: Network Libraries Overview
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4.18.1 Foundation Libraries

Name Description Module API Link Use
Link
Bluetooth Low Energy (BLE) based | bluetooth | ej.bluetooth package
Bluetoothl on the Generic Attribute Profile » Bluetooth
(GATT). utility Library
Network interfaces management | ecom- NetworklInterfaceManager
ECOM-Netwbrind P configurations. network | class
Wi-Fi connectivity. ecom- A%WiﬂManager class o
ECOM-WIFI wifi + Wi-Fi setup Ex-
ample
o Wi-Fi utility Li-
brary
Client and Server raw TCP/IP sock- | net java.net package
NET ots. « NET Example
o NET utility
Library
) Cryptographic operations. security javax.crypto package
Security
Client and Server secure sockets | ssl java.net.ssl package
SsL layer using Transport Layer Secu- : SSL mutual
rity (TLS) protocols. client Example
« SSL mutual
server Example
« SSL utility
Library

4.18.2 Add-On Libraries
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loT Libraries

Name Description Module API Link Use
Link
Network connection state and no- | android- | ConnectivityManager .
Android | tifications. connectiviy class » Connectivity Ex-
Connectivjity ample
OpenJDK HTTP client. httpclient,| HttpURLConnection .
HTTP http- class « HTTP client
Client sclient README
« See also REST
client Example
Tiny footprint yet extensible web | hoka HttpServer class
HTTP server. « Hoka user man-
Server ual
(Hoka) « Hoka Example
Tiny footprint MQTT 3.1.1 client | micropaho| MgttClient class .
MQTT based on Eclipse Paho Java APIs. » MicroPaho
Client README
(MicroPahp) « MQTT _ publish
Example
o MQTT subscribe
Example
REpresentational State Tranfer | restclient | Resty class )
REST (REST) client. * REST___client
Client README
« REST client Ex-
ample
REpresentational State Tranfer | restserver | RestServer class
REST (REST) server using on Hoka HTTP * REST server Bx-
server Server. ample
Simple Network Time Protocol | sntpclient | SntpClient class )
SNTP (SNTP) client, used to retrieve the * SNTP client
Client current time from an NTP server. README
WebSocket client (RFC 6455). websocket] WebSocket class
WebSocket websocket + WebSocket
Client secure client README
» WebSocket

client Example
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https://repository.microej.com/modules/ej/library/iot/hoka/
https://repository.microej.com/javadoc/microej_5.x/apis/ej/hoka/http/HttpServer.html
https://github.com/MicroEJ/LibraryJava-hoka/blob/master/hoka/user-manual.rst
https://github.com/MicroEJ/LibraryJava-hoka/blob/master/hoka/user-manual.rst
https://github.com/MicroEJ/Example-Hoka
https://repository.microej.com/modules/ej/library/iot/micropaho/1.0.0/
https://repository.microej.com/javadoc/microej_5.x/apis/org/eclipse/paho/client/mqttv3/MqttClient.html
https://repository.microej.com/modules/ej/library/iot/micropaho/1.0.0/README-1.0.0.md
https://repository.microej.com/modules/ej/library/iot/micropaho/1.0.0/README-1.0.0.md
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.mqtt.publisher
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.mqtt.publisher
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.mqtt.subscriber
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.mqtt.subscriber
https://repository.microej.com/modules/ej/library/iot/restclient/
https://repository.microej.com/javadoc/microej_5.x/apis/ej/rest/web/Resty.html
https://repository.microej.com/modules/ej/library/iot/restclient/1.1.0/README-1.1.0.md
https://repository.microej.com/modules/ej/library/iot/restclient/1.1.0/README-1.1.0.md
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.rest
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.rest
https://repository.microej.com/modules/ej/library/iot/restserver/
https://repository.microej.com/javadoc/microej_5.x/apis/ej/restserver/RestServer.html
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.dynamic-restserver
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.dynamic-restserver
https://repository.microej.com/modules/ej/library/iot/sntpclient/
https://repository.microej.com/javadoc/microej_5.x/apis/android/net/SntpClient.html
https://repository.microej.com/modules/ej/library/iot/sntpclient/1.3.0/README-1.3.0.md
https://repository.microej.com/modules/ej/library/iot/sntpclient/1.3.0/README-1.3.0.md
https://repository.microej.com/modules/ej/library/iot/websocket/
https://repository.microej.com/modules/ej/library/iot/websocket-secure/
https://repository.microej.com/modules/ej/library/iot/websocket-secure/
https://repository.microej.com/javadoc/microej_5.x/apis/index.html?ej/websocket/WebSocket.html
https://repository.microej.com/modules/ej/library/iot/websocket/2.0.0/README-2.0.0.md
https://repository.microej.com/modules/ej/library/iot/websocket/2.0.0/README-2.0.0.md
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.websocket
https://github.com/MicroEJ/Example-Sandboxed-IOT/tree/master/com.microej.example.iot.ssl.websocket
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Data Serialization Libraries

Name Description Module API Link Use
Link
Concise Binary Object Representa- | cbor )
CBOR tion (CBOR) encoder and decoder ChorEncoder » CBOR Tutorial
(RFC 7049). Class
CborDecoder
class
joon | JavaScript Object Nofation (JSON | jsor jsONObject | - README
class (decoder)  JSON Tutorial
JSONWriter
class (encoder)
Google Protocol Buffers 3 encoder | protobuf3 Protobuf3
;E?‘;Zi:l ar\d decoder, suppgrthg files com- CodedInputStreatn Example
piled by protoc with lite plugin. class (decoder)
CodedOutputStream
class (encoder)
eXtensible Markup Language en- | kxml2 _
XML coder and decoder (kXML 3). XmlPullParser * XML Tutorial
class (decoder)
XmlSerializer
class (encoder)
Cloud Agent Libraries
Name Description Module Link | Use
AWS loT Core client, providing pub- | aws-iot
AWS lish/subscribe functionalities. » AWS ol Core README
ToT « AWS loT Core Example
Core
Google Cloud Platform lot Core client. gcp-iotcore )
Google » Google Cloud Platform Getting
Cloud Started
Platforn
Tot
Core
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https://repository.microej.com/javadoc/microej_5.x/apis/com/google/protobuf/CodedOutputStream.html
https://repository.microej.com/javadoc/microej_5.x/apis/com/google/protobuf/CodedOutputStream.html
https://github.com/MicroEJ/Demo-Protobuf3
https://github.com/MicroEJ/Demo-Protobuf3
http://kxml.sourceforge.net/about.shtml
https://repository.microej.com/modules/org/kxml2/kxml2/
https://repository.microej.com/javadoc/microej_5.x/apis/org/xmlpull/v1/XmlPullParser.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/xmlpull/v1/XmlPullParser.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/xmlpull/v1/XmlSerializer.html
https://repository.microej.com/javadoc/microej_5.x/apis/org/xmlpull/v1/XmlSerializer.html
https://repository.microej.com/modules/ej/library/iot/aws-iot/
https://repository.microej.com/modules/ej/library/iot/aws-iot/2.0.0/README-2.0.0.md
https://github.com/MicroEJ/AWS
https://forge.microej.com/artifactory/microej-developer-repository-release/googlecloud/iotcore/
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4.19 Character Encoding

4.19.1 Default Encoding

The default character encoding is 150-8859-1. It is thus the encoding used when:
« creating a new string from a byte array without specifying the encoding (String(byte[]) constructor),
« getting the byte array from a string without specifying the encoding (String.getBytes() method),
« printing a string to standard output stream (System.out),

« creating a new PrintStream without specifying the encoding.

4.19.2 UTF-8 Encoding

EDC provides an implementation of the UTF-8 character encoding. It can be embedded using the Embed UTF-8
encoding option (otherwise a java.io.UnsupportedEncodingException exception will be thrown).

Thisimplementation also supports Unicode code points as supplementary characters, by setting the constant com.
microej.library.edc.supplementarycharacter.enabled to true.

4.19.3 Custom Encoding

It is possible to connect additional custom encodings. Please contact our support team for more details.

4.19.4 Console Output

By default, the standard output stream ( System.out ) uses 1S0-8859-1 encoding to print strings. If you want to
print a string with a different encoding, you can create a new PrintStream:

PrintStream outUtf8 = new PrintStream(System.out, true, "UTF-8");
outUtf8.printIn("");

Warning: Make sure you embed the UTF-8 encoder (see UTF-8 Encoding)

The print methods write the raw byte array with the encodingused by the PrintStream to the console. The console
must then be configured with the same encoding to display characters properly.

Set Encoding in MicroEJ SDK Console

The default encoding for Eclipse consoles is UTF-8. If your application prints non-ASCII characters, they may not
be displayed properly.

The encoding used by a console for a given application can be set in the application launcher options: Run >
Run Configurations... ,and then Common tab> Encoding radio buttons.
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Fig. 83: Eclipse Launcher Console Encoding Options

4.20 Limitations

The following table lists the limitations of MicroEJ Architectures version 7.14.0 or higher, for both Evaluation and
Production usage. Please consult MicroEJ Architectures Changelog for limitations changes on former versions.

Note: The term unlimited means there is no Architecture specific limitation. However, there may be limitations
driven by device memory layout. Please refer to Platform specific documentation to get the memory mapping of
MicroEJ Core Engine sections.
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Table 21: Architecture Limitations

Item EVAL PROD
[Mono-Sandbox] Number of concrete types' 8192 8192
[Multi-Sandbox] Number of concrete types per context' 4096 4096
Number of abstract classes and interfaces unlimited unlimited
Class or Interface hierarchy depth 127 127
Number of methods unlimited unlimited
Method size in bytes 65536 65536
Numbers of exception handlers per method 63 63
Number of parameters for an SNI method 15 15
Number of instance fields” (Base type) 4096 4096
Number of instance fields? (References) 31 31
Number of static fields (boolean + byte) 65536 65536
Number of static fields (short + char) 65536 65536
Number of static fields (int + float) 65536 65536
Number of static fields (long + double) 65536 65536
Number of static fields (References) 65536 65536
Number of threads 63 63
Number of held monitors® 63 63

Time limit 60 minutes unlimited
Number of methods and constructors calls 500000000 unlimited
Number of Java heap Garbage Collection 3000° unlimited

! Concrete types are classes and arrays that can be instantiated.

2 All instance fields declared in the class and its super classes.

3 The maximum number of different monitors that can be held by one thread at any time is defined by the maximum number of monitors per
thread Application option.

% The Java heap Garbage Collection limit may throw unexpected cascading java.lang.OutOfMemoryError exceptions before the MicroEJ Core
Engine exits.
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CHAPTER

FIVE

PLATFORM DEVELOPER GUIDE

5.1 Introduction

5.1.1 Scope

This document explains how the core features of MicroEJ Architecture are accessed, configured and used by the
MicroEJ Platform builder. It describes the process for creating and augmenting a MicroEJ Architecture. This doc-
ument is concise, but attempts to be exact and complete. Semantics of implemented Foundation Libraries are
described in their respective specifications. This document includes an outline of the required low level drivers
(LLAPI) for porting the MicroEJ Architectures to different real-time operating systems (RTOS).

MicroEJ Architecture is state-of-the-art, with embedded MicroEJ runtimes for MCUs. They also provide simulated
runtimes that execute on workstations to allow software development on “virtual hardware.”

5.1.2 Intended Audience

The audience for this document is software engineers who need to understand how to create and configure a Mi-
croEJ Platform using the MicroEJ Platform builder. This document also explains how a MicroEJ Application can
interoperate with C code on the target, and the details of the MicroEJ Architecture modules, including their APIs,
error codes and options.

5.2 MicroEJ Platform

5.2.1 Introduction

A MicroEJ Platform includes development tools and a runtime environment.
The runtime environment consists of:

« A MicroEJ Core Engine.

« Some Foundation Libraries.

« Some C libraries.
The development tools are composed of:

« Java APIs to compile MicroEJ Application code.

« Documentation: this guide, library specifications, etc.

+ Tools for development and compilation.
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« Launch scripts to run the simulation or build the binary file.

« Eclipse plugins.

5.2.2 Build Process

This section summarizes the steps required to build a MicroEJ Platform and obtain a binary file to deploy on a

board.

The following figure shows the overall process. The first three steps are performed within the MicroEJ Platform
builder. The remaining steps are performed within the C IDE.

MicroElJ

Architecture

MicroEJ Workbench

CIDE

configuration project project ‘

1. Create a new MicroEJ Platform
el Nl IS s Configuration

= 2.Select and configure

additional modules

l

3. Build the MicroEJ
Platform

MicroEJ MicroEJ Platform

Application code

}

4. Build the MicroEJ
Application

|

Application
library file

C application
code and Board
Support Package

Architecture

library file
(microejruntime.a)

(microejapp.o)

|

5. Build and link the full
application

|

Executable

application

}

6. Program and test the
application on the
board

Fig. 1: Overall Process

5.2. MicroEJ Platform
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The steps are as follow:

1.

Create a new MicroEJ Platform configuration project. This project describes the MicroEJ Platform to build
(MicroEJ Architecture, metadata, etc.).

Select which modules provided by the MicroEJ Architecture will be installed in the MicrokJ Platform.
Build the MicroEJ Platform according to the choices made in steps 1and 2.

Compile a MicroEJ Application against the MicroEJ Platform in order to obtain an application file to link in
the BSP.

Compile the BSP and link it with the MicroEJ Application that was built previously in step 4 to produce a
MicroEJ Firmware.

Final step: Deploy MicroEJ Firmware (i.e. the binary application) onto a board.

5.2.3 Concepts

MicroEJ Platform Configuration

A MicroEJ Platform is described by a .platform file. This file is usually called [name].platform,and is stored at
the root of a MicroEJ Platform configuration project called [name]-configuration.

The configuration file is recognized by the MicroEJ Platform builder. The MicroEJ Platform builder offers a visual-
ization with two tabs:
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¥ STM32FT46GDISCO-example-CMThardfp_ARMCCS 23

= O

0 Overview

Platform Properties Platform Content

[General information about this platform., The content of the platform is composed of two parts:

Device: STM3IZFTA6GDISCO €2 Environment: select the architecture,

Name: example ‘¥ Modules: select modules to import in the platform.

fersion: - 72057

Version: 2.1,0-RC201604072057 Platform Configuration

Provider : Microk) Once the content of the platform is chosen, it can be configured.
Vendor URL:

#2| Configuration

Each module can be configured creating a folder with its name along
the .platform file. It could contain:

* an optional [module]. properties file,
* opticnal module specific files and folders.

Meodifying one these files requires to build the platform again,

Build
Generate and test the platform.

X Build Plstform: The new platform is now available and visible in
Available Platforms

Owverview | Content
Fig. 2: MicroEJ Platform Configuration Overview Tab

This tab groups the basic platform information used to identify it: its name, its version, etc. These tags can be
updated at any time.
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£ Content

Environment
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Modules = Details

Medules included in the Platform.

type filter text Description
Add MicrolUl user interface library.

MName Cl Confi .
onfiguration
7 [ ] Standalone = Requires “microui/microuixml” file
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Display References
Font Designer » Embedded Ul extension reference manual
Font Generator
Front Panel
[] Image BMP Maonochrome Decader
Image Generator
Image PMNG Decader Content
Inputs
[JLEDs
Java APls:
ot = MICROUI-2.0
hd Java Implementations:
« PUMP
= MICROUI-2.0

Owerview | Content

Fig. 3: MicroEJ Platform Configuration Content Tab

This tab shows all additional modules (see Modules) which can be installed into the platform in order to augment
its features. The modules are sorted by groups and by functionality. When a module is checked, it will be installed
into the platform during the platform creation.

Modules

The primary mechanism for augmenting the capabilities of a Concepts is to add modules to it.

A MicroEJ module is a group of related files (Foundation Libraries, scripts, link files, C libraries, Simulator, tools,
etc.) that together provide all or part of a platform capability. Generally, these files serve a common purpose. For
example, providing an API, or providing a library implementation with its associated tools.

The list of modules is in the second tab of the platform configuration tab. A module may require a configuration
step to be installed into the platform. The Modules Detail view indicates if a configuration file is required.
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Low Level API Pattern

Principle

Each time the user must supply C code that connects a platform component to the target, a Low Level APl is defined.
There is a standard pattern for the implementation of these APIs. Each interface has a name and is specified by two
header files:

« [INTERFACE_NAMET.h specifies the functions that make up the public API of the implementation. In some
cases the user code will never act as a client of the API, and so will never use this file.

o [INTERFACE_NAME]_impl.h specifies the functions that must be coded by the user in the implementation.

The user creates implementations of the interfaces, each captured in a separate C source file. In the simplest form
of this pattern, only one implementation is permitted, as shown in the illustration below.

Low Level API

LLXXX.h LLXXX_implL.h

void LLXXX_init(); void LLXXX_IMPL_init();

application.c MYIMPL.c

#include "LLXXX.h™ #include "LLXXX impl.h"

Main() { Void LLXXX_IMPL_init() {
LLXXX init(); // implementation code

} }

Fig. 4: Low Level API Pattern (single implementation)

The following figure shows a concrete example of an LLAPI. The C world (the board support package) has to imple-
menta send function and must notify the library using a receive function.
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MicroEJ Application

Java communication library (ECOM Comm)

MicroEJ world call LLAPI
LLAPI notify library
LLCOM.h LLCOM_impl.h
void LLCOM dataReceived(..); void LLCOM IMPL sendData(..);
LLAPI
C world call LLAP! implement LLAPI
driver_interrupt.c driver.c
#include "LLCOM.h™ #include "LLCOM_IMPL.h"
IRQ data received(..) { void LLCOM IMPL sendData(..) {
LLCOM_dataReceived(..); // implementation code
1 1
J J

Fig. 5: Low Level API Example

Multiple Implementations and Instances

When a Low Level API allows multiple implementations, each implementation must have a unique name. At run-
time there may be one or more instances of each implementation, and each instance is represented by a data
structure that holds information about the instance. The address of this structure is the handle to the instance,
and that address is passed as the first parameter of every call to the implementation.

The illustration below shows this form of the pattern, but with only a single instance of a single implementation.
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Low Level API

LLXXX.h

void LLXXX init(LLXXX*

env);

4

LLXXX_implL.h

void LLXXX TMPL init(LLXXX* env);

4

MYIMPL.h

#include

typedef struct MYIMPL {

"LLXXX.h™

struct LLXXX header;

//specific fields defined here
} MYIMPL;
void MYIMPL_new(MYIMP* env);

application.c

Main() {

#include "MYIMPL.h"

MYIMPL instance;

MYIMPL_new(&instance);
LLXXX init(&instance);

4

MYIMPL.c

#include "MYIMPL.h"
#define LLXXX_ IMPL MYIMPL
#include "LLXXX impl.h"

Void LLXXX_IMPL_init(LLXXX* env) {
// implementation code

} v

Fig. 6: Low Level API Pattern (multiple implementations/instances)

The #define statementin MYIMPL.c specifies the name given to this implementation.

5.3 MicroEJ Architecture

MicroEJ Architecture features the MicroEJ Core Engine built for a specific instructions set (ISA) and compiler.

The MicroEJ Core Engine is a tiny and fast runtime associated with a Scheduler and a Garbage Collector.

MicroEJ Architecture provides implementations of the following Foundation Libraries :

« Embedded Device Configuration (see [EDC]).

« Beyond Profile (see /[BON]).

« Simple Native Interface (see [SN/]).
« Kernel & Features (see [KF]).

+ Shielded Plug (see [SP)).

The following figure shows the components involved.
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Fig. 7: MicroEJ Architecture Modules

Three Low Level APIs allow the MicroEJ Architecture to link with (and port to) external code, such as any kind of
RTOS or legacy C libraries:

« Simple Native Interface (see [SNI])
+ Low Level MicroEJ Core Engine (see LLMJVM)
« Low Level Shielded Plug (see LLSP)

For further information on Architecture installation and releases, you can check these chapters:

5.3.1 Naming Convention

MicroEJ Architecture files ends with the . xpf extension, and are classified using the following naming convention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]/[VERSION]/[UID]-[VERSION]-[USAGE]. xpf

« ISA:instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32,...).
+ TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48).

+ UID:Architecture unique ID (e.g. flopi4G25).

« VERSION: module version (e.g. 7.12.0).

« USAGE = eval forevaluation Architectures, prod for production Architectures.

For example, MicroEJ Architecture versions for Arm® Cortex®-M4 microcontrollers compiled with GNU CC
toolchain are available at https://repository.microej.com/modules/com/microej/architecture/CM4/CM4hardfp_
GCC48/flopi4G25/.
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See Platform Configuration for usage.

5.3.2 MicroEJ Architectures Changelog
Notation
Aline prefixed by [ describes a change that only applies on a specific configuration: [Core Engine Capability/
Instruction Set/C Compiler]:
«+ Core Engine Capability
- Single: Mono-Sandbox (default)
- Tiny:Tiny Application
- Multi: Multi-Sandbox
« Instruction Set
- ARM9 : ARM ARM9
Cortex-A:ARM Cortex-A

Cortex-M:ARM Cortex-M

ESP32: Espressif ESP32

RX : Renesas RX
x86 : Intel x86

« C Compiler
ARMCC5 : Keil ARMCC uVision v5

IAR74 : IAR Embedded Workbench for ARM v7.4

QNX65 : BlackBerry QNX 6.5

ONX70 : BlackBerry QNX 7.0

[7.18.0] - 2022-09-14

Integration

+ Added support for Windows 11.
+ Added License Manager support for macOS aarch64 (M1 chip).

+ Removed warning when launching Applications or Tools with JDK 11 (Warning: Nashorn engine is planned to
be removed from a future JDK release).
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SOAR

+ Added grouping of all immutables objects in a single ELF section.

[7.17.0] - 2022-06-13
Core Engine
+ Fixed potential premature evaluation timeout when Core Engine is not started at the same time as the device.

« Fixed potential crash during the call of LLMJVM_dump when printing information about the Garbage Collector.

+ Added new functions to Low Level APl LLMJVM_MONITOR_impl.h (see Advanced Event Tracing):

- void LLMJVM_MONITOR_IMPL_on_invoke_method(void* method) : called by the MicroEJ Core Engine
when an method is invoked.

- void LLMJVM_MONITOR_IMPL_on_return_method(void* method) : called by the MicroEJ Core Engine
when a method returns.

+ [Cortex-M] - Added support for MCU configuration with unaligned access traps enabled (UNALIGN_TRP bit set
in CCR register).

Foundation Libraries

« Updated KF toversion 1.6:
- Added Kernel.canUninstall() method.

Integration

« Fixed some Architecture tools compatibility issues with SDKs running on JDK 11.
« Fixed missing default value for ShieldedPlug server port when running it with MMM ( 10082 ).
« Updated Memory Map Scripts for ej.microvg library.

« Updated Architecture End User License Agreement to version SDK 3.1-A.

Simulator

+ Added class file major version check (<=51). Classes must be compiled for Java 7 or lower. Set the options
property S3.DisableClassFileVersionCheck to false to disable this verification.

« Added native method signature in the stack trace of the UnsatisfiedLinkError thrown when a native method
is missing.

Fixed HIL engine method NativeInterface.getResourceContent() that generates a runtime error in the
Simulator.

« Fixed error “Internal limits reached ... S3 internal heap is full” when repeatedly loading a resource that is
available in the classpath but not referenced ina .resources.list file.

+ Fixed OutOfMemoryError when loading a large resource with Class.getResourceAsStream().

« Fixed A[].class.isAssignableFrom(B[].class) returning false instead of true when B isasubclass
of A.
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« Fixed potential “Internal limits reached” error when an OutOfMemoryError is thrown.

« Fixed error “Cannot pin objects anymore” when passing repeatedly immutable objects to a native method.

« Fixed properties not passed correctly to the mocks when the Virtual Device is executed from a path that con-
tains spaces.

+ [Multi] - Fixed unexpected error when kernel.kf file is missing and KF library is used: “Please specify a
‘kernel.kf’ file to enable Kernel & Features semantics.”

SOAR

[Multi] - Fixed type double[] notrecognizedin kernel.api file.

» Fixed internal error when using a BON constant in an if statement at the end of a try block.

« Fixed internal error when a try block ends with an assert expression while assertions are disabled.

+ [Multi] - Raise a warning instead of an error when duplicated .kf files are detected in the Kernel classpath.
Usual classpath resolution order is used to load the file (see MicroEJ Classpath).

[Multi] - Fixed SOAR error when building a Feature that uses an array of basetypes that is not explicitly de-

clared in the kernel.api file of the Kernel.

+ [Multi] - Optimized “Build Dynamic Feature” scripts speed by removing unnecessary steps.

[7.16.0] - 2021-06-24

Known Issues

« [Multi] - SOAR may fail to build a Feature with the following message:

1 : KERNEL/FEATURE ERROR
[M25] - Type double[] is expected to be owned by the Kernel but is not embedded.

Workaround is to explicitly declare each array of basetypes in your kernel . api file:

<type
<type
<type
<type
<type
<type
<type
<type

Notes

name="int[]"/>
name="long[]1"/>
name="short[]"/>
name="double[]"/>
name="float[]"/>
name="byte[]"/>
name="char[]"/>
name="boolean[]"/>

The Device module provided by the MicroEJ Architecture is deprecated and will be removed in a future version.
It has been moved to the Device Pack. Please update your Platforms.
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Core Engine

« Added a dedicated error code LLMJVM_E_INITIALIZE_ERROR (-23) when LLMJVM_IMPL_initialize()
, LLMJVM_IMPL_vmTaskStarted() , or LLMJVM_IMPL_shutdown() fails. Previously the generic error code
LLMJVM_E_MAIN_THREAD_ALLOC (-5) was returned.

« Added automatic heap consumption fing when option com.microej.runtime.debug.heap.monitoring.
enabled issetto true

« Fixed some parts of LLMJVM_checkIntegrity() code were embedded even if not called

+ [Multi] - Fixed potential crash during the call of LLMJVM_checkIntegrity() whenanalyzinga corrupted Java
stack (make this function robust to object references with an invalid memory address)

Foundation Libraries

Added source code for KF, SCHEDCONTROL , SNI, SP implementations

« Updated KF APl with annotations for Null analysis

« Updated SNI APl with annotations for Null analysis

+ Updated SP APl with annotations for Null analysis

« Updated ResourceManager implementation with annotations for Null analysis

« Updated KF implementation:

Added missing Kernel.getAllFeatureStateListeners() method
Updated code for correct Null analysis detection

Fixed Feature.getCriticality() to throw IllegalStateException if it is in state UNINSTALLED (instead of re-
turning NORM_CRITICALITY)

Fixed potential race condition between Kernel.addResourceControllListener() and Ker-
nel.removeResourceControlListener(). Adding a new listener may not register it if another one is
removed at the same time.

Integration

« Added a new task in ELF Utils library allowing to update the content of an ELF section:

Declaration:

<taskdef classpath="${platform.dir}/tools/elfutils.jar"” classname="com.is2t.elf.utils.
—AddSectionTask” name="addSection"” />

Usage:

<addSection file="${executable.file}" sectionFile="${section.file}" sectionName="${section.

—name}"” sectionAlignment="${section.alignment}"” outputDir="${output.dir}"” outputName="$
—{output.name}"” />

+ Updated Architecture End User License Agreement to version SDK 3.0-C

+ Updated copyright notice of Low Level APIs header files to latest MicroEJ SDK default license

+ Updated Architecture module with required files and configurations for correct publication in a module
repository (README .md , LICENSE. txt,and CHANGELOG.md)
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Simulator

+ Added an option (com.microej.simulator.hil.frame.size)to configure the HIL engine max frame size
+ Fixed load of an immutable byte field (sign extension)

« Fixed java.lang.String constructors String(byte[] bytes, ...) when passing characters in the range
[0x80,0xFF] using default 1S0-8859-1 encoding

« Fixed potential crash in debug mode when a breakpointis set on a field access (introduced in version 7.13.0

)

« Fixed wrong garbage collection of an object only referenced by an immortal object

SOAR

+ Fixed the following compilation issuesin if statement with BON constant:
- too many code may be removed when the block contains a while loop

- potential Stacks merging coherence error may be thrown when the block contains a nested
try-catch statement

- potential Stacks merging coherence error when declaring a ternary expression with Con-
stants.getBoolean() in condition expression

« Fixed assert statement removal when it is located at the end of a then block: the else block may be
executed instead of jumping over

« Removed names of arrays of basetype unless soar.generate.classnames optionissetto true

« [Multi] - Fixed potential link exception when a Feature use one of the ej_bon_ByteArray methods (e.g. ej.
kf.InvalidFormatException: code=51:0N_ej_bon_ByteArray_method_readUnsignedByte_AB_I_I)

« [Multi] - Fixed SOAR error ( Invalid SNI method ) when one of the ej.bon.Constants.getXXX() methods is
declared in a kernel.api file. Thisissue was preventing from using BON Constants in Feature code.

Tools

+ Updated Code Coverage Analyzer report generation:

Automatically configure src/main/java source directory besidea /bin directory if available

Added an option ( cc.src.folders ) to specify the source directory (require MicroEJ SDK 5.4.1 or
higher)

Removed the analysis of generated code for synchronized statements

Fixed crash when loading source code with annotations
+ Fixed Memory Map scripts: ClassNames group may contain duplicate sections with Types group

« Fixed load of an ELF executable when a section overlaps a segment (updated ELF Utils, Kernel Packager and
Firmware Linker)

« Fixed Firmware Linker to generate output executable file at the same location than the input executable file
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[7.15.1] - 2021-02-19

SOAR

+ [Multi] - Fixed potential VM crash when declaring a Proxy class which is abstract.
[7.15.0] - 2020-12-17
Core Engine

« Added support for applying Feature relocations

Foundation Libraries

« Updated KF implementation to apply Feature relocations using the Core Engine. The former Java im-
plementation is deprecated but can still be enabled using the option com.microej.runtime.kf.link.
relocations. java.enabled.

Integration

+ Updated the Architecture naming convention: the usage level is prod instead of dev .

« Fixed generation of temporary properties file with a .properties.list extension instead of deprecated
.system.properties extension.

SOAR

« Fixed crash when declaring a clinit dependency rule on a class that is loaded but not embedded.

Tools

+ Fixed Memory Map Script A1l graph creation to prevent slow opening of large .map file in Memory Map
Analyzer.

[7.14.1] - 2020-11-30

Core Engine

+ [Multi/x86/QNXT] - Fixed missing multi-sandbox version
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Tools

« Fixed categories for class names and SNI library in Memory Map Scripts

[7.14.0] - 2020-09-25

Notes

The following set of Architecture properties are automatically provided as BON constants:
e com.microej.architecture.capability=[tiny|single|multi]
e com.microej.architecture.name=[architecture_uid]
o com.microej.architecture.level=[eval|prod]
e com.microej.architecture.toolchain=[toolchain_uid]
e com.microej.architecture.version=7.14.0
The following set of Platform properties (customer defined) are automatically provided as BON constants:
o com.microej.platform.hardwarePartNumber
e com.microej.platform.name
o com.microej.platform.provider
o com.microej.platform.version

o com.microej.platform.buildlLabel

Foundation Libraries

« Updated EDC UTF-8 encoder to support Unicode code points as supplementary characters

« Fixed java.lang.NullPointerException thrown when java.util. WeakHashMap.put() method is called with a
null key (introduced in version 7.71.0)

Integration

Added all options starting with com.microej. prefixas BON constants

Added all properties defined in architecture.properties as options prefixed by com.microej.
architecture.

Added all properties defined in release.properties as options prefixed by com.microej.platform.

Added all properties defined in script/mjvm.properties as options prefixed by com.microej.
architecture.

« Added an option ( com.microej.library.edc.supplementarycharacter.enabled) to enable support for
supplementary characters (enabled by default)

+ Updated Memory Map Scripts to extract Java static fields in a dedicated group named Statics
+ Updated Memory Map Scripts to extract Java types in a dedicated group named Types

« Fixed generated Feature filename (unexpanded ${feature.output.basename} variable, introduced in ver-
sion 7.13.0)
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+ Fixed definition of missing default values for memory options (same values than launcher default ones)

+ [Tiny,Multi] - Added display of the Core Engine capability when launching SOAR

SOAR

+ [Multi] - Added a new attribute named api in Kernel soar.xml file indicating which types, methods and
static fields are exposed as Kernel APIs

« [Multi] - Fixed potential link error when calling java.lang.Object.clone() method on an array in Feature mode

Tools

« Updated serial PC connector to JSSC 2.9.2 (COM port could not be open on Windows 10 using a JRE 8u261
or higher)

[7.13.3] - 2020-09-18

Core Engine

+ [QNX70] - Embed method names and line numbers information in the application

+ [Cortex-A/QNXT70] - Fixed wrong float/double arguments passed to the SNI natives (introduced in version
7.12.0)

Simulator

« Fixed unnecessary stacktrace dump on Long.parseLong() error

+ Fixed UTF-8 encoded Strings not correctly printed

Tools

+ Updated Memory Map Scripts for ej.library.runtime.basictool library

[7.13.2] - 2020-08-14
Core Engine
« [ARM9/QNX65] - Fixed custom convention call

« [x86/QNXT70] - Fixed SIGFPE raised when overflow occurs on division

+ [x86/QNXT70] - Fixed issue with NaN conversion to int or long
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Tools

« Fixed Feature build script for MicroEJ SDK 5.x (introduced in version 7.13.0)

« Updated Memory Map Scripts for MicroUl 3 and Service libraries

[7.13.1] - 2020-07-20

Core Engine

+ [ESP32] - Fixed potential PSRAM access faults by rebuilding using esp-idf v3.3.0 toolchain ( simikou2 )

[7.13.0] - 2020-07-03

Core Engine

« Added SNI-1.4 support, with the following new LLSNI.h Low Level APIs:

Added function
Added function
Added function
Added function
Added function
Added function
Added function
Added function
Added function

SNI_registerResource()
SNI_unregisterResource()
SNI_registerScopedResource()
SNI_unregisterScopedResource()
SNI_getScopedResource()
SNI_retrieveArrayElements()
SNI_flushArrayElements()
SNI_isResumePending()

SNI_clearCurrentJavaThreadPendingResumeFlag()

Added define SNI_VERSION

Added define SNI_IGNORED_RETURNED_VALUE

Added define SNI_TLLEGAL_ARGUMENT

Updated the documentation of some functions to clarify the behavior

+ Added a message to lllegalArgumentException thrown in an SNI call when passing a non-immortal array in
SNI (only in case the Platform is configured to disallow the use of non-immortal arrays in SNI native calls)

« Added function LLMJVM_CheckIntegrity() to LLMJVM.h Low Level APIto perform heap and internal struc-
tures integrity check

« Updated KF implementation to use SNI-1.4 to close native resources when the Feature is stopped ( ej.
lang.ResourceManager is now deprecated)

+ Updated LLMIVM_dump() output with the following new information related to SNI-1.4 native resource
management:

Last native method called (per thread)

Current native method being invoked (per thread)

Last native resource close hook called (per thread)

Current native resource close hook being invoked (per thread)
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Pending Native Exception (per thread)

Pending SNI Scoped Resource to close (per thread)

Current Garbage Collector state: (running or not, last scanned object address, last scanned object class)

LLMIVM schedule request (global and per thread)

« Updated non-immortal object access from SNI default behavior (now allowed by default)

Fixed thread state displayed by LLMIVM_dump for threadsin SLEEP state

+ Fixed sni.h headerfile function prototypes using the SNI_callback typedef

Fixed crash when an OutOfMemoryError is thrown while creating a native exception in SNI

[Multi] - Fixed runtime exceptions that can be implicitly thrown (such as NullPointerException) which were
not automatically exposed by the Kernel

[Multi] - Fixed passing Kernel array parameters through a shared interface method call. These parameters
were passed by copy instead of by reference as specified by KF specification

[Multi] - Fixed execution context when jumping in a catch block of a ej.kf.Proxy method (the catch block was
executed in the Kernel context instead of the Feature context)

+ [ARMCC5]-Fixed link error Undefined symbol _java_Ljava_lang_OutOfMemoryError_field_OOMEMethodAddr_I
with ARM Compiler 5 linker (introduced in version 7.72.0)

Foundation Libraries

« Updated SNI toversion 1.4
« Updated internal library Resource-Manager-1.0 as deprecated. Use SNI-1.4 native resourcesinstead

« Updated Thread.getld() method implementation to return the same value than
SNI_getCurrentJavaThreadID() function

« Optimized SNI.toCString() method by removing a useless temporary buffer copy

« Fixed EDC implementation of String(byte[],int,int) constructor which could allocate a too large temporary
buffer

+ Fixed EDC implementation of Thread.interrupt() method to throw a java.lang.SecurityException when the
interrupted thread cannot be modified by the the current thread

+ Fixed EDC implementation to remove remaining references to java.util.SecurityManager class when it is dis-
abled

« Fixed EDC implementation of Thread.interrupt() method that was declared final
« Fixed EDC APl of Thread.interrupt() to clarify the behavior of the method
« Fixed EDC API of java.util.Calendar method to specify that non-lenient mode is not supported

« Fixed EDC APl of java.io.FilterinputStream.in field to be marked @Nullable
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Integration

+ Updated Architecture End User License Agreement to version SDK 3.0-B

Simulator

« Added SNI-1.4 support, with the following new HIL APIs:

- Added methods NativelInterface.suspendStart() and NativeInterface.suspendStop() to notify
the simulator that a native is suspended so that it can schedule a thread with a lower priority

« Added KF support to dynamically install Features ( . fs3 files)

« Added the capability to specify the Kernel UID from an option (see optionsin Simulator > Kernel > Kernel
uID)

+ Added object size in generated .heap dump files

Optimized file accesses from the Application

Fixed crash in debug mode when paused on a breakpoint in MicroEJ SDK and hovering a Java variable with
the mouse

« Fixed potential crash in debug mode when putting a breakpoint in MicroEJ SDK on a line of code declared in
aninner class

« Fixed potential crash in debug mode (java.lang.NullPointerException) when a breakpoint set on afield access
is hit

« Fixed potential crash in debug mode (ArrayindexOutOfBoundsException)

Added support for JDWP commands DisableCollection / EnableCollection inthe debugger

Fixed invalid heap dump generation in debug mode.

Fixed crash when a Mockup implements com.is2t.hil.StartListener and this implementation throws
an uncaught exception in the clinit

Fixed verbose of missing resource only when a resource is available in the classpath but not declared in a
.resources.list file

Fixed heap consumption simulation for objects instances of classes declaring fields of type float or double

« Fixed Device UID not displayed in the Front Panel window title (introduced in version 7.71.0)

Fixed loading of a resource from a JAR when the path starts with /
« Fixed potential deadlock on Front Panel startup in some cases

« Fixed Thread.getState() returning TERMINATED whereas the thread is running

Fixed Simulator which may not stop properly when closing the Front Panel window

Fixed Front Panel which stops sending widget events when dragging out of a widget

[Multi] - Fixed monitor that may not be released when an exception occurs in a synchronized block (intro-
duced in version 7.10.0)

[Multi] - Fixed invalid heap dump generation that causes heap analyzer crash

[Multi] - Fixed potential crash (java.lang.NullPointerException) in debug mode when debugging an Applica-
tion (introduced in version 7.70.0)

[Multi] - Fixed error when using KF library without defining a kernel.kf file in the Kernel (introduced in
version 7.10.0)
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SOAR

« Added anoption (soar.bytecode.verifier)toenable ordisable the bytecode verifier (disabled by default)

« Removed size related limits in Architecture Evaluation version

Tools

+ Added SNI-1.4 supportto HIL Engine

« Updated Heap Dumper to verbose information about the memory section when an overlap is detected in the
HEX file

« Updated Memory Map Scripts (Security, DTLS, Device)

» Fixed License Manager (Evaluation) random crash on Windows 10 when a Platform is built using Build
Module button

» Fixed License Manager (Evaluation) wrong UID computation after reboot when Windows 10 Hyper-V feature
is enabled

Fixed HIL Engine to exit as soon as the Simulator is disconnected (avoid remaining detached processes)

Fixed ELF to Map generating symbol addresses different from the ELF symbol addresses (introduced in ver-
sion 7.11.0)

Fixed Heap Dumper crash when a wrong object header is encountered

Fixed Heap Dumper failure when a memory dump is larger than the heap section

Fixed Heap Dumper crash when loading an Intel HEX file that contains lines of type 02

[7.12.0] - 2019-10-16

Core Engine

« Updated implementation of internal OutOfMemoryError thrown with the maximum number of frames that
can be dumped

+ Updated LLMIVM_dump() output with the following new information:

Maximum number of alive threads

Total number of created threads

Maximum number of stack blocks used

Current number of stack blocks used

Objects referenced by each stack frame: address, type, length (in case of arrays), string content (in case
of String objects)

[Multi] - Kernel stale references with the name of the Feature stopped
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Foundation Libraries

« Fixed EDC implementation of Throwable.getStackTrace() when called on a OutOfMemoryError thrown by
Core Engine or Simulator (either the returned stack trace array was empty or a java.lang.NullPointerException
was thrown)

+ [Tiny] - Fixed EDC implementation of StackTraceElement.toString() (removed the character . before the
type)

« [Multi] - Fixed KF implementation of Feature.start() to throw an ExceptionininitializerError when an exception
is thrown in a Feature clinit method

Simulator

« Updated implementation of internal OutOfMemoryError thrown with more than one frames dumped per
thread

- By default the 20 top frames per thread are dumped. This can be modified using S3.
OutOfMemoryErrorNbFrames system property

Fixed wrong parsing of an array of long when an element is declared with only 2 digits (e.g. 25 was parsed
as 2)

Fixed error parsing of an array of byte when an element is declared with the unsigned hexadecimal notation
(e.g. 0xFF) (introduced in version 7.70.0)

Fixed crash when ResourceBuffer.readString() is called on a String greater than 63 characters (introduced in
version 7.10.0)

« Fixed code coverage .cc generation of classpath directories

Fixed crash during a GC when computing the references map of a complex method (an error message is
dumped with the involved method name and suggest to increase the internal stack using S3.JavaMemory.
ThreadStackSize system property)

+ [Multi] - Added validity check of Shared Interface declaration files ( . si ) according to KF specification

« [Multi] - Fixed processing of Resource Buffers declared in Feature classpath

SOAR

« Added anew option core.memory.oome.nb. frames to configure the maximum number of stack frames that
can be dumped when an internal OutOfMemoryError is thrown by Core Engine

Tools

+ Updated Heap Dumper to verbose detected object references that are outside the heap

+ Updated Heap Dumper to throw a dedicated error when an object reference does not target the beginning of
an object (most likely a corrupted heap)

+ Updated Heap Dumper to dump .heap.error partial file when a crash occurred during heap processing

+ Fixed Heap Dumper crash when processing an object owned by a Feature which type is also owned by the
Feature (was working before only when the type is owned by the Kernel)

« Fixed Firmware Linker potential negative offset generation when some sections do not appear in the same
order in the ELF file than in their associated LOAD segment
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« Fixed Code Coverage Analyzer potential generated empty report (wrong load of classfiles from JAR files)

[7.11.0] - 2019-06-24

Important Notes

« Java assertions execution is now disabled by default. If you experience any runtime trouble when migrat-
ing from a previous Architecture, please enable Java assertions execution both on Simulator and on Device
(maybe the application code requires Java assertions to be executed).

« Calls to Security Manager are now disabled by default. If you are using the Security Manager, it must be
explicitly enabled using the option described below (likely the case when building a Multi-Sandbox Firmware
and its associated Virtual Device).

+ Front Panel framework is now provided by the Architecture instead of the Ul Pack. This allow to build a Plat-
form with a Front Panel (splash screen, basic I/0, ...), even if it does not provide a MicroUl port. Moreover,
the Front Panel framework APl has been redesigned and is now distributed using the ej. tool.frontpanel.
framework module instead of the legacy Eclipse classpath variable.

Known Issues

+ SOAR Internal SOAR error or Stacks merging coherence error thrownwhenan if statement (being
removed) is declared at the end of a try block:

try {

if (Constants.getBoolean(XXX)) { // constant resolved to false
. // code being removed

}
} catch (Exception e) {

3

Core Engine

« Added EDC-1.3 support for daemon threads
« Added BON support for ej.bon.Util.newArray(T[],int)
« [Multi/ARMCC5] - Fixed unused undefined symbol that prevent Keil MDK-ARM to link properly

Foundation Libraries

+ Updated EDC to version 1.3 (see EDC-1.3 API Changelog)

- Updated the implementation code for correct Null analysis detection (added assertions, extracted mul-
tiple field accesses into a local)

- Fixed PrintStream.PrintStream(OutputStream, boolean) writer initialization
- Removed useless String literals in java.lang.Throwable

« Updated UTF-8 decoder to support Unicode code points

« Updated BON to version 1.4 (see BON-1.4 API Changelog)
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« Updated TRACE toversion 1.1
- Added ej.trace.Tracer.getGrouplD()
- Added a BON Constant ( core. trace.enabled) to remove trace related code when tracing is disabled

+ Fixed KF to call the registered Thread.UncaughtExceptionHandler when an exception is thrown by the first
Feature thread

Integration

+ Added new options for Java assertions execution in category Runtime ( core.assertions.sim.enabled
and core.assertions.emb.enabled). By default, Java assertions execution is disabled both on Simulator
and on Device.

« Updated options categories (options property names left unchanged)
- Added a new category named Runtime
- Renamed Target to Device
- Moved Embed All type names option from Core Engine to Runtime
- Moved Core Engine under Device
- Removed category Target > Debug and moved Trace optionsto Runtime
- Removed category Debug and moved all sub categories under Simulator
- Renamed category JDWP to Debug

+ Addedanoption(com.microej.library.edc.securitymanager.enabled)toenable Security Manager run-
time checks (disabled by default)

Simulator

+ Added a cache to speed-up classfile loading in JARs

+ Added EDC-1.3 support for daemon threads

« Added BON-1.4 support for compile-time constants (load of .constants.list resources)

« Added BON-1.4 support for ej.bon.Util.newArray()

« Added Front Panel framework

+ Updated error message when reaching S3 simulator limits

« Removed the Bootstrapping a Smart Software Simulator message when verbose mode in enabled

« Fixed Object.clone() on an immutable object to return a new (mutable) object instead of an immutable one
« Fixed Object.clone() crash when an OutOfMemory occurs

« Fixed potential crash when calling an abstract method (some interfaces of the hierarchy were not taken into
account - introduced in version 7.70.0)

« Fixed OutOfMemory errors even if the heap is not full (resources loaded from Class.getResourceAsStream()
and ResourceBuffer creation were taken into account in simulated heap memory - introduced in version
7.10.0)

« Fixed potential crash when a GC occurs while a ResourceBuffer is opened (introduced in version 7.70.0)

« Fixed potential debugger hangs when an exception was thrown but not caught in the same method
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+ [Multi] - Fixed wrong class loading in some cases

+ [Multi] - Fixed wrong immutable loading in some cases

SOAR

+ Added BON-1.4 support for compile-time constants (load of .constants.list resources)
+ Added bytecode removal for Java assertions (when option is disabled)
« Added bytecode removal for if(ej.bon.Constants.getBoolean()) pattern

- then or else block is removed depending on the boolean condition

- WARNING: Current limitation: the " if** statement cannot wrap or be nested in a " “try-catch-finally **
statement

+ Added an option for grouping all the methods by type in a single ELF section
- com.microej.soar.groupMethodsByType.enabled ( false by default)

- WARNING: this option avoids to reach the maximum number of ELF sections (65536) when building a large
application, but affects the application code size (especially inline methods are embedded even ifthey are
not used)

+ Added an error message when microejapp.o cannot be generated because the maximum number of ELF
sections (65536) is reached

Tools

+ Updated License Manager (Production) to debug dongle recognition issues. (usage is java -Djava.
library.path=resources/os/[0S_NAME] -jar licenseManager/licenseManagerUsbDongle.jar in an
Architecture or Platform folder)

+ Updated License Manager (Production) to support dongle recognition on macOS 10.14 (Mojave)

Fixed ELF To Map to produce correct sizes from an executable generated by IAR Embedded Workbench for
ARM

Fixed Firmware Linker .ARM.exidx section generation (missing section link content)

Updated deployment files policy for Platforms in Worskpace, in order to be more flexible depending on the
C project layout. This also allows to deploy to the same C project different Applications built with different
Platforms

- Platform configuration: in bsp/bsp.properties,anew option output.dir indicates where the files
are deployed by default

* Application ( microejapp.o ) and Platform library ( microejruntime.a ) are deployed to
${output.dir}/1lib. Platform header files (*.h) are deployed to ${output.dir}/inc/

* When this option is not set, the legacy behavior is left unchanged (project.file optionin collab-
oration with augmentCProject scripts)

- Launch configuration: Device > Deploy options allow to override the default Platform configuration
in order to deploy each MicroEJ file into a separate folder.

» Fixed wrong ELF file generation when a section included in a LOAD segment was generated before one of
the sections included in a LOAD segment declared before the first one (integrated in ELF Utils and Firmware
Linker)
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+ Fixed wrongELFfile generation when a section included in a LOAD segment had an address which was outside
its LOAD segment virtual address space (integrated in ELF Utils and Firmware Linker)

[7.10.1] - 2019-04-03

Simulator

« Fixed Object.getClass() may return a Class instance owned by a Feature for type owned by the Kernel

[7.10.0] - 2019-03-29

Core Engine

« Added internal memories checks at startup: heaps and statics memories are not allowed to overlap with
LLBSP_IMPL_isInReadOnlyMemory()

« [Multi] - Updated Feature Kill implementation to prepare future RAM Control (fully managed by Core Engine)

+ [Multi] - Updated implementation of ej.kf.Kernel: all APIs taking a Feature argument now will throw a
java.lang.lllegalStateException when the Feature is not started

Foundation Libraries

« Updated KF libraryin sync with Core Engine Kill related fixes and Simulator with Kernel & Features semantic

+ Updated BON library on Simulator (now uses the same implementation than the one used by the Core Engine)

Integration

+ Added generation of architecture.properties file when building a Platform. (Used by SDK 5.x when
manipulating Platforms & Virtual Devices)

Simulator

« Added Embed all types names option for Simulation

« Added memory size simulation for Java Heap and Immortal Heap (Enabling Use target characteristics
option is no more required)

+ Added Kernel & Features semantic, as defined in the KF-1.4 specification
- Fully implemented:
* Ownership for types, object and thread execution context
* Kernel mode
* Context Local Static Field References
- Partially implemented:
* Kernel API (Type grained only)

* Shared Interfaces are binded using direct reference links (no Proxy execution)
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* Feature.stop() does not perform the safe kill. The application cannot be stopped unless it has cor-
rectly removed all its shared references.

- Not implemented:
* Dynamic Feature installation from Kernel.install(java.io.InputStream)

* Execution Rules Runtime checks

Tools

« Updated Memory Map Scripts (Bluetooth, MWT, NLS, Rcommand and AllJoyn libraries)

« Fixed Kernel Packager internal limits error when the ELF executable does not contains a .debug.soar
section

Fixed wrong ELF file generation when segment file size is different than the mem size (integrated in ELF Utils
and Firmware Linker)

Fixed Simulator COM port mapping default value (setto disabled instead of UART<->UART in order to avoid
an error when launch configuration is just created)

Fix ELF To Map: the total sections size were not equal to the segments size

[7.9.1] - 2019-01-08

Tools

« Fixed ELF objcopy generation when ELF executable file contains 0 size segments

« Fixed Stack Trace Reader error when ELF executable file contains relocation sections
[7.9.0] - 2018-09-20
Core Engine

+ Fixed OutOfMemoryError thrown when allocating an object of the size of free memory in immortals heap

SOAR

+ Optimized SOAR processing (up to 50% faster on applications with tens of classpath entries)
[7.8.0] - 2018-08-01
Tools

« [ARMCC5] - Updated SOAR Debug Infos Post Linker tool to generate the full ELF executable file
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[7.7.0] - 2018-07-19

Core Engine

+ Added a permanent hook LLMJVM_on_Runtime_gc_done called after an explicit java.lang.Runtime.gc()

» Updated internal heap header for memory dump

SOAR

+ Added check for the maximum number of allowed concrete types (avoids a Core Engine link error)

Tools

« Added Heap Dumper tool

[7.6.0] - 2018-06-29

Foundation Libraries

« [Multi] - Updated BON library: a Timer owned by the Kernel can execute a TimerTask owned by a Feature

[7.5.0] - 2018-06-15

Internal Release - COTS Architecture left unchanged.
[7.4.0]-2018-06-13
Core Engine

« Removed partial support of ej.bon.Util.throwExceptionInThread() (deprecated)
« [Multi/Linux] - Updated default configuration to always embed method names

+ [Multi/Cortex-M] - Optimized KF checks execution for array & field accesses

Foundation Libraries

« Updated ej.bon.Timer to schedule ej.bon.TimerTask owned by multiple Features
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Simulator

« Fixed implementation of Class.getResourceAsStream() to throw an IOException when the stream is closed

SOAR

« [GCC] - Fixed microejapp.o link with GCC 6.3

Tools

+ Added a retry mechanism in the Testsuite Engine

+ Added a message to suggest increasing the JVM heap when an OutOfMemoryError occurs in the Firmware
Linker tool

« Fixed generation of LL header files for all cross compilation toolchains (file separator for included paths is /

)
« [Cortex-A/ARMCC5] - Fixed SNI convention call issue
o [ESP32,RX] - Fixed Firmware Linker toolinternal limit

[7.3.0] - 2018-03-07
Simulator

« Added an option for the IDE to customize the mockups classpath

« Fixed Deadlock in Shielded Plug remote client when interrupting a thread that waits for block modification
[7.2.0] - 2018-03-02
Core Engine

« [Multi] - Enabled quantum counter computation only when Feature quota is set

+ [Cortex-M/IAR74] - Updated compilation flags to -0Oh

Simulator

+ Added a hook in the mockup that is automatically called during the HIL Engine startup
« Added dump of loaded classes when verbose option is enabled

« Fixed Runtime.freeMemory() call freeze when Emb Characteristics option is enabled

Fixed ShieldedPlug server error after interrupting a thread that is waiting for a database block

Fixed crash Access to a wrong reference in some cases

Fixed java.lang.NullPointerException when interrupting a thread that has not been started

Fixed crash when closing an HIL connection in some cases

« [Multi] - Fixed KF & Watchdog library link when Emb Characteristics option isenabled
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+ [Multi] - Fixed XML Parsing error when Emb Characteristics optionisenabled
[7.1.2] - 2018-02-02
SOAR

« Fixed SNI library was added in the classpath in some cases
[maintenance/6.18.0] - 2017-12-15
Core Engine

« [Multi] - Enabled quantum counter computation only when Feature quota is set

+ [Cortex-M/IART4] - Updated compilation flags to -0Oh

Simulator

« Fixed Runtime.freeMemory() call freeze when Emb Characteristics option is enabled
+ [Multi] - Fixed KF & Watchdog library link when Emb Characteristics option is enabled

+ [Multi] - Fixed XML Parsing error when Emb Characteristics optionisenabled

Tools
« Updated Kernel API Generator tool with classes filtering
[7.1.1] - 2017-12-08
Tools
o [Multi/RX] - Fixed Firmware Linker tool
[7.1.0] - 2017-12-08
Core Engine

« [Multi/RX] - Added KF support
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Integration

+ Fixed SNI-1.3 library name

SOAR

+ [RX] - Added support for ELF symbol prefix _

Tools

« Updated Kernel API generator tool with classes filtering
[7.0.0] - 2017-11-07
Core Engine

« Added SNI-1.3 support

« SNI_suspendCurrentJavaThread() is notinterruptible via Thread.interrupt() anymore

Foundation Libraries
« Updated to SNI-1.3
[6.17.2] - 2017-10-26
Simulator
+ Fixed deadlock during bootstrap in some cases
[6.17.1] - 2017-10-25
Core Engine
« Fixed conversion of -0.0 into a positive value
[6.17.0) - 2017-10-10
Tools

« Updated Memory Map Scripts for TRACE library
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[6.16.0] - 2017-09-27

Core Engine

« Fixed External Resource Loader link error (introduced in version 6.13.0)
[6.15.0] - 2017-09-12
Core Engine

« Added a new option to configure the maximum number of monitors that can be owned per thread (8 per
thread by default, as it was fixed before)

Foundation Libraries

+ Fixed ECOM-COMM internal heap calibration

SOAR

+ Added log of the class loading cause
[6.14.2] - 2017-08-24
Tools

« Fixed Firmware Linker toolscript(load activity.xml from the wrong folder)

« Fixed load of symbol _java_Ljava_io_EOFException thatcan be required by some linkers even if this sym-
bolis not touched

[6.14.1] - 2017-08-02

Simulator

+ Fixed Device Mockup too long initialization that may block the Front Panel Mockup

Foundation Libraries

« Fixed BON .types.list potential conflicts with KF
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Tools

« Modified Firmware Linker internalscripts structure for new Virtual Devices tools
[6.13.0] - 2017-07-21
Core Engine

« Added support for ej.bon.ResourceBuffer

Foundation Libraries

« Updated to BON-1.3

SOAR

+ Added support for *.resourcesext.list (resources excluded from the firmware)

Tools

+ Added BON Resource Buffer generator
[6.12.0] - 2017-07-07
Core Engine

« Added a trace when IllegalMonitorStateException is thrown on a monitorexit

Tools

« Added property skip.mergelLibraries for Platform Builder.
« Updated serial PC connectorto JSSC v2.8.0

Simulator

« Fixed unexpexted java.lang.NullPointerException in some cases
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[6.11.0] - 2017-06-13

Integration

« Fixed useless watchdog library copied in root folder
[6.11.0-betal] - 2017-06-02
Core Engine

« Added an option to enable execution traces
« Added Low Level API LLMJVM_MONITOR_impl.h
« Added Low Level API LLTRACE_impl.h

Foundation Libraries
« Added TRACE-1.0
[6.10.0] - 2017-06-02
Core Engine
« Optimized java.lang.Runtime.gc() (removed useless heap compaction in some cases)
[6.9.2] - 2017-06-02
Integration

+ Fixed missing propertiesin release.properties (introduced in version v6.9.7)

« Fixed artifacts build dependencies to private dependencies

[6.9.1] - 2017-05-29

SOAR

+ [Multi] - Fixed selected methods list in report generation (removed Kernel related method)
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[6.9.0] - 2017-03-15

Base version, included into MicroEJ SDK 4.1.

5.4 MicroEJ Packs

5.4.1 Overview

On top of a MicroEJ Architecture can be imported MicroEJ Packs which provide additional features such as:

« Serial Communications,

« Graphical User Interface,

« Networking,
« File System,
. etc.

Each MicroEJ Pack is optional and can be selected on demand during the MicroEJ Platform confiquration step.

5.4.2 Naming Convention

MicroEJ Packs are distributed in two packages:
+ MicroEJ Architecture Specific Pack under the com/microej/architecture/* organization.
+ MicroEJ Generic Pack under the com/microej/pack/* organization.

See Pack Import for usage.

Architecture Specific Pack
MicroEJ Architecture Specific Packs contain compiled libraries archives and are thus dependent on the MicroEJ
Architecture and toolchain used in the MicroEJ Platform.

MicroEJ Architecture Specific Packs files ends with the .xpfp extension and are classified using the following
naming convention:

com/microej/architecture/[ISA]/[TOOLCHAIN]/[UID]-[NAME]-pack/[VERSION]/[UID]-[NAME]-pack-[VERSION].xpfp

« ISA:instruction set architecture (e.g. CM4 for Arm® Cortex®-M4, ESP32 for Espressif ESP32,...).
+ TOOLCHAIN : C compilation toolchain (e.g. CM4hardfp_GCC48).

« UID: Architecture unique ID (e.g. flopi4G25).

« NAME : pack name (e.g. ui).

« VERSION: pack version (e.g. 13.0.4).

For example, MicroEJ Architecture Specific Pack Ul versions for Arm® Cortex®-M4 microcontrollers compiled
with GNU CC toolchain are available at https://repository.microej.com/modules/com/microej/architecture/CM4/
CM4hardfp_GCC48/flopi4G25-ui-pack/.
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Generic Pack

MicroEJ Generic Packs can be imported on top of any MicroEJ Architecture.

They are classified using the following naming convention:

com/microej/pack/[NAME]/[NAME]-pack/[VERSION]/

« NAME : pack name (e.g. bluetooth).
+ VERSION: packversion (e.g. 2.1.0).

For example, MicroEJ Generic Pack Bluetooth versions are available at https://repository.microej.com/modules/
com/microej/pack/bluetooth/bluetooth-pack/.

Legacy Generic Pack

Legacy MicroEJ Generic Packs files end with the .xpfp extension. These Packs contain one or more Platform
modules. See Platform Module Configuration for their configuration. They are classified using the following naming
convention:

com/microej/pack/[NAME]/[VERSION]/[NAME]-[VERSION]. xpfp

« NAME : pack name (e.g. net).
+ VERSION: packversion (e.g. 9.2.3).

For example, the Legacy MicroEJ Generic Pack NET version 9.2.3 is available at https://repository.microej.com/
modules/com/microej/pack/net/9.2.3/net-9.2.3.xpfp.

5.5 Platform Creation

This section describes the steps to create a new MicroEJ Platform in MicroEJ SDK, and options to connect it to an
external Board Support Package (BSP) as well as a third-party C toolchain.

Note: If you own a legacy Platform, you can either create your Platform again from scratch, or follow the Former
Platform Migration chapter.

5.5.1 Architecture Selection

The first step is to select a MicroEJ Architecture compatible with your device instructions set and C compiler.

MicroEJ Corp. provides MicroEJ Evaluation Architectures for most common instructions sets and compilers at
https://repository.microej.com/modules/com/microej/architecture.

Please refer to the chapter Architectures MCU / Compiler for the details of ABl and compiler options.

If the requested MicroEJ Architecture is not available for evaluation or to get a MicroEJ Production Architecture,
please contact your MicroEJ sales representative or our support team.
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5.5.2 Platform Configuration

The next step is to create a MicroEJ Platform configuration project:

« Select File > New > Project... > General > Project ,

« Enter a Projectname . The name is arbitrary and can be changed later. The usual convention is
[PLATFORM_NAME]-configuration,

« Clickon Finish button. A new empty project is created,

« Install the latest Platform Configuration Additions. Files within the content folder have to be copied
to the configuration project folder, by following instructions described at https://github.com/MicroEJ/
PlatformQualificationTools/blob/master/framework/platform/README.rst.

You should get a MicroEJ Platform configuration project that looks like:

w = myplatform-configuration
w = bsp
|=| bsp.properties
w [ build
= module
= platform
CHAMNGELOG.md
README.md
|%] .project
%I configuration.xml
¥ default.platform
& module.ant
by moduledvy
= module.properties
& override.module.ant

Fig. 8: MicroEJ Platform Configuration Project Skeleton

Note: The version of installed Platform Configuration Additions is indicated in the CHANGELOG file.

Edit the Module Description File module.ivy to declare the MicroEJ Architecture dependency:

<dependencies>

<dependency org="com.microej.architecture.[ISA].[TOOLCHAIN]" name="[UID]" rev="[VERSION]">
<artifact name="[UID]"” m:classifier="[USAGE]" ext="xpf"/>
</dependency>

</dependencies>

The name of the module dependency needed for your Platform can be found in the chapter Architectures MCU

/ Compiler. Check the table of your corresponding Architecture and follow the link in the Module Name
column.

For example, to declare the MicroEJ Evaluation Architecture version 7.14.0 for Arm® Cortex®-M4 microcon-
trollers compiled with GNU CC toolchain:
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<dependencies>
<dependency org="com.microej.architecture.CM4.CM4hardfp_GCC48" name="flopi4G25" rev="7.14.0">
<artifact name="flopi4G25" m:classifier="eval" ext="xpf"/>

</dependency>

</dependencies>

And the module for this Architecture is located in the Central Repository at https://repository.microej.
com/modules/com/microej/architecture/CM4/CM4hardfp_GCC48/flopi4G25/7.14.0/.

Note: The Platform Configuration Additions allow to select the Architecture USAGE using
the option com.microej.platformbuilder.architecture.usage . Edit the file module.
properties to set the property to prod to use a Production Architecture and to eval to
use an Evaluation Architecture.

5.5.3 Pack Import

MicroEJ Pack provides additional features on top of the MicroEJ Architecture such as Graphical User Interface or
Networking.

Note: MicroEJ Packs are optional. You can skip this section if you intend to integrate MicroEJ runtime only with
custom libraries.

To declare a MicroEJ Pack dependency, edit the Module Description File module.ivy as follows:

<dependencies>
<!-- MicroEJ Architecture Specific Pack -->
<dependency org="com.microej.architecture.[ISA].[TOOLCHAIN]" name="[UID]-[NAME]-pack” rev="[VERSION]
="/>

<!-- MicroEJ Generic Pack -->
<dependency org="com.microej.pack.[NAME]" name="[NAME]-pack” rev="[VERSION]"/>

<!-- Legacy MicroEJ Generic Pack -->
<dependency org="com.microej.pack” name="[NAME]" rev="[VERSION]"/>

</dependencies>

For example, to declare the MicroEJ Architecture Specific Pack Ul version 13.0.4 for MicroEJ Architecture
flopi4G25 on Arm® Cortex®-M4 microcontrollers compiled with GNU CC toolchain:

<dependencies>
<!-- MicroEJ Architecture Specific Pack -->

<dependency org="com.microej.architecture.CM4.CM4hardfp_GCC48" name="flopi4G25-ui-pack” rev="13.0.4
="/>

</dependencies>

To declare the MicroEJ Generic Pack Bluetooth version 2.1.0:
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<dependencies>
<!-- MicroEJ Generic Pack -->
<dependency org="com.microej.pack.bluetooth” name="bluetooth-pack” rev="2.1.0"/>

</dependencies>

And to declare the Legacy MicroEJ Generic Pack Net version 9.2.3:

<dependencies>
<!-- Legacy MicrokEJ Generic Pack -->
<dependency org="com.microej.pack” name="net" rev="9.2.3"/>

</dependencies>

Warning: MicroEJ Architecture Specific Packs and Legacy MicroEJ Generic Packs provide Platform modules that
are not installed by default. See Platform Module Configuration section for more details.

5.5.4 Platform Build
The MicroEJ Platform can be built either from the SDK or from the MMM CLI. To build the MicroEJ Platform from the
SDK, perform a regular Module Build:
« Right-click on the Platform Configuration project,
+ Select Build Module .
To build the MicroEJ Platform from the MMM CLI:

+ Setthe eclipse.home property to the path of your SDK, using -Declipse.home=<path> in the command
line or using the Shared configuration.

By default, the SDK’s path is one of the following directories:
- onWindows: C:\Program Files\MicroEJ\MicroEJ-SDK-<YY.MM>\rcp
- onLinux: /home/<user>/MicroEJ/MicroEJ-SDK-<YY.MM>/rcp

- on macOs: /Applications/MicroEJ/MicroEJ-SDK-<YY.MM>/rcp/MicroEJ-SDK-<YY.MM>.app/
Contents/Eclipse

+ From the Platform Configuration project, execute the command: mmm

In both cases the build starts and the build logs are redirected to the integrated console. Once the build is termi-
nated, you should get the following message:

module-platform:report:

[echo] -

[echo] Platform has been built in this directory 'C:\tmp\mydevice-Platform-[TOOLCHAIN]-
—0.1.0".

[echo] To import this project in your MicroEJ SDK workspace (if not already available):

[echo] - Select 'File' > 'Import...' > 'General' > 'Existing Projects into Workspace'.
—> 'Next'

[echo] - Check 'Select root directory' and browse 'C:\tmp\mydevice-Platform-
—[TOOLCHAIN]-0.1.0' > 'Finish'

[echo] -

—

(continues on next page)
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(continued from previous page)

BUILD SUCCESSFUL

Total time: 43 seconds

Then, import the Platform directory to your MicroEJ SDK workspace as mentioned in the report. You should
get a ready-to-use MicroEJ Platform project in the workspace available for the MicroEJ Application project to
run on. You can also check the MicroEJ Platform availability in:  Window > Preferences > MicroEJ >

Platforms in workspace .

v & mydevice-Platform-mytoclchain-0.0.1
v [ build
=| release.properties
w = source
= documentation
= include
[= javahPls
[= javalibs
= lib
[= licenseManager
= link
= linker
= MICROINVM
= mocks
[= plugins
[ resources
= 53
[= scripts
(= tools
=| architecture.properties
readme.md
=| release.properties
| £ workbenchExtension_edc.jar
| £ workbenchExtension_launchScriptFramework,jar
[ £ workbenchExtension_micrajvm.jar
| £ workbenchExtension_nls jar
| £ workbenchExtension jar
| £ workbenchExtensiond.jar

Fig. 9: MicroEJ Platform Project

This step is only required the first time the Platform is built, or if the Platform properties have changed (i.e, name,
version). When the same Platform is built again, the Platform project should be automatically refreshed after few

seconds. In case of any doubt, right-click on the Platform project and select Refresh to getthe new content.
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5.5.5 Platform Module Configuration

A Platform module is the minimal unit that can extend a MicroEJ Architecture with additional features such as:

+ Runtime Capability (e.g. Multi-Sandbox, External Resources Loader) ,

« Foundation Library Implementation (e.g. MicroUl, NET),
« Simulator (e.g. Front Panel Mock),
« Tool (e.g. MicroEJ Java H).

Platform modules provided by MicroEJ Generic Packs are automatically installed during the Platform build and do
not require extra configuration. They are not displayed in the Platform Editor.

Platform modules provided by MicroEJ Architectures, MicroEJ Architecture Specific Packs and Legacy MicroEJ Generic
Packs following list are not installed by default. They must be enabled and configured using the Platform Editor.

Before opening the Platform Editor, the Platform must have been built once to let MicroEJ Module Manager resolve
and download MicroEJ Architecture and Packs locally. Then import them in MicroEJ SDK as follows:

« Select File > Import > MicroEJ > Architectures ,
» Browse myplatform-configuration/target~/dependencies folder (contains .xpf and .xpfp files once the
Platform is built),

+ Check the |agree and accept the above terms and conditions... box to accept the license,

« Clickon Finish button. This may take some time.

Once imported, double-click on the default.platform file to open the Platform Editor.

From the Platform Editor, select the Content tab to access the modules selection. Platform modules can be
selected/deselected from the Modules frame.

Platform modules are organized into groups. When a group is selected, by default, all its modules are selected. To
view all the modules making up a group, click on the Expand All icon on the top-right of the frame. This will let you
select/deselect on a per module basis. Note that individual module selection is not recommended and that it is
only available when the module have been imported.

The description and contents of an item (group or module) are displayed beside the list on item selection.

All the selected Platform modules will be installed in the Platform.
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I mydevice-myplatform-mytoolchain b

{¥ Content

Environment

Architecture Browse...

Modules 1 Details
Modules included in the Platform.

type filter text Description
Multi Applications modules group.
Mame

[] Device Information

[] External Resources Loader
[] Front Panel

[]Fs

[] HAL

[] Javato C Interface

[] Multi Applications

] NET

[] Serial Communication

[ ssL
Ul

Fig. 10: MicroEJ Platform Configuration Modules Selection

Each selected Platform module can be customized by creatinga [module] folder named after the module beside

the .platform file definition. It may contain:

« A [module].properties file named after the module name. These properties will be injected in the execu-

tion context prefixed by the module name. Some properties might be needed for the configuration of some
modules. Please refer to the modules documentation for more information.

+ A bsp.xml file which provides additional information about the BSP implementation of Low Level APIs.

This file must start with the node  <bsp> . It can contain several lines like this one:
<nativeName="A_LLAPI_NAME" nativelImplementation name="AN_IMPLEMENTATION_NAME"/>

where:

- A_LLAPI_NAME referstoalLow Level APl native name. Itis specific to the MicroEJ C library which provides
the Low Level API.

- AN_IMPLEMENTATION_NAME refersto the implementation name of the Low Level API. It is specific to the
BSP; and more specifically, to the C file which does the link between the MicroEJ C library and the C
driver.

These files will be converted into an internal format during the MicroEJ Platform build.

« Optional module specific files and folders
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Modifying one of these files requires to build the Platform again.

Note: Itis possible to quickly rebuild the Platform from the Platform Editor if only Platform module configuration
has changed. Click on the Build Platform link on the Platform configuration Overview tab.

5.5.6 Platform Customization

The configuration project (the project which contains the .platform file) can containan optional dropins folder.

The contents of this folder will be copied integrally into the final Platform. This feature allows to add some addi-
tional libraries, tools etc. into the Platform.

The dropins folder organization should respect the final Platform files and folders organization. For instance, the

tools are located in the sub-folder tools . Launch a Platform build without the dropins folder to see how the
Platform files and folders organization is. Then fill the dropins folder with additional features and build again the
Platform to obtain an advanced Platform.

The dropins folder files are kept in priority. If one file has the same path and name as another file already installed
into the Platform, the dropins folder file will be kept.

Platform build can also be customized by updating the configuration.xml file beside the .platform file. This

Ant script can extend one or several of the extension points available. By default, you should not have to change
the default configuration script.

Modifying one of these files requires to build the Platform again.

5.5.7 Platform Publication

The publication of the built Platform to a module repository is disabled by default. It can be enabled by setting the
skip.publish property defined in the file module.properties of the Platform configuration projectto false.

The publication is generally kept disabled by default in the project sources since developers use the locally built
platform, but must be enabled in the Continuous Integration environment. This can be done by leaving the skip.
publish propertyto true inthe project sourcesand by overwritingitin the command launched by the Continuous
Integration environment, for example:

mmm publish shared -Dskip.publish=false

5.5.8 BSP Connection
Principle
Using a MicroEJ Platform, the user can compile a MicroEJ Application on that Platform. The result of this compila-

tionisa microejapp.o file.

This file has to be linked with the MicroEJ Platform runtime file (microejruntime.a) and a third-party C project,
called the Board Support Package (BSP), to obtain the final binary file (MicroEJ Firmware). For more information,
please consult the MicroEJ build process overview.

The BSP connection can be configured by defining 4 folders where the following files are located:
« MicroEJ Application file (microejapp.o).

« MicroEJ Platform runtime file (microejruntime. a, also available in the Platform 1ib folder).
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« MicroEJ Platform header files (+. h, also available in the Platform include folder).
« BSP project build script file (build.bat or build.sh).

Once the MicroEJ Application file ( microejapp.o ) is built, the files are then copied to these locations and the
build.bat or build.sh fileis executed to produce the final executable file (application.out).

Note: The final build stage to produce the executable file can be done outside of MicroEJ SDK, and thus the BSP
connection configuration is optional.

BSP connection configuration is only required in the following cases:
« Use MicroEJ SDK to produce the final executable file of a Mono-Sandbox Firmware (recommended).
+ Use MicroEJ SDK to run a MicroEJ Test Suite on device.

« Build a Multi-Sandbox Firmware.

MicroEJ provides a flexible way to configure the BSP connection to target any kind of projects, teams organizations
and company build flows. To achieve this, the BSP connection can be configured either at MicroEJ Platform level
or at MicroEJ Application level (or a mix of both).

The 3 most common integration cases are:
« Case 1: No BSP connection
The MicroEJ Platform does not know the BSP at all.

BSP connection can be configured when building the MicroEJ Application (absolute locations).

C application

MicroEJ code and Board

frslm e MicroEJ Platform

Support Package

BSP absolute locations

MicroEJ Firmware

Fig. 11: MicroEJ Platform with no BSP connection

This case is recommended when:
- the MicroEJ Firmware is built outside MicroEJ SDK.

- the same MicroEJ Platform is intended to be reused on multiple BSP projects which do not share the
same structure.

« Case 2: Partial BSP connection
The MicroEJ Platform knows how the BSP is structured.

BSP connection is configured when building the MicroEJ Platform (relative locations within the BSP), and the
BSP root location is configured when building the MicroEJ Application (absolute directory).
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C application

MicroElJ

MicroEJ Platform code and Board

Support Package

Application code

BSP relativie locations
BSP roofidirectory

MicroEJ Firmware

Fig. 12: MicroEJ Platform with partial BSP connection

This case is recommended when:
- the MicroEJ Platform is used to build one MicroEJ Application on top of one BSP.

- the Application and BSP are slightly coupled, thus making a change in the BSP just requires to build the
firmware again.

« Case 3: Full BSP connection
The MicroEJ Platform includes the BSP.

BSP connection is configured when building MicroEJ Platform (relative locations within the BSP), as well as
the BSP root location (absolute directory). No BSP connection configuration is required when building the
MicroEJ Application.

C application
code and Board
Support Package

MicroEJ

e onEed MicroEJ Platform

BSP relative locations
BSP root directory

MicroEJ Firmware

Fig. 13: MicroEJ Platform with full BSP connection

This case is recommended when:
- the MicrokEJ Platform is used to build various MicroEJ Applications.
- the MicroEJ Platform is validated using MicroEJ test suites.

- the MicroEJ Platform and BSP are delivered as a single standalone module (same versioning), perhaps
subcontracted to a team or a company outside the application project(s).
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Options

BSP connection options can be specified as Platform options or as Application options or a mix of both.

The following table describes the Platform options, which can be set in the bsp/bsp.properties file of the Plat-
form configuration project.

Table 1: MicroEJ Platform Options for BSP Connection

Option Description Example
Name
) | The path relative to BSP root.dir where to deploy the Mi- ) )
M1Croejapp croEJ Application file (microejapp.o). MicrokJ/lib
relative.
dir
The path relative to BSP root.dir where to deploy the Mi-
microejlib croEy Platform runtime file (microejruntime. a). MicroEJ/1lib
relative.
dir
The path relative to BSP root.dir where to deploy the Mi-
microejint ¢roE ) Platform headerfiles (*.h). MicrokJ/inc
relative.
dir
) | Thepathrelativeto BSP root.dir where to execute the BSP ' )
microejscryifitd script file (build.bat or build.sh). Project/MicrokJ
relative.
dir
The 3rd-party BSP project absolute directory, to be included )
root. to the Platform. c:\\Users\\user\\mybsp onWin-
dir dows systems or /home/user/bsp
on Unix systems.

The following table describes the Application options, which can be set as regular MicroEJ Application Options.
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Table 2: MicroEJ Application Options for BSP Connection

Option Name Description

Deploy the MicroEJ Application file (microejapp. o) to the location defined by the Platform
d§ploy ..bsp. (defaults to true when Platform option microejapp.relative.dir isset).
microejapp

Deploy the MicroEJ Platform runtime file ( microejruntime.a) to the location defined by
deploy.bsp. the Platform (defaults to true when Platform option microejlib.relative.dir isset).
microejlib

Deploy the MicroEJ Platform header files ( *.h ) to the location defined by the Platform (de-
dgployipsp. faultsto true when Platform option microejinc.relative.dir is set).
microejinc

Execute the BSP build script file (build.bat or build.sh) at the location specified by the
deploy.bsp. Platform. (defaults to false and requires microejscript.relative.dir Platform option
microejscript to be set).

The 3rd-party BSP project absolute directory. This option is required if at least one the 4
deploé’ : bsp. options described above is set to true and the Platform does not include the BSP.
root.air

) Absolute path to the directory where to deploy the MicroEJ Application file (microejapp.o
d?ploy -.dl'”- ). An empty value means no deployment.
microejapp

) Absolute path to the directory where to deploy the MicroEJ Platform runtime file (
deploy.dir. microejruntime.a) to this absolute directory. An empty value means no deployment.
microejlib

) Absolute path to the directory where to deploy the MicroEJ Platform header files ( *.h ) to
d?ploy "‘.j”' this absolute directory. An empty value means no deployment.
microejinc

) Absolute path to the directory that contains the BSP build script file (build.bat or build.sh
deploy.dir. ). An empty value means no build script execution.
microejscript

Note: It is also possible to configure the BSP root directory by setting the build option toolchain.dir , instead
of the application option deploy.bsp.root.dir . This allows to configure a MicroEJ Firmware by specifying both
the Platform (using the target.platform.dir option) and the BSP at build level, without having to modify the
application options files.

For each Platform BSP connection case, here is a summary of the options to set:

« No BSP connection, executable file built outside MicroEJ SDK

Platform Options:

[NONE]

Application Options:

[NONE]

« No BSP connection, executable file built using MicroEJ SDK

Platform Options:

[NONE]

Application Options:
deploy.dir.microejapp=[absolute_path]
deploy.dir.microejlib=[absolute_path]
deploy.dir.microejinc=[absolute_path]

(continues on next page)
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(continued from previous page)

deploy.dir.microejscript=[absolute_path]
deploy.bsp.microejscript=true

« Partial BSP connection, executable file built outside MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]

« Partial BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]

Application Options:
deploy.bsp.root.dir=[absolute_path]
deploy.bsp.microejscript=true

+ Full BSP connection, executable file built using MicroEJ SDK

Platform Options:
microejapp.relative.dir=[relative_path]
microejlib.relative.dir=[relative_path]
microejinc.relative.dir=[relative_path]
microejscript.relative.dir=[relative_path]
root.dir=[absolute_path]

Application Options:
deploy.bsp.microejscript=true

Build Script File
The BSP build script file is used to invoke the third-party C toolchain (compiler and linker) to produce the final
executable file (application.out)
The build script must comply with the following specification:
« On Windows operating system, it is a Windows batch file named build.bat.

« On macOS or Linux operating systems, it is a shell script named build.sh, with execution permission en-
abled.

« On error, the script must end with a non zero exit code.
« On success

- The executable must be copied to afile named application.out inthe directory from where the script
has been executed.

- The script must end with zero exit code.
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Many build script templates are available for most commonly used C toolchains in the Platform Qualification Tools
repository.

Note: The final executable file must be an ELF executable file. On Unix, the command file(1) can be use to
check the format of a file. For example:

~$ file application.out
ELF 32-bit LSB executable

Run Script File

This script is required only for Platforms intended to run a MicroEJ Testsuite on device.
The BSP run script is used to invoke a third-party tool to upload and start the executable file on device.
The run script must comply with the following specification:
« On Windows operating system, it is a Windows batch file named run.bat.
« OnmacOS or Linux operating systems, it is a shell script named run.sh, with execution permission enabled.

« The executable file is passed as first script parameter if there is one, otherwise itis the application.out file
located in the directory from where the script has been executed.

« On error, the script must end with a non zero exit code.

« Onsuccess:
- The executable file (application.out ) has been uploaded and started on the device
- The script must end with zero exit code.

The run script can optionally redirect execution traces. If it does not implement execution traces redirection, the
testsuite must be configured with the following Application Options in order to take its input from a TCP/IP socket
server, such as Serial to Socket Transmitter.

testsuite.trace.ip=localhost
testsuite.trace.port=5555

5.6 Platform Qualification

5.6.1 Introduction

A MicroEJ Platform integrates one or more Foundation Libraries with their respective Abstraction Layers.

Platform Qualification is the process of validating the conformance of the Abstraction Layer that implements the
Low Level APIs of a Foundation Library.
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Fig. 14: Platform Qualification Overwiew

For each Low Level API, an Abstraction Layer implementation is required. The validation of the Abstraction Layer
implementation is performed by running tests at two-levels:

+ In C, by calling Low Level APIs (usually manually).

« In Java, by calling Foundation Library APIs (usually automatically using Platform Test Suite).

The following figure depicts an example for the FS Pack:
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Fig. 15: Platform Qualification Example for FS Pack

MicroEJ provides a set of tools and pre-defined projects aimed at simplifying the steps for validating Platforms in
the form of the Platform Qualification Tools (PQT).

5.6.2 Platform Qualification Tools Overview

The Platform Qualification Tools provide the following components:
+ Platform Configuration Additions (PCA):

- Used to:

* Manage MicroEJ Architecture, MicroEJ Packs and the Platform build with the MicroEJ Module Man-
ager.

* Configure the BSP connection to call the build and run scripts.

- Added when creating a Platform (see Platform Creation or check the tutorial Create a MicroEJ Firmware
From Scratch).

« Build and Run Scripts examples:
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- Used to generate and deploy a MicroEJ Firmware on a device by invoking a third-party toolchain for the
BSP

- Added when integrating the BSP to the Platform (see Build Script File and Run Script File or check the
tutorial Create MicroEJ Platform Build and Run Scripts).

+ Cand Java Test Suites:
- Used to validate the Low Level APIs implementations

- Validated during the BSP development and whenever an Abstraction Layer implementation is added or
changed (see Platform Test Suite or check the tutorial Run a Test Suite on a Device).

Please refer to the Platform Qualification Tools README for more details and the location of the components.

5.6.3 Platform Test Suite

The purpose of a MicroEJ Platform Test Suite is to validate the Abstraction Layer that implements the Low Level
APIs of a Foundation Libraries by automatically running Java tests on the device.

The MicroEJ Test Suite Engine is used for building, running a Test Suite, and providing a report.

A Platform Test Suite contains one or more tests. For each test, the Test Suite Engine will:
1. Build a MicroEJ Firmware for the test.
. Program the MicroEJ Firmware onto the device.
. Retrieve the execution traces.

2
3
4. Analyze the traces to determine whether the test has PASSED or FAILED.
5. Append the result to the Test Report.

6

. Repeat until all tests of the Test Suite have been executed.
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Fig. 16: Platform Test Suite on Device Overview

5.6.4 Test Suite Versioning

Foundation Libraries are integrated in a MicroEJ Platform by MicroEJ Packs (see Pack Import). Use the Test Suite
version compliant with the API version provided by the Foundation Library to validate the Abstraction Layer im-
plementation. For example, the Test Suite FS module 3.0.3 should be used to validate the Abstraction Layerimple-
mentation of the Low Level API FS provided by the FS Pack 5.1.2.

Note: A MicroEJ Pack can provide several Foundation Libraries.

Core Engine

Table 3: Core Engine Validation

Architecture Test Suite
7.0.0 or higher Core Engine Test Suite
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Ul Pack

Table 4: Ul Validation

Ul Pack

C Test Suite

13.0.0 or higher (U13)

Graphical User Interface Test Suite

[6.0.0-12.1.5] (UI2)

Graphical User Interface Test Suite

FS Pack
Table 5: FS APl Implementation and Validation
FS Pack FS API Java Test Suite
[5.1.2-5.2.0[ 2.0.6 3.0.3
[4.0.0-4.1.0[ 2.0.6 On demand'

BLUETOOTH Pack

Table 6: BLUETOOTH API Implementation and Validation

BLUETOOTH Pack BLUETOOTH API Java Test Suite
2.1.0 2.1.0 2.0.0
2.01 2.0.0 2.0.0
NET Pack
On demand'.
Table 7: NET, SSL and SECURITY APIs Implementations and Validations
NET Pack NET API SSL API SECURITY | NET Java Test | SSL Java Test | SECURITY Java
API Suite Suite Test Suite
[8.1.2-8.2.0] 1.1.0 2.1.0 N/A 3.4.0 (On | 3.0.1 (On de- | N/A
demand') mand')
9.0.0 1.1.0 2.2.0 1.3.1 3.4.0 (On | 31.4 (On de- | 1.1.0 (On de-
demand') mand’) mand')
[9.0.1-9.4.1] 1.1.1 2.2.0 1.3.1 3.52 (On de- | 314 (On de- | 1.1.0 (On de-
mand') mand') mand')
10.0.0 1.1.2 2.2.1 1.4.0 3,52 (On de- | 31.4 (On de- | 1.2.0 (On de-
(On de- | mand") mand') mand')
mand')
! Test Suite available on demand, please contact MicroEJ Support.
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5.7 MicroEJ Core Engine

The MicroEJ Core Engine and its components represent the core of the Architecture. It is used to compile and
execute at runtime the MicroEJ Application code.

5.7.1 Functional Description

The following diagram shows the overall process. The first two steps are performed within the MicroEJ Workbench.
The remaining steps are performed within the C IDE.

MicroEJ MicroEJ Platform

Application code

Build the MicroEJ
Application
MicroEJ Workbench

CIDE

C application Application Architecture
code and Board library file library file
Support Package (microejapp.o) (microejruntime.a)

Build and link the full
application

Executable

application

Program and test the
application on the board

Fig. 17: MicroEJ Core Engine Flow

1. Step1consists in writing a MicroEJ Application against a set of Foundation Libraries available in the platform.

2. Step 2 consists in compiling the MicroEJ Application code and the required libraries in an ELF library, using
the SOAR.

3. Step 3 consistsin linking the previous ELF file with the MicroEJ Core Engine library and a third-party BSP (OS,
drivers, etc.). This step may require a third-party linker provided by a C toolchain.
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5.7.2 Architecture
The MicroEJ Core Engine and its components have been compiled for one specific CPU architecture and for use
with a specific C compiler.

The architecture of the platform engine is called green thread architecture, it runs in a single RTOS task. Its be-
havior consists in scheduling MicroEJ threads. The scheduler implements a priority preemptive scheduling policy
with round robin for the MicroEJ threads with the same priority. In the following explanations the term “RTOS
task” refers to the tasks scheduled by the underlying OS; and the term “MicroEJ thread” refers to the Java threads
scheduled by the MicroEJ Core Engine.

RTOS Task 1 RTOS Task 2 RTOS Task 3 RTOS Task 4

Fig. 18: A Green Threads Architecture Example

The activity of the platform is defined by the MicroEJ Application. When the MicroEJ Application is blocked (when
all MicroEJ threads are sleeping), the platform sleeps entirely: The RTOS task that runs the platform sleeps.

The platform is responsible for providing the time to the MicroEJ world: the precision is 1 millisecond.

5.7.3 Capabilities

MicroEJ Core Engine defines 3 exclusive capabilities:
« Mono-sandbox: capability to produce a monolithic firmware (default one).

« Multi-Sandbox: capability to produce a extensible firmware on which new applications can be dynamically
installed. See section Multi-Sandbox.

« Tiny application: capability to produce a compacted firmware (optimized for size). See section Tiny Applica-
tion.

All MicroEJ Core Engine capabilities may not be available on all architectures. Refer to section Supported MicroEJ
Core Engine Capabilities by Architecture Matrix for more details.
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5.7.4 Implementation

The MicroEJ Core Engine implements the [SNI] specification. It is created and initialized with the C function
SNI_createVM. Then it is started and executed in the current RTOS task by calling SNI_startVM. The function
SNI_startVM returns when the MicroEJ Application exits or if an error occurs (see section Error Codes). The func-
tion SNI_destroyVM handles the platform termination.

The file LLMJVM_impl.h that comes with the platform defines the API to be implemented. See section LLMJVM:
MicroEJ Core Engine.

Initialization

The Low Level MicroEJ Core Engine API deals with two objects: the structure that represents the platform, and the
RTOS task that runs the platform. Two callbacks allow engineers to interact with the initialization of both objects:

o LLMJVM_IMPL_initialize: Called once the structure representing the platform is initialized.

o LLMJVM_IMPL_vmTaskStarted : Called when the platform starts its execution. This function is called within
the RTOS task of the platform.

Scheduling

To support the green thread round-robin policy, the platform assumes there is an RTOS timer or some other mecha-
nism that counts (down) and fires a call-back when it reaches a specified value. The platforminitializes the timer us-
ingthe LLMJVM_IMPL_scheduleRequest function with one argument: the absolute time at which the timer should
fire. When the timer fires, it must call the LLMJVM_schedule function, which tells the platform to execute a green
thread context switch (which gives another MicroEJ thread a chance to run).

When several MicroEJ threads with the same priority are eligible for execution, the round-robin algorithm will
automatically switch between these threads after a certain amount of time, called the time slice. The time slice
is expressed in milliseconds, and its default value is 20 ms. It can be configured at link time with the symbol
_java_round_robin_period, defined in the linker configuration file 1inkVMConfiguration.lscf located in the
Platform folder /MICROJVM/1ink/ . To override the content of this file, create, in the Platform configuration project,
a folder named /dropins/MICROJVM/1ink/ , and copy into this folder the file 1inkVMConfiguration.lscf re-
trieved from an existing Platform. Since a symbol cannot be null, the actual time slice value in milliseconds is
_java_round_robin_period - 1.Setthesymbolto1 (i.e.,time slice to 0) to disable the round-robin scheduling.

Warning: Modifying the time slice value is an advanced configuration that can impact the performances.

Decreasing the time slice will increase the number of context switches. Therefore scheduler will use more CPU
time.

Increasing the time slice can create a latency with intensive threads monopolizing the CPU.
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Idle Mode

When the platform has no activity to execute, it calls the LLMJVM_IMPL_idleVM function, which is assumed to put
the RTOS task of the platform into a sleep state. LLMJVM_IMPL_wakeupVM is called to wake up the platform task.
When the platform task really starts to execute again, it calls the LLMJVM_IMPL _ackWakeup function to acknowledge
the restart of its activity.

Time

The platform defines two times:

+ the application time: The difference, measured in milliseconds, between the current time and midnight, Jan-
uary 1,1970, UTC.

« the system time: The time since the start of the device. This time is independent of any user considerations,
and cannot be set.

The platform relies on the following C functions to provide those times to the MicroEJ world:

o LLMJVM_IMPL_getCurrentTime : Depending on the parameter ( true / false) must return the application
time or the system time. This function is called by the MicroEJ method System.currentTimeMillis(). Itis
also used by the platform scheduler, and should be implemented efficiently.

« LLMJVM_IMPL _getTimeNanos : must return the system time in nanoseconds.

o LLMJVM_IMPL_setApplicationTime : must set the difference between the current time and midnight, Jan-
uary 1,1970, UTC.

Error Codes

The C function SNI_createVM returns a negative value if an error occurred during the MicroEJ Core Engine ini-
tialization or execution. The file LLMIVM.h defines the platform-specific error code constants. The following table
describes these error codes.
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9

Table 8: MicroEJ Core Engine Error Codes

Error Code

Meaning

0

The MicroEJ Application ended normally (i.e., all the
non-daemon threads are terminated or System.
exit(exitCode) has been called). See section Exit
Codes.

The microejapp.o produced by SOARis not compati-
ble with the MicroEJ Core Engine (microejruntime.a
). The object file has been built from another MicroEJ
Platform.

Internal error. Invalid link configuration in the MicroEJ
Architecture or the MicroEJ Platform.

Evaluation version limitations reached: termination of
the application. See section Limitations.

Not enough resources to start the very first MicroEJ
thread that executes main method. See section Op-
tion(text): Java heap size (in bytes).

Number of threads limitation reached. See sections
Limitations and Option(text): Number of threads.

-13

Fail to start the MicroEJ Application because the speci-
fied MicroEJ heap is too large or too small. See section
Option(text): Java heap size (in bytes).

14

Invalid MicroEJ Application stack configuration. The
stack start or end is not eight-byte aligned, or stack
block size is too small. See section Option(text): Num-
ber of blocks in pool.

-16

The MicroEJ Core Engine cannot be restarted.

-7

The MicroEJ Core Engine is not in a valid state because
of one of the following situations:
+ SNI_startVM called before SNI_createVM.
+ SNI_startVM called while the MicroEJ Apppli-
cation is running.
» SNI_createVM called several times.

The memory used for the MicroEJ heap or immor-
tal heap does not work properly. Read/Write mem-
ory checks failed. This may be caused by an invalid
external RAM configuration. Verify _java_heap and
_java_immortals sections locations.

The memory used for the MicroEJ Application static
fields does not work properly. Read/Write memory
checks failed. This may be caused by an invalid exter-
nal RAM configuration. Verify .bss.soar section lo-
cation.

KF configuration internal error. Invalid link configura-
tion in the MicroEJ Architecture or the MicroEJ Plat-
form.

Number of monitors per thread limitation reached.
See sections Limitations and Options .

Internal error. Invalid FPU configuration in the MicroEJ
Architecture.

-23

The function LLMJVM_IMPL_initialize defined in
the Abstraction Layer implementation returns an er-
ror.

5.7*MicroEJ Core Engine

The function LLMJVM_IMPL_vmTaskStarted definﬁq

in the Abstraction Layerimplementation returns an er-
ror.

5

-25

The function LLMJVM_IMPL_shutdown defined in the

Ahctraction | aver imnlemeaeantatinn ratiirne an arrar
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Example

The following example shows how to create and launch the MicroEJ Core Engine from the C world. This function (
microej_main) should be called from a dedicated RTOS task.

#include <stdio.h>
#include "microej_main.h"
#include "LLMJVM.h"
#include "sni.h"

#ifdef __cplusplus
extern "C" {
#endif

/**
* @brief Creates and starts a MicroEJ instance. This function returns when the MicroEJ execution ends.
*/
void microej_main(int argc, char *xargv)
{
voidx vm;
int32_t err;
int32_t exitcode;

// create VM
vm = SNI_createVM();

if(vm == NULL)
{
printf("MicroEJ initialization error.\n");
}
else

{
printf("MicroEJ START\n");

// Error codes documentation is available in LLMJVM.h
err = SNI_startVM(vm, argc, argv);

if(err < 0)
{
// Error occurred
if(err == LLMJVM_E_EVAL_LIMIT)

{
printf("Evaluation limits reached.\n");
3
else
{
printf("MicroEJ execution error (err = %d).\n", err);
3
}
else
{
// VM execution ends normally
exitcode = SNI_getExitCode(vm);
printf("MicroEJ END (exit code = %d)\n", exitcode);
}

// delete VM
SNI_destroyVM(vm);
(continues on next page)
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(continued from previous page)

3

#ifdef __cplusplus

3
#endif

Dump the States of the Core Engine

Theinternal MicroEJ Core Engine function called LLMJVM_dump allows you to dump the state of all MicroEJ threads:
name, priority, stack trace, etc. This function must only be called from the MicroJvm virtual machine thread context
and only from a native function or callback. Calling this function from another context may lead to undefined
behavior and should be done only for debug purpose.

This is an example of a dump:

VM Dump
Java threads count: 3

Peak java threads count: 3

Total created java threads: 3

Last executed native function: ©@x90035E3D
Last executed external hook function: 0x00000000

State: running

Java Thread[1026]

name="main"” prio=5 state=RUNNING max_java_stack=456 current_java_stack=184

java.lang.MainThread@@xC@@83C7C:
at (native) [0x90003F65]
at com.microej.demo.widget.main.MainPage.getContentWidget(MainPage. java:95)
Object References:
- com.microej.demo.widget.main.MainPage@oxC00834EQ
- com.microej.demo.widget.main.MainPage$1@0xC0082184
- java.lang.Thread@oxCo082194
- java.lang.Thread@oxCo082194
at com.microej.demo.widget.common.Navigation.createRootWidget(Navigation.java:104)
Object References:
- com.microej.demo.widget.main.MainPage@oxC00834EQ
at com.microej.demo.widget.common.Navigation.createDesktop(Navigation. java:88)
Object References:
- com.microej.demo.widget.main.MainPage@oxC00834EQ
- ej.mwt.stylesheet.CachedStylesheet@dxC00821DC
at com.microej.demo.widget.common.Navigation.main(Navigation.java:40)
Object References:
- com.microej.demo.widget.main.MainPage@dxC00834EQ
at java.lang.MainThread.run(Thread. java:855)
Object References:
- java.lang.MainThread@oxC@@83C7C
at java.lang.Thread.runWrapper(Thread. java:464)
Object References:
- java.lang.MainThread@oxCe@83C7C
at java.lang.Thread.callWrapper(Thread. java:449)
Java Thread[1281]
name="UIPump"” prio=5 state=WAITING timeout(ms)=INF max_java_stack=120 current_java_stack=117

(continues on next page)
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(continued from previous page)

external event: status=waiting

java.lang.Thread@oxC0083628:
at ej.microui.MicroUIPump.read(Unknown Source)
Object References:
- ej.microui.display.DisplayPump@dxC0083640
at ej.microui.MicroUIPump.run(MicroUIPump.java:176)
Object References:
- ej.microui.display.DisplayPump@dxC0083640
at java.lang.Thread.run(Thread. java:311)
Object References:
- java.lang.Thread@dxC0083628
at java.lang.Thread.runWrapper(Thread. java:464)
Object References:
- java.lang.Thread@oxC0083628
at java.lang.Thread.callWrapper(Thread. java:449)
Java Thread[1536]
name="Thread1"” prio=5 state=READY max_java_stack=60 current_java_stack=57

java.lang.Thread@oxCo082194:
at java.lang.Thread.runWrapper(Unknown Source)
Object References:
- java.lang.Thread@oxC0082194
at java.lang.Thread.callWrapper(Thread. java:449)

Garbage Collector

State: Stopped

Last analyzed object: null

Total memory: 15500

Current allocated memory: 7068
Current free memory: 8432
Allocated memory after last GC: @
Free memory after last GC: 15500

Native Resources
Id CloseFunc Owner Description

See Stack Trace Reader for additional info related to working with VM dumps.
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Dump The State Of All MicroEJ Threads From A Fault Handler

Itis recommended to call the LLMJVM_dump APlasa lastresortinafault handler. Calling LLMJVM_dump is undefined
if the VM is not paused. The call to LLMJVM_dump MUST be done last in the fault handler.

Trigger VM Dump From Debugger

To trigger a VM dump from the debugger, set the PC register to the LLMIVM_dump physical memory address.

The symbol for the LLMIVM_dump APl is defined in the header file LLMJVM. h. Search for this symbol in the appro-
priate C toolchain .map file.

Note: LLMJVM_dump (in LLMJVM.h) needs to be called explicitly. A linker optimization may remove the symbol if
itis not used anywhere in the code.

Requirements:
« Embedded debugger is attached and the processor is halted in an exception handler.

« Away to read stdout (usually UART).

Check Internal Structure Integrity

The internal MicroEJ Core Engine function called LLMJVM_checkIntegrity checks the internal structure integrity
of the MicroJvm virtual machine and returns its checksum.

« If an integrity error is detected, the LLMJVM_on_CheckIntegrity_error hook is called and this method re-
turns 0.

« If nointegrity error is detected, a non-zero checksum is returned.

This function must only be called from the MicroJvm virtual machine thread context and only from a native function
or callback. Calling this function multiple times in a native function must always produce the same checksum. If
the checksums returned are different, a corruption must have occurred.

Please note that returning a non-zero checksum does not mean the MicroJvm virtual machine data has not been
corrupted, as it is not possible for the MicroJvm virtual machine to detect the complete memory integrity.

MicroJvm virtual machineinternal structures allowed to be modified by a native function are not taken into account
for the checksum computation. The internal structures allowed are:

« basetype fields in Java objects or content of Java arrays of base type,

« internal structures modified by a LLMIJVM function call (e.g. set a pending Java exception, suspend or resume
the Java thread, register a resource, ...).

This function affects performance and should only be used for debug purpose. A typical use of this APl is to verify
that a native implementation does not corrupt the internal structures:

void Java_com_mycompany_MyClass_myNativeFunction(void) {
int32_t crcBefore = LLMJVM_checkIntegrity();
myNativeFunctionDo();
int32_t crcAfter = LLMJVM_checkIntegrity();
if(crcBefore != crcAfter){
// Corrupted MicroJVM virtual machine internal structures
while(1);
(continues on next page)
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5.7.5 Generic Output

(continued from previous page)

The System.err stream is connected to the System.out print stream. See below for how to configure the desti-

nation of these streams.

5.7.6 Link

Several sections are defined by the MicroEJ Core Engine. Each section must be linked by the third-party linker.

Table 9: Linker Sections

Section name Aim Location Alignment (in bytes)

System Applications statics RW 4
.bss.features.installed y PP

Application static RW 8
.bss.soar pplicat !

) Application threads stack blocks RW 8

.bss.vm.stacks. java
ICETEA_HEAP MicroEJ Core Engine internal heap Internal RW | 8

Application hea RW 4
_java_heap PP P

Application i h RW 4
java. immortals pplication immortal heap

Application resources RO 16
.rodata.resources

System Applications code and resources | RO 4
.rodata.soar.features

Shielded Plug data RO 4
.shieldedplug &
Ctext soar Application and library code RO 16

. MicroEJ Core Engine generated code RX ISA Specific

.text.__icetea__x*

Note: Sections ICETEA_HEAP,

startup.

_java_heap and _java_immortals are zero-initialized at MicroEJ Core Engine

5.7.7 Dependencies

The MicroEJ Core Engine requires an implementation of its low level APIs in order to run. Refer to the chapter
Implementation for more information.
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5.7.8 Installation

The MicroEJ Core Engine and its components are mandatory. In the platform configuration file, check
Multi Applications to install the MicroEJ Core Engine in “Multi-Sandbox” mode. Otherwise, the “Single appli-
cation” mode is installed.

5.7.9 Use

The EDC API Module must be added to the module.ivy of the MicroEJ Application Project. This MicroEJ module is
always required in the build path of a MicroEJ project; and all others libraries depend on it. This library provides a
set of options. Refer to the chapter Application Options which lists all available options.

<dependency org="ej.api” name="edc" rev="1.3.3"/>
The BON API Module must also be added to the module.ivy of the MicroEJ Application project in order to access the
[BON] library.

<dependency org="ej.api” name="bon" rev="1.4.0"/>

5.8 Advanced Event Tracing

5.8.1 Principle
MicroEJ Core Engine allows method execution to be profiled. The following two new hooks functions are used for
that:

+ LLMJVM_MONITOR_IMPL_on_invoke_method called atthe start of the method invocation.

o LLMJVM_MONITOR_IMPL _on_return_method called when returning from the invoked method.

Calling these functions each time a method is invoked will slow down the application execution, so these functions
are not called by default when event tracing is enabled and started.

Note: This feature requires Architecture version 7.17.0 or higher and is only available on MicroEJ Core Engine,
not on Simulator.

To activate them, you need to follow these steps:
« Enable and start the trace see here

« Tell the third-party linker program to redirect all calls to LLMIVM_invoke_method and
LLMIVM_return_method symbols to respectively LLMIVM_invoke_method_with_trace and
LLMIVM_return_method_with_trace symbols.
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5.8.2 Platforms using GNU LD linker

Add the following options to the LD linker command line:

--require-defined=LLMJVM_invoke_method_with_trace
--defsym=LLMJVM_invoke_method=LLMJVM_invoke_method_with_trace
--require-defined=LLMJVM_return_method_with_trace
-—defsym=LLMIVM_return_method=LLMIJVM_return_method_with_trace

5.8.3 Platforms using IAR ILINK linker

Pass the following options to the ILINK linker program

--redirect LLMJVM_invoke_method=LLMJVM_invoke_method_with_trace
--redirect LLMJVM_return_method=LLMIJVM_return_method_with_trace

5.9 Multi-Sandbox

5.9.1 Principle
The Multi-Sandbox capability of the MicroEJ Core Engine allows a main application (called Standalone Application)
to install and execute at runtime additional applications (called Sandboxed Applications).

The MicroEJ Core Engine implements the [KF] specification. A Kernel is a Standalone Application generated on a
Multi-Sandbox-enabled platform. A Feature is a Sandboxed Application generated against a specific Kernel.

A Sandboxed Application may be dynamically downloaded at runtime or integrated at build-time within the exe-
cutable application.
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5.9.2 Functional Description

The Multi-Sandbox process extends the overall process described in the overview of the platform process.

Sandboxed

Application code

Kemel

Application Build the Feature
executable

Binary

application
(application.fo)

Install the Feature Install the Feature in
on Device the executable
(Software InputStream) (Firmware Linker)

Fig. 19: Multi-Sandbox Process

Once a Kernel has been generated, additional MicroEJ Application code (Feature) can be built against the Kernel .
The binary application file produced ( application.fo)is compatible only for the Kernel on which it was gener-
ated. Generating a new Kernel requires that you generate the Features again on this Kernel.

For more details, please refer to the Kernel Developer Guide, especially Multi-Sandbox Kernel link and Sandboxed

Application link sections.

5.9.3 Memory Considerations

Multi-Sandbox memory overhead of MicroEJ Core Engine runtime elements are described in the table below.

Table 10: Multi-Sandbox Memory Overhead

Runtime element | Memory | Description
Object RW 4 bytes
Thread RW 24 bytes
Stack Frame RW 8 bytes
Class Type RO 4 bytes
Interface Type RO 8 bytes
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5.9.4 Dependencies

o LLKERNEL_impl.h implementation (see LLKERNEL: Multi-Sandbox).

5.9.5 Installation

Multi-Sandbox is an additional module, disabled by default.

To enable Multi-Sandbox of the MicroEJ Core Engine, in the platform configuration file, check Multi Applications

5.9.6 Use

The KF API Module must be added to the module.ivy of the MicroEJ Application project to use [KF] library.

<dependency org="ej.api” name="kf" rev="1.4.4"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

5.10 Tiny Application

5.10.1 Principle

The Tiny application capability of the MicroEJ Core Engine allows to build a main application optimized for size.
This capability is suitable for environments requiring a small memory footprint.

5.10.2 Installation

Tiny application is an option disabled by default. To enable Tiny application of the MicroEJ Core Engine, set the
property mjvm.standalone.configuration in configuration.xml file as follows:

<property name="mjvm.standalone.configuration” value="tiny"/>

See section Platform Customization for more info on the configuration.xml file.

5.10.3 Limitations

In addition to general Limitations:

« The maximum application code size (classes and methods) cannot exceed 256KB . This does not include
application resources, immutable objects and internal strings which are not limited.

» The option SOAR > Debug > Embed alltype names has no effect. Only the fully qualified names of
types marked as required types are embedded.
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5.11 Native Interface Mechanisms

The MicroEJ Core Engine provides two ways to link MicroEJ Application code with native C code. The two ways are
fully complementary, and can be used at the same time.

5.11.1 Simple Native Interface (SNI)
Principle

[SNI] specification defines how to cross the barrier between the Java world and the native world:

« Call a Cfunction from Java.
« Pass parameters to the C function.
+ Return avalue from the C world to the Java world.

« Manipulate (read & write) shared memory both in Java and C: the immortal space.

Functional Description

The following illustration shows both Java and C code accesses to shared objects in the immortal space, while also
accessing their respective memory.
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Fig. 20: [SNI] Processing

Example

package example;
import java.io.IOException;

/**

* Abstract class providing a native method to access sensor value.
* This method will be executed out of virtual machine.

*/

public abstract class Sensor {

public static final int ERROR = -1;

public int getValue() throws IOException {
int sensorID = getSensorID();
int value = getSensorValue(sensorlID);
if (value == ERROR) {
throw new IOException("Unsupported sensor”);
(continues on next page)
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(continued from previous page)

}
return value;

}

protected abstract int getSensorID();

public static native int getSensorValue(int sensorlID);

3
class Potentiometer extends Sensor {

protected int getSensorID() {
return Constants.POTENTIOMETER_ID; // POTENTIOMETER_ID is a static final
}

// File providing an implementation of native method using a C function
#include <sni.h>
#include <potentiometer.h>

#define SENSOR_ERROR (-1)
#define POTENTIOMETER_ID (3)

jint Java_example_Sensor_getSensorValue(jint sensor_id){

if (sensor_id == POTENTIOMETER_ID)

{
return get_potentiometer_value();
3
return SENSOR_ERROR;
3
Synchronization

A call to a native function uses the same RTOS task as the RTOS task used to run all Java green threads. So during
this call, the MicroEJ Core Engine cannot schedule other Java threads.

[SNI] defines C functions that provide controls for the green threads’ activities:

o int32_t SNI_suspendCurrentJavaThread(int64_t timeout) : Suspends the execution of the Java thread
that initiated the current C call. This function does not block the C execution. The suspension is effective only
at the end of the native method call (when the C call returns). The green thread is suspended until either an
RTOS task calls SNI_resumeJavaThread, or the specified number of milliseconds has elapsed.

e int32_t SNI_getCurrentJavaThreadID(void) : Permits retrieval of the ID of the current Java thread within
the C function (assuming it is a “native Java to C call”). This ID must be given to the SNI_resumeJavaThread
function in order to resume execution of the green thread.

o int32_t SNI_resumeJavaThread(int32_t id) : Resumes the green thread with the given ID. If the thread
is not suspended, the resume stays pending.
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Fig. 21: Green Threads and RTOS Task Synchronization

The above illustration shows a green thread (GT3) which has called a native method that executes in C. The C code

suspends the thread after having provisioned its ID (e.g. 3). Another RTOS task may later resume the Java green
thread.

Dependencies

No dependency.

Installation

The [SNI] library is a built-in feature of the Architecture, so there is no additional dependency to call native code

from Java. In the Platform configuration file, check Javato C Interface > SNIAPI to install the additional Java
APIs in order to manipulate the data arrays.

Use

The SNI API module must be added to the module.ivy of the Application project to use the [SN/] library.

<dependency org="ej.api” name="sni" rev="1.3.1"/>
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5.11.2 Shielded Plug (SP)

Principle

The Shielded Plug (SP) library provides data segregation with a clear publish-subscribe API. The data-sharing be-
tween modules uses the concept of shared memory blocks, with introspection. The database is made of blocks:
chunks of RAM.

Module 1 ) Module 2
ShieldedPlug (written in

Database JavaorC)

(written in
JavaorC)

Fig. 22: A Shielded Plug Between Two Application (Java/C) Modules.

Documentation Link

Java APls https://repository.microej.com/javadoc/microej_5.x/apis/ej/sp/
package-summary.html

Specification http://e-s-r.net/download/specification/ESR-SPE-0014-SP-2.0-A.pdf

Module https://repository.microej.com/modules/ej/api/sp/

Functional Description

The usage of the Shielded Plug (SP) starts with the definition of a database. The implementation uses an XML file
description to describe the database; the syntax follows the one proposed by the [SP] specification.

Once this database is defined, it can be accessed within the MicroEJ Application or the C application. The SP Foun-
dation Library is accessible from the [SP] API Module. This library contains the classes and methods to read and
write data in the database. The C header file sp.h available in the MicroEJ Platform source/include folder
contains the C functions for accessing the database.

To embed the database in your binary file, the XML file description must be processed by the SP compiler. This
compiler generates a binary file ( .o ) that will be linked to the overall application by the linker. It also generates
two descriptions of the block ID constants, one in Java and one in C. These constants can be used by either the Java
or the C application modules.

Shielded Plug Compiler

A MicroEJ tool is available to launch the compiler. The tool name is ' Shielded Plug Compiler . It outputs:

« Adescription of the requested resources of the database as a binary file ( . o) that will be linked to the over-
all application by the linker. It is an ELF format description that reserves both the necessary RAM and the
necessary Flash memory for the Shielded Plug database.

« Two descriptions, onein Javaand onein C, of the block ID constants to be used by either Java or C application
modules.
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Fig. 23: Shielded Plug Compiler Process Overview

Example

Below is an example of using a database. The code that publishes the data is writtenin C, and the code that receives
the data is written in Java. The data is transferred using two memory blocks. TEMP is a scalar value, THERMOSTAT
is a boolean.

Database Description

The database is described as follows:

<shieldedPlug>
<database name="Forecast” id="0" immutable="true" version="1.0.0">
<block id="1" name="TEMP" length="4" maxTasks="1"/>
<block id="2" name="THERMOSTAT" length="4" maxTasks="1"/>
</database>
</shieldedPlug>

Java Code

From the database description we can create an interface.

public interface Forecast {
public static final int ID = 0;
public static final int TEMP = 1;
public static final int THERMOSTAT = 2;

Below is the task that reads the published temperature and controls the thermostat.

public void run(){
ShieldedPlug database = ShieldedPlug.getDatabase(Forecast.ID);
while (isRunning) {
//reading the temperature every 30 seconds
//and update thermostat status
try {
int temp = database.readInt(Forecast.TEMP);
print(temp);
//update the thermostat status
(continues on next page)
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(continued from previous page)
database.writeInt(Forecast. THERMOSTAT, temp>tempLimit ? @ : 1);
3
catch(EmptyBlockException e){
print("Temperature not available");

}
sleep(30000);

C Code

Here is a C header that declares the constants defined in the XML description of the database.

#define Forecast_ID @
#define Forecast_TEMP 1
#define Forecast_THERMOSTAT 2

Below, the code shows the publication of the temperature and thermostat controller task.

void temperaturePublication() {
ShieldedPlug database = SP_getDatabase(Forecast_ID);
int32_t temp = temperature();
SP_write(database, Forecast_TEMP, &temp);

3

void thermostatTask(){
int32_t thermostatOrder;
ShieldedPlug database = SP_getDatabase(Forecast_ID);
while(1){
SP_waitFor(database, Forecast_THERMOSTAT);
SP_read(database, Forecast_THERMOSTAT, &thermostatOrder);
if(thermostatOrder == 0) {
thermostatOFF();
3
else {
thermostatON();
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Dependencies

o LLSP_impl.h implementation (see LLSP: Shielded Plug).

Installation

The [SP] library and its relative tools are an optional feature of the platform. In the platform configuration file,
check Javato ClInterface > Shielded Plug to install the library and its relative tools.

Use

The Shielded Plug APl Module must be added to the module.ivy of the Application project.

<dependency org="ej.api” name="sp" rev="2.0.2"/>

This library provides a set of options. Refer to the chapter Application Options which lists all available options.

5.11.3 MicroEJ Java H

Principle
This MicroEJ tool is useful for creating the skeleton of a C file, to which some Java native implementation func-

tions will later be written. This tool helps prevent misses of some #include files, and helps ensure that function
signatures are correct.

Functional Description

MicroEJ Java H tool takes as input one or several Java class files (*.class) from directories and / or JAR files. It looks
for Java native methods declared in these class files, and generates a skeleton(s) of the C file(s).

=

*.class

Fig. 24: MicroEJ Java H Process
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